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FCC Warning

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with this manual, may cause harmful interference to radio communications. Operation of this equipment in a residential
area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

CE Mark Warning
This is a Class A product. In a domestic environment, this product may cause radio interference in which case the user may be required
to take adequate measures.

Warnung!
Dies ist ein Produkt der Klasse A. Im Wohnbereich kann dieses Produkt Funkstoerungen verursachen. In diesem Fall kann vom
Benutzer verlangt werden, angemessene Massnahmen zu ergreifen.

Precaucion!
Este es un producto de Clase A. En un entorno doméstico, puede causar interferencias de radio, en cuyo case, puede requerirse al
usuario para que adopte las medidas adecuadas.

Attention!
Ceci est un produit de classe A. Dans un environnement domestique, ce produit pourrait causer des interférences radio, auquel cas
I"utilisateur devrait prendre les mesures adéquates.

Attenzione!
I1 presente prodotto appartiene alla classe A. Se utilizzato in ambiente domestico il prodotto puo causare interferenze radio, nel cui caso
¢ possibile che I"utente debba assumere provvedimenti adeguati.

VCCI Warning

ZOEERE. ERILASESEREZETETEERS (VOO 1) R
WRD S T2 ANREMRE T, COEBEHERETHER TS 2EE
HEEFEEITIEMANET. ZORGITEEAEABNLEECMT
LBLIERENS I EAE D ET.

BSMI Warning

EEHERE
15 7= F AR B R E . TR B R RIE fr E F I, A R S R R T8,
TEETEIEN T R E S HERENFEEREN R

MIC Warning
A= 77| (A58 dESA2]7])

ol 7|7|= e ELo= MALABIS K& e 7|7|0|2Y
O AL EE= ALEALE O] & F2|s5tA|7] Hi2jo{, atef
AZ ool £= FASIA S Moll= 7HE 822 WESHAZ|
Hhgh o

CCC Warning

IR ARER , HEERREF , XERTHEEXERETE
EEEELT , TEBFEAFHETEREYIETTHERE -



Table of Contents

Listof FigUres. . ... e e 9
Listof Tables . ... 13
About ThisDocument . .......... ... it 15
AUdIENCE . . . .o 15
Organization . . . .. ..ottt 15
Document Conventions. . .. ....oo ittt e 15
Safety INStructions. . ... ..o 16
Safety Cautions . .. ... 16
General Precautions for Rack-Mountable Products. .. ................. 18
Protecting Against Electrostatic Discharge .. ........................ 19

Battery HandlingReminder. .. ............. ... .. i 19

1 Overview of the D-Link Unified AccessSystem ........... 21
D-Link Unified Access System Components. . . ............vvnnn.. 21
D-Link Unified Switch. . ........ ... . 22

D-Link ACCESS POINt . . ... i e 22
WLANMisualization . ... o e 23
D-Link Unified Access SystemTopology . . ..., 23
Sngle Unified SwitchDeployment . ..., 24

Peer Unified SwitchDeployment ............. ... ... ... .. ... 24
Understandingthe User Interfaces. . .............. .. ... ... ...... 25
UsingtheWeb Interface ............. e 26

Using the Command-Linelnterface ............... ... ... ... ..... 28

USING SNMP & oo 29
Wireless System Features and Sandards Support . .................. 30

2 Planning the D-Link Unified Access System Network . .. ... 33
SystemM REqQUITEMENES. . . .. .o 33
WLAN Topology Considerations. . ..., 34
Access Point-to-Switch Discovery. . .. ..o e 36
AccessPoint Placement. . ... ... i 36
Network Planning to Support Layer 3Roaming. .. .................. 37

3 InstallingtheHardware.............. ... ... ... ...... 39
Hardware OVEIrVIEW . . .. ..o e 39
Front Panel Components. . . ... ...t 40

LED INdiCators . . . ..ot 41

Rear Panel Description. . ... e e e 43
SAdePanels . ... 43
Installation .. ... 44
Package Contents . . ... ..o e 44
Installation Guidelines . ... 44

Installing the Switch withouttheRack .............................. 45



D-Link Unified Access System User Manual

4

Installing the SwitchinaRack. . ............. .. ... ... .. i iio... 45
PoweringOntheSwitch. . ... . 46
Installingthe SFP POrts. . ... oot 46
Installing the Optional Modules . ............ ... ... .. ... 47
Connecting to the External Redundant Power System .................. 49
ConnectingtheSwitch . ........ ... .. 49
Connecting the SnvitchtotheNetwork. .. ........ ... ... ... ... ... 50
Connecting the Snvitchand AP Directly. . . ...t 50
Connecting the Switch and AP through the L2/L3 Network . ............. 51
ConnectingtotheCoreNetwork . .. ... i 51
Installing the D-Link Unified AccessSystem .............. 53
System Deployment OVErview. . .. ..o 53
Connecting the SwitchtotheNetwork . .......... .. ... .. ... .. .... 55
Enabling the WLAN FeaturesontheSwitch. . ...................... 56
Preparingthe AccessPoInts. ... ... 58
Loggingontothe AP . ... . i 58
Changingthe AP Password . . . . ...t e 59
Configuring 802.1X Authentication Informationonthe AP .............. 59
Configuring AP-to-Switch Authentication Information. ... .............. 60
Configuring VLAN Information on the AccessPoint. ................... 60
Discovering Access Pointsand Peer Switches. .. ................... 61
Understanding the Discovery Methods . . .......... ... ... ... .. ..., 61
Discovery and Peer SMItChes. . .. ... 64
Assigning the IP Address to Switchesand Managed APS . ... ............ 64
Enabling the AP and Peer Switch Discovery. ..............cocevuvn... 67
Authenticating and Validating AccessPoints. .. .................... 74
Configuring AP Authentication . . ........... it 75
Using the Local Database for AP Validation. . ........................ 76
Using the RADIUS Database for AP Validation .. ..................... 78
Managing Failedor Rogue APS . . ... ... . i 80
Configuring AccessPoint Settings. . ..................... 83
AP Profiles, Networks, and the Local Database. . .................. 83
AccessPoint Profiles. .. ... ... 83
NEWOIKS . .o e 84
Local AccessPoint Database. . ... ... 84
Configuring AAA and RADIUS SettingS . ... .. oo oo 85
Configuring WirelessRadio Settings . ... ...t 87
Configuring SSID Settings . . .. .. oo 93
Managing Virtual Access Point Configuration . ....................... 93
Configuring the Default Network. .. ... .o 94
Enabling and Configuring Additional VAPS . .. ......... ... ... ........ 98
Configuringa VAP for L3Tunnels. . .. ... 99
Configuring AP SECUrity .. ..ot e 101
Configuring Valid AccessPoint Settings ........................ 106
6 Managing and Maintaining D-Link AccessPoints......... 109

© 2001- 2008 D-Link Corporation. All Rights Reserved.



Resettingthe AccessPoints .. ... 109

Managing Radio Frequency Settings. .. .......... ..o 110
Configuring Channel Plan and Power Settings .. ... oL 110
Viewing the Channel PlanHistory ............. .. ... ... .. .. ..... 113
Initiating Manual Channel Plan Assignments. ... .................... 114
Initiating Manual Power Adjustments. .. .......... ... ... ... ..... 115

Upgrading the Access Point Software. .. ........................ 116

Performing Advanced Access Point Management .. ............... 119
Enabling AP Debugging . . ..o oo e 120
Adjustingthe Channel and Power. . ............. ... ..., 120

Monitoring Statusand Statistics. .............. ... ..., 123

Monitoring Wireless Global Information. ....................... 123
Viewing IP Discovery Satus. . .. .. oo oo e 126

MonitoringPeer SwitchStatus . . .. ... 126

Monitoring All AccessPoints .. ... 127

Monitoring Managed AccessPoint Satus .. ...................... 130
Monitoring Managed AP SatistiCS. . ... ..o 138

Viewing Access Point Authentication FailureSatus . ............... 142

Monitoring Rogue and RF Scan AccessPoints................... 143

Monitoring Associated Client Information. . ..................... 145
Viewing Associated Client Satus . ... 146
Viewing Associated Client SSID Satus. .. .. .. oo oo 149
Viewing Associated Client VAP Satus . .......coooivi e 149
Viewing Associated Client Satistics . . ........ooo i 149

Viewing Client Authentication FailureSatus. .. ................... 151

Monitoring and Managing AdHoc Clients . ..................... 153

Configuring Advanced Settings. . . ..................... 155

Creating, Configuring, and Managing AP Profiles. ............... 155
Creating, Copying, and Deleting AP Profiles. .. ..................... 157
Applyingan AP Profile. . ......... .. 158

Configuring Global Settings . .. ...........cc i, 159

EnablingSNMP Traps. . .. ... e 161

Configuring QOS. . . . ..o 163

Configuring the CaptivePortal .. ...................... 167

Configuring Global Captive Portal Settings. . .................... 168

Configuring the CaptivePortal . ........... ... ... .. .. ... . .. 169
Changing the Captive Portal Settings. ............ .. .. i, 170
Customizing the Captive Portal WebPage. . .. ...................... 172

Monitoring and Configuring Captive Portal Users . . .............. 174
Configuring Usersinthe Local Database. .. ........................ 175
Configuring Usersina Remote RADIUS Server. . ...ttt 176

Associating | nterfaces with the CaptivePortal . .. ................. 177

Viewing the Captive Portal Global Satus. .. ..................... 178

Viewing CP Activation and Activity Satus . . ... ... 179



D-Link Unified Access System User Manual

Viewing Interface Activation Status. . ..., 181
Viewing I nterface Capability Satus. . . ... 181
ViewingtheClient Summary. ............ .. 183
ViewingClientDetail . ......... .. i 184
Viewing the Client Satistics. . . ... ..o 185
Viewing the Client Interface AssociationStatus . ..................... 185
Viewing the Client CP AssociationSatus. . .. ..o, 186

INMP Trap Configuration . ............. .. 187

10 Visualizing the WirelessNetwork. .. .................... 189
I mporting and Configuring a Background Image. ................ 190
Setting Up the Graph Components. .. ..., 191
CreatingaNew Graph. . .. ...t 191
Graphingthe WLAN Components. . .......cviv e eieee 194
Understandingthe MenuBar Options . .. ........................ 196
Legend Menu . . . ... o 198
ManagingtheGraph. . ... .. 201

A D-Link Unified Access System Default Settings........... 203
Default D-Link Unified Smtch Settings . .. ... ..ot 203
Default D-Link Access Point Settings. . ... ... .o 204
Default D-Link Access Point Profile Settings. .. ................... 205
Default Captive Portal Settings . ... ... 206

B Configuringthe External RADIUS Server ............... 207
Configuring RADIUS Settings for AccessPoints. . ................. 207
FreeRADIUS Server Configuration Example. . .................... 209
Configuring RADIUSCIlients. . ... e e 209
Creating and Including an Attribute Dictionary .. .................... 209

Adding Access Pointstothe Valid AP Database. .. ................... 210
Configuring RADIUS Settings for WirelessClients .. ............... 211
Configuring RADIUSfor Client MAC Authentication. .. ............... 211
FreeRADIUS Example for Wireless Client Configuration. .. ......... 212
Configuring User-Based Authentication and Dynamic VLANS. . ......... 212
Configuring MAC Authentication . ..., 213

C L3RoamingExample ......... ... ... . i i 215
Configuring the WLAN and Tunnel Interfaces. .................... 216
Using a Loopback Interface for the Wireless Functions . ............... 217
Creating the VLAN Routing Interface . .. ........................... 218
Configuring the L3 Tunnel Network . .. .......... ... .. .. .. .. 220
Example of Configuring L3 Roaming by Usingthe CLI ................ 221
Example of Configuring L3 Roaming by Using the Web Interface .. .. .. .. 224
Configuring DHCP Relay andthe DHCP Server. .................. 225
ConfiguringtheRelay Agent . . . ... 225
ConfiguringtheDHCP Server. ... o e 226

D Understanding Quality of Service ...................... 229
QoSandLoadBalancing ... ... 229

6 ©2001- 2008 D-Link Corporation. All Rights Reserved.



802.11leand WMM SandardsSupport .. ..., 229

Coordinating TrafficFlow . ............ .. .. ... .. 230
QoSQueuesand DSCPonPackets .............. ... ..., 230
EDCF Control of Data Framesand AIFS .. ...................... 231
Random Backoff and Contention Windows. . . ..................... 232
Packet Bursting for Better Performance ......................... 232
TXOP Interval for Client Sations. .. ........... ..o .. 233
802.1pand DSCPtagS . . . .o oo 233
Limited Warranty (USAOnly) ........................ 235
Product Registration. . ...t 239
LimitedWarranty . .........o e e 240
What You Must Do For Warranty Service: . .......ooveiie et 241
What IsNotCovered . . .......... i e 241
Trademarks . .. ..o e e 242
Copyright Satement . ... e e e 242
FCCWMAINING. ..o e e e e e e e e 242
Technical Support. ...... ... o 243
International Offices. . ........... .. i 267
Registration Card

All Countriesand Regions ExcludingUSA. .. ..................... 268



D-Link Unified Access System User Manual

8 ©2001- 2008 D-Link Corporation. All Rights Reserved.



List of Figures

List of Figures

Figure 1. Sample WLAN VisSualiZation...........ccceieiereneneneneseeeeeeee e 23
Figure 2. Single Unified Switch with Layer 2 Roaming Support............cccceeueen... 24
Figure 3. Peer Unified Switch with Layer 3 Roaming SUPPOIt.........ccccceeeeeenees 25
Figure 4. Web Interface LayOuL............cooueeeieeiieieeneeeeeeeeeee s 26
Figure 5. Cascading Navigation MeNU ..........ccccceeeeiieieciesieeie e 27
Figure 6. Hierarchical Tree Navigation MenU..........ccceoveieieneninenencneeeeeeas 27
Figure 7. D-Link Unified Access System COmMPONENtS.........cccceverererereneniennens 34
Figure 8. Wiring Closet TOPOIOQY .....cc.ecvveireeiieeiesieeie et ete st 35
Figure 9. Data Center TOPOIOGY .....c..covererereeieieeriesie et 36
Figure 10. Inter-Subnet ROBMING ........coiiirieieieese e 38
Figure 11. Front Panel View of the DWS-3024L as Shipped ........ccccccevvevveennnee. 40
Figure 12. Front Panel View of the DWS-3024 as Shipped...........ccoovininineenens 40
Figure 13. Front Panel View of the DWS-3026 as Shipped...........ccoovivininennene 40
Figure 14. LED Indicators on DWS-3024L .........ccceoveiecieieeie e 41
Figure 15. LED Indicators 0N DWS-3024 ..........ooeiieiiieieieneneese e 41
Figure 16. LED Indicators 0N DWS-3026 ..........ccoerereeeeieienieseesiesiesiesieeieeeeeas 41
Figure 17. Rear panel view of DWS-3024/DWS-3024L ........cccceevveceiiesieenene 43
Figure 18. Rear panel view Oof DWS-3026 .........cccceieierienienienesieseseseseeeeeeeas 43
Figure 19. Prepare Switch for Installation on a Desktop or Shelf ... 45
Figure 20. Fasten Mounting Bracketsto SWitCh...........ccccevveceiieveccie e 45
Figure 21. Mounting the Switch ina Standard 19" Rack ..........c.ccooeveeiiicccncee 46
Figure 22. Inserting the Fiber-Optic Transceiversinto the Switch....................... 47
Figure 23. Front Panel of the DEM-410X ........cccccoviieiiereeeeseese e 48
Figure 24. Front Panel of the DEM-410CX .......ccccoeiiiininenineneeeeeeee e 48
Figure 25. Inserting the optional module into the Switch (DWS-3026)............... 48
Figure 26. DWS-3026 with optional DEM-410X module installed..................... 49
Figure 27. RPS CONNECTON ........o.eiieieieriesiesiesit et sre s 49
Figure 28. Switch and AP Connected DIreCtly .........ccoceoeeiienenenineiesereeeeeens 50
Figure 29. Switch and APs Connected Through Network...........c.cccoecvveevinennee. 51
Figure 30. Switch Connected to NetWOrk COre..........ccceoveiererenineneneseeeeeenes 51
Figure 31. Ethernet Connection for Static IP Assignment...........cccccoeevinecenenne 58
Figure 32. L2 Discovery EXample.......cccoovoeiieie i 62
Figure 33. L3 Discovery EXample ..o 62
Figure 34. L3 Discovery EXampPIe 2........cooiiiinineineeeeee s 63
Figure 35. DHCP Option EXamMPIe........ccccoveiieeecice e 63
Figure 36. Requiring AP AUtNENtiCaLION ..........cooviiiiieieeeee e 76
Figure 37. MAC ACCESS CONIOI .......coviiieiieieieieeie et 86
Figure 38. RadiO SEINGS.......ccoviieiiieiesiese ettt nas 88
FIQUIre 39. VAP SELlINGS.......coirieiierieeeeeeeee st 93
Figure 40. Configuring NetwOork Settings...........cccoeerererereneneneeeeee e 95
Figure 41. AP Profile With Five VAPsEnabled ... 98
Figure 42. Networks Available to the Wireless Client ...........ccovievenineninennns 98
Figure 43. L3 Roaming EXampIe..........cocooiriiiiiieereee e 100



D-Link Unified Access System User Manual

10

Figure 44. AP Network Security OptionS.........cccucceeveeiieieeseeie e sie e seesieeeens 101
Figure 45. Static WEP Configuration ...........ccccecvreeneeieeseese e e 102
Figure 46. WPA Personal Configuration...........ccccoeuererenenesieeseenese s 104
Figure 47. Adding aValid AP ...t 106
Figure 48. Configuring aValid AP........cccov et 107
Figure 49. ACCESS POINt RESEL ........ooviiiiiiiirieeeeeeee e 109
Figure 50. RF Channel Plan and Power Configuration ...........ccccceeveevveieevieenee. 111
Figure 51. Channel Plan HiStOrY........cccocoeeiieieiiesece e 113
Figure 52. Manual Channel Plan ... 114
Figure 53. Manual Power AdiUSIMENES ........cceevueiiecicie e 115
Figure 54. AP UPQIade.......ccveiuieeceee ettt 116
Figure 55. AP UPQrade SLALUS. .......cccooerierierieriesiesiesiesieeee e 117
Figure 56. Advanced AP Management............cccveveveeiieneeseeie e sie e see s 119
Figure 57. Global WLAN SEEEUS .......ccceieeeieeiesieeie et 124
Figure 58. Wireless DiSCOVENY SEALUS.........cccerueriereriinieriesieeeeeesee e 126
Figure 59. Peer SWItCh STALUS........ccceceeieeiecee e 127
Figure 60. All ACCESS POINES.......cccciiiieciecie ettt 127
Figure 61. Managed AP SEALUS ..........cceiirerieniesierieeeeee e 130
Figure 62. Managed AP StatISICS.......c.ccceveeieiieseerie et 138
Figure 63. Authentication Failed AP StatuS..........c.ccccevveeeveere e 142
FIQUIE B4, RF SCAN ..ottt e 144
Figure 65. Associated Client SLALUS.........ccccveieereeiesierie e eee e 145
Figure 66. Client Authentication Failure Status.............cccovveeveeveceececce e, 152
Figure 67. Ad HOC ClIENTS.......coiiiiieceee e e 153
Figure 68. Multiple AP Profil€S.........coiiece e 156
Figure 69. Adding aProfile........ccccviieiiece e 157
Figure 70. Configuring an AP Profile...........cooiiiiiiieeeeeese e 157
Figure 71. Applying the AP Profile.......ccoveeieeeicecece e 158
Figure 72. Global Configuration.............ccecveiueiieeseeie e 159
Figure 73. SNMP Trap Configuration ...........cceoerereneneneneseeee e 161
Figure 74. Q0S CONfiQUIaion .........cccveeeiieiieiee s eie et 163
Figure 75. Navigating to the Captive Portal Feature...........ccccceevvevecceeveeieennnnn, 167
Figure 76. Global Captive Portal Configuration..............coeverereeenieeneneneneens 168
Figure 77. Captive Portal SUMMAIY .......cccccevieiiiieiicie e 169
Figure 78. Captive Portal Configuration............cccceevveieieeseeie e eseeseeseeenens 170
Figure 79. CP Web Page CUStOMIZALION .........ccooiierieriinienieseeeeee e 172
Figure 80. Captive Portal Local User SUMMary .........cccceceveeveeeesecieseesieeeens 174
Figure 81. Local User Configuration............ccceevueeeeieerienieeseesie e sieeseeseesseenens 175
Figure 82. Global Captive Portal Configuration..............coevererenieeieeneneneneens 177
Figure 83. Global Captive Portal Status ............cceeeverieeiieieeseeie e 178
Figure 84. CP Activation and ACtiVity StatUS..........ccceeveeveereiieesieie e 179
Figure 85. Interface ACiValion SEALUS .........ccervereerireneniereeeee e 181
Figure 86. Interface Capability StatUS ..........ccceeveeeerieeieceese e 182
Figure 87. ClIent SUMMAIY .........cceiueiieieee st 183
Figure 88. Client DELail .........ccooiiiiiiieeeere e 184
Figure 89. Client StatiStiCS......ccveiirrieieceese e 185

© 2001- 2008 D-Link Corporation. All Rights Reserved.



List of Figures

Figure 90. Interface - Client SEatUS........cccvcceeiieieciecece e 185
Figure 91. CP - Client SLALUS........cccvieeriecie et et 186
Figure 92. SNMP Trap Configuration ..........cccceeeererereneneneseeee e 187
Figure 93. Sample WLAN VisualiZation...........cccccveveeiereeiesiee e see e 190
Figure 94. MUItiple Graphs..........ccoieii et 194
Figure 95. List View and Tabbed VIeW.........cccoviriiiiiiicccee e 194
Figure 96. Component TOO! TiP ....ccveieeeieieeseeie ettt 195
Figure 97. Graphed COMPONENLS...........coiviieiieiieeieseeree e eee e sre e 196
FIQUIE 98. LEGENG ...ttt 198
Figure 99. Sentry Mode - Detailled VIeW.........cccoevveeeiece e 199
Figure 100. Channel ColOrS.........ccciiiieiiee ettt 199
Figure 101. Tool Tip for Radio Managed AP Information.............cccccecvreruenene. 200
Figure 102. Wireless Component AttribDULES ...........cocvieeiieciiie e, 201
Figure 103. Example of a Network with L3 Tunnel Subnet...............cccerueeeee. 216
Figure 104. Traffic PrioritiZation..........c.ccooeeeeiierieneseseseseeeseeee e 234

11



D-Link Unified Access System User Manual

12 ©2001- 2008 D-Link Corporation. All Rights Reserved.



List of Tables

List of Tables

Table 1. Typographical Conventions . .. ............ it 16
Table2. LED DesCription . ...t et 42
Table 3. Basic Wireless Global Configuration . ......................... 56
Table 4. IEEE 802.1X Supplicant Commands . ......................... 59
Table 5. APVLAN Commands . . ... vov vt 61
Table 6. L3/IP DISCOVEIY . . .ottt e e e e e 70
Table7. Global RADIUS Server . ... 85
Table8. MAC Authentication ......... ..., 87
Table9. Radio SEttings . . ... ..o 88
Table 10. Advanced Radio Configuration .. ........... ... ... oo, 92
Table 11. Default VAP Configuration .. ............. i, 9
Table 12. Wireless Network Configuration . ............. .. ..o, 95
Table13. StAtiCWEP . ... ..o 102
Table14. Static WPA . 104
Table 15. Valid AccessPoint Summary ..............ooiiiinen.n.. 106
Table16. Valid AP Configuration .. ..., 107
Table 17. RF Channel Plan and Power Adjustment ..................... 112
Table18. Channel Plan History . ... 114
Table19. APUpPgrade .. ... 116
Table20. APUpgrade Status . . .. .. oot 118
Table21. Advanced APManagement .. ............ i, 119
Table22. APDEDUG . . ... oo 120
Table 23. Managed AP Channel/Power Adjust .. ....................... 120
Table 24. Global WLAN StatistiCs . .....oovii e 124
Table25. Peer SwitchStatus . ... ... i 127
Table 26. Monitoring All AccessPoints ............... ..., 128
Table 27. Managed AccessPoint Status .. ..., 130
Table 28. Detailed Managed AccessPoint Status .. ..................... 132
Table29. Managed APRadioSummary .............. ..., 134
Table 30. Managed APRadioDetail ............... ... ... ... .. ... .... 134
Table 31. Managed AP Neighbor Status ... ..., 136
Table32. Neighbor APClients ............. i, 137
Table 33. Managed AccessPoint VAP Status . .. ...t 138
Table 34. Managed Access Point WLAN Summary Statistics ............. 139
Table 35. Managed Access Point Ethernet Summary Statistics ............ 139
Table 36. Detailed Managed Access Point Statistics . . .. ................. 140
Table 37. Managed Access Point Radio Statistics . . ..................... 140
Table 38. Managed Access Point VAP Statistics ....................... 141
Table 39. Access Point Authentication FaillureStatus . . ... ............... 143
Table40. AccessPointRFScanStatus . ... ... .o 145
Table 41. Associated Client StatusSummary .............cccovvennn... 146
Table42. Detailed Associated Client Status ... ..., 147
Table 43. Associated Client Neighbor AP Status .. ..................... 148

13



D-Link Unified Access System User Manual

14

Table 44. Associated Client SSID Status . . . .. ..o o 149
Table 45. Associated Client VAP Status .. ... ..o 149
Table 46. Associated Client Association Summary Statistics . ............. 150
Table 47. Associated Client Summary Statistics . ....................... 150
Table 48. Associated Client Association Detail Statistics . ................ 150
Table 49. Associated Client Session Detail Statistics .................... 151
Table50. FailledClient Status . ...t e 152
Table 51. Client Authentication FailureStatus . ........................ 153
Table52. AdHocClientStatus .. ... ..o 154
Table 53. General Global Configurations ............................. 160
Table54. SNMP Traps . ..ot e 161
Table55. QOS SEttiNgS . . ..ot 164
Table 56. Global Captive Portal Configuration ......................... 168
Table57. Captive Portal Summary ............ ... 169
Table58. CPConfiguration . . ... e 170
Table 59. CP Web Page Customization ... ............ccoiviinenan.... 173
Table60. Local User SUMMAry . ......cviiiii it 175
Table 61. Local User Configuration ..............c.cuiiniiininnennen.. 175
Table 62. Captive Portal User RADIUS Attributes . .. ................... 176
Table 63. Global Captive Portal Configuration ......................... 177
Table 64. Global Captive Portal Status . .............. ... 179
Table 65. CP Activationand Activity Status . . .. ....................... 180
Table 66. Interface Activation Status .. ... 181
Table 67. Interface and Capability Status .. ......... ... ... ... ... ... ... 182
TableB68. Client SUMMary . ...... ...t et 183
TableB9. ClientDetail .. ... ...t e 184
Table 70. Client Interface Association Connection Statistics .............. 185
Table 71. Interface- Client Status . . . ... e 186
Table72. CP-Client StatuS . . . .. ..o vt 186
Table 73. SNMP Trap Configuration ............ .. ... 187
Table 74. WLAN Visuaization Menu Bar Options ..................... 196
Table 75. Component Information . .. ............ ... ... 201
Table76. SwitchDefaults ............ .. .. 203
Table77. Default AP Settings ...t 204
Table 78. AP ProfileDefault Settings . ...........cco i 205
Table 79. Default Captive Portal Settings . ..., 206
Table 80. RADIUS Attributes for the AccessPoint ..................... 207
Table 81. RADIUS Attributes for WirelessClients ..................... 211
Table 82. RADIUS Attributes for Wireless Client MAC Authentication . . . . . 211
Table83. L3 Tunnel StatusValues ..., 223
Table84. VLAN Priority Tags . ....cviii e 234

© 2001- 2008 D-Link Corporation. All Rights Reserved.



About This Document

About This Document

This guide describes the planning, setup, configuration, administration, and maintenance for
the D-Link Unified Access System.

Audience

Theinformation in thisguideisintended for the person responsible for installing, configuring,
monitoring, and maintaining the D-Link Unified Access System as part of a network
infrastructure.

Organization

The D-Link Unified Access System User Manual contains the following chapters:

e Chapter 1, “Overview of the D-Link Unified Access System” on page 21

» Chapter 2, “Planning the D-Link Unified Access System Network” on page 33
» Chapter 3, “Installing the Hardware” on page 39

»  Chapter 4, “Installing the D-Link Unified Access System” on page 53

»  Chapter 5, “Configuring Access Point Settings’ on page 83

»  Chapter 6, “Managing and Maintaining D-Link Access Points’ on page 109
*  Chapter 7, “Monitoring Status and Statistics” on page 123

e Chapter 8, “Configuring Advanced Settings’ on page 155

»  Chapter 9, “Configuring the Captive Portal” on page 167

»  Chapter 10, “Visualizing the Wireless Network” on page 189

* Appendix A, “D-Link Unified Access System Default Settings’ on page 203
* Appendix B, “Configuring the External RADIUS Server” on page 207

* Appendix C, “L3 Roaming Example” on page 215

» Appendix D, “Understanding Quality of Service” on page 229

* Appendix E, “Limited Warranty (USA Only)” on page 235

» Appendix F, “Technical Support” on page 243

Document Conventions

This section describes the conventions this document uses.
NOTE: A Note provides more information about a feature or technology.
CAUTION: A Caution provides information about critical aspects of the

configuration, combinations of settings, events, or procedures that can
adversely affect network connectivity, security, and so on.

Audience 15
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This guide uses the typographical conventions that Table 1 describes.
Table 1. Typographical Conventions

Symbol Description Example
Bold Menu titles, page names, and button names Click Submit to apply your
Settings.
Blue Text Hyperlinked text. See” About This Document”

on page 15.

courier font

Screen text, file names.

(swi tch-pronpt)#

courier bold

Commands, user-typed command-line entries

show net wor k

courier font Command parameter, which might be a val ue
italics variable or fixed value.
<> Anglebrackets Indicates aparameter isavariable. Youmust  <val ue>
enter avalue in place of the brackets and text
inside them.
[ ] Square brackets  Indicates an optional fixed parameter. [ val ue]
[<>] Angle Indicates an optional variable. [ <val ue>]
brackets within
square brackets
{} curly braces Indicates that you must select a parameter {choicel | choice2}
from thelist of choices.
| Vertical bars Separates the mutually exclusive choices. choicel | choice2
[{}] Braceswithin  Indicate a choice within an optional element.  [{choi cel | choice2}]
square brackets

Safety Instructions

Use the following safety guidelines to ensure your own personal safety and to help protect
your system from potential damage.

Safety Cautions

To reduce the risk of bodily injury, electrical shock, fire, and damage to the equipment,
observe the following precautions.

Observe and follow service markings. Do not service any product except as explained in
your system documentation. Opening or removing covers that are marked with the
triangular symbol with alightning bolt may expose you to electrical shock. Only atrained
service technician should service components inside these compartments.

If any of the following conditions occur, unplug the product from the electrical outlet and
replace the part or contact your trained service provider:

- The power cable, extension cable, or plug is damaged.
- Anobject hasfallen into the product.

- The product has been exposed to water.

- The product has been dropped or damaged.

- The product does not operate correctly when you follow the operating instructions.
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Keep your system away from radiators and heat sources. Also, do not block the cooling

vents.

Do not spill food or liquids on your system components, and never operate the product in

awet environment. If the system gets wet, see the appropriate section in your

troubleshooting guide or contact your trained service provider.

Do not push any objects into the openings of your system. Doing so can cause afire or an

electric shock by shorting out interior components.

Use the product only with approved equipment.

Allow the product to cool before removing covers or touching internal components.

Operate the product only from the type of external power source indicated on the electrical

ratings label. If you are not sure of the type of power source required, consult your service

provider or local power company.

To help avoid damaging your system, be sure the voltage selection Switch (if provided) on

the power supply is set to match the power available at your location:

- 115voalts(V)/60 hertz (Hz) in most of North and South America and some Far Eastern
countries such as South Korea and Taiwan

- 100 V/50 Hz in eastern Japan and 100 V/60 Hz in western Japan

- 230V/50 Hz in most of Europe, the Middle East, and the Far East

Also be sure that attached devices are electrically rated to operate with the power available

in your location.

Use only approved power cable(s). If you have not been provided with a power cable for

your system or for any AC-powered option intended for your system, purchase a power

cable that is approved for use in your country. The power cable must be rated for the

product and for the voltage and current marked on the product's electrical ratings label.

The voltage and current rating of the cable should be greater than the ratings marked on

the product.

To help prevent an electric shock, plug the system and peripheral power cablesinto

properly grounded electrical outlets. These cables are equipped with three-prong plugs to

help ensure proper grounding. Do not use adapter plugs or remove the grounding prong

from acable. If you must use an extension cable, use a 3-wire cable with properly

grounded plugs.

Observe extension cable and power strip ratings. Make sure that the total ampere rating of

all products plugged into the extension cable or power strip does not exceed 80 percent of

the ampere ratings limit for the extension cable or power strip.

To help protect your system from sudden, transient increases and decreases in electrical

power, use a surge suppressor, line conditioner, or uninterruptible power supply (UPS).

Position system cables and power cables carefully; route cables so that they cannot be

stepped on or tripped over. Be sure that nothing rests on any cables.

Do not modify power cables or plugs. Consult alicensed electrician or your power

company for site modifications. Always follow your local/national wiring rules.

When connecting or disconnecting power to hot-pluggable power supplies, if offered with

your system, observe the following guidelines:

- Install the power supply before connecting the power cable to the power supply.

- Unplug the power cable before removing the power supply.

- If the system has multiple sources of power, disconnect power from the system by
unplugging al power cables from the power supplies.

Move products with care; ensure that all casters and/or stabilizers are firmly connected to

the system. Avoid sudden stops and uneven surfaces.
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General Precautions for Rack-Mountable Products

Observe the following precautions for rack stability and safety. Also refer to the rack
installation documentation accompanying the system and the rack for specific caution
statements and procedures.

» Systems are considered to be components in arack. Thus, “component” refersto any
system as well asto various peripherals or supporting hardware.

CAUTION: Installing systemsin arack without the front and side stabilizersinstalled
could cause the rack to tip over, potentially resulting in bodily injury
under certain circumstances. Therefore, always install the stabilizers
before installing components in the rack.

» After installing system/components in arack, never pull more than one component out of
the rack on its lide assemblies at one time. The weight of more than one extended
component could cause the rack to tip over and may result in serious injury.

» Before working on the rack, make sure that the stabilizers are secured to the rack,
extended to the floor, and that the full weight of the rack rests on the floor. Install front and
side stabilizers on asingle rack or front stabilizers for joined multiple racks before
working on the rack.

» Alwaysload the rack from the bottom up, and load the heaviest item in the rack first.

» Make surethat the rack islevel and stable before extending a component from the rack.

»  Use caution when pressing the component rail release latches and sliding a component
into or out of arack; the diderails can pinch your fingers.

» After acomponent isinserted into the rack, carefully extend the rail into alocking
position, and then dlide the component into the rack.

» Do not overload the AC supply branch circuit that provides power to the rack. The total
rack load should not exceed 80 percent of the branch circuit rating.

» Ensure that proper airflow is provided to components in the rack.

» Do not step on or stand on any component when servicing other componentsin arack.

NOTE: A qualified electrician must perform all connectionsto DC power and to
safety grounds. All electrical wiring must comply with applicable local or
national codes and practices.

CAUTION: Never defeat the ground conductor or operate the equipment in the
absence of asuitably installed ground conductor. Contact the appropriate
electrical inspection authority or an electrician if you are uncertain that
suitable grounding is available.

CAUTION: Thesystem chassis must be positively grounded to the rack cabinet frame.
Do not attempt to connect power to the system until grounding cables are
connected. Completed power and safety ground wiring must be inspected
by aqualified electrical inspector. An energy hazard will exist if the safety
ground cable is omitted or disconnected.
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Protecting Against Electrostatic Discharge

Static electricity can harm delicate components inside your system. To prevent static damage,
discharge static electricity from your body before you touch any of the electronic components,
such as the microprocessor. You can do so by periodically touching an unpainted metal surface
on the chassis.

You can also take the following steps to prevent damage from electrostatic discharge (ESD):

1. When unpacking a static-sensitive component from its shipping carton, do not remove the
component from the antistatic packing material until you are ready to install the
component in your system. Just before unwrapping the antistatic packaging, be sure to
discharge static electricity from your body.

2. When transporting a sensitive component, first place it in an antistatic container or
packaging.

3. Handleall sensitive componentsin a static-safe area. If possible, use antistatic floor pads
and workbench pads and an antistatic grounding strap.

Battery Handling Reminder

CAUTION: Thereisadanger of explosion if the battery isincorrectly replaced.
Replace only with the same or equivalent type of battery recommended
by the manufacturer. Discard used batteries according to the
manufacturer's instructions.

Safety Instructions 19
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Overview of the D-Link Unified Access
System

The D-Link Unified Access System is awireless local area network (WLAN) solution that
enables WLAN deployment while providing state-of-the-art wireless networking features. It is
a scalable solution that provides secure wireless connectivity and seamless layer 2 and layer 3
roaming for end users.

This chapter contains the following sections:

» D-Link Unified Access System Components

» D-Link Unified Access System Topology

e Understanding the User Interfaces

»  Wireless System Features and Standards Support

D-Link Unified Access System Components

The D-Link Unified Access System components include the D-Link Unified Switch and the
D-Link Access Point (AP).

The DWS-3024L Unified Switch can manage up to 24 D-Link Access Points, whereas the
DWS-3024 and the DWS-3026 switches can manage up to 48 D-Link Access Points. Each
managed access point can handle up to 512 associated wireless clients (256 per radio). The
switch tracks the status and statistics for al associated WLAN traffic and devices.

You can configure up to four peer D-Link Unified Switches that share various information
about APs and their associated wireless clients. The peer Unified Switches can be directly
connected to each other, separated by layer 2 bridges, or located in different 1P subnets.
Wireless clients can roam among the access points managed by peer Unified Switches without
losing network connections.

Whether or not you have a peer group, the D-Link Unified Access System can support a total
of 8000 wireless clients.

D-Link Unified Access System Components 21
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D-Link Unified Switch

The D-Link Unified Switch handles Layer 2, 3, and 4 switching and routing functions for
traffic on the wired and wireless LAN. The DWS-3024L manages up to 24 access points
(APs), and the DWS-3024 and DWS-3026 switches manage up to 48 APs. The Unified Switch
user interface allows you to configure and monitor all AP settings and maintain a consi stent
configuration among all APsin the network.

The Unified Switch supports advanced data path connectivity, mobility control, security
safeguards, control over radio and power parameters, and management features for both
network and element control. The Unified Switch allows you to control the discovery,
validation, authentication, and monitoring of peer Unified Switches, D-Link Access Points,
and clients on the WLAN, including discovery and status of rogue APs and clients.

The D-Link Unified Access System works with the following D-Link switches:

 DWS-3024 (24 GE ports)
DWS-3024L (24 GE ports)
»  DWS-3026 (24 GE ports + 2 10G ports)

D-Link Access Point

The D-Link Access Point can operate in one of two modes. Standalone Mode or Managed
Mode. In Standalone Maode, the D-Link Access Point acts as an individual access point in the
network, and you manage it by connecting to the AP and using the Administrator Web User
Interface (Ul) or command-lineinterface (CLI). In Managed Mode, the D-Link Access Point
is part of the D-Link Unified Access System, and you manage it by using the D-Link Unified
Switch. If an AP isin Managed Mode, the Administrator Web Ul services on the AP are
disabled. Accessislimited to the CLI through Telnet.

The Standalone Mode is appropriate for small networks with only afew APs. The Managed
Mode is useful for any size network. If you start out with D-Link Access Pointsin Standalone
Mode, you can easily transition the APs to Managed Mode when you add a Unified Switch to
the network. By using the AP in Managed Mode, you can centralize AP management and
streamline the AP upgrade process by pushing configuration profiles and software upgrades
from the Unified Switch to the managed APs. The D-Link Unified Access System User Manual
primarily describes the D-Link Access Point in Managed Mode. For information about
configuring the D-Link Access Point in Standalone Mode, see the Unified Access Point (AP)
Administrator’s Guide.

The D-Link Unified Access System works with the following D-Link access points:

+ DWL-3500AP
» DWL-8500AP

The DWL-3500A P supports one radio, and the DWL-8500A P supports two radios. The DWL-
3500A P radio and one of the DWL-8500AP radios operatein |EEE 802.11g mode. The second
radio on the DWL-8500AP operates in | EEE 802.11a mode.

Each access point supports up to eight virtual access points (VAPSs) on each radio. The VAP
feature allows you to segment each physical access point into eight logical access points (per
radio) that each support aunique SSID, VLAN ID, and security policy.
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WLAN Visualization

The D-Link Unified Access System includes the WLAN Visualization tool, which provides a
graphical representation of your wireless network through a Web browser. WLAN
Visualization detects and displays the D-Link Unified Switch, D-Link Access Points, other
access points, and all wireless clients associated with the D-Link Access Point. You can import
information about your building layout to customize the network view.

Figure 1 shows an example of afloor plan and network with a D-Link Unified Switch that
manages two APs. The graph also shows a peer switch and arogue AP in the network.

Figurel. Sample WLAN Visualization

File Edit View Options Legend Help

&afa] DLt

Bulling Hetatels e Prapie

Switches | Buiding 100 |

v

nz2 i 110 | 108 | 108
i :

- .8 o 1k 's 'i_'::_
_03 116 i Jase | s ] 1m0
12
o
/ '

Managed APs

F j: \Ti _:mhurn_
=] G b T |l)
B [

! = 5 124 123 122 121 120
o= —0 g_g— | 1 c
L s

: =

RF Scan APs B
00:00:84:20:50:10 —
00:02:BC:00:12:90
00:02:BC:00:12:91 :
00:02:BC:00:13:50
q I DEE

The WLAN Visualization tool provides an AP power display with color-coded channelsto

help you determine where to physically place access points to reduce interference or increase
coverage on your WLAN.

D-Link Unified Access System Topology

The WLAN network topology you use depends on the size and requirements of your network.
Small-to-medium networks might require only one Unified Switch that manages afew D-Link
Access Points. For larger networksthat need greater roaming capabilitiesfor wirelessclients, a
deployment with multiple peer switches that each manage several APs might be appropriate.
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Single Unified Switch Deployment

When you deploy a D-Link Access Point, the D-Link Unified Switch can automatically detect
the AP and assign a default profile, which includes automatic RF channel selection and
automatic power adjustment. Figure 2 shows a deployment with one D-Link Unified Switch
that manages three D-Link Access Points.

Figure 2. Single Unified Switch with Layer 2 Roaming Support
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Unified Switch
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Serial Connection

Remote Management
Station
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When the APs are on the same subnet and have the same SSID, wireless clients can seamlessly
roam among the three APs with no interruption in network access. The client keeps the same
I P address and does not need to re-authenticate when it moves into the broadcast area of a
different AP. Configuration changes to the APs are managed by the switch simultaneously or
on aper-AP basis.

Peer Unified Switch Deployment

To support larger networks, you can configure up to four switches as peers, which increases
the size and range of the WLAN. Figure 3 shows a D-Link Unified Access System
deployment that utilizes three peer Unified Switches. Each peer Unified Switch can manage

© 2001- 2008 D-Link Corporation. All Rights Reserved.



1 Overview of the D-Link Unified Access System

up to 48 access points (DWS-3024 and DWS-3026) or 24 access points (DWS-3024L). The
Unified Switch and the APs it manages do not need to be on the same subnet.

Figure 3. Peer Unified Switch with Layer 3 Roaming Support
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Peer Unified Switches share information about APs and allow Layer 3 roaming among them.
To support this, peer Unified Switches establish |Pv4 tunnels so that the wireless client keeps
the same I P address even when the client associates with an access point in a different subnet.
The Layer 3 roaming service allows wireless phone users to roam between access points
connected to different subnets without dropping calls.

Understanding the User Interfaces

The D-Link Unified Access System enables centralized management of multiple wireless
access points, which not only facilitates deployment and management, but also enhances
security. The D-Link Unified Access System includes a set of comprehensive management
functions for managing and monitoring the WLAN by using one of the following three
methods:

*  Web-based
e Command-Line Interface (CLI)
» Simple Network Management Protocol (SNMP)

Each of the standards-based management methods enables you to configure, manage, and
control the components of the D-Link Unified Access System locally or remotely.
Management is standards-based, with configuration parameters and a private MIB that
provides control for functions not completely specified in the standard MIBs.

The method you use to configure and monitor the D-Link Unified Switch depends on your
network size and requirements, and on your preference.
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Using the Web Interface

The following Web browsers are supported for Web interface accessto the switch:

+  Microsoft® Windows® Internet Explorer 6.0
»  Microsoft® Windows® Internet Explorer 7.0

Use the following procedures to log on to the Web Interface:

1. Open aWeb browser and enter the IP address of the switch in the Web browser address

field.

2. Enter the user name and password into the dialogue box that appears.

The user name and password are the same as those you use to log on to the command-line
interface. By default, the user name is admin, and there is no password.

3. After the system authenticates you, the System Description page displays.

Figure 4 shows the layout of the D-Link Unified Switch Web interface. Each Web page
contains three main areas: interface configuration graphic, the navigation tree, and the

configuration status or options.

Figure4. Web Interface L ayout
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The interface configuration graphic is a Java™ applet that displays the ports on the D-Link

Unified Switch. This graphic appears at the top of each page to provide an aternate way to
navigate to configuration and monitoring options.
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Click the port you want to view or configure to see a menu that displays statistics and
configuration options. Click the menu option to access the page that contains the configuration
or monitoring options. Click L ogout to log out of the Web Interface. From the Logout prompt,
click Ok to save your changes and make the changes permanent. Click Cancel to close the
Web Interface without saving your changes.

If you click the graphic but do not click a specific port, the main menu appears. This menu
contains the same option as the navigation menu on the left side of the page.

Figure5. Cascading Navigation Menu
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A hierarchical-tree view appears to the left of the panel. The tree consists of a combination of
folders, subfolders, and configuration and status HTML pages. Click the folder to view the
optionsin that folder. Each folder contains either subfolders or HTML pages, or acombination
of both. Figure 6 shows an example of afolder, subfolder, and HTML page in the navigation
menu. When you click afolder or subfolder that is preceded by aplus (+), the folder expands
to display the contents. If you click an HTML page, a new page displays in the main frame. A
folder or subfolder has no corresponding HTML page.

Figure 6. Hierarchical Tree Navigation Menu
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The panel directly under the graphic and to the right of the navigation menu displays the
configuration information or status for the page you select. On pages that contain
configuration options, you can input information into fields or select options from drop-down
menus.
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Each page contains access to the HTML -based Help that explains the fields and configuration
options for the page. Many pages also contain command buttons.

The following command buttons are used throughout the pages in the Web interface:

Submit Clicking the Submit button sends the updated configuration to the switch.
Configuration changes take effect immediately, but some changes are not
retained across a power cycle unless you save them to the system configura-
tionfile.

Save Clicking the Save button saves the current configuration to the system config-
uration file. When you click Save, changes that you have submitted are saved
even when you reboot the system. To save the configuration, use the Save
Changes link in the Tools menu.

Refresh Clicking the Refresh button refreshes the data on the panel.

WLAN Tabs

Many of the pages in the WLAN folder contain tabs to simplify navigation and to group
functions for a common feature. Click the tab to access a specific page.

NOTE: Other packages in the software suite do not use tabs in the Web interface.

Tools Menu

If you mouse over the Tool icon, alist of the following useful system tools appears.

* Reset Configuration

* Reset Password

* Reboot System

» Save Changes

* Download File

» Upload File

* Multiple Image Services

Each iteminthelist isalink to the Web page where you can perform the related task.

Using the Command-Line Interface

28

The command-line interface (CLI) is atext-based way to manage and monitor the system. You
can access the CLI by using adirect serial connection or by using aremote logical connection
with Telnet or SSH.

The CLI groups commands into modes according to the command function. Each of the
command modes supports specific commands. The commands in one mode are not available
until you switch to that particular mode, with the exception of the User EXEC mode
commands. You can execute the User EXEC mode commands in the Privileged EXEC mode.

To display the commands available in the current mode, enter a question mark (?) at the
command prompt. To display the available command keywords or parameters, enter aquestion
mark (?) after each word you type at the command prompt. If there are no additional command
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keywords or parameters, or if additional parameters are optional, the following message
appears in the output:

<cr> Press Enter to execute the command
For more information about the CL1, see the D-Link CLI Command Reference.
The D-Link CLI Command Reference lists each command available from the CLI by the

command name and provides a brief description of the command. Each command reference
aso contains the following information:

»  The command keywords and the required and optional parameters.
»  The command mode you must be in to access the command.
» Thedefault value, if any, of a configurable setting on the device.

The show commands in the document also include a description of the information that the
command shows.

Using SNMP

For D-Link Unified Switch software that includes the SNMP module, you can configure
SNMP groups and users that can manage traps the SNM P agent generates.

The D-Link Unified Switch uses both standard public MIBsfor standard functionality as well
as anumber of additional private MIBs for additional functionality supported by the switch.
All private MIBs begin with a“DLINK-" prefix. The main object for interface configurationis
in DLINK-SWITCHING-MIB, which is aprivate MIB. Some interface configurations also
involve objectsin the public MIB, IF-MIB.

SNMP is enabled by default. The System Description Web page, which is the page the
displays after a successful login, and the show sysi nf o command display the information you
need to configure an SNMP manager to access the switch.

Any user can connect to the switch using the SNMPv3 protocol, but for authentication and
encryption, you need to configure anew user profile. To configure a profile by using the CL1,
see the SNMP section in the D-Link CLI Command Reference. To configure an SNMPv3
profile by using the Web interface, use the following steps.

1. Select LAN > Administration > User Accountsfrom the hierarchical tree on the left side
of the Web interface.

2. Using the User pull-down menu, select Create to create a new user.
3. Enter anew user namein the User Namefield.

4. Enter anew user password in the Passwor d field and then retypeit in the Confirm
Password field.

To use SNMPv3 Authentication for this user, set a password of eight or more
alphanumeric characters.

5. To enable authentication, use the Authentication Protocol pull-down menu to select
either MD5 or SHA for the authentication protocol.

6. To enable encryption, use the Encryption Protocol pull-down menu to select DES for the
encryption scheme. Then, enter an encryption code of eight or more alphanumeric
charactersin the Encryption Key field.
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7. Click Submit.

To access configuration information for SNMPv1 or SNMPv2, click LAN > Administration
> SNMP Manager and click the page that contains the information to configure.

Wireless System Features and Standards Support

In addition to core switching features, the D-Link Unified Switch supports the following
features and standards:

* |IPTunneling
e Spanning Tree
»  Auto detection and configuration of APs
»  Automatic Peer-Switch Discovery
* Automatic or Manual RF Channel Assignment
* Automatic or Manual AP Power Adjustment
* AP Authentication
* Client Authentication
» Load Balancing
* RF Scan and AP Sentry Mode
* Dual Radio Support
e Multiple Mode Support for Radios:
- |EEE 802.11a
|EEE 802.11b
|EEE 802.11g
- Dynamic Turbo 5Ghz
- Dynamic Turbo 2.4 Ghz
» |EEE 802.11h (TPC and DFS)
»  Security Standard Support:
- WEP (64, 128)
- WEP (152)
- TKIP
- AES& CCMP
- Inhibit SSID broadcast
- WPA (Personal)
- WPA (Enterprise)
- WPA2 (Personal) 802.11i
- WPA2 (Enterprise) 802.11i
*  MAC Authentication
* Multiple BSSID/VLANSs
e Security and Authentication Settings per SSID
* VLAN Support
e |EEE 802.11d (Country Code)
* |EEE 802.11e (WMM)
* RADIUS support
*  WLAN Visualization (NMS like product for APs)
* Mobility
- Inter- and Intra- Subnet Fast Roaming
- Key caching
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- Tunneled and distributed forwarding
- Peer-to-peer WLAN switch roaming
* Intrusion Detection
- Rogue AP detection
- Rogue Client detection
- Station blacklisting
- Ad-hoc network detection
* Network Management
- SNMPvV1, v2c, v3
- CLI
- SYSLOG
- Upto24 APs (DWS-3024L) or 48 APs (DWS-3024 and DWS-3026) per switch
- Auto APimage download
- D-Link WLAN Private MIB
e Simultaneous AP upgrade
» Centralized data forwarding viatunneling for fast roaming and unified QoS
* APRF Monitoring
e Configuration & Firmware Upload/Download

Each AP supports 8 virtual access points (VAPs) per radio. You can configure a unique SSID
and security policy on each VAP. The following list shows some of the D-Link Access Point
features and standards support:

*  WLAN and |IEEE Standards
- |EEE 802.11a
- |EEE 802.11b
- |EEE 802.11d
- |EEE 802.11e (WMM)
- |EEE 802.11g
- |EEE 802.11h
- |EEE 802.11i (WPA2)
- |EEE 802.1X - 2001 Port Based Network Access Control
- |EEE802.3af PoE Support
*  WLAN RF Features
-  RF Scan
- Transmit Power Control
- Load Balancing
- Dynamic Channel Assignment
- Dual Radio Support
- Atheros Dynamic Turbo 5Ghz
- Atheros Dynamic Turbo 2.4 Ghz
- TELEC 4.9GHZ 802.11a modes
- Wireless Statigtics
Virtual AP with Multiple BSSIDS/SSIDs
«  WLAN AP Management
- CLI Management (SSH)
- Web Management (SSL support)
- TFTP
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WLAN Networking and QoS
- Switch/AP Discovery
- Tunneling
- WMM (802.11¢)
- 802.1p (MAC layer QoS support)
- DSCP
- Dynamic VLANSs
- MACACLs
SpectralLink Priority Support
*  WLAN Encryption and Security
- WEP
- TKIP
- AES& CCMP
- Rogue AP detection
- Ad-Hoc Client Detection
- Inhibit/ Ignore SSID broadcast
- Weak IV avoidance
- MAC Authentication
- Port/IP blocking
- RADIUS support
- EAP
-  PEAP
- TLSandTTLS
- WHPA (Personal, Enterprise)
- WPA2 (Personal, Enterprise) 802.11i
- 802.1X Supplicant
- Client Authentication
- Firewal/IP filtering support
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Planning the D-Link Unified Access
System Network

The D-Link Unified Access System provides continuous, high-speed access between your
wireless and Ethernet devices. It is an advanced, scalable, standards-based solution for
wireless networking. The D-Link Unified Access System enables wireless local area hetwork
(WLAN) deployment while providing state-of-the-art wireless networking features.

This chapter contains the following sections to help you plan your D-Link Unified Access
System:

»  System Reguirements
*  WLAN Topology Considerations
» Network Planning to Support Layer 3 Roaming

System Requirements

You accomplish theinitial D-Link Unified Switch configuration by using a direct cable
connection. After the initial configuration, you can manage the Unified Switch by using a
Web-based user interface (Ul), command lineinterface (CLI), or SNMP. The following list
describes the minimum requirements you need to install and manage the D-Link Unified
Switch:

* VT100 terminal or PC with terminal-emulation software

» Direct seria connection to the console port of the D-Link Unified Switch

* Remote system for management access with a Web browser, Telnet/SSH client, or SNMP
manager

To support security and networking featuresin D-Link Unified Access System, you can use
the following optiona equipment on your network:

* A RADIUS server for authentication and accounting features for wireless clients, access
points, and peer Unified Switches

*  Network equipment that supports VLANS

* A DHCP server to dynamically assign network information to the switch and to all access
points

* A Syslog server for external logging
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Figure 7 shows asimple D-Link Unified Access System deployment with required and
optiona equipment for setup and operation.

Figure 7. D-Link Unified Access System Components

Terminal with Direct
Serial Connection
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RADIUS Server Wireless Clients
DHCP Server
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NOTE: The D-Link Unified Switch hasabuilt-in DHCP server. If you do not already
have a DHCP server on your network, you can configure the Unified Switch
to assign network information to network hosts.

Asthe figure shows, the wireless clients can be laptop computers, personal digital assistants

(PDAs), smart phones, or any other hand-held, portable or stationary device equipped with a
Wi-Fi adapter and supporting drivers. In order to connect to the access point, wireless clients
need the software and hardware the following list describes:

* A portable or built-in Wi-Fi client adapter that supports one or more of the IEEE 802.11
modes in which you plan to run the access point. (IEEE 802.11a, 802.11b, 802.11Q)

» Client software such as Microsoft Windows Supplicant configured to associate with the
WLAN.

*  Wireless security software that is compatible with the authentication mode the access
point uses.

WLAN Topology Considerations

The D-Link Unified Switch adds WLAN functionality to the base switching and IP routing
features standard in most Layer 2/3 switches. Where you put the D-Link Unified Switch in
your network depends on the size, requirements, and existing topology of your network. If you
are adding awireless network to an existing network, your requirements are different than the
requirements of someone who does not have a sufficient LAN infrastructure.

Sincethe D-Link Unified Switch has Layer 2/3 switching functions aswell asWLAN data and
management functions, you can connect D-Link Access Points, wired PCs, or other network
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2 Planning the D-Link Unified Access System Network

equipment such as hubs, routers, or other switches directly to the 10/100/1000 M bps Ethernet
ports on the switch. All connections to the D-Link Unified Switch must be wired connections
since the switch does not have any radios.

In Figure 8, the D-Link Unified Switches are both LAN and WLAN switches that handle
traffic from end users connected to the wired LAN as well as traffic from the D-Link Access
Points. In the diagram, Building 1 and Building 2 have a D-Link Unified Switch on each floor.

Figure 8. Wiring Closet Topology

Unified Switch Unified Switch

Building 1
Floor 2 Building 2
Floor 2
Unified Switch Unified Swit
Building 1
Floor 1 Building 2
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To Network
Backbone

The four D-Link Unified Switches are in the same peer group. This allows wireless clientsto
roam between floors and between buildings without the need to re-authenticate. Additionally,
each Unified Switch sharesitslist of managed APs and wireless clients with the switchesin
the peer group so that the APs and wireless clients are not reported as rogues (unknown).

Thetopology in Figure 8 works well if you need to add, upgrade, or replace LAN switches on
your network.

NOTE: When tunneled clients are used in conjunction with peer switches, one of the
peer switches must be configured as a default gateway for the tunneled cli-
ents. Normally the default gateway routes al traffic from the client’s subnet to
other subnets, however in a peer switch network the Unified Switch that man-
agesthe AP to which the client is associated routes the frames into the remote
subnets. This means that each peer switch must have routing table entries that
enable it to route frames to every subnet in the network.
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Figure 9 shows two D-Link Unified Switches in the network data center. In this deployment,
the switches do not connect directly to APs or end-user nodes.

Figure 9. Data Center Topology

AN Switch

Unified Switches

The data center topology is a good solution in networks where the goal isto add awireless

LAN to anetwork with minimal changes to the existing network. Traffic from wireless clients
to the APs is either tunneled through the Unified Switch or tagged withaVLAN ID by the AP
and handled accordingly. If the traffic is tagged, it might not pass through the Unified Switch.

Access Point-to-Switch Discovery

To enable the AP and Unified Switch to discover each other, you can use one of the following
four methods:

* Enter the IP address of the Unified Switch into the AP

» Enter the IP address of the AP into the Unified Switch

»  Configurethe DHCP server to pass the | P address of the Unified Switch to the APin DHCP
option 43

» Usethe D-Link Wireless Device Discovery Protocol

The AP-to-switch discovery method you use depends on your network topology. For example,
if the Unified Switch and AP arein the same Layer 2 multicast domain, we recommend that
you use the D-Link Wireless Device Discovery Protocol.

These options are discussed in more detail in * Discovering Access Points and Peer Switches’
on page 61.

Access Point Placement

D-Link Access Points can be on the same subnet as the switch or on a different subnet. You
can connect the AP directly to the Unified Switch or to another networking device. The range
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of the D-Link Access Point is about 100 meters, but the range is affected by various
environmental factors.

To maximize the range, use the following guidelines for the placement of the AP:

» Placethe APin an area where you expect wireless clients will operate.

» Elevated locations, such as on top of ashelf are preferred to increase line-of-sight access.

* Avoid placing the AP near sources of interference, such as PCs, microwaves, and 2.4 GHz
cordless phones.

» Keep the AP away from large metal surfaces.

» Position the antenna horizontally to increase the up-and-down range, or position it
vertically to increase side-to-side coverage.

*  When APs are within broadcast range of each other, use non-interfering RF channels (five
channels apart for the 802.11b/g radio).

How close you place APs to each other depends on the RF transmission power level, the
number of wireless clients on your network, and the channels the APs use. The RF signal
transmission power level directly affects the broadcast range of the AP signal. If the power
level istoo low, wireless clients will not detect the signal or experience poor WLAN
performance. If the power level istoo high, the RF signal might interfere with other APs
within range. If the RF signal broadcasts beyond the physical confines of your building or
network, it increases the security threat to the network.

When the power level is high and RF broadcast areais larger, more wireless clients can detect
the signal and associate with the AP. An increase in the number of wireless clients that
associate with the AP generally means that the amount of traffic the AP receives and transmits
increases aswell. You can limit the network utilization level allowed on an AP to prevent
wireless clients from experiencing slower network speeds. However, once the network
utilization is reached, new clients are unable to associate with the AP. If an AP frequently
reaches the network utilization limit, it might indicate that you should add another AP nearby.
You can configure the APs to automatically adjust the power and channel to the needs of the
network environment.

Network Planning to Support Layer 3 Roaming

With the D-Link Unified Access System, mobile stations can maintain their IP connections
while roaming from one access point to another even when these access points are attached to
different IP subnets. This feature enables Voice over IP (Vol P) deployments on 802.11
subnetted networks.

It is often necessary to subdivide the enterprise |Pv4 network into several subnets. An access
point may be directly attached to the Unified Switch or it may be located several router hops
away from the Unified Switch.

To support layer 3 roaming, it is necessary to keep the wireless client's | P address unchanged
while it roams over different subnets. This guarantees seamless roaming as the | P changeover
process does not take place while wireless clients roam across subnet borders.
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The D-Link Unified Access System provides two ways to prevent the IP address of aroaming
client from changing:

1. You can associate the SSID for roaming with aVVLAN and configure the network devices
on your network to allow VLAN trunking across different subnets. By doing this, the
client will always stay in the same VLAN and retain the same | P address while it roams.

This approach is appropriate when it is not difficult to configure VLAN trunking on
devicesin the network.

2. You can associate the SSID for roaming with atunneled subnet. In this case, the switch
uses | P tunneling to establish alink between itself and the access point it manages. The
switch routes all 1Pv4 unicast frames so that the wireless networks are perceived aslocally
attached networks by the Unified Switch.

Routing must be enabled on the switch to support L3 roaming.

Figure 10 shows a single wireless client as it roams among three APs in three different
subnets. A D-Link Unified Switch controls the three APs. When the wireless client connectsto
any of the APs, it receives an | P address from the Unified Switch that isin the L3 Tunnel
subnet. Asthe client roams among the APs, it maintains its connection to the WLAN and
keeps the same | P address that the switch originally assigned it. All traffic the client sends and
receives goes through the switch.

Figure 10. Inter-Subnet Roaming
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In the tunneling configuration, you can use ACL lists and QoS parameters to ensure that time-
sengitive traffic, such as Vol P, takes priority over other WLAN traffic.

For many I P phone systems, you must connect a call server to awired port on the L3 tunnel
subnet. You must also either configure DHCP relay on the switch or configure the switch to bea
DHCP server. APs, peer switches, and other routers cannot be connected to the L 3 tunnel subnet.

For more information about L 3 tunnelling and how to configureit, see“ Configuring a VAP for
L3 Tunnels’ on page 99 and Appendix C, “L 3 Roaming Example”on page 215.
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Installing the Hardware

This chapter provides instructions for installing the D-Link DWS-3024, DWS-3024L, and
DWS-3026 switch hardware. The following sections describe thisinstallation process:

» Hardware Overview
- Front Panel Components
- LED Indicators
- Rear Panel Description
- SidePanels
e Installation
- Package Contents
- Installation Guidelines
- Installing the Switch without the Rack
- Instaling the Switch in a Rack
- Powering On the Switch
- Installing the SFP ports
- Installing the Optional Modules
- Connecting to the External Redundant Power System
e Connecting the Switch
- Connecting the Switch to the Network
- Connecting the Switch and AP Directly
- Connecting the Switch and AP through the L2/L 3 Network
- Connecting to the Core Network

Hardware Overview

This section describes the font, back, and side panels and the LED indicators on the switch.
The DWS-3024/DWS-3024L and DWS-3026 have dlightly different front and back panels
based on the available features.
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Front Panel Components

The front panel of the Switch consists of LED indicators for Power, Console, RPS, PoE, and
Link/Act/Speed for each port on the Switch including 10GE Ports for optional modules and

SFP port LEDs. Table 2 describes the LED indicators in more detail.

Figure 11. Front Panel View of the DWS-3024L as Shipped

l D-Link

mmmmm

nnnnnnnnnnnn

l, DWs-3024L

Figure12. Front Panel View of the DWS-3024 as Shipped
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LED Indicators

The Switch supports LED indicators for Power, Console, RPS, PoE, and Port LEDs including
10GE port LEDs for optional module inserts on the DWS-3026.

Figure 14. LED Indicators on DWS-3024L
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Figure 15. LED Indicators on DWS-3024
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Figure 16. LED Indicatorson DWS-3026
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The following table describes the LEDs and the M ode Select Button on the front panel of each
Switch.

Table 2. LED Description

LED Description

Power This LED lights green after powering the Switch on to indicate the ready
state of the device. Theindicator is dark when the Switch is no longer
receiving power (i.e powered off).

Console This LED blinks green during the Power-On Self Test (POST). When the
POST isfinished, the LED goes dark. The indicator lights steady green when
an active console link isin session via the RS-232 consol e port.

RPS This LED lights when the internal power has failed and the RPS has taken
over the power supply to the Switch. Otherwise, it remains dark.

Link/Act/Speed You can change the mode of the LEDs over each port to display the
and PoE Mode information about the link, activity, and speed of aport or whether 802.3af
Power Over Ethernet (PoE) is supporting devices attached to the port.

To change the LED mode from Link/Act/Speed to POE and vice versa, press
the LED Mode Select Button.

Port LEDs One row of LEDsfor each port islocated above the ports on the front panel.
Theindicator above the left side of aport corresponds to the port below the
indicator in the upper row of ports. The indicator above the right side of a
port corresponds to the port below the indicator in the lower row of ports.
The port LEDs show information about link, activity, and speed on the port
or Power over Ethernet usage on the port, depending on the LED mode you
select.

For Link/Act/Speed Mode:

* Solid Green—Indicates avalid 1000Mbps link on the port, while a
blinking green light indicates activity on the port (at 17000M bps).

 Solid Amber—Indicates avalid 10 or 100Mbps link on the port.

« Blinking Amber—Indicates activity on the port (at 1200Mbps).

« Off—No link/activity on the port.

For PoE Mode:

 Solid Green—Power feeding (802.3af-compliant PD was detected).

* Blinking Amber—PoE port ERROR (non-standard PD connected, Under
load state according to 802.3af (current is below | min), Overload state
according to 802.3af (current is above | cut), hardware problems
preventing port operation, power budget exceeded, short condition was
detected at a port delivering power, temperature overload at the port,
succession of Underload and Overload states caused port shutdown (may
be caused by a PD's DC/DC fault)...etc.)

« Off—No power feeding (no PD detected, or no connection)
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3 Installing the Hardware

Table 2. LED Description

LED Description

10GE Port LEDs (DWS-3026 only) A steady green light denotes avalid link on the port while
ablinking green light indicates activity on the port. These LEDs remain dark
if there is no link/activity on the port.

Combo SFP Ports  The LED indicators for the Combo ports are located above the ports and
numbered 1 — 4 for Combo 1, Combo 2, Combo 3, and Combo 4 ports. A
steady green light indicates avalid link on the port while a blinking green
light indicates activity on the port. These LEDs remain dark if thereisno
link/activity on the port.

Rear Panel Description

The AC power connector is a standard three-pronged connector that supports the power cord.
Plug the femal e connector of the provided power cord into this socket, and plug the male side
of the cord into a power outlet. The Switch automatically adjustsits power setting to any
supply voltage in the range from 100 ~ 240 VAC at 50 ~ 60 Hz.

The rear panel also includes an outlet for an optional external power supply. When a power
failure occurs, the optional external RPS will immediately and automatically assume the
power supply for the Switch.

The rear panel of the DWS-3024/DWS-3024L contains an AC power connector, a system fan
vent, and a redundant power supply connector.

Figure 17. Rear panel view of DWS-3024/DW S-3024L
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Therear panel of the DWS-3026 contains an AC power connector, a system fan vent, a
redundant power supply connector and two empty dots for optional 10GE module inserts.

Figure 18. Rear panel view of DWS-3026
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Side Panels

The system fans and heat vents located on each side of the Switch dissipate heat. Do not block
these openings. Leave at least 6 inches of space at the rear and sides of the Switch for proper
ventilation. Without proper heat dissipation and air circulation, system components might
overheat, which could lead to system failure and severely damage components.
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Installation

This section describes how to install the Switch on aflat surface or in a standard equipment
rack. It also describes how to install the optional components for the Switch.

Package Contents

Open the shipping carton of the Switch and carefully unpack its contents. The carton should
contain the following items:

7.

o 0k~ wbdE

One Switch

One AC power cord

Mounting kit (two brackets and screws)

Four rubber feet with adhesive backing

RS-232 console cable

One CD Kit for DWS-3000 Series Administrator’s Guide and CLI Reference Guide
Registration card & China Warranty Card (for China only)

If any item is missing or damaged, please contact your local D-Link Reseller for replacement.

Installation Guidelines

Please follow these guidelines for setting up the Switch:

Install the Switch on a sturdy, level surface that can support at least 6.6 Ib. (3 kg) of
weight. Do not place heavy objects on the Switch.

The power outlet should be within 1.82 meters (6 feet) of the Switch.

Visually inspect the power cord and see that it is fully secured to the AC power port.
Make sure that there is proper heat dissipation from the Switch and adequate ventilation
around the Switch. Leave at least 10 cm (4 inches) of space at the front and rear of the
Switch for ventilation.

Install the Switch in afairly cool and dry place for the acceptable temperature and
humidity operating ranges.

Install the Switch in asite free from strong electromagnetic field generators (such as
motors), vibration, dust, and direct exposure to sunlight.

When installing the Switch on alevel surface, attach the rubber feet to the bottom of the
device. The rubber feet cushion the Switch, protect the casing from scratches, and prevent
it from scratching other surfaces.
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Installing the Switch without the Rack

First, attach the rubber feet included with the Switch if installing on a desktop or shelf. Attach
these cushioning feet on the bottom at each corner of the device. Allow enough ventilation
space between the Switch and any other objectsin the vicinity.

Figure 19. Prepare Switch for Installation on a Desktop or Shelf

Rubber Feet

Installing the Switch in a Rack
The Switch can be mounted in a standard 19" rack. Use the following diagrams as a guide.

Figure 20. Fasten Mounting Bracketsto Switch
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Fasten the mounting brackets to the Switch using the screws provided. With the brackets
attached securely, the Switch can be mounted in a standard rack as shown in Figure 21.

Figure21. Mounting the Switch in a Sandard 19" Rack

Powering On the Switch

Plug one end of the AC power cord into the power connector of the Switch and the other end
into the local power source outlet.

After powering on the Switch, the LED indicatorswill momentarily blink. This blinking of the
LED indicators represents areset of the system.

Power Failure

As aprecaution, in the event of a power failure, unplug the Switch. When power is resumed,
plug the Switch back in.

Installing the SFP ports

The DWS-3000 series switches are equipped with SFP (Small Form-factor Pluggable) ports,
which are to be used with fiber-optical transceiver cabling in order to uplink various other
networking devices for agigabit link that may span great distances. These SFP ports support
full-duplex transmissions, have auto-negotiation and can be used with DEM-310GT
(1000BASE-LX), DEM-311GT (1000BA SE-SX), DEM-314GT (1000BA SE-LH) and DEM-
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315GT (1000BASE-ZX) transceivers. See the figure below for installing the SFP portsin the
Switch.

Figure 22. Inserting the Fiber-Optic Transceiversinto the Switch

Installing the Optional Modules

Therear panel of the DWS-3026 includes two open slots that may be equipped with the DEM-
410X 1-port 10GE XFP uplink module, or a DEM-410CX 1-port 10GBASE-CX4 uplink
module, both sold separately.

Adding the DEM-410X optional module allows the switch to transmit data at arate of ten
gigabits per second. The module port(s) are compliant with standard |EEE 802.3ae, support
full-duplex transmissions only and must be used with XFP M SA-compliant transceivers.

The DEM-410CX uses copper wire medium, not optic fiber and therefore has atransmit length
[imit up to 1 meters. Compliant with the IEEE802.3ak standard, this module uses a 4-lane
copper connector for data transfer in full-duplex mode.

To install these modules in the DWS-3026 Switch, follow the steps listed in this section.

CAUTION: Before adding the optional module, make sure to disconnect all power
sources connected to the Switch. Failure to do so may result in an
electrical shock, which may cause damage, not only to the individual but
to the Switch as well.

At the back of the Switch to the left are the two slots for the optional modules. These slots
must be covered with the faceplate if the slots are not being used. To install amodulein an
available slot, remove the faceplate by oosening the screws and pulling off the plate.
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The front panels of the available modules are shown here:

Figure 23. Front Panel of the DEM-410X
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Figure 24. Front Panel of the DEM-410CX
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Install the Module

Unplug the Switch before removing the faceplate covering the empty slot. To install the
module, slideit in to the available dot at the rear of the Switch until it reaches the back, as
shown in the following figure. Gently, but firmly push in on the module to secureit to the
Switch. The module should fit snugly into the corresponding receptors.

Figure 25. Inserting the optional module into the Switch (DW S-3026)
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Now tighten the two screws at adjacent ends of the module into the available screw holes on
the Switch. The upgraded Switch is now ready for use.

Figure 26. DWS-3026 with optional DEM-410X moduleinstalled

Connecting to the External Redundant Power System

The Switch supports an external redundant power system (RPS). The diagrams below
illustrate a proper RPS power connection to the Switch. Please consult the documentation for
information on power cabling and connectors and setup procedure.

Figure 27. RPS Connector
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Connecting the Switch

This section describes how to connect the following nodes:

»  Switch to the network

» APdirectly to the Switch

* AP to the Switch through the L 2/L 3 network

»  Switch through the 10GB uplink to the network core

NOTE: All 24 high-performance N-Way Ethernet ports can support both MDI-11 and
MDI-X connections.
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Connecting the Switch to the Network

You can use any of the 1000BASE-T ports, 10GB ports, or fiber-optic ports to connect the
Switch to your network. The type of port you use to connect the switch depends on your
network requirements and the type of node to which you connect the Switch, which might be a
hub, router, or another switch.

Thereisagreat deal of flexibility on how connections are made using the appropriate cabling.

» Connect a10BASE-T hub or switch to the Switch via atwisted-pair Category 3, 4 or 5
UTP/STP cable.

» Connect a100BASE-TX hub or switch to the Switch via atwisted-pair Category 5 UTP/
STP cable.

e Connect 1000BASE-T switch to the Switch viaatwisted pair Category 5e UTP/STP
cable.

» Connect a switch supporting a fiber-optic uplink to the Switch's SFP ports viafiber-optic
cabling.

»  Change the Switch to POE mode using the M ode Select button. When in PoE Mode, the
Switch works with all D-Link 802.3af capable devices.

The Link/Act LEDsfor each UTP port will light green or amber when the link isvalid. A
blinking LED indicates packet activity on that port.

Connecting the Switch and AP Directly

You can connect one or more DWL-3500AP or DWL-8500A P access points directly to the
Switch by using a straight-through or crossover UTP cable.

Figure 28. Switch and AP Connected Directly

UTP Cable — p» |

THERAREAR R B AR R g

Access Point

50 © 2001- 2008 D-Link Corporation. All Rights Reserved.



3 Installing the Hardware

Connecting the Switch and AP through the L2/L3 Network

The Switch can discover and manage APs whether they are directly connected, connected
through a device in the same subnet, or connected to different subnets.

Figure29. Switch and APs Connected Through Network
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Connecting to the Core Network

The optional 10GB ports on the DWS-3026 are ideal for uplinking to the core network.
Connections to the Gigabit Ethernet ports are made using a fiber-optic cable or Category 5e
copper cable, depending on the type of port. A valid connection is indicated when the Link

LED islit.
Figure 30 shows the rear panel of the DWS-3026 with the optional DEM-410X module.

Figure 30. Switch Connected to Network Core
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Installing the D-Link Unified Access
System

This chapter contains the following sectionsto help you install your D-Link Unified Access
System network:

e System Deployment Overview

»  Connecting the Switch to the Network

» Enabling the WLAN Features on the Switch

*  Preparing the Access Points

» Discovering Access Points and Peer Switches
» Authenticating and Validating Access Points

System Deployment Overview

To setup and deploy the D-Link Unified Access System solution, use the following general
steps:

1. Planthe WLAN network topology.

Decide where to locate each access point to maximize accessibility to the WLAN by
wireless clients and to minimize radio frequency (RF) interference by other access points.
You should also determine how to integrate the D-Link Unified Switch into your existing
network topology. For more information about planning the WLAN topology, see
“WLAN Topology Considerations’ on page 34.

2. Install and configure the D-Link Unified Switch.

Toinstall and configure the switch, you need a serial connection to the switch, or you must
connect to the switch from a host in the same subnet as the switch default | P address
(10.90.90.90/8). From theinitial connection to the switch, you can configure basic
network information or enable the DHCP client on the switch to acquire this information
automatically.

3. Enable the WLAN switch function and assign an IP address to the WLAN switch
interface.

The WLAN features on the switch are enabled by default. The WLAN feature must be
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enabled in order for the switch to discover and validate D-Link Access Points. If the
routing mode is disabled, the Unified Switch function uses the | P address of the network
interface. If routing is enabled, the switch uses aloopback or routing interface for the
wireless functions. Changing the I P address of the network interface automatically
disables and re-enables the wireless function. Enabling routing also disables and re-
enables the wireless function.

4. Configure the default AP Profile settings that the access point will use after the switch
validatesit.

When the switch successfully validates an access point, it sends the AP Profile to the
access point. The AP Profile contains al of the access point configuration information,
such as the radio, security, and SSID settings. You can configure al of the AP settings
before or after the switch validates an AP. For information about configuring the default
AP profile, see Chapter 5, “Configuring Access Point Settings’ on page 83.

5. Prepare and deploy D-Link Access Points and enable AP-to-switch discovery.

After you connect an AP to the network and it obtains an IP address (either statically or
dynamically by using DHCP), the Unified Switch can automatically discover the AP.
However, if your network uses IEEE 802.1X authentication or you require the AP to be
authenticated by the switch upon discovery, you must log on to the AP and configure
security information.

6. Authenticate and validate the APs.

You can optionally configure the Unified Switch so that it only manages APs that it
authenticates. You can use the local database or an external RADIUS database for AP
authentication. Whether or not you require AP-to-Unified Switch authentication, the
switch must be able to validate an AP before it can manage the AP. For the switch to
validate the AP, you must add the MA C address of each AP to the AP database on the
switch or to the database on an external RADIUS server.

Once you validate the AP, you can use the switch to manage the AP and to view client
associations, status, and statistics.If you follow the procedures in this chapter, the APs will
have the default configuration profile. The default AP Profile settings are listed in
Appendix A.

CAUTION: The default AP profile does not use a security mechanism for wireless
client associations. All wireless clients will be able to connect to an AP
and access your network.

To prevent unauthorized access to the network by wireless clients, you can configure security
on the default profile before you deploy the APs, or you can create additional AP profilesto
assign the APs when you add them to the Valid AP database. For information about how to
configure default profile settings, see Chapter 5, “ Configuring Access Point Settings’ on

page 83.

You can use the switch to create multiple AP profiles to assign the APs that you deploy on
your network. For each profile, you can define information such as RF configuration, QoS
configuration, and virtual AP (VAP) configuration. For information about AP profiles, see
“AP Profiles, Networks, and the Local Database” on page 83. For information about creating
and configuring a new AP profile, see “ Creating, Configuring, and Managing AP Profiles’ on
page 155.
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Connecting the Switch to the Network

After you perform the physical hardware installation, you need to connect the D-Link Unified
Switch to the network. The default | P address of the switch is 10.90.90.90/8, and DHCP is
disabled by default. If you want to enable DHCP on the switch or assign a different static IP
address, you must connect to the switch and change the default settings.

You can connect to the switch through Telnet or a Web browser from a host on the 10.0.0.0/8
network, or you can connect to the switch through the console port (RS-232 DCE). After you
connect to the switch, you can provide network information or enable the DHCP client.

To connect to the switch from a host on the 10.0.0.0 network, enter the default | P address of
the switch (10.90.90.90) into the address field of a Web browser or a Telnet client.

To connect to the console port and provide network information, use the following steps.

1.

Using a null-modem cable, connect aVT100/ANSI terminal or a workstation to the
console (serial) port.

If you attached a PC, Apple, or UNIX workstation, start a terminal-emulation program,
such as HyperTerminal or TeraTerm.

Configure the terminal-emulation program to use the following settings:
- Baud rate: 115,000 bps

- Databits: 8

- Parity: none

- Stophit: 1

- Flow control: none

Press the return key, and the User : prompt appears.

Enter adni n asthe user name. There isno default password. PressENTER at the password
prompt if you did not change the default password.

After a successful login, the screen shows the (swi t ch- pr onpt ) > prompt.

At the (swi t ch- pr onpt ) > prompt, enter enabl e to enter the Privileged EXEC command
mode. Thereisno default password to enter Privileged EXEC mode. PressENTER at the
password prompt if you did not change the default password.

The command prompt changes to (swi t ch- pr onpt ) #.

Configure the network information.

- Touse aDHCP server to obtain the IP address, subnet mask, and default gateway
information, enter net work prot ocol dhcp.

- Touse aBootP server to obtain the | P address, subnet mask, and default gateway
information, enter net wor k pr ot ocol boot p.

- To manually configure the IP address, subnet mask, and default gateway, enter
network parns <i paddress> <net mask> [ <gat eway>], for example:

network parms 192.168.2.23 255.255.255.0 192.168.2.1

The default gateway is an optional parameter, so you do not need to enter an address
to execute the command.
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To view the network information, enter show net wor k.

6. To save these changes so they are retained during a switch reset, enter the following
command:

wite

Once the D-Link Unified Switch is connected to the network, you can use the |P address for
remote access to the switch by using a Web browser or through Telnet or SSH.

Enabling the WLAN Features on the Switch

In order for the Unified Switch to be able to discover and manage access points, the WLAN
switch and its operational status must both be enabled. The WLAN component is enabled by
default.

When you access the switch user interface, make sure you set the correct country code for the
switch so that the access points can only operate in the modes permitted in your country. The
default country codeis US for operation in the United States.

To set the country code and enable the switch by using the Web interface, click
Administration > Basic Setup. Table 3 describes the fields on the Wireless Global
Configuration page.

NOTE: Wireless features are available under the WL AN tab on the navigation menu.

NOTE: Most configuration pages have a Submit button, which applies the changesto
the running configuration but does not save them to non-volatile memory
(NVRAM). To make the changes permanent so they persist across a reboot,
click the Tool, then click Save Changes to navigate to the appropriate page.
You can also use thewr i t e command in Privileged Exec mode.

Table 3. Basic Wireless Global Configuration

Field Description
Enable WLAN Check the box to enable WL AN switching functionality on the system. Clear
Switch the check box to administratively disable the WLAN switch.

If you clear the check box, all peer switches and APsthat are associated with
this switch are disassociated.

Disabling the WLAN switch does not affect non-WLAN features on the
switch, such as VLAN or STP functionality.

WLAN Switch Shows the operationa status of the switch. The status can be one of the
Operational Satus  following values:

Enabled

Enable-Pending

Disabled

Disable-Pending

If the status is pending, click Refresh to refresh the screen.
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Table 3. Basic Wireless Global Configuration

Field Description
WLAN Switch If the statusis disabled, thisfield appears and one of the following reasonsis
Disable Reason listed:
¢ None—The cause for the disabled status is unknown.
e Administrator disabled—The Enable WLAN Switch check box has been
cleared.
¢ No P Address—The WLAN interface does not have an IP address.
¢ NoSSL Files—The D-Link Unified Switch communicates with the APs
it manages by using Secure Sockets Layer (SSL) connections. The first
time you power on the Unified Switch, it automatically generates a
server certificate that will be used to set up the SSL connections. The
SSL certificate and key generation can take up to an hour to complete.
If routing is enabled on the switch, the operational status might be disabled
due to one of the following reasons:
¢ No Loopback Interface—The switch does not have aloopback interface.
¢ Globa Routing Disabled—Even if the routing mode is enabled on the
WLAN switch interface, it must also be enabled globally for the
operational status to be enabled.
For information about how to configure a loopback interface and enable
routing, see “D-Link Unified Switch with Routing Enabled” on page 65.
IP Address Thisfield shows the | P address of the WLAN interface on the switch. If

routing is disabled, the IP address is the network interface. If routing is
enabled, thisisthe IP address of the routing or loopback interface you
configure for the Unified Switch features.

AP Authentication

Select the check box to require APs to be authenticated before they can
associate with the switch.

AP MAC Select the database to use for AP validation.
Validation +  Local—If you select this option, you must add the MAC address of each
APtothelocal Valid AP database.
* RADIUS—If you select this option, you must configure the MAC
address of each AP in an external RADIUS server.
Country Code Select the country code for the country where your switch and APs operate.

A popup window asks you to confirm the change.

Wireless regulations vary from country to country. Make sure you select the
correct country code so that your WLAN system complies with the
regulations in your country. Some WLAN modes, such as the Atheros
modes, are not available in some countries.

Changing the country code disables and re-enables the switch. Any channel
and radio mode settings that are invalid for the regulatory domain are reset to
the default values.

The country code (IEEE 802.11d) is transmitted in beacons and probe
responses from the access points.

From the CLI, you can view the same information that is available on the Wireless Global
Configuration page with the show wi r el ess command in Privileged EXEC mode. If you
need to change the country code, you can view the list of available countries and their two-
letter codes with the show wi rel ess country-code command.
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The CLI commands to set the country code and enable the WLAN switch are availablein
Wireless Config mode. To set the country code, enter count ry- code <code>. To enable the
WLAN switch, enter enabl e. The following example shows how to access Wireless Config
mode, set the country code to Canada, and enable the WLAN switch.

(swi tch-pronpt) #configure

(swi tch-pronpt) (Config)#wreless

(switch-pronpt) (Config-wreless)#country-code CA
(swi tch-pronpt) (Config-wirel ess)#enable

Preparing the Access Points

Depending on your network security requirements, you might need to connect to the access
point CLI and configure some settings before you connect it to the network. By default, the AP
uses untagged VLANSs and no security. If your network requires |EEE 802.1X authentication,
you must configure the supplicant information in the AP before you connect to the network.
Also, if you configure the D-Link Unified Switch to require local AP authentication, you must
connect to the access point CLI and configure a pass phrase. To prevent wireless clients from
having access to the AP management interface, you can create a management VLAN.

NOTE: The commands you enter on the AP apply the changes to the running
configuration but does not save them to non-volatile memory (NVRAM). To
make the changes permanent so they persist across a reboot, use the save-

r unni ng command.

Logging on to the AP

You can access the AP CL1 only through Telnet. The default IP address is 10.90.90.91/8, and
DHCP is enabled by default on the D-Link Access Point. When you connect the AP to a
network with a DHCP server, the AP automatically acquires an |P address. If thereisno
DHCP server on the network, the AP retainsits default | P address of 10.90.90.91/8 until you
assign astatic |P address.

For initial configuration with a direct Ethernet connection, make sure your PC has an |P
addressin the 10.0.0.0/8 subnet so you can access the AP CLI.

To use a direct-cable connection, connect one end of an Ethernet straight-through or crossover
cable to the network port on the access point and the other end of the cable to the Ethernet port
on the PC, as shown in Figure 31.

Figure 31. Ethernet Connection for Static | P Assignment
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Crossover or straight-through
cable if your AP

This PC must have an IP address
on the same subnet as the Access Point.)
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If you use this method, you will need to reconfigure the cabling for subsequent startup and
deployment of the access point so that the access point is no longer connected directly to the
PC but instead is connected to the LAN.

When you Telnet to the AP CLI the DLI NK- WLAN- AP | ogi n: prompt appears.

Enter adni n as the user name and adni n as the password. After a successful login, the
DLI NK- W.AN- AP# prompt appears.

For information about how to disable the DHCP client on the AP or to set astatic | P address,
see “D-Link Access Point” on page 67 in the Assigning the IP Address to Switches and
Managed APs section.

Changing the AP Password

For access to the AP, you need to provide the user name (admin), and a password. We
recommend that you change the default AP password to make access to the device more
secure.

To change the default password, log on to the AP and enter the following command:

set system password <password>

For example, the following command changes the password to test1234.

set system password test1234

The password you type appearsin plain text. You are not asked to confirm the password after
you enter it once.

Configuring 802.1X Authentication Information on the AP

On networks that use |EEE 802.1X port-based network access control, a supplicant (client)
cannot gain accessto the network until the 802.1X authenticator grants access. If your network
uses 802.1X, you must configure 802.1X authentication information that the AP can supply to
the authenticator.

NOTE: The access point supports MD5 authentication.

Table 4 shows the commands you can use to configure 802.1X supplicant information.
Table 4. |EEE 802.1X Supplicant Commands

Action Command

View 802.1X supplicant settings get dot 1x-suppl i cant

Enable 802.1X supplicant set dot 1x-supplicant status up

Disable 802.1X supplicant set dot 1x- supplicant status down

Set the 802.1X user name set dot 1x-supplicant user <nane>

Set the 802.1s password set dot 1x-suppl i cant password <password>
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In the following example, the administrator enables the 802.1X supplicant and sets the user
name to wlanAP and the password to test1234.

WLAN- AP# set dot 1x-supplicant status up

WLAN- AP# set dot 1x-supplicant user W anAP

W.AN- AP# set dot 1x-supplicant password test1234
W.AN- AP# get dot 1x-suppli cant

Property Val ue

status up

user w anAP

Configuring AP-to-Switch Authentication Information

You can configure a pass phrase on the AP and on the switch so that only authenticated APs
can associate with the switch. If you do enable AP authentication on the Unified Switch, you
must connect to the access point CL1 and configure a pass phrase. This pass phrase must bethe

same as the one you configure on the Unified Switch.

To configure the pass phrase on the AP, use the following command:

set managed- ap pass- phrase <phrase>

The pass phrase can be up to 32 al phanumeric characters.

For example, the following command sets the AP-to-Unified Switch authentication pass
phrase to test1234.

W.AN- AP# set nmnaged- ap pass-phrase test1234

For more information about AP-to-Unified Switch authentication and how to configure it on
the switch, see “ Configuring AP Authentication” on page 75.

Configuring VLAN Information on the Access Point

The management VLAN isVLAN 1 by default. This VLAN is also the default untagged
VLAN. Thismeansthat all traffic, including management traffic, is untagged.

If you want to limit access to the management interface on the access point or if you aready
have a management VLAN configured on your network with a different VLAN ID, you can
change the VLAN ID of the management VLAN on the access point from the AP CLI.

© 2001- 2008 D-Link Corporation. All Rights Reserved.



4 Installing the D-Link Unified Access System

Table 5. AP VLAN Commands

Action Command

View management interface get nanagenent

information, including the VLAN ID

Set the management VLAN 1D set managenent vlan-id <1-4094>
View untagged VLAN information get unt agged-vl an

Enable the untagged VLAN set untagged-vlan status up

Disable the untagged VLAN set untagged-vlan status down

Set the untagged VLAN 1D set untagged-vlan vlan-id <1-4094>

Discovering Access Points and Peer Switches

The D-Link Unified Switch can discover, validate, authenticate, or monitor the following
system devices:

*  Peer Unified Switches
e D-Link Access Points

* Wirdessclients

* Rogue APs

* Roguewireless clients.

This section describes the procedures you use to discover D-Link Access Points and other
D-Link Unified Switches. For information about the discovery of wireless clients, see
“Monitoring Associated Client Information” on page 145. For more information about
discovering rogue devices, see “Monitoring Rogue and RF Scan Access Points’ on page 143.

In order for the Unified Switch to discover other WLAN devices and establish communication

with them, the devices must have their own |P address, must be able to find other WLAN
devices, and must be compatible.

When the D-Link Unified Switch discovers and validates D-Link Access Points, the switch
takes over the management of the AP. The default AP Profile settings are listed in
Appendix A.

For information about how to change the AP Profile settings, see Chapter 5, “Configuring
Access Point Settings’ on page 83.

Understanding the Discovery Methods

The Unified Switch and AP have multiple ways of discovering each other. The following
exampl es describe different ways the discovery can occur.

Example 1: L2 Discovery

In Figure 32, the AP and Unified Switch are directly connected. The devices arein the same
layer 2 broadcast domain and use the default VLAN settings. After both devices acquirean IP
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address, either statically or through DHCP, the Unified Switch automatically discoversthe AP
through its broadcast of a L2 discovery message.

Figure32. L2 Discovery Example

L2 Discovery

{ ﬂ{ffﬁ Message

Access Point Unified Switch

In this example, the administrator does not need to configure any discovery information on the
AP or the Unified Switch. The L2 discovery works automatically when the devices are directly
connected or connected by using alayer 2 bridge.

For more information about this discovery method, see “D-Link Wireless Device Discovery
Protocol” on page 68.

Example 2: IP Address of AP Configured in the Switch

Figure 33 shows two access points. One AP is directly connected to the D-Link Unified
Switch, and the other AP is connected viaa L3 switch.

Figure 33. L3 Discovery Example 1
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Unified Switch

UDP Discovery
(i1 Message L3 Discovery List
(ip) -
192.168.1.12

192.168.3.42

Access Point 1
IP: 192.168.1.12

Access Point 2
IP: 192.168.3.42

The administrator disablesthe L2 discovery method on the switch and adds the | P addresses of
the APsto the L3 Discovery list on the switch. The Unified Switch sends UDP discovery
messages to the IP addresses in its list. When the AP receives the messages and decides that it
can connect to the switch, it initiates an SSL TCP connection to the switch.

For information about how to configure this discovery method, see “ Configuring IP Addresses
of Peersand APsin the Switch” on page 69.
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Example 3: IP Address of Switch Configured in the AP

In this example, the administrator connects to the access point CLI and statically configures
the IP addresses of two D-Link Unified Switchesthat are allowed to manage the AP.

Figure 34. L3 Discovery Example 2

() UDP Discovery
Unified Switch IP List () Message . T
1921683154 | = 4" Unified Switch 1

192.168.22.161 IP: 192.168.1.54

Unified Switch 2
IP: 192.168.22.161

The AP sends a UDP discovery message to thefirst I P address configured in itslist. When the
switch receives the message, it verifies that the vendor ID on the AP isvalid, thereisno
existing SSL TCP connection to the access point, and the maximum number of managed APs
hasn't been reached. If all these conditions are met then the switch sends an invitation message
to the AP to start the SSL. TCP connection.

If the AP does not receive an invitation from the first Unified Switch configured in itslist, it
sends a UDP discovery message to the second Unified Switch configured in the list five
seconds after sending the message to the first Unified Switch.

When an IP address of a Unified Switch is configured on the AP, the AP only associates with
that switch even if other switches discover the AP by using other mechanisms.

For more information about how to configure this discovery method, see “ Setting the Switch
IP Addressin the D-Link Access Point” on page 71.

Example 4: DHCP Option

In this example, the administrator has configured the IP address of the Unified Switch as an
option in the DHCP response to the DHCP request that the AP sends the DHCP server.

Figure 35. DHCP Option Example

(e DHCP Re =
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DHCP Response S

AP DHCP Server

Discovering Access Points and Peer Switches 63



D-Link Unified Access System User Manual

The AP can learn up to four Unified Switch | P addresses or DNS names through DHCP option
43 in the DHCP response.

This discovery method only worksif you configure the DHCP option before the AP receives
its network information from the DHCP server.

For information about how to configure option 43 with the IP address of one or more Unified
Switch, see “ Setting the Switch Information in the DHCP Option” on page 73.

Discovery and Peer Switches

When multiple peer switches are present in the network, you can control which switch or
switches are allowed to discover a particular AP by the discovery method you use.

If you want to make sure that an AP is discovered by one specific switch, use one of the
following methods:

» Disable L2 Discovery on al switches and configure the IP address of the AP in only one
Unified Switch.

» Configure the IP address of one Unified Switch in the AP.

» Configure the DHCP option 43 with the IP address of only one Unified Switch.

An alternative approach is to configure the RADIUS server to return a switch | P address
during AP MAC address checking in the AP authentication process. For information about
how to configure the RADIUS server to return aswitch | P address, see Appendix B,
“Configuring the External RADIUS Server” on page 207.

If the RADIUS server indicates that the AP isavalid managed AP and returns an | P address of
aswitch that is not the same as this switch, then the switch sends a“re-link” message to the
access point with the I P address of the Unified Switch to which the AP should be talking to.
When the AP getsthe re-link message it modifies or setsthe Unified Switch | P address, breaks
the TCP connection with the current switch and starts a new discovery process.

You can configure the D-Link Unified Access System so that each AP is allowed to be
managed by any of the four switches in a peer group. If the Unified Switch that manages an
AP goes down, one of the backup switches takes over the management responsihilities.

To use one or more peer switches as a backup for an AP, use one of the following discovery
methods:

» If the AP and any of the peer switches are in the same L2 broadcast domain, L2 Discovery
is enabled, and all the devices use the default VLAN settings, a peer switch will
automatically discover the AP if the primary Unified Switch becomes unavailable.

» Configure the |P address of the AP in up to four switches.

» Connect to the access point CLI and configure the I P address of up to four switches.

» Configure the DHCP option 43 with the IP address of up to four switches in a peer group.

Assigning the IP Address to Switches and Managed APs

D-Link Unified Switches communicate with each other and with D-Link Access Points by
using the IP protocol, so each device must have avalid IP address.
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D-Link Unified Switch with Routing Disabled

If routing is disabled on the D-Link Unified Switch, it uses the network interface address of
the switch that you configured during the initial setup process.

NOTE: If you change the | P address of the network interface, the wireless function on
the switch automatically disables and re-enables. If you used DHCP for the IP
address assignment, make sure the lease does not expire.

D-Link Unified Switch with Routing Enabled

If the routing mode is enabled on the D-Link Unified Switch, you must create aloopback or
routing interface on the switch. Peer switches and APs use the IP Address of the lowest
loopback interface index to identify and communicate with the switch. If you do not define a
loopback interface, the wireless function uses the lowest index routing interface.

If routing is enabled, we strongly recommend that you define aloopback interface on the
switch. By creating aloopback interface, you can control which routing interface the wireless
function uses for its | P address when multiple routing interfaces exist. This can avoid
discovery problems for the discovery modes that use the | P address of the Unified Switch.
With the loopback interface, the | P address of the wireless function is always the same.

NOTE: Inthiscontext, the loopback interface does not refer to the loopback interface
with the 127.0.0.1 IP address. When you configure aloopback interface for
the wireless interface on the switch, it is essentially a permanent logical inter-
face and cannot have an | P address of 127.0.0.1. You must create a dedicated
subnet for the loopback interface, and other devices on the network must be
able to contact the I P address of the loopback interface.

The advantage of defining aloopback interface is that the interface never goes down. The
disadvantage is that network configuration is more complex because the loopback interface is
located on its own subnet and the rest of the network must know how to get to the subnet.

The network must have routes between the Unified Switch and the APs you want it to manage.
The APs must be able to ping the | P address assigned to the wireless interface on the Unified
Switch. You configure static routes on the switch through the configuration pages under LAN
> L 3 Features > Router.

The following procedures show an example of how to enable routing and configure alP
address on arouting or loopback interface by using the CLI:

1. Logontothe CLI and switch to Global Config mode:

(sw tch-pronpt)

User: admin

Passwor d:

(switch-pronpt) >enabl e
Passwor d:

(swi tch-pronpt) #config
(switch-pronpt) (Config)#

2. Enable routing.
(switch-pronmpt) (Config)#ip routing
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3. Changeto Interface Config mode for loopback interface 0, and assign an | P address and

subnet mask.

(switch-prompt) (Config)#interface | oopback 0
(switch-pronmpt) (Interface |oopback O)#i p address 10.1.1.1 255.255.0.0

[Optional] Change to Interface Config mode for slot O, port 2, assign an |P address, and
enable routing on the interface.
(switch-prompt) (Config)#interface 0/2

(switch-pronmpt) (Interface 0/2)#ip address 192.168.1.24 255.255.255.0
(switch-prompt) (Interface 0/2)#routing

You can also use the Web interface or SNMP to enable routing and configure an |P address.
The following shows the procedures to enable routing and configure an IP address on the
switch by using the Web interface.

NOTE: Routing is available under the L AN tab on the navigation menu.

1.

o 0~ Wb

Log on to the Web interface and click L 3 Features > | P > Configuration to accessthe | P
Configuration page.

From the Routing M ode drop-down menu, choose Enable, and then click Submit.

To create aloopback interface, click Routing > L oopback > Configuration.

From the Loopback drop-down menu, choose Create, and then click Submit

Enter an IPv4 address and subnet mask in the appropriate fields, and then click Submit.

To create arouting interface and assign an |P address, click Routing > | P > Interface
Configuration, and select the interface to configure from the Slot/Port drop-down menu.

Enter an | P address and subnet mask in the appropriate fields, choose Enable from the
Routing M ode drop-down menu, and click Submit.

IP Interface Configuration

SlotiPort 03 >
IP Address [192.168.1.12
Subnet Mask 255255255 0

Routing Mode

Administrative Mode Enable +

Link Speed Data Rate

Forward Net Directed Broadcasts Disable «

Active State Inactive

MAC Address 00:02:BC:00:00:79
Encapsulation Type Ethernet

Proxy Arp Enable

Local Proxy Arp Disable ~

IP MTU 1500 | (6810 1500)
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D-Link Access Point

On the D-Link Access Points, the default | P addressis 10.90.90.91/8, and DHCP is enabled by
default. If you do not have a DHCP server on the network, the AP retainsits default | P address
until you assign a static |P address.

You can connect to the AP CLI from ahost on the 10.0.0.0/8 network by telnetting to the AP’'s
default IP address.

To set astatic |P address on the AP, use the following procedures:

1. Logontothe D-Link Access Point.
For information about how to log on to the AR, see “Logging on to the AP’ on page 58.

2. Enter get managenent to view information about the AP's management interface.
3. Disablethe DHCP client on the AP so that it does not broadcast DHCP requests.
set nmanagenent dhcp-status down

4. To set the static I P address, enter the following command:
set nmanagenent static-ip <i paddress> static-mask <subnet_nask>

For example:
set nmanagenent static-ip 192.168.22.133 static-mask 255.255.255.0

5. To set the default gateway, enter the following command:
set static-ip-route gateway <gateway_i p> mask <subnet >

For example,
set static-ip-route gateway 102.168.22.1 mask 255.255.255.0

6. Fromthe CLI, enter save- r unni ng to save the configuration to memory.

You can use the Unified Switch asa DHCP server. If you plan to use the Unified Switch as the
DHCP server that responds to DHCP requests from the AP, see “ Setting the Switch
Information in the DHCP Option” on page 73

Enabling the AP and Peer Switch Discovery

The D-Link Unified Switch can discover peer Unified Switches and D-Link Access Points
regardless of whether these devices are connected to each other, located in the same Layer 2
broadcast domain, or attached to different | P subnets.

You can enable discovery between the D-Link Access Point and D-Link Unified Switch by
using one of following four mechanisms:

* UseVLANSsto broadcast the D-Link Wireless Device Discovery Protocol.

»  Connect to the access point CLI and manually add the I P address of the switch.

» Configure aDHCP server to include the switch IP address in the DHCP response to the
AP DHCP client request.

* Manually add the IP address of the AP to the switch. Multiple peer switches might find the
same access point. Thefirst association aways takes precedence. The AP does not change
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its association unless the connectivity to the current Unified Switch fails or the switch tells
the AP to disassociate and associate with another switch.

The following sections describe each discovery mechanism.

D-Link Wireless Device Discovery Protocol

The Wireless Device Discovery Protocol is part of the D-Link Wireless AP Protocol
(DWAPP). It isagood discovery method to use if D-Link Unified Switches and D-Link
Access Points are located in the same Layer 2 multicast domain. The D-Link Unified Switch
periodically sends a multicast packet containing the discovery message on each VLAN
enabled for discovery. You can enable the discovery protocol on up to 16 VLANS.

By default, VLAN 1 isenabled onthe AP, and VLAN 1 isenabled for discovery on the
Unified Switch. If the switch and AP arein the same Layer 2 multicast domain, you might not
need to take any action to enable AP-to-Switch discovery.

If the switch has discovered anew AP by using L2 discovery and the MAC address of the AP
isnot in the Valid AP database, the AP appearsin the list on the M onitoring > Access Point >
Authentication Failed Access Points page. To view AP authentication failures from the CLI,
enter show wirel ess ap failure status in Privileged EXEC mode.

The APs process the discovery message only when it comes in on the management VLAN.
The APs do not forward the L2 discovery messages onto the wireless media.

Use the following procedures to add aVLAN to the discovery list by using the Web interface:

1. Useabrowser to log on to the D-Link Unified Switch.

2. From the Navigation menu, click Administration > Basic Setup, then select the
Discovery tab.

3. Make surethe box for L2/VL AN Discovery is selected and add the management VLAN
ID of an AP or peer switch to the VL AN (1-4094) field.

4. Click Add to add the VLAN to thelist.

| clobal | | Aaa/RaDIUS | Radio | ssiD | valid AP |
fConfiguration

L3/IP Discovery [ L2/VLAN Discovery

IP List <empty list> VLAN List 1 - Default
2 - Engineering
3 - Marketing

IP Address Range  From To| VLAN (1-4094) 4

[ Refresh | [ Submit | [ Mest |

5. Click Submit to apply the changes.
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From the Unified Switch, you can check the discovery status. To view information about
whether the switch discovered the AP, click the M onitoring > Access Points > M anaged
Access Pointstab. If you have not added the MAC address of the AP to the local or RADIUS
Valid AP database, the AP appearsin the Monitoring > Access Point > Authentication
Failed Access Pointslist, and the failure type is listed as No Database Entry. For more
information about AP validation, see “ Authenticating and Validating Access Points’ on

page 74.
The following example shows how to add aVLAN to thelist by using the CLI.

1. FromaTelnet, SSH, or serial connection, log on to the D-Link Unified Switch and enter
the Wireless Configuration mode.

(swi tch-pronpt) >enable

Passwor d:

(swi tch-pronpt) #config
(switch-pronpt) (Config)#wreless

2. AddaVLAN tothe discovery list:
(switch-prompt) (Config-wirel ess)#di scovery vlan-list 4

3. Enter CTRL + Z to return to Privileged EXEC mode.
4. Savethe changesto the configuration file:
(switch-pronpt) #wite

This operation may take a few mnutes.
Managenment interfaces will not be available during this tine.

Are you sure you want to save? (y/n) y

Configuration Saved!
To check the managed status from the Unified Switch CLI, enter the following command:

(switch-pronpt) #show wirel ess ap status
Configuring IP Addresses of Peers and APs in the Switch

You can configure up to 256 | P addresses for potential peer switches and APs in the D-Link
Unified Switch. The switch sends association invitationsto all 1P addressesin thislist. If the
device accepts the invitation and is successfully validated by the switch, the switch and the AP
or peer switch are associated.

This discovery method mechanism is useful for peer switch discovery and AP discovery when
the devicesarein different | P subnets. In fact, for a switch to recognize a peer that isnot on the
same subnet, you must configure the | P addresses of each switch in the peer’s L3 discovery
list.

NOTE: Thelist of IP addressesis separate and independent from the list of valid
managed APs. Devices discovered through thislist might not be valid APs or
switches.

NOTE: If an AP has aready been discovered through another method, the Unified
Switch will not poll the IP address of the AP,
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Table 6. L 3/I P Discovery

Field

Description

L3/IP Discovery

This check box is used to enable or disable | P-based discovery of access
points and peer Unified Switches. When checked, IP polling is enabled and
the switch will periodically poll each address in the configured IP List. By
default, L3/IP Discovery is enabled.

IPList Thelist of 1P addresses configured for discovery, to remove entries from the
list select one or more entries and press the delete button. There are no
default entries, the maximum number of entries supported is 256.

IP AddressRange  Thistext field is used to add arange of IP address entriesto the IP List. Enter

the IP address at the start of the address range in the From field, and enter
the IP address at the end of the rangein the To field, then click Add. All IP
addressesin the range are added to the [P List. Once al desired entries are
added, click Submit to save thelist in the running configuration.

NOTE: To add asingle IP address, enter the addressin the From field and
leave the To field blank, then click Add.

To view the IP address of the AP, log on to the AP as described in “Logging on to the AP’ on
page 58 and enter the get nanagenent command.

Use the following procedures to add the | P address of a peer switch or AP to the discovery list
by using the Web interface:

1
2.

Discovery tab.

Use a browser to log on to the D-Link Unified Switch.
From the Navigation menu, click Administration > Basic Setup, then select the

Clear the check box for L 2/1 P Discovery to prevent the switch from sending L2

Discovery messages.

Make sure the check box for L 3/I P Discovery is selected and add the range of peer switch

or D-Link Access Point | P addresses in the From and To fields next to | P Address Range.

If the |P addresses are non-contiguous or if you only want to add one | P address, enter the
the address in the From field, and leave the To field blank.

Click Add to add the IP addresses to the list.
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6. Click Submit to apply the changes to the switch.

| Global | | AAA RADlUSl Radiul S‘SIDl Valid AP‘
i i ~onfiguration

L3/IP Discovery L2/VLAN Discovery []

IP List 192.168.1.45 VLAN List 1 - Default
192.168.1.46
192.168.1.47
192.168.1.48
192.168.1.49
192.168.1.50
192.168.1.51

IP Address Range  From[192.168.1.45  To[192.168.151 |  VLAN (1-4094) |

FAAT i
[ Refresh | S*bmit [ Mest |

To view information about whether the switch successfully polled the IP address you entered,
click the Monitoring > Global > | P Discovery tab.

The following example shows how to add an address to the L3 Discovery list by using the
CLI.

1. FromaTelnet, SSH, or serial connection, log on to the D-Link Unified Switch and enter
the Wireless Configuration mode.

(swi tch-pronpt) >enable

Passwor d:

(switch-pronpt) #config
(switch-pronpt) (Config)#wreless

2. Addthe IP address of a peer switch or AP to the discovery list:
(switch-pronpt) (Config-wirel ess)#di scovery ip-list 192.168.6.211

From the CLI, you can only add one |P address at atime.

3. Enter CTRL + Z to return to Privileged EXEC mode.

4. Savethe changesto the configuration file:
(switch-prompt) #wite

This operation may take a few mnutes.
Management interfaces will not be available during this tinme.

Are you sure you want to save? (y/n) y

Configuration Saved!
To check the managed AP status from the Unified Switch CLI, enter the following command:

(swi tch-pronpt) #show wirel ess ap status

Setting the Switch IP Address in the D-Link Access Point

You can connect to the D-Link Access Point CLI and statically set the IP address or DNS
name of the D-Link Unified Switch. You can configure up to four D-Link Unified Switches
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for AP association, but you can only use one switch to manage the AP. The other three
switches are backup or alternate switches.

Once you configure the AP with the | P addresses or DNS names of switches, the AP will only
associate with those switches. Even if other switches discover the AP by using other
mechanisms, the AP only accepts associations from the Unified Switches you configure. If
you change the | P address of the switch that managesthe AP, you must use a secondary switch
to manage the AP. You can connect directly to the AP CLI and configure the I P address of the
switch that will manage the AP.

If you know the I P address of the D-Link Access Point, you can Telnet to the CLI. The default
IP address of the AP is 10.90.90.91 with a default subnet mask of 255.0.0.0.

NOT E: For this method to work, the AP must be able to find aroute to the Unified
Switch.

1. Logontothe D-Link Access Point.

For information about how to log on to the AP, see “Logging on to the AP’ on page 58.
2. Enter the IP address of up to four switches that are permitted to manage the AP.

For example, to enter a Unified Switch with an IP address of 192.168.66.202 and a
Unified Switch with an 1P address of 192.168.19.242, use the following commands:

WLAN- AP# set nmanaged-ap switch-address-1 192. 168. 66. 202
WLAN- AP# set nmanaged-ap switch-address-2 192.168. 19. 242

3. Usetheget managed- ap command to verify that the information you entered is correct.
WLAN- AP# get managed- ap

Property Val ue
node up
ap-state down

192. 168. 66. 202
192. 168. 19. 242

swi t ch- addr ess-
swi t ch- addr ess-
swi t ch- addr ess-
swi t ch- addr ess-
dhcp-swi t ch- addr ess-
dhcp-swi t ch- addr ess-
dhcp-swi t ch- addr ess-
dhcp-swi t ch- addr ess-
managed- node- wat chdog O

A WNBE

A WN PR

From the Unified Switch, you can check the discovery status. To view information about
whether the switch discovered the AP, click the M onitoring > Access Points > M anaged
Access Pointstab. It might take several minutes for the AP to discover the switch.

NOTE: If you have not added the MAC address of the AP to thelocal or RADIUS
Valid AP database, the AP appearsin the M onitoring > Access Point >
Authentication Failed Access Pointslist, and the failure typeis No Database
Entry. For more information about AP validation, see “ Authenticating and
Validating Access Points’ on page 74.

To check the Managed AP status from the Unified Switch CLI, enter the following command:

(swi tch-pronpt) #show wirel ess ap status
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Setting the Switch Information in the DHCP Option

Instead of statically configuring the Unified Switch IP addressin the AP, you can configure the
DHCP server on your network to pass the | P addresses of up to four D-Link Unified Switches
to the access point in DHCP option 43. If you configured a static | P address in the D-Link
Access Point, the AP ignores DHCP option 43.

The procedures to add the DHCP option to the DHCP server depend on the type of DHCP
server you use on your network. If you use a Microsoft Windows 2000 or Microsoft Windows
2003 DHCP Server, you configure the scope you use with the access points with DHCP
Option 43, as the following procedures describe.

1. From the DHCP manager, right-click the applicable scope and select Configure
Options...

feonce =loix|

File  Action Wiew Help

&= BE B 2|

@ D_HCP Scope Options

=8 ﬁ;) IvITnc-wireless wlan.com [192,168,30.2] Cipkion Marme | Vendor
E“—j Scope [20.0.0,0] murali éDDS Router Standard
E‘Cj atope;[20.4,0.0] idrall o 006 DS Servers Standard
3% :cope E;gggg} mura:!g ﬁaDIS DS Domain Mame Standard
=] =N
: R i &P 044 WINSINENS Servers Standard

--{[7 Address Poal
':@ AL gﬁsms WINSIMET Mode Type Standard

l:@ Reservations

[ Scope Options

= Scope [192.168.30.0] WYLAN-10
--{[7) Address Poal

(D Address Leases

-8 Reservations

| =3 scor
- B0 Scop Wiew 3
CQ Sery

Configure Optians. ..

Refresh
Export List...

Help 4 I I _’i

+ [Configure scope options | |

2. Fromthe Available Options list, scroll to Option 43 and select the 043 Vendor Specific
Info check box.

3. Enter the Option 43 data into the Data Entry field.
The format for DHCP option 43 values are defined by RFC 2132. To enter an IP address
of 192.168.1.10 into the Binary column, you enter the data type code (01) and the address

length (04), followed by the I P address in hexadecimal format. You repeat the data type
and address length codes for each address you enter.

For example, to add the four switch 1P addresses 192.168.1.10, 192.168.2.10,
192.168.3.10, and 192.168.4.16 to Option 43, you enter the following hexadecimal
numbers into the Data Entry field:

0104 0C A801 0A 0104 0C A8 02 0A 0104 0C A803 0A 0104 0C AB04 10
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The following image shows the four 1P addresses entered into the Data Entry field on the

Windows DHCP server.
File  Action Wiew Help
= | Bn BB 2 &
) oHep | Scope options
E@ Ivl7nc-wireless. wlan.com [192,168.30.21 IS — I vendor
15 3 o 2l ondd
D Scof
General |Advanced| s Standard
Mame Standard
Awailable Dptions | Description AI S:rvers Stan:ar:
[ 041 NIS Servers Addresses c e Type Atailca
O 042 NTP Servers Addresses c
043 Vendor 5pecific Infa Embedded «
044 WINS/MBNS Servers MEMS Addn -
«| | »
—Data entry
Data; Binary: ASCIL:
ooon 01 04 CO A8 01 DA 01 04 AT
0008 CO AS 02 DA 01 04 CO AR A7 . A7
0010 03 0A 01 04 CO A8 04 10 ... &7
o00nis

(5] I Cancel Apply

4. Click OK.
The following figure shows a scope with Option 43 configured.
E® pHep 10l =]
File  Action Wiew Help
5 B0 DB 2| &
@ DHCP Scope Opkions
Eﬂ) Il7nc-wireless. wlan,com [192,168.30,2] e | . | Value | e
‘ -1 Seope [20.0.0.0] murali §003 Router Standard 192.168.30.1 Mone
g Scope [20.1.0.0] m“ra:!l &P 006 DNS Servers Standard 192.168.30.2 Mone
D gcope ggigg} murali #4015 DS Domain Name Standard wlan,com Tone
_ L 043 vendor Specific Info Standard 0104c0801 0201 4 cDaB020a... Mone )
= WD‘H WINSMENS Servers Standard 192,168,302 Maone
{3 Address Leases
I {8 Reservations g&ﬂ‘ls WINS/MET Mode Type Skandard 05 Mone
| (g Scope Options
| ElD Scope [192,168,30,0] WYLAN-10 . .
-{[7) Address Paal Scope with Configured
{3 Address Leases Option 43 Information
LBl Reservations
{8 Scope Options
[]‘-D Scope [192,168.31,0] WYLAN-20
[]‘-D Scope [192,168,32,0] WYLAN-30
(L7 Server Options
} 1] | i3]

Authenticating and Validating Access Points

For aD-Link Unified Switch to manage an AP, you must add the MA C address of the AP to
thelocal or external RADIUS database. When the switch discovers an AP that is hot managed
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by another Unified Switch, it looks up the MAC address of the AP in the local or RADIUS
Valid AP database. If it findsthe MAC addressin the database, the switch validatesthe AP and
assumes management. If you have not added the MAC address of the AP to the database, the
AP appearsin the Authentication Failed Access Pointslist, and the failure type is No Database
Entry.

Optionally, you can require that the AP is authenticated before the Unified Switch managesit.
You can add authentication information about the AP when you add its MAC address to the
local or RADIUS database.If you enable authentication, it takes place immediately after the
switch validates the AP.

NOTE: When a switch successfully validates an AP, it sends an AP Profile to the
access point. The AP Profile contains all of the access point configuration
information, such asthe radio, security, and SSID settings. You can configure
all of the AP settings before the switch validates an AP. For information about
configuring the default AP profile, see Chapter 5, “ Configuring Access Point
Settings’ on page 83.

Configuring AP Authentication

Unless access to the wired network is secured with IEEE 802.1X authentication or another
security mechanism, the AP should always use authentication so that Rogue APs do not
automatically associate with the switch.

If you require the AP to authenticate itself to the switch, you must perform the following three
steps:

1. Enable AP authentication on the switch, which is described in this section.

2. Connect to the access point CLI and configure a pass phrase as described in “ Preparing the
Access Points’ on page 58.

3. Enter the pass phrase in the Valid AP database.

To enter apass phrase in the local database, see “Using the Local Database for AP
Validation” on page 76. To enter a pass phrase in the RADIUS database, see “Using the
RADIUS Database for AP Validation” on page 78.
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To enable AP authentication on the Unified Switch, click Administration > Basic Setup.
From the Global tab, check the AP Authentication box, then click Submit to apply your
changes.

Figure 36. Requiring AP Authentication

76

I Discuveryl AAA RADIUSl Radiﬂl ‘S‘SIDl Valid AP|

al Configuration

Enable WLAN Switch
WLAN Switch Operational Status Enabled
IP Address 10.254.24 145

AP Authentication

@ Local ORADIUS
Country Code US - United States

AP MAC Validation

Maote: The county code w3y only be modiffed wher the WLAN switek iz dizszbled, modifying the couwntry affects the opemting mgulatony domain for a2l
manFged AP,

[ Refresh | [ Submit | [ Mext |

To enable AP authentication from the CL 1, access Wireless Config mode and enable
authentication:

(switch-pronpt) >enable

Passwor d:

(swi tch-pronpt) #config

(switch-prompt) (Config)#wirel ess

(switch-pronpt) (Config-wrel ess)#ap authentication

Using the Local Database for AP Validation

To use the local Valid AP database, set the AP MAC Validation to loca, add APsto the
database, and configure the settings for the APs in the database. All of the configuration takes
place on the switch.

To set up the local database for AP MAC Validation, use the following steps:

1. Fromthe Administration > Basic Setup > Global page, make sure AP MAC Validation
is set to Local, which is the default.

2. Click Submit if you made any changes.
3. Click the valid AP tab.
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4. Inthe MAC Addressfield, enter the MAC address of the AP to validate, and enter the
physical location of the AP in the second field, then click Add.

| Global | Discovery | AAA | RADIUS | Radio | ssID ‘ ‘

Valid Access Point Summary

MAC Address Location Managed Mode Profile
[]00:11:95:A3:78:30 Lab1 WS Managed 1-Default
[100:11:95:A3:78:40 Lab2 WS Managed 1-Default

00:00:00-00-00-00

Delete All_| [ Refresh

NOTE: If the switch has already discovered the AP, the MAC address of the AP
appears on the M onitoring > Access Points > M anaged Access Points page
or on the M onitoring > Access Point > Authentication Failed Access
Points page. To view the MAC address of discovered APsfrom the CLI, enter
show wirel ess ap status Or show wirel ess ap failure statusin
Privileged EXEC mode.

After you add the AP, additional fields appear so you can provide configuration
information about the AP, including a passphrase for AP authentication.

5. If you selected the AP Authentication check box on the Wireless Global Configuration
page, select the Apply check box and enter an authentication password for the AP,

Global | Discovery | AAA/RADIUS | Radio | ssiD | ‘

Valid Access Point Configuration
MAC Address (0011 95 4378 30 v]
Managed Mode |WS Managed __ili
Location ]Engmeering
Authentication Password | ................. | Edit
Profile 1-Dfauk ]
802.11a radio Channel Auto [ Power (%) 0 |
802.11g radio Channel [Auto [v] Power (%) [0 [+]
[ Delete H Refresh H Submit I [Back]

The password must match the pass phrase that you configured on the AP. The length of the
password can be 8-63 a phanumeric characters, but for good security, you should enter at
least 24 characters.

6. Usethe default settings or configure other information about the AP, such as the channel
the AP uses and the strength of the power transmission.

For more information about the fields on the Valid Access Point Configuration page and
how to configure valid APs, see “Configuring Valid Access Point Settings’ on page 106.

7. Click Submit to apply your changes to the running configuration.
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The following example shows how to configure the local database by using the CL1:

1. Logon to the switch and enter Wireless Config Mode.

(swi tch-pronpt) >enable

Passwor d:

(swi tch-pronpt) #config

(swi tch-pronpt) (Config)#wreless

2. Setthelocal database as the validation method.
(switch-pronpt) (Config-wreless)#ap validation |ocal

3. Enter the MAC address of the AP to add to the database and configure a password:
(swi tch-pronpt) (Config-wirel ess)#ap database 00: 02: BC: 00: 14: 40

4. If you require AP-to-switch authentication, enter the pass phrase for the AP

(swi tch-pronpt) (Config-ap)#password
Enter password (8 - 63 characters): ***xxx*kkkxxxxkksx
Re_enter paSSV\Drd:******************

For information about configuring additional database parametersfor an AP by using the CLI,
see the D-Link CLI Command Reference.

Using the RADIUS Database for AP Validation

To use aRADIUS server to vaidate the AP, you must configure settings on both the Unified
Switch and the RADIUS server. From the switch, set the AP Validation to RADIUS and
configure information about the RADIUS server, such asits IP address. From the RADIUS
server, configure information about the Valid APs, including the pass phrase for AP
authentication. For information about the parameters to configure on the RADIUS server, see
Appendix B, “Configuring the External RADIUS Server” on page 207.

When you enable RADIUS as the validation method, the local Valid AP database is not used.
The Valid AP database is only used for local authentication and validation.

To use aRADIUS server for the Valid AP database, use the following procedures.

1. Fromthe Administration > Basic Setup > Global page, set AP Validation to RADIUS.
2. Click Submit to apply the changes.

3. Fromthe LAN menu, click Security > RADIUS > RADIUS Authentication Server
Configuration.

The RADIUS settings in the AAA/RADIUS tab in the Wireless Globa Configuration
Basic Setup are applied to access points that use the default AP Profile - and not to the
switch. If you require aRADIUS server to authenticate wireless clients before they can
associate with an AP, you configure the settings in the AAA/RADIUS tab as described in
“Configuring AAA and RADIUS Settings” on page 85.
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4. Enter the IP address of the RADIUS server to use for the valid AP database and click

6.

Submit.

RADIUS Authentication Server Configuration

RADIUS Server IP Address Add |v|
IP Address 192.168.5.20|

Additional fields appear.

Configure information that the Unified Switch must use to contact the RADIUS server on
your network, such as the shared secret.

RADIUS Authentication Server Configuration

RADIUS Server IP Address 192.168.5.20 [V:i
Port 1812 (0 to 65535)
Secret ************ Appw
Primary Server Yes .!.Y!
Message Authenticator Enable {v:
Secret Configured No
Current Yes
[ Submit H Remove H Refresh

Click Submit to apply your changes.

The following example shows how to configure RADIUS authentication by using the CLI:

1.

Enter the Wireless Config mode.

(swi tch-pronpt) >enable

Passwor d:

(switch-pronpt) #config
(switch-pronpt) (Config)#wreless

Set the RADIUS server as the validation method.
(switch-pronpt) (Config-wreless)#ap validation radius

Exit to Global Config Mode and configure the RADIUS settings.

In the following command example, the RADIUS server |P addressis 192.168.2.2.

(switch-prompt) (Config-wirel ess)#exit

(switch-pronpt) (Config)#radius server host auth 192.168.2.2
(switch-pronmpt) (Config)#radius server key auth 192.168.2.2
Enter secret (16 characters max):***x**kxkkhxhdkhskx

Re_enter SeCI’etZ******************

For information about configuring additional RADIUS parameters by using the CLI, see the
D-Link CLI Command Reference.
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Managing Failed or Rogue APs

If an AP attempts to contact a switch but the authentication fails or if the MAC address of an
APisnot in the Valid AP database, AP Validation fails and the AP appearsin the list on the
Authentication Failed Access Points page. If the switch learns about an AP that is not in the
database, and the AP has not tried to discover the switch, the AP appearsin thelist on the
Rogue/RF Scan Access page.

You can add the AP to the local Valid AP database from the list on the Authentication Failed
Access Points page or the Rogue/RF Scan Access page.

To add an AP from the Authentication Failed Access Points page or the Rogue/RF Scan
Access page to the local Valid AP database, use the following procedures:

1. Access either the Authentication Failed Access Points page or the Rogue/RF Scan
Access page from the by clicking M onitoring > Access Point folder.

2. Select the check box associated with the AP and click M anage.

Authentication Failed Access Points

MAC Address IP Address Last Failure Type Age
[100:11:95:a3:7a:d0 10.27.65.184 Mo Database Entry 0d:00:00:20

Delete All ][ Manage J[ Refresh
L

NOTE: You cannot add an AP to the RADIUS database from the AP authentication
failure page. If you use aRADIUS server for AP Validation, you must enter
the AP information into the RADIUS database.

3. TheValid Access Point Configuration page for the added AP is displayed.
Configure the appropriate fields, such as Location and Profile, and then click Submit.

| Gioball Discovery | AAA/RADIUS | Radio | ssiD | |

Valid Access Point Configuration
MAC Address 00:11:95:23:7Ta:d0 |¥|
Managed Mode WS Managed ]
Location
Authentication Password O eait
Profile 1- Default |»|
802.11a radio Channel Auto v Power 0 [
802.11g radio Channel Auta |/ Power 0 |
Delete |[ Refresh | [ Submit | [ Back |

The AP is added to the Valid AP database, and its MAC address appears in the list on the
Administration > Basic Setup > Valid AP page.
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NOTE: If you select multiple APs to manage, the Web interface displays the selected
APsinthe MAC Address field one by one after you submit a configured AP
entry.

To view thelist of failed APs by using the CLI, usetheshow wi rel ess ap failure status
command in Privileged EXEC mode. To view the list of APs detected through the RF scan,
usetheshow wirel ess ap rfscan status command.

To add afailed or rogue AP to the local Valid AP database, use the procedures described in
“Using the Local Database for AP Validation” on page 76.
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Configuring Access Point Settings

After you validate a D-Link Access Point that associates with a switch, the switch assumes
management functions for the AP. You can configure all of the AP settings directly from the
switch before or after you validate the AP. The D-Link Unified Access System utilizes the D-
Link Wireless AP Protocol (DWAPP) for the switch to discover, configure, manage, and
monitor the APs. This chapter describes the AP settings and how to manage them by using the
D-Link Unified Switch.

This chapter contains the following sections:

» AP Profiles, Networks, and the Local Database
e Configuring AAA and RADIUS Settings

»  Configuring Wireless Radio Settings

» Configuring SSID Settings

e Configuring Valid Access Point Settings

For information about the commands you use to configure access point settings by using the
CLI, seethe D-Link CLI Command Reference.

NOT E: Changing some access point settings might cause the AP to stop and restart
system processes. If this happens, wireless clients will temporarily lose
connectivity. We recommend that you change access point settings when
WLAN trafficislow.

AP Profiles, Networks, and the Local Database

This section provides an overview of the access point profiles, wireless networks, and the local
access point database that you configure on the D-Link Unified Switch.

Access Point Profiles

You manage the configuration of D-Link Access Points through the use of configuration
profiles. A profileislike a configuration template that you can apply to one or more APs. The
D-Link Unified Switch allows you to create multiple configuration profiles for access points.
When you validate an AP, you can specify which profile the AP receives.

You can define many AP profiles on the Unified Switch, but each access point can only have
one profile at atime. You can use the same profile for multiple APs, or you can create a unique
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profile to assign each AP that the switch manages. An existing profile and all of its
configurations may be copied to another profile or used to create a new profile. Each
configuration profile can have unique settings for the following access point features:

* RADIUS server settings

*  MAC authentication list

» Radio interface and RF configuration

* QOS Configuration

» Virtua Access Point (VAP) Configuration

When you modify and apply a profile, the switch applies the changes to the APs it manages
that use the modified profile.

NOTE: The switch only applies the changes to the APs after you explicitly apply the
profile on the Advanced Configuration > AP Profile page or use the ap
profile apply command.

Until you apply the updated profile to the APs, the APs continue to operate with the original
AP profile settings. If you assign anew profile to the AP in the Valid AP database, you must
reset the AP.

All of the AP settings that you configure from the tabs on the Basic Setup page are for the
default AP profile. When you make changes to these settings, the settings affect all APsthat
use the default profile.

All of the fields that you configure for the default profile are also available for profiles that
you create. For information about how to create a new profile and assign it to an AP, see
“Creating, Configuring, and Managing AP Profiles’ on page 155.

Networks

In general, awireless client connects to an access point by choosing a network (identified by
the SSID) from alist of available wireless networks. You configure these wireless networks,
including their associated SSID, on the D-Link Unified Switch.

You manage the networks available on the WLAN by modifying or adding network
configurations, which include settings for the SSID, VLAN ID, security, and tunneling
parameters. You can associate a network with a Virtual APs (VAPs) within an AP
configuration profile.

By default, the switch has 8 networks, and each network is associated with one of the 8 VAPs
on each radio. You can modify (but not delete) the default network configurations and add new
network configurations. The first network is configured with adefault SSID “Guest Network,”
and the other networks have default SSIDs assigned based on the Network ID. All the default
networks are configured with open authentication and assigned to the default VLAN 1. The
default VLAN isused if RADIUS-based authentication is not configured for the network or
the RADIUS server does not return aVLAN for a specific client.

Local Access Point Database

In order for a Unified Switch to manage an access point, you must add the physical MAC
address of the AP to the Valid AP database. The Valid AP database can reside locally on the
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switch or externally on a RADIUS server. When an AP is discovered, the switch verifies the
AP's MAC address according to the validation mode (local or RADIUS) aslong asthe AP is
enabled for Managed M ode and has been authentication (if required). Once the AP isverified,
it becomes managed by the switch.

If an AP isdiscovered and its MAC addressis not found in the Valid AP database or the AP
failsto authenticate, the switch adds an entry to the AP failurelist. If you use the local Valid
AP database, you can add the failed AP to the Valid AP database directly from the AP
Authentication Failures page.

The Valid AP database stores additional information about the AP along with its MAC address
such as the AP mode, local authentication password, and the AP profile that the access point
uses. You can aso manually set the channel and RF signal transmit power level for an
individual AP, which overrides the channel and power settings in the AP profile.

Configuring AAA and RADIUS Settings

In the D-Link Unified Access System, you can use a RADIUS server for the following
functions:

» Management of client-to-AP authentication and accounting
* Management of AP-to-Switch authentication and accounting
e Database for AP settings

The information in this section applies to the client-to-AP authentication and accounting
management. For information about AP-to-switch management, see “Using the RADIUS
Database for AP Validation” on page 78. For information about how to set AP database
settingsin the RADIUS server, see Appendix B, “ Configuring the External RADIUS Server”
on page 207.

The RADIUS server that you configure from the Administration > Basic Setup >
AAA/RADIUS tab isthe RADIUS server for the default AP profile. For each network, you
can configure aunique RADIUS server or use the default RADIUS server.

When you use a RADIUS server for wireless client-to-AP communications, such as when
clients use WPA Enterprise or WEP |EEE 802.1X security to connect to the AP, the AP isthe
RADIUS client and communicates with the RADIUS server. The Unified Switch does not
tunnel packets between the AP and RADIUS server. This means that you must configure the
AP asaclient in the RAIDUS server. For information about how configure RADIUS clients,
see Appendix B.

Table 7 describes the fields you can configure for the default AP profile RADIUS server.
Table 7. Global RADIUS Server

Field Description
IP Address  Thisisthe|P address of the RADIUS server the AP uses for authentication.
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Table 7. Global RADIUS Server

Field Description

Secret The RADIUS Secret is the shared secret key for the RADIUS server. Click the Edit
check box to enter a secret. The text you enter isdisplayed as“*” charactersto
prevent others from seeing the RADIUS key as you type.

Accounting  RADIUS Accounting allows you to track and measure the resources a particular user
has consumed such as system time and amount of data transmitted and received.

NOTE: If you access the RADIUS and MAC Authentication configuration
information from the AP Profile page, the Profile Namefield also appears. To
rename the profile, delete the existing name and enter the new name in the
field, then click Submit.

Onthe AAA/RADIUS tab, you can aso configure aglobal list containing the MAC addresses
of wireless clientsto allow or deny accessto APs. Thelist only appliesto profiles that use
local MAC Authentication, which isan SSID setting. MAC Authentication is disabled by
default. For information about enabling MAC Authentication, see “ Configuring the Default
Network” on page 94.

If you select Allow as the default action, the wireless clients you add to the Allow MAC List
can connect to the AP, and all other wireless clients are denied. If you select Deny as the
default action, the wireless clients with the MAC addresses that you add to the Deny MAC list
cannot associate with the AP,

NOTE: The MAC list label updates depending on the default action you select.

Figure37. MAC Access Control

86

MAC Authentication

Default Action & Ajlow O Deny Default Action O Allgw %] Deny

2 AC e Allows only MAC Deny MAC List QL&FFE1CF267
SEE e T addresses that f0:0F:FE:1C:F8:B1
00:0F FE:1C:F8:A8 . . B Lo e
00:0F:FE:1C:F&:C5 appear in the list SSSEEEEEE'SE

MAC Authentication

Denies only MAC T
addresses that

appear in the list

MAC Address  |00:0F:FE:1C:F8:C5 e e

[Add J [ Delete | k

To add awireless client to the MAC Authentication list, enter the MAC address of the client in
the MAC Addressfield and click Add. You must click Submit to apply the changes.
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The following table describes the MAC Authentication fields in more detail.

Table 8. MAC Authentication

Field Description

Default Action The default action is the action that is taken for unknown MAC addresses of
wireless clients that attempt to associate with an access point.

¢ Allow—Only the clients you explicitly add to thislist are all owed access
to APsthat use MAC Authentication.

¢ Deny—Only the clients you explicitly add to thislist are denied access
to APsthat use MAC Authentication.

MAC List Thislist shows the MAC address of the wireless clients that have aready
been added to the list of wireless clientsto allow or deny access to the APs.

MAC Address Enter the MAC address of the wireless client to allow or deny access to all
APsthat use this profile.

Configuring Wireless Radio Settings

The DWL-3500AP supports one radio that operates in IEEE 802.11g mode. The DWL-
8500AP supportstwo radios: Radio 1 operatesin |EEE 802.11amode, and Radio 2 operatesin
|EEE 802.11g mode.

The difference between the IEEE 802.11 modes is the frequency in which they operate. IEEE
802.119g operates in the 2.4 GHz frequency, and |EEE 802.11a operates in the 5 GHz
frequency of the radio spectrum.

You configure the default radio settings from the Administration > Basic Setup > Radio tab,
which Figure 38 shows.
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NOTE: Theradio settings for the IEEE 802.11g radio are directly below the settings
for the IEEE 802.11a radio.When the profile is applied to the DWL-3500AP,
only the settings for the IEEE 802.119 radio are applied.

Figure 38. Radio Settings
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The following table describes the fields you can configure from the Radio tab on the Basic
Setup page. After you change the settings, click Submit to apply the settings.

Table 9. Radio Settings

Field Description
Sate Specify whether you want the radio on or off by clicking On or Off.
If you turn off aradio, the AP sends disassociation frames to all the wireless
clientsit is currently supporting so that the radio can be gracefully shutdown
and the clients can start the association process with other available APs.
Super A Super A and Super G attempt to increases performance through bursting and
Super G frame compression. Performance increases when the AP communi cates with

Super A and Super G-enabled clients. However, with Super A and Super G
enabled, the access point transmissions consume more bandwidth.

e Toenable Super A or Super G, select Enabled.

e Todisable Super A or Super G, select Disabled.

e Toenable Super A or Super G with Dynamic Turbo, select Enable with
Dynamic Turbo.
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Table 9. Radio Settings

Field

Description

RTS Threshold

The RTS threshold specifies the packet size of arequest to send (RTS)
transmission. This helps control traffic flow through the access point,
especially one with alot of clients.

If you specify alow threshold value, RTS packets will be sent more
frequently. Thiswill consume more bandwidth and reduce the throughput of
the packet.

On the other hand, sending more RTS packets can help the network recover
from interference or collisions which might occur on abusy network, or on a
network experiencing el ectromagnetic interference.

The RTS Threshold value can be between 0 and 2347.

L oad Balancing

If you enable load balancing, you can control the amount of traffic that is
alowed onthe AP,

L oad Utilization

Thisfield allows you to set athreshold for the percentage of network
bandwidth utilization allowed on the radio. Once the level you specify is
reached, the AP stops accepting new client associations.

If you specify 0 in thisfield, all new associations will be allowed regardiess
of the utilization rate.

RF Scan Other
Channds

The access point can perform RF scans to collect information about other
wireless devices within range and then report this information to the Unified
Switch.

If you select the Scan Other Channels check box, the radio periodically
moves away from the operational channel to scan other channels.

Enabling this mode causes the radio to interrupt user traffic, which may be
noticeable with voice connections. Changing the channels aso causes the
radio to lose auto-calibration settings which may degrade the signal quality.

When the Scan Other Channels check box is hot enabled the AP scans only
the operating channel.

RF Scan Interval

Thisfield controls the length of time between channel changes during the RF
Scan.

RF Scan Sentry

If you select the RF Scan Sentry check box, the radio primarily performs
dedicated RF scanning. The radio passively listens for beacons and traffic
exchange between clients and other access points but does not accept
connections from wireless clients. In sentry mode, all VAPs are disabled.

In this mode, the radio switches from one channel to the next. The length of
time spent on each channel is controlled by the scan duration. The default
scan duration is 10 milliseconds.

RF Scan Sentry
Channeds

The radio can scan channelsin the radio frequency used by the 802.11b/g
band, the 802.11a band, or both bands. Select the channel band for the radio
to scan.

NOTE: The band selection applies only to radios in sentry mode.
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Table 9. Radio Settings

Field

Description

Sation | solation

Select the check box to enable Station I solation, or clear it to disable station
isolation.

»  Enabled: Access point blocks communication between wireless clients.
The access point still allows data traffic between its wireless clients and
wired devices on the network, but not among wireless clients.

« Disabled: Wireless clients can communicate with one another normally
by sending traffic through the access point.

Note: Station Isolation is operational only for clients that transmit non-

tunneled traffic. When client traffic istunneled, Station Isolation isnot in

effect for those clients even if it is enabled.

Note: Station Isolation is configured independently for each radio. You
cannot configure Station I solation on a per-SSID or per-AP basis.

Rate Sets

Check the transmission rate sets you want the access point to support and the
basic rate sets you want the access point to advertise.

Rates are expressed in megabits per second.

Basic

These numbers indicate rates that the access point will advertise to the
network for the purposes of setting up communication with other APs and
client stations on the network. It is generally more efficient to have an AP
broadcast a subset of its supported rate sets.

Supported

These numbers indicate rates that the access point supports. You can check
multiple rates (click a check box to select or de-select arate). The AP
automatically chooses the most efficient rate based on factorslike error rates
and distance of client stations from the AP,

Mode

The Mode defines the Physical Layer (PHY) standard the radio uses.

The DWL-3500AP and Radio 1 on the DWL-8500AP use the | EEE 802.11g
mode PHY standard. This mode is a higher speed extension (up to 54 Mbps)
to the 802.11b PHY, while operating in the 2.4 GHz band. It uses orthogonal
frequency division multiplexing (OFDM). It supports data rates ranging from
1to 54 Mbps. IEEE 802.11b clients can use the 802.11g mode.

Radio 2 on the DWL-8500AP use the |EEE 802.11a mode, whichisa PHY
standard that specifies operating in the 5 GHz U-NII band using orthogonal
frequency division multiplexing (OFDM). It supports datarates ranging from
6 to 54 Mbps.

If the radio state is disabled, the mode displays as Off.

Maximum Clients

Specify the maximum number of stations allowed to access this access point
a any onetime.

You can enter a value between 0 and 256.
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Table 9. Radio Settings

Field Description

DTIM Period The Delivery Traffic Information Map (DTIM) message is an element
included in some beacon frames. It indicates which client stations, currently
sleeping in low-power mode, have data buffered on the access point awaiting
pick-up.

The DTIM period you specify indicates how often the clients served by this
access point should check for buffered data still on the AP awaiting pickup.
Specify aDTIM period within the given range (1 - 255).

The measurement is in beacons. For example, if you set thisfield to “1”
clientswill check for buffered data on the AP at every beacon. If you set this
field to 10, clients will check on every 10th beacon.

Beacon Period Beacon frames are transmitted by an access point at regular intervalsto
announce the existence of the wireless network. The default behavior isto
send a beacon frame once every 100 milliseconds (or 10 per second).

The Beacon Interval valueis set in milliseconds. Enter avalue from 20 to

2000.
Automatic The channel defines the portion of the radio spectrum that the radio uses for
Channd transmitting and receiving. Therange of channels and the default channel are

determined by the Mode of the radio interface.

When the AP boots, the AP scans the RF area for occupied channels and
selects a channel from the available non-interfering, or clear channels.
However, channel conditions can change during operation.

Enabling the Automatic Channel makes APs assigned to thisprofile eligible
for auto-channel selection. You can automatically or manually run the auto-
channel selection algorithm to allow the Unified Switch to adjust the channel
on APsas WLAN conditions change.

By default, the global auto-channel mode is set to manual. To enable the
automatic channel selection mode, go to the AP Management > RF

M anagement page and select Fixed or Interval for the Channel Plan mode.
You can aso run the automatic channel selection algorithm manually from
the Manual Channel Plan page.

NOTE: If you assign astatic channel to an APinthe Valid AP database or on
the Advanced AP Management page, the AP will not participate in the auto-
channel selection.

Limit Channels If the radio is operating in 802.11amode, you can select the Limit Channels
check box to allow the AP to select from the available channels.

NOTE: The available channels depends on the country in which the APs
operate.

If the Limit Channels option is not selected, the AP can also broadcast on
channels 149, 153, 157, 161, and 165. Some legacy 802.11a adapters might
not support these higher channel numbers.
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Table 9. Radio Settings

Field

Description

Automatic Power

The power level affects how far an AP broadcastsits RF signal. If the power
level istoo low, wireless clients will not detect the signal or experience poor
WLAN performance. If the power level istoo high, the RF signal might
interfere with other APs within range.

Automatic power uses a proprietary algorithm to automatically adjust the RF
signal to broadcast far enough to reach wireless clients, but not so far that it
interfereswith RF signals broadcast by other APs. The power level algorithm
increases or decreases the power level in 10% increments based on presence
or absence of packet retransmission errors.

Initial Power

The automatic power agorithm will not reduce the power below the number
you set in theinitial power field. By default, the power level is 100%.
Therefore, even if you enable the automatic power, the power of the RF
signal will not decrease.

The power level is a percentage of the maximum transmission power for the
RF signal.

Antenna Diversity

Select the antenna use to receive and transmit wireless traffic:

« Auto: Automatically select the best antennato send and receive traffic.
¢ Primary: Use the primary antennato send and receive traffic.
e Secondary: Use the secondary antennato send and receive traffic.

If you access the Access Point Profile Radio configuration through the Advanced
Configuration > AP Profile > Radio tab, some additiona fields are available for

configuration.

The following table describes the fields for the AP radio that are only available from the
Advanced Configuration menu.

Table 10. Advanced Radio Configuration

Field

Description

RF Scan Duration

Thisfield controls the amount of time the radio spends scanning the other
channél (in milliseconds) during an RF scan.

Transmit Lifetime

Shows the number of millisecondsto wait before terminating attemptsto
transmit the MSDU after the initial transmission.

Receive Lifetime

Shows the number of milliseconds to wait before terminating attempts to
reassemble the MMPDU or MSDU after theinitial reception of afragmented
MMPDU or MSDU.

Frag Threshold

The fragmentation threshold limits the size of packets transmitted over the
network. Acceptable values are even numbers from 256-2345. Packets that
are under the configured size are not fragmented. A value of 2346 means that
packets are not fragmented.

Short Retries

Thevalue in thisfield indicates the maximum number of transmission
attempts on frame sizes less than or equal to the RTS Threshold. Therangeis
1-255.

Long Retries

Thevalue in this field indicates the maximum number of transmission
attempts on frame sizes greater than the RTS Threshold. The rangeis 1-255.
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Configuring SSID Settings

The SSID tab displaysthe virtual access point (V1AP) settings associated with the default AP
profile. Each VAP has an associated network, which isidentified by its network number and
Service Set Identifier (SSID). You can configure and enable up to 8 VAPs per radio on each
physical access point.

Figure 39. VAP Settings
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VAPs segment the wireless LAN into multiple broadcast domains that are the wireless
equivalent of Ethernet VLANS. To awireless client, each VAP appears to be a single physical
access point. However, since the VAPs use the same channel, there is no risk of RF
interference among the networks that are on asingle AP.

VAPs can help you maintain better control over broadcast and multicast traffic, which affects
network performance. You can also configure different security mechanisms for each VAP.

A VAPisa“physical” entity. Each VAP maps directly to aMAC address. A network isa
logical entity that you apply to a VAP. Networks are identified by a network number and an
associated SSID. The SSID does not need to be unique for each network. You can create and
modify a network in one place and apply the network to one or more VAP as needed. This
allows you to mix networks within different profiles without having to reconfigure everything.
When you edit a network configuration that is applied to more than one VAP, you edit it for
every VAP that uses the network.

Managing Virtual Access Point Configuration

The Default AP profile has one VAP enabled by default. The default VAP uses the Guest
Network SSID, and there is no security to prevent wireless clients from associating with the
VAP. To enable additional VAPs, select the check box next to the VAP. Once you enable a
VAP, you can select the network (SSID) to use from the drop-down menu. To change Network
settings, click Edit.
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The following table describes the fields on the SSID page.
Table 11. Default VAP Configuration

Field Description

Radio 1 You configure the VAPs for Radio 1 and Radio 2 separately. Select the radio
Radio 2 to configure the settings for before you enable the VAP,

Check Box This check box enables or disables the corresponding VAP on the radio.

When checked, the VAP is enabled. The SSID field on the pageis aso
enabled to allow network selection for the VAP,

NOTE: You cannot disable the default VAP, VAPO.

Networ k The drop-down menu lists the available networks that you can assign to the
VAP, You can configure up to 64 separate networks on the switch and apply
them across multiple radio and VAP interfaces. By default, eight networks
are pre-configured and applied in order to the VAPs on each radio.

To configure additional networks, click Advanced Configuration >

Networks.
Edit Click Edit to modify settings for the corresponding network.
When you click edit, the Wireless Network Configuration page appears.
VLAN Showsthe VLAN ID of the VAP. To change this setting, click Edit.
L3 Tunnd Shows whether L3 Tunneling is enabled on the VAP. To change this setting,
click Edit.

NOTE: When L3 tunneling is enabled the VLAN ID is not used. In fact, the
switch puts the management VLAN ID, if any, on the tunneled packets.

Hide SSID Shows whether the VAP broadcasts the SSID. If enabled, the SSID for this
network is not included in AP beacons. To change this setting, click Edit.

Security Shows the current security settings for the VAP. To change this setting, click
Edit.

Configuring the Default Network

Each network isidentified by its Service Set Identifier (SSID), which is an alphanumeric key
that identifiesawireless local area network. You can configure up to 64 different networks on
the D-Link Unified Switch. Each network can have a unique SSID, or you can configure
multiple networks with the same SSID.
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When you click Edit on the VAP page, the Wireless Network Configuration page appears, as
Figure 40 shows.

Figure40. Configuring Network Settings
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Table 12 describes the fields on the Wireless Network Configuration page. After you change
the wireless network settings, click Submit to save the changes.

Table 12. Wireless Network Configuration

Field Description

SSID Wireless clients identify awireless network by the SSID, which isan
aphanumeric key that uniquely identifies awirelesslocal areanetwork. The
SSID can be up to thirty-two charactersin length, and there are no
restrictions on the characters that may be used in an SSID.

Hide SSID You can hide the SSID broadcast to discourage stations from automatically
discovering your access point. When the broadcast SSID of the AP ishidden,
the network nameis not displayed in the list of available networks on aclient
station. Instead, the client must have the exact network name configured in
the supplicant beforeit is able to connect.

Disabling the broadcast SSID is sufficient to prevent clients from
accidentally connecting to your network, but it will not prevent even the
simplest of attempts by a hacker to connect, or monitor unencrypted traffic.

This offers avery minimal level of protection on an otherwise exposed
network (such as a guest network) where the priority is making it easy for
clients to get a connection and where no sensitive information is available.
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Table 12. Wireless Network Configuration

Field

Description

VLAN

A virtual LAN (VLAN) is a software-based, logical grouping of deviceson a
network that allow them to act asif they are connected to a single physical
network, even though they may not be. The nodesin aVVLAN share
resources and bandwidth, and areisolated on that network.

The D-Link Unified Access System supports the configuration of awireless
VLAN. You can configure each VAP to be on aunique VLAN or on the same
VLAN as other VAPs.

When awireless client connects to the AP by using this network (SSID), the
AP tags the client’s traffic with the VLAN ID you configurein thisfield. By
default, all networksuse VLAN 1, which is also untagged by defauilt.

NOTE: The VLAN ID you configure in thisfield can be overwritten by the
VLAN ID configured for the AP in the RADIUS server. In other words, if
your network usesaRADIUS server to assign wireless clientsto VLANS, the
wireless client usesthe VLAN ID from the RADIUS server and ignores the
VLAN ID configured on the VAP,

L3 Tunnel

The L3 Tunnel feature allows mobile stations to maintain their IP
connections while roaming from one access point to another access point
even when these access points are attached to different | P subnets.

NOTE: When L3 tunneling is enabled the VLAN ID isnot used. In fact, the
switch puts the management VLAN ID, if any, on the tunneled packets.

NOTE: If the wireless network topology changes (for example, a
DWS-3000 switch reboots) while the L3 tunneling feature isin use, you
should perform an ARP refresh on wired clients to speed up the process of
re-establishing connectivity to the tunneled network.

Before you enable this feature, make sure your network meets the design
requirements described in “Network Planning to Support Layer 3 Roaming”
on page 37.

For more information about the L3 Roaming network, see “ Configuring a
VAP for L3 Tunnels’ on page 99.

L3 Tunnel Satus

Thisfield shows the status of L3 Tunneling. In order for tunnel to be
completely configured, routing must be enabled and the switch must have a
routing interface | P address that is in the tunnel subnet. The the status can be
one of the following:

e None (L3 Tunnel is disabled or the network is not associated with any
AP profiles)

e Configured

*  Not Configured - Routing Disabled

*  Not Configured - No Routing Interface

L3 Tunnel Subnet

The network | P address you enter in thisfield must bein the same subnet asa
routing interface for the WLAN that you define on the switch.

L3 Tunnel Mask

Enter the subnet mask for the network |P address on the L3 Tunnel subnet.
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Table 12. Wireless Network Configuration

Field

Description

MAC
Authentication

If you enable MAC authentication, wireless clients must be authenticated by
the AP in order to connect to the network. You must configure the MAC
addresses of the clientsto accept or deny (based on the default action you set
in the AP profile) in one of the following databases:

e Local
< RADIUS
RADIUSIP If you use aRADIUS server to authenticate wireless clients, you can use the
Address same RADIUS server that you configure on the AAA/RADIUS tab for the
profile, or you can specify a different RADIUS server.
To specify a RADIUS server for this VAP, clear the Use Profile check box
and enter the IP address of the RADIUS server in thefield.
RADIUS Secret To enter a RADIUS secret, select the Edit check box and type the secret in
thefield.
RADIUS Select the RADIUS Accounting check box to enable accounting for wireless
Accounting clients on the specified RADIUS server.
Security The default AP profile does not use any security mechanism by default. In

order to protect your network, we strongly recommend that you select a
security mechanism so that unauthorized wireless clients cannot gain access
to your network.

The following WLAN network security options are available:

¢ None
« WEP
« WPA/WPA2

If you select WEP or WPA/WPA2 as your security mechanism, adialogue
box asksif you want to change network security. After you click OK,
additional fields appear, and any network settings that you modified are
applied to the switch.

“Configuring AP Security” on page 101 describes the security mechanisms
and the additional fields you can configure if you select WEP or
WPA/WPA2.

D-Link's Adaptable Wireless technology provides you with the choice to associate a wireless
network (SSID) withaVLAN or atunneled subnet. To associate an SSID with aVLAN, enter
aVLAN ID inthe VLAN field. To associate an SSID with a tunneled subnet, enable L3
Tunnel and complete the L3 Tunnel Subnet and L3 Tunnel Mask fields.

The Adaptable Wireless technol ogy offers maximized flexibility. The wireless application can
determine how traffic is handled. For example, guest traffic can be tunneled to the switch for
centralized security control, and Vol P traffic can be tagged with aVLAN ID and forwarded
directly from the access point for optimal performance.
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Enabling and Configuring Additional VAPs

When awireless client searches for avail able wireless networks, each VAP you enable on the
VAP tab appears as a separate network to the wireless client. Figure 41 shows an example of
an AP Profile with five VAPs enabled. Each VAP uses a different network.

Figure4l. AP Profile With Five VAPs Enabled

AP Profile 1-Default
®1-802.11a O2-802.11g

SSID VLAN L3 Tunnel Hide SSID Securi

Guest Metwark . 1-Default Dizabled Dizabled Mane
Engineering hd 1-Default Disabled Disabled YWPRA Enterprise
QA Test v 1-Default Disabled Disabled WA Enterprise
Human Resources % 1-Default Dizabled Dizabled WA Enterprize
Marketing v 1-Default Disabled Disabled YWPA Personal
[] Managed S5ID B 1-Default Disabled Disabled Mone

[] Managed S5ID 7 1-Default Disabled Disabled MNone

[] Managed 551D 8 1-Default Disabled Disabled MNone

[ Refresh | [ Submit | [ Mext |

Figure 42 shows what a user on a Microsoft Windows XP client sees when the user searches
for wireless networks within range.

Figure 42. Networks Availableto the Wireless Client

r -
57 Wireless Metwork Connection |Z|
Network Tasks
g. Refresh network list Click an item in the list below to conmect o a wireless network in range or o get more

information.

<2 Set up a wireless netwark
for & home or small office

ankt b connect to this

Related Tasks

j‘) Learn about wireless

networking
Change the order of : Marketing
preferred networks (‘i})
@3 Change advanced ‘r‘ Security-enabled wireless network (WPA) lll!!
settings ((ﬁ)) QA Test
"_r‘: Security-enabled wireless network (WPA) III!!

({i}) Human Resources

({?}) Guest Network

‘r‘ Security-enabled wireless network (WPA) lll!!

~n B

Lo

Although the wireless client finds five different wireless networks, these networks are all on
the same access point. The D-Link Access Point 1ooks like five separate access points to the
wireless client.
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In this example, the administrator configured multiple VAPs based on different functional
groups within the company. Each VAP has a different SSID, security settings, and VLAN 1D
to separate traffic.

You can associate the same network (SSID) with multiple VAPs. When you do this, the VAPs
look like the same network to wireless clients. Some administrators configure VAPs with
identical settings on each radio so that wireless clients can connect to the same network
whether their wireless adapters are 802.11a or 802.11b/g compatible.

By default, both radios have the same networks assigned to the VAPs, and only VAPO is
enabled. You must configure each radio independently. In other words, if you enable
additional VAPs on oneradio, it does not affect the VAPs on the second radio.

Configuring a VAP for L3 Tunnels

This section provides an overview of the L3 Tunneling feature. For a detailed configuration
example of a network that uses L3 roaming, see Appendix C, “L3 Roaming Example” on
page 215.

The L3 Tunnel feature allows mobile stations to maintain their P connections while roaming
from one access point to another access point even when these access points are attached to
different P subnets. Thisfeature is especially useful for environments that use wireless Voice
over |P (VolP) on the 802.11 networks with multiple subnets.

“Configuring QoS’ on page 159" Configuring QoS’ on page 163.

If you enable L3 tunnels, we recommend that you enable and configure a separate VAP for
clients that need to use this feature. Configure clients that need L3 Tunneling to connect to the
SSID with L3 tunnels enabled, but configure all other wireless clients to use the VAP with L3
tunnels disabled.
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In general, only clients that transmit and receive time-sensitive data while roaming need to
take advantage of thisfeature. Figure 43 shows a network with two APs that are controlled by
aD-Link Unified Switch. The APs and switch are all on different subnets.

Figure43. L3 Roaming Example

100

Associated With:
AP1

SSID: VolP Network

IP: 192.168.100.51

3 AP1
@) 3 VAPs

SSID - Guest Network Unified Switch
SSID - Company WLAN

SSID - VoIP Network ’

3 3 VAPs:
SSID - Guest Network
SSID - Company WLAN
SSID - VolP Network

Associated With:
AP1

SSID: Company WLAN
IP: 192.168.20.20

Associated With:
AP2

SSID: Guest Network
IP: 192.168.30.11

Associated With:
AP2

SSID: VoIP Network
IP: 192.168.100.52

Both of the APsin Figure 43 use the same default profile. The default profile has three virtual
access points (VAPs) enabled, and each VAP uses a different network (SSID). When users
search for available wireless networks, all three SSIDs appear in the list of networks. The
laptop clients connect to the Company WLAN or Guest Network, and the Vol P phones
connect to the Vol P Network.

The L3 Tunnel feature is enabled on the Vol P network, but it is disabled on the Guest and
Company WLAN networks since those networks are primarily for data traffic. The Vol P
network isfor voice traffic. L3 Roaming uses | P tunneling so clients appear to be on the same
subnet even though the APs are on different subnets.

In the sample network that Figure 43 shows, the laptop users are connected to different WLAN
networks on two different APs. The Internet phone users are connected to the same WLAN
network on two different APs. On the Vol P Network, the phone users can seemlessly roam
between AP1 and AP2 without service interruption or the need to re-authenticate or change
networks.

The Unified Switch usesa VLAN routing interface as a separate logical network configured
for the L3 tunnel network. This network isthe L3 tunneling subnet and has a network address
of 192.168.100.0.

Tunneling is not expected to work with port-based routing interfaces. All tunneled routing
interfaces must be VLAN routing interfaces. APs should not be attached via port-based
routing interfaces as well.
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If the wireless network topology changes (for example, a DWS-3000 switch reboots) while the
L 3 tunneling feature isin use, you should perform an ARP refresh on wired clientsto speed up
the process of re-establishing connectivity to the tunneled network.

For information about how to configure a network to use L3 tunneling, including CLI
commands and Web configuration procedures, see Appendix C, “L3 Roaming Example” on
page 215.

Configuring AP Security

The Default AP profile does not use any security mechanism by default. In order to protect
your network, we strongly recommend that you select a security mechanism so that
unauthorized wireless clients cannot gain access to your network.

From the Wireless Networ k Configuration page, you can select None, WEP or WPA/WPA2
asthe WLAN security mechanisms, as Figure 44 shows. The default is None.

Figure44. AP Network Security Options

Security @ pNone OWEP OWPAMPAZ

The following sections describe the security mechanicians.

Using No Security

If you select None as your security mode, no further options are configurable on the AP. This
mode means that any data transferred between the D-Link Access Point and the associated
wireless clientsis not encrypted, and any wireless client can associate with the AP,

This security mode can be useful during initial network configuration or for problem solving,
but it is not recommended for regular use on the internal network because it is not secure.

Using Static or Dynamic WEP

Wired Equivalent Privacy (WEP) isadataencryption protocol for 802.11 wireless networks. I
you select this security mechanism, all wireless clients and access points on the network are
configured with a 64-bit (40-bit secret key + 24-bit initialization vector (1V)), 128-bit (104-bit
secret key + 24-bit V), or 152-bit (128-bit secret key + 24-bit V) Shared Key for data
encryption.

Static WEP is not the most secure mode available, but it offers more protection than setting the
security mode to None asit does prevent an outsider from easily sniffing out unencrypted
wireless traffic.

Dynamic WEP is more secure than Static WEP, but you need a RADIUS server to manage the
dynamically generated keys.

WEP encrypts data moving across the wirel ess network based on a static key. (The encryption
algorithmisa*stream” cipher called RC4.)

Configuring SSID Settings 101



D-Link Unified Access System User Manual

If you select WEP as the Security Mode, additional fields display, as Figure 45 shows.

Figure45. Static WEP Configuration

102

Security O Mane ®WEP OWPANMPAZ
® Static WEP O WEP IEEES0Z. 1x
Authentication [ open Systern [ Shared Key
WEP Key Type ®@ascl OHEx
WEP Key Length (bits) 5igs O128 O152
WEP Keys Tx
® 1 ;éhcde
O 2 [fghij
O3 ;.R.Imno
© 4 parst

Table 13 describes the configuration options for WEP.
Table 13. Static WEP

Field Description

Satic WEP or Static WEP uses static key management. You manually configure the same

WEP IEEE 802.1X keysto encrypt data on both the wireless client and the AP. Dynamic WEP
(WEP IEEE 802.1X) uses dynamically generated keys to encrypt client-to-
AP traffic. Dynamic WEP is more secure than Static WEP, but you need a
RADIUS server to manage the keys.

If you select WEP IEEE 802.1X, the screen refreshes, and there are no more
fields to configure. The AP uses the global RADIUS server | P address and

secret or the RADIUS server settings you specify for the VAP. The AP acts as
the RADIUS client and must be configured asaclient in the RADIUS server

For information about how to configure the global RADIUS server settings
on the Unified Switch, see “Configuring AAA and RADIUS Settings’ on

page 85.

Authentication Choose the authentication type:

¢ Open System—No authentication is performed

¢ Shared Key—Provides arudimentary form of user authentication,
which many experts consider to be less secure than Open System sinceit
sends the WEP key to the client in plain text.

¢ Both—Only WEP clients are authenticated.

WEP Key Type Select the key type by clicking one of the radio buttons:

¢ ASCII—Includes upper and lower case a phabetic letters, the numeric
digits, and specia symbols such as @ and #. Spaces are not permitted.
¢ Hex—Includesdigits0to 9 and the letters A to F.
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Table 13. Static WEP

Field Description

WEP Key Length Specify the length of the key by clicking one of the radio buttons:
e 64 bits
e 128 bits
e 152 bits

Tx The Transfer Key Index indicates which WEP key the access point uses to
encrypt the datait transmits. To select atransfer key, click the button located
between the key number and the field where you enter the key. In Figure 45,
the transfer key is 3.

WEP Keys You can specify up to four WEP keys. In each text box, enter a string of

characters for each key. These are the RC4 WEP keys shared with the
stations using the access point.

Use the same number of characters for each key. The number of keysyou
enter depends on the Key Type and Key Length. Thefollowing list showsthe
number of keysto enter in the field:

e 64 bit—ASCII: 5 characters; Hex: 10 characters

e 128 bit—ASCII: 13 characters; Hex: 26 characters

e 152 bit—ASCII: 16 characters;, Hex: 32 characters

Each client station must be configured to use one of these same WEP keysin
the same dlot as specified here on the AP.

Static WEP Rules

If you use Static WER, the following rules apply:

All client stations must have the Wireless LAN (WLAN) security set to WEP and all
clients must have one of the WEP keys specified on the AP in order to de-code AP-to-
station data transmissions.

The AP must have all keysused by clientsfor station-to-AP transmit so that it can de-code
the station transmissions.

The same key must occupy the same slot on all nodes (AP and clients). For example if the
AP definesabc12 key as WEP key 3, then the client stations must define that same string
as WEP key 3.

Client stations can use different keys to transmit data to the access point. (Or they can all
use the same key, but thisis less secure because it means one station can decrypt the data
being sent by another.)

On some wireless client software, you can configure multiple WEP keys and define a
client station “transfer key index”, and then set the stations to encrypt the data they
transmit using different keys. This ensures that neighboring APs cannot decode each
other’s transmissions.

You cannot mix 64-bit, 128-bit, and 152-bit WEP keys between the access point and its
client stations.

Using WPA/WPAZ2 Personal or Enterprise

WPA and WPA2 are Wi-Fi Alliance | EEE 802.11i standards, which include AES-CCMP and
TKIP mechanisms. The WPA/WPA2 Personal employs a pre-shared key to perform aninitial
check of credentials. The WAP/WPA2 Enterprise uses a RADIUS server to authenticate users.
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If you select WPA/WPA?2 as the security mode, additional fields display, as Figure 46 shows.

Figure 46. WPA Personal Configuration

104

WPA Key Type ASCI

Passphrase

Security ONone OWEP @WPAMPAZ
@WPA Personal OWPA Enterprise

WPA Versions [FIWEA FIWPAZ
WPA Ciphers MTKIP COCCMP{AES)

Table 14 describes the configuration options for the Static WPA security mode.

Table 14. Static WPA

Field

Description

WPA Personal or
WPA Enterprise

WPA/WPA 2 Personal uses static key management. You manually configure
the same keys to encrypt data on both the wireless client and the AP,
WPA/WPA2 Enterprise uses aRADIUS server and dynamically generated
keysto encrypt client-to-AP traffic. WPA Enterprise is more secure than
WPA Personal, but you need a RADIUS server to manage the keys.

If you select WPA Enterprise, the screen refreshes and a different set of
fields appear (described later in thistable). The AP usesthe global RADIUS
server | P address and secret or the RADIUS server settings you specify for
the VAP. The AP acts as the RADIUS client and must be configured as a
client in the RADIUS server.

For information about how to configure the global RADIUS server settings
on the Unified Switch, see “Configuring AAA and RADIUS Settings” on

page 85.

WPA Versions

Select the types of client stations you want to support:

«  WHPA. If dl client stations on the network support the original WPA but
none support the newer WPA2, then select WPA.

< WPA2. If dl client stations on the network support WPA 2, we suggest
using WPA 2 which provides the best security per the IEEE 802.11i
standard.

«  WPA and WPA2. If you have amix of clients, some of which support
WPA2 and others which support only the original WPA, select both of
the boxes. This lets both WPA and WPA2 client stations associate and
authenticate, but uses the more robust WPA2 for clients who support it.
ThisWPA configuration allows more interoperability, at the expense of
some security.
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Table 14. Static WPA

Field Description
WPA Ciphers Select the cipher suite you want to use:
« TKIP

« CCMP(AES

« TKIPand CCMP (AES)

Both TKIP and AES clients can associate with the access point. WPA
clients must have one of the following to be able to associate with the AP:

«  Avdid TKIPkey
+  Avaid AES-CCMP key

WPA Key Type Select the key type by clicking one of the radio buttons:

e ASCII—Includes upper and lower case al phabetic letters, the numeric
digits, and special symbols such as @ and #. Spaces are not permitted.
¢ Hex—Includes digits 0 to 9 and the letters A to F.

Passphrase The WPA Key isthe shared secret key for WPA Personal. Enter a string of
at least 8 characters to a maximum of 63 characters.

Pre-Authentication If you select WPA/WAP2 Enterprise, you can enable Pre-Authentication.

Click the Pre-Authentication check box if you want WPA2 wireless clients
to send pre-authentication packets. The pre-authentication information is
relayed from the access point the client is currently using to the target
access point.

Enabling this feature can help speed up authentication for roaming clients
who connect to multiple access points. Only clients that connect by using
WPA2 can use thisfeature. It is not supported by the original WPA.

Pre-Authentication Enter the number of pre-authentications that can be in progress

Limit simultaneously on an AP. The limit preventstoo much load on the RADIUS
server. This does not prevent the pre-authentication from being attempted
again when the load is lighter. A value of O represents no limit.

NOTE: Thisfield isonly available if you access the network through the
AP Profile or Network page under Advanced Configuration.

Key Forwarding Select the check box to allow APsto forward the Pairwise Master Key
(PMK) for the wireless client to other APsin case the client roamsto
another AP.

NOTE: Thisfield isonly available if you access the network through the
AP Profile or Network page under Advanced Configuration.

Key Caching Hold Enter the amount of minutes a PMK will be held by the AP. This appliesto

Time PMK s generated by RADIUS, those that come from pre-authentication, and
those that are forwarded to the AP. Note that this time limit can be
overridden by RADIUS if the RADIUS server returns alonger timein the
Session-Timeout attribute for a particular user. The valid values of this are
from 1-1440 minutes.

NOTE: Thisfield isonly available if you access the network through the
AP Profile or Network page under Advanced Configuration.
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Configuring Valid Access Point Settings

You can add an AP into thelist of Valid APs from the Administration > Basic Setup > Valid
AP tab, as Figure 47 shows, or you can add an AP from the AP Authentication Failures or
Rogue AP/RF Scan lists.

From the Valid AP page, you can manually set the channel and RF signal transmit power level
for an individual AP. You can aso configure the AP mode and local authentication password,
and you can specify which profile the AP uses.

Figure47. Adding aValid AP

106

| Global | Discovery | AAA/RADIUS | Radio | ssID | ‘

Valid Access Point Summary .

MAC Address Location Managed Mode Profile
[]00:11:95:A3:78:30 Lab1 WS Managed 1-Default
[100:11:95:A3:78:40 Lab2 WS Managed 1-Default

00:00:00-00-00-00

Delete All_| [ Refresh

After you enter the MAC address of the AP to add to the lit, click Add to add the AP to the
database and to access the configuration page for the AP. For an AP that isalready in the
database, click the MAC address of the AP to access its configuration page.

Table 15. Valid Access Point Summary

Field Description

MAC Address Enter the MAC address of the AP in this field. When you add the MAC
address, you add the AP to the local database on the switch.

Managed Mode Thisfield displays the current mode of the AP. You can configure the mode
on the Valid Access Point Configuration page, which you access by clicking
the MAC address of the AP,

Profile Thisfield displays the AP profile assigned to the AP,

If you have multiple AP profiles, you can assign anew profileto an AP from
the summary page. Select the check box next to one or more APs, then select
the new profile from the drop-down menu. Click Change Profile to apply
the profile to the selected APs.

If you use the local database for AP validation, the switch maintains the database of access

points that you validate. When you add the MAC address of an AP to the database, you can
specify whether the AP isaManaged AP, Standalone AP, or Acknowledged Rogue and assign
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an AP profile to the device. When the switch collects and reports information from the RF
scan, it can assign the appropriate status to an AP if it isin the database.

Figure48. Configuring a Valid AP

| Global | Discovery | AAA/RADIUS | Radio | ssiD | |

Valid Access Point Configuration

[ Delete H Refresh ” Submit ] [Back]

MAC Address (001195 A3 7830 [+

Managed Mode | WS Managed . V

Location |Engineermg

Authentication Password |................. Ea

Profile 1 - Default ;'v"

802.11a radio Channel _.Aum v Power (%) 0
802.11g radio Channel Auto v Power (%) 0

Table 16 describes the fields available on the Valid Access Point Configuration page.

Table 16. Valid AP Configuration

Field Description

MAC Address

Thisfield shows the MAC address of the AP. To change this field, you must

delete the entire Vaid AP configuration and then enter the correct MAC
address from the page that lists all Valid APs.

Managed Mode

You can configure the D-Link Access Point to be in one of three modes.

¢ Sandalone—The AP acts as an individual access point in the network.
You do not manage the AP by using the switch. Instead, you log on to
the AP itself and manage it by using the Administrator Web User

Interface (UI) or CLI.

¢ WS Managed—The AP is part of the D-Link Unified Access System,
and you manage it by using the D-Link Unified Switch. If an APisin
Managed Mode, the Administrator Web Ul on the AP are disabled.

¢ Acknowledged Rogue—The AP has been discovered by the switch and
acknowledge asaRogue. ThisAPisnot aD-Link Access Point. You can
add an Acknowledged Rogue to the Valid AP list to prevent the Rogue
from being identified as a threat.

L ocation
32 alphanumeric characters.

To help you identify the AP, you can enter alocation. Thisfield accepts up to

Authentication

You can require the AP to authenticate itself with the switch upon discovery.

Passwor d If you require authentication, which is a setting on the Basic Setup > Global
tab, you enter the password in thisfield. The password in this field must
match the password configured on the AP,

Profile If you configure multiple AP Profiles, you can select the profile to assign to

this AP. For more information about configuring AP Profiles, see“ Creating,
Configuring, and Managing AP Profiles’ on page 155.
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Table 16. Valid AP Configuration

Field

Description

Channd

The Channel defines the portion of the radio spectrum that the radio uses for
transmitting and receiving. Therange of channels and the default channel are
determined by the Mode of the radio interface and the country in which the
APs operate.

In the United States, |EEE 802.11b/802.11g modes (802.11 b/g) support use
of channels 1 through 11 inclusive, while |EEE 802.11a mode supports a
larger set of non-consecutive channels (36,40,44, 48, 52, 56, 60, 64, 149,
153, 157, 161, 165).

Interference can occur when multiple access points within range of each
other are broadcasting on the same or overlapping channels. The impact of
this interference on network performance can intensify during busy times
when alarge amount of data and mediatraffic is competing for bandwidth.

If you select auto, the AP scansthe RF areafor occupied channels and selects
achannel from the available non-interfering, or clear channels. The AP
selects the best channel whenever its radio or radios restart.

If you specify a channel, make sure that the channel does not interfere with
the channel that neighbor APs use.

NOTE: The channel you set for an AP in the valid AP database is fixed and
takes precedence over initial channel selection done by the AP and any
automatic channel planning done by the switch.

NOTE: For radios that use 802.11a mode, some countries have a regul atory
domain that requires radar detection. For these countries (based on the
country code setting), the radio automatically uses the 802.11h protocol for
selecting the channel if radar is detected on the statically assigned channel.

Power

The power level affects how far an AP broadcastsits RF signal. If the power
level istoo low, wireless clients will not detect the signal or experience poor
WLAN performance. If the power level istoo high, the RF signal might
interfere with other APs within range.

The default value of 0 indicatesthat the AP usesthe power level setinthe AP
profile.

NOTE: The power level you set for an AP in the valid AP database is fixed
and takes precedence over any automatic power adjustments done by the AP
or the switch.
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Managing and Maintaining D-Link
Access Points

This chapter contains the following sections to help you manage and maintain the D-Link
Access Points on your D-Link Unified Access System network:

* Resetting the Access Points

» Managing Radio Frequency Settings

*  Upgrading the Access Point Software

» Performing Advanced Access Point Management

For information about the commands you use to manage and maintain the APs by using the
CLI, seethe D-Link CLI Command Reference.

Resetting the Access Points

You can manually reset one or al APs from the D-Link Unified Switch. When you issue the
command to reset an AP, the AP closes the SSL connection to the switch before resetting the
hardware.

To reset one or more APs, click AP Management > Reset.

Figure 49. Access Point Reset

| Managed AP Reset

MAC Address Location IP Address Status Reset Status
00:01:01:02:01:01 TestLab 192.168.0.1 Ianaged Mot Started
[00:01:01:02:02:01 Devlab 192 16802 IWanaged Mot Started
[000:01:01:02:03:01 Eng 192 16803 Managed Mot Started

[ Feset ][ FesetAll ][ Fefresh ]

Select the APs you want to reset and click Reset, or click Reset All to reset al of the APs
managed by the switch.
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The APs might take several minutes to reset and re-establish communication with the switch.
While the AP is resetting, the status changes to failed, and then back to managed once the AP
is back online.

Managing Radio Frequency Settings

The radio frequency (RF) broadcast channel defines the portion of the radio spectrum that the
radio on the access point uses for transmitting and receiving. The range of available channels
for an access point is determined by the IEEE 802.11 mode (also referred to as band) of the
access point.

The DWL-3500AP is asingle-band system that operatesin 802.11g mode, and the DWL-
8500AP is adual-band system that operatesin 802.11a and 802.11g modes. |EEE 802.11b and
802.11g modes (802.11 b/g) operate in the 2.4 GHz RF frequency and support use of channels
1 through 11. IEEE 802.11a mode operatesin the 5 GHz frequency and supports alarger set of
non-consecutive channels (36,40,44, 48, 52, 56, 60, 64, 149, 153, 157, 161, 165).

NOTE: The availabl e channels depends on the country in which the APs operate. The
channels described in this section are valid for the United States.

Interference can occur when multiple access points within range of each other are
broadcasting on the same or overlapping channels. The impact of this interference on network
performance can intensify during busy times when alarge amount of data and mediatrafficis
competing for bandwidth. For the “b/g” radio band, the classical set of non-interfering
channelsis 1, 6, 11. Channels 1, 4, 8, 11 produce minimal overlap. A similar set of non-
interfering channelsis used for the“ &’ radio band, which includes all channels for that mode
since they are not overlapping.

Configuring Channel Plan and Power Settings

The D-Link Unified Switch software contains a channel plan algorithm that automatically
determines which RF channels each D-Link Access Point should use to minimize RF
interference. When you enabl e the channel plan algorithm, the switch periodically evaluates
the operational channel on every AP it manages and changesthe channel if the current channel
isnoisy.

NOTE: Theregulation of radio frequencies and channel assignments varies from
country to country. In countries that do not support channels 1, 6, and 11 on
the 802.11b/g radio, the channel plan agorithm isinactive. For the 802.11a
radio, the algorithm isinactive in countries that require 802.11h radar
detection, which includes European countries and Japan.

The automatic channel selection algorithm does not affect APs that meet any of the following
conditions:

» Thechannd is statically assigned to the AP in the RADIUS or local AP database.

» Thechannd has been statically assigned to the AP from the AP M anagement >
Advanced page.

» TheAPusesaprofile that has the Automatic Channel field disabled (Radio Configuration
Setting).
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Additionally, radios configured to use Super A or Super G cannot use the channel plan
agorithm.

NOTE: If the AP isnot assigned afixed channel or is not assigned a specific channel
by the automatic channel selection algorithm, the AP channel selection mode
is set to “best.” This meansthat the AP selects the “best” channel whenever
the radio restarts or if the AP detects aradar signal.

The RF transmission power level affects how far an AP broadcastsits signal. If the power
level istoo low, wireless clients will not detect the signal or experience poor WLAN
performance. If the power level istoo high, the RF signal might interfere with other APs
within range or broadcast the signal beyond the desired physical boundaries, which can create

a security risk.

Automatic power uses a proprietary algorithm to automatically adjust the RF signal to
broadcast far enough to reach wireless clients, but not so far that it interferes with RF signals

broadcast by other APs.

To configure Channel Plan and Power Adjustment settings, click AP Management > RF
M anagement.

Figure50. RF Channel Plan and Power Configuration

I Channel Plan Historyl Manual Channel Planl Manual Power Adjuatment3|
RF Configuration
Channel Plan ®380211a ©O802.11bfg
Channel Plan Mode OFixed Time @ Manual O Interval
Channel Plan History Depth 5 [toto 10)
Channel Plan Interval (hours) |6 {6 to 24)
Channel Plan Fixed Time (hh:mm) IO : IO
Power Adjustment Mode @Manual Olnterval
Power Adjustment Interval (minutes) |15 {15 to 1440)

Table 17 describes the RF Channel Plan and Power Adjustment fields you can configure.

NOTE: When the AP changes its channel, all associated wireless clients temporarily
lose their connection to the AP and must re-associate. The re-association can
take severa seconds, which can affect time-sensitive traffic such as voice and

video.
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Table 17. RF Channel Plan and Power Adjustment

Field

Description

Channd Plan

Before you configure channel plan settings, select the mode to configure.

Channd Plan
Mode

Thisfield indicates the channel assignment mode. The mode of channel plan
assignment can be one of the following:

¢ Fixed Time—If you select the fixed time channel plan mode, you
specify the time for the channel plan and channel assignment. In this
mode the plan is applied once every 24 hours at the specified time.

¢ Manual—With the manual channel plan mode, you control and initiate
the calculation and assignment of the channel plan. You must manually
run the channel plan agorithm and apply the channel plan to the APs.

¢ Interval—Intheinterva channel plan mode, the switch periodically
calculates and applies the channel plan. You can configure the interval
to be from every 6 to every 24 hours. The interval period begins when
you click Submit.

Channd Plan
History Depth

The channel plan history liststhe channels the switch assigns each of the APs
it manages after a channel plan is applied. Entries are added to the history
regardless of interval, time, or channel plan mode.

The number you specify in this field controls the number of iterations of the
channel assignment.

NOTE: The APs changed in previous iterations cannot be assigned new
channelsin the next iteration. This history prevents the same APsfrom being
changed time after time. For example, if the history depthis set to 3, and an
access point changes its channel for iteration 1, then it will not change the
channel beforeiteration 5 of the channel adjustment algorithm (if needed).

Channd Plan
Interval

If you select the I nterval channel plan mode, you can specify the frequency
at which the channel plan calculation and assignment occurs. The interval
timeisin hours, and you can specify an interval that ranges between every 6
hoursto every 24 hours.

Channd Plan
Fixed Time

If you select the Fixed Time channel plan mode, you can specify the time at
which the channel plan calculation and assignment occurs. The channel plan
calculation will occur once every 24 hours at the time you specify.
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Table 17. RF Channel Plan and Power Adjustment

Field Description
Power Adjustment  You can set the power of the AP radio frequency transmission in the AP
Mode profile, the local database or in the RADIUS server. The power level inthe

AP profileis the default level for the AP, and the power will not be adjusted
below the value in the AP profile.

The settingsin the local database and RADIUS server always override power
set in the profile setting. If you manually set the power, the level isfixed and
the AP will not use the automatic power adjustment algorithm.

You can configure the power as a percentage of maximum power, where the
maximum power is the minimum of power level allowed for the channel by
the regulatory domain or the hardware capability.

¢ Manual—Inthismode, you run the proposed power adjustments
manually from the Manual Power Adjustments page.

¢ Interval—In this mode, the switch periodically calculates the power
adjustments and applies the power for all APs. Theinterval period
begins when you click Submit.

NOTE: If you set the power level inthelocal or RADIUS database, the
settings override the power level set in the AP profile.

For more information about manually setting the power level, see
“Configuring Wireless Radio Settings’ on page 87 and “Configuring Valid
Access Point Settings’ on page 106.

Power Adjustment
Interval

This field determines how often the switch runs the power adjustment
agorithm. The algorithm runs automatically only if you set the power
adjustment mode to I nterval.

Viewing the Channel Plan History

The D-Link Unified Switch stores channel assignment information for the APs it manages. To

access the Channel Plan History information, click the AP M anagement > RF Management
> Channel Plan History tab.

Figure51. Channel Plan History

Configuration |

Operational Status
Last leration
Last Algorithm Time

AP MAC Address
00:11:95:23:7h:a0

Channel Plan History

I Manual Channel Plan | Manual Power Adjustments |

®a0z11a COa802.11h/g

Active
2
JAN 01 02:25:22 1970

Location Radio Iteration Channel
Conference Room A& 1-802.11a 1 44
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Table 18 describes the Channel Plan History fields
Table 18. Channel Plan History

Field Description
802.11a The 802.11a and 802.119 radios use different channel plans, so the switch
802.11g tracks the channel history separately for each radio. The channel information

that displays on the page is only for the radio you select.

Operational Satus Thisfield shows whether the switch is using the automatic channel
adjustment algorithm on the D-Link Access Point radios.

Last Iteration The number in thisfield indicates the last iteration of channel plan
adjustments. The APs that received a channel adjustment in previous
iterations cannot be assigned new channelsin the next iteration to prevent the
same APs from being changed time after time.

On the AP Management > RF Management > Configuration tab, you can
set the history depth to control the maximum number of iterations stored and
displayed in the channel plan history.

Last Algorithm Shows the date and time when the channel plan algorithm last ran.

Time NOTE: To set the system time on the switch, you must use SNTP, which is
disabled by default. From the Web interface, you configure the SNTP client
and server information from the LAN > Administration > SNTP Settings
page. From the CL1, use the snt p commandsin Globa Config mode.

AP MAC Address  Thistable displays the channel assigned to an AP in an iteration of the
L ocation channel plan.

Radio

Iteration

Channd

Initiating Manual Channel Plan Assignments

If you specify Manual as the Channel Plan Mode on the Configuration tab, the M anual
Channel Plan page allows you to initiate the Channel Plan algorithm.

To manually run the channel plan adjustment feature, select the radio to update the channelson
(802.11aor 802.11g) and click the Sart button.

Figure52. Manual Channel Plan

114

T T
| Configuration | Channel Plan History | I Manual Power Adjustments |

®8a0z.11a O802.11h/g

Current Status Algorithm Complete
AP MAC Address Location Radio Current Channel New Channel
00:11:95:23:7h:a0 Conference Room & 1-802.11a 149 44

[ #pply | [ Clear | [ Refresh | [ Start |
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The Current Status of the plan shows one of the following states:

None—The channel plan algorithm has not been manually run since the last switch reboot.
Algorithm In Progress—The channel plan agorithm is running.

Algorithm Complete—The channel plan algorithm has finished running. A table displays
to indicate proposed channel assignments. Each entry shows the AP along with the current
and new channel. To accept the proposed channel change, click Apply. You must
manually apply the channel plan for the proposed assignments to be applied.

Apply In Progress—The switch is applying the proposed channel plan and adjusting the
channel on the APslisted in the table.

Apply Complete—The algorithm and channel adjustment are complete.

After the channel plan runs, atable shows any APs that the algorithm recommends for new
channel assignments. The current channel shows the current operating channel, and the new
channel shows the proposed channel. To apply the new channels, click Apply. If no APs
appear after the algorithm is complete, the algorithm does not recommend any channel
changes.

It is possible for the network configuration to change between the time the automatic channel
selection runs and the time you attempt to apply the proposed channel assignments.

The channel will fail to be applied to an AP if one of the following conditions exist:

The AP hasfailed.

The radio on the AP has been disabled through a profile update.

The channel is not valid for the radio mode.

The AP has been rebooted since the channel plan was computed and acquires a stetic
channel that has been set statically vialocal database.

The channel has been set manually through the advanced page.

The auto-channel mode has been disabled in the profile for this AP,

Initiating Manual Power Adjustments

If you select Manual as the Power Adjustment Mode on the Configuration tab, you can
manually initiate the power adjustment algorithm on the Manual Power Adjustments page.

Figure 53. Manual Power Adjustments

| Configuration | Channel Plan History | Manual Channel Plan | |

Manual Power Adjustments

Current Status Mone

No proj 1 power adj t entries exist.
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The Current Status of the plan shows one of the following states:

* None—The power adjustment algorithm has not been manually run since the last switch
reboot.

* Algorithm In Progress—The power adjustment algorithm is running.

* Algorithm Complete—The power adjustment al gorithm has finished running.

A table displays to indicate proposed power adjustments. Each entry shows the AP along
with the current and new power levels. To accept the proposed change, click Apply. You
must manually apply the power adjustment for the proposed assignments to be applied.

* Apply In Progress—The switch is adjusting the power levelsthat the APs use.
* Apply Complete—The algorithm and power adjustment are complete.

Upgrading the Access Point Software

The D-Link Unified Switch can upgrade software on the APs that it manages. To upgrade one
or more D-Link Access Point from the switch that manages it, click the WLAN > AP
M anagement > Softwar e Downloads tab.

Figure54. AP Upgrade

Wireless Software Download
Server Address 10 254 24 73

File Path [downloads/ap
File Name W
Group Size ’10— (1to 48)
Managed AP 'A_H

a It takes about 12 minutes for the upgrade process to complete for an AP. After that the AP will become
managed again.

NOTE: The APs automatically reset after the code is successfully downloaded.

Table 19 describes the fields you must complete to upgrade D-Link Access Points.
Table 19. AP Upgrade

Field Description

Server Address Enter the IP address of the host where the upgrade file is located. The host
must have a TFTP server installed and running.

File Path Enter the path to the directory where the upgrade file islocated. You may

enter up to 96 characters.
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Field

Description

File Name

Enter the name of the upgrade file. You may enter up to 32 characters, and
the file extension “.tar” must be included.

Group Size

When you upgrade multiple APs, each AP contacts the TFTP server to
download the upgrade file. To prevent the TFTP server from being
overloaded, you can limit the number of APsto be upgraded at atime.

In the Group Size field, enter the number of APs that can be upgraded at the
same time. When one group compl etes the upgrade, the next group begins
the process.

Managed AP

The combination box lists the APs that the switch manages. Each AP is
identified by its MAC address and location (if specified). To upgrade one or
more APs, select the AP MAC address from the list. To upgrade al APs,
select “All” from the top of the list. The Group Size field limits the number
of simultaneous AP upgradesin order not to overwhelm the TFTP server.

NOTE: Werecommend that you upgrade all managed APs at the same time.

After you provide the information about the upgrade file, click Sart to begin the upgrade
process. Additiona fields appear to provide information about upgrade status and success.

The software download could be aborted while the code transfer isin progress for any AP only
during the time the Abort button is displayed. It still completes the download from the TFTP
server, but does not update its NVRAM. Once the NVRAM update begins for all APs
involved, the Abort button disappears. An activity/progress bar is displayed during the
upgrade. The activity bar is no longer displayed once the upgrade process is complete, that is,
the AP is up and running and managed.

Figure55. AP Upgrade Satus.

Server Address
File Path

File Name
Group Size
Managed AP

Managed AP
00:11:95:A3:78:40

Wireless Software Download

10.254.24 B8 | Download Status In Progress
|dawnloads/ap | Download Count 1
DL20061128“1.tar [ Successful Download Count a

[10 .'-:-(1 to 48) . Failure Count 0

All b

Location Status Software Version
Diownloading 011.281
Note: R takes about 12 minutes for the upgrade process to complate for 3k AP. After that the AP will become managed aqgain.
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Table 20 describes the fields that appear after you start the AP upgrade process.
Table 20. AP Upgrade Satus

Field Description

Download Satus Thisfield shows the status of the upgrade process for al APs:

* Not Started—The Unified Switch has not started the download process.

¢ Reguested—A request to download AP software has been made, but the
switch has not done any downl oads.

¢ InProgress—The APis currently attempting to download software from
the server.

¢ Success—Download completed successfully on al APs. An AP reports
asuccessful download to the switch after the software transfers from the
TFTP server to the AP and the code checksum is good. The code must
also match the intended hardware platform.

e Failure—Download failed on al APs. A software download failsif the
AP reports a software download failure due to an inability to contact the
TFTP server or find the upgradefile, or if the AP loses connectivity with
the switch.

Download Count The number in this field shows the number of managed APs to download
softwarein the current download request. If you selected All for the managed
APs to upgrade, the download count shows the number of managed APs at
the time the download request was started. The valueis 1 if only one APis
being updated.

Success Count The number in this field shows the number of APs that have successfully
downloaded the new code. This value starts with O at the beginning of the
download and increases by one for every AP that successfully downloaded
the code.

Failure Count The number in this field shows the number of APsthat failed to download
the new code. This value starts with O at the beginning of the download and
increases by one for every AP that failed to downloaded the code.

A table also appears and lists each AP, its download status, and the software version it is
downloading. The status for an individual AP can have one of the following values:

* Reguested—Download has been requested for this AP.

»  Success—The AP reported successful code download.

» Fallure—The AP reported afailed code download.

» Code Transfer In Progress—The code download to the AP isin progress.

*  NVRAM Update In Progress—The AP NVRAM is being updated.

»  Waiting for APs to Download—The code transfer is complete, but the AP iswaiting for
the remaining APs to finish downloading and then it will start updating its NVRAM.

»  Aborted—The upgrade of the AP was aborted.
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Performing Advanced Access Point Management

When the D-Link Access Point isin Managed mode, remote access to the AP is disabled.
However, you can enable Telnet access by enabling the Debug feature on the AP
Management > Advanced page. From the Advanced page, you can a so manually changethe
RF channel and power for each radio on an AP.

Figure 56. Advanced AP Management

MAC Address
00:01:01:02:01:01

00:01:01:02:02:01

00:01:01:02:03:01

Location Debug Radio Channel Power (%

TestLab Disahled 1-802.11a ] ]
2-802.11g ] ]

Devlah Disabled 1-802.113 ] ]
2-802.11g ] ]

Eng Disabled 1-802.113 ] ]
2-802.11g ] ]

Each AP managed by the D-Link Unified Switchislisted by its MAC address and location.
The location is based on the value in the RADIUS or local Valid AP database. Table 21
describes the Advanced features you can configure for the AP.

Table 21. Advanced AP Management

Field

Description

Debug

To help you troubleshoot, you can enable Telnet access to the AP so that you
can debug the device from the CLI.

The Debug field shows the debug status and can be one of the following:

+ Disabled

e Set Requested

e SetinProgress

e Enabled

To change the status, click the Debug status link. The Managed AP Debug
page appears. Table 22 describes the fields on the new page.

Channd

Click the Channél link to access the Managed AP Channel/Power Adjust
page. From that page, you can set anew channel for Radio 1 or Radio 2. The
available channel s depend on the radio mode and country in which the APs
operate. Table 23 describes the fields on the new page.

Power

Click the Power link to access the Managed AP Channel/Power Adjust page.
From that page, you can set a new power level for the AP. Table 23 describes
the fields on the new page.
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Enabling AP Debugging

You can enable debugging on an AP to allow Telnet access to the access point. Once you
Telnet to the AP, you can issue commands from the CLI to help you troubleshoot.

Thefieldsin Table 22 appear when you click the Debug link for amanaged AP on the
Managed AP Advanced page.

Table 22. AP Debug

Field Description

MAC Address Shows the MAC address of the access point.

Location Shows the location of the access point, as configured in the Valid AP data-
base.

IP Address Shows the IP address of the AP.

Satus Shows the debug status, which can be one of the following:

*  None—Debugging has not been enabled or disabled.
*  Set Requested—A request has been made to change the debug status.
e Set Complete—Debugging has been enabled or disabled.

Passwor d Enter the admin password for the AP (the default is admin).

Confirm Password  Since the password is encrypted, you must retype the password to confirm
the password.

Enable Debug Select or clear the Enable check box to enable or disable debugging.

Once once you Telnet to the AP, you get an AP interface login prompt. The
user name is admin. Enter the password you set in the previousfield. The
default password isadmin if you did not specify a new password. From the
AP CLI, you can also access the standard Linux prompt by typing the'!" char-
acter.

You can issue the following debug commands at the Linux OS prompt:

e get management —Display management interface information
e get managed- ap—Display managed AP information
You can issue the following debug commands at the Linux OS prompt:

e ifconfig—display al interfaces.
e cat /proc/nmeni nf o—View memory utilization

Adjusting the Channel and Power

Changes you make to the channel and power are runtime changes only. If you change the
channel or power settings, the new settings are lost if the AP or switch is reset.

Thefieldsin Table 23 appear when you click the current channel or power setting for an AP on
the Managed AP Advanced page.

Table 23. Managed AP Channel/Power Adjust

Field Description
AP MAC Address  Showsthe MAC address of the access point.
Radio Displaysthe radio and its mode. The changes apply only to thisradio.
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Table 23. Managed AP Channel/Power Adjust

Field

Description

Channd Satus

The statusis one of the following:

*  None
e Set Requested
e Set Complete

Channd

The Channel defines the portion of the radio spectrum that the radio uses for
transmitting and receiving. Therange of channels and the default channel are
determined by the Mode of the radio interface.

|EEE 802.11b/802.11g modes (802.11 b/g) support use of channels 1
through 11 inclusive, while |EEE 802.11a mode supports alarger set of non-
consecutive channels (36,40,44, 48, 52, 56, 60, 64, 149, 153, 157, 161, 165).

NOTE: The available channels depends on the country in which the APs
operate.

NOTE: For radios that use 802.11a mode, some countries have a regul atory
domain that requires radar detection. For these countries (based on the
country code setting), the radio automatically uses the 802.11h protocol for
selecting the channel if radar is detected on the statically assigned channel.

Interference can occur when multiple access points within range of each
other are broadcasting on the same or overlapping channels. The impact of
this interference on network performance can intensify during busy times
when alarge amount of data and mediatraffic is competing for bandwidth.

If you select auto, the AP scans the RF areafor occupied channels and selects
achannel from the available non-interfering, or clear channels.

If you specify a channel, make sure that the channel does not interfere with
the channel that neighbor APs use.

Power Satus

The statusis one of the following:

*  None
e Set Requested
e Set Complete

Power

The power level affects how far an AP broadcastsits RF signal. If the power
level istoo low, wireless clients will not detect the signal or experience poor
WLAN performance. If the power level istoo high, the RF signal might
interfere with other APs within range.
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Monitoring Status and Statistics

This chapter contains the following sections to help you monitor the status and statistics for
your D-Link Unified Access System network:

* Monitoring Wireless Global Information

* Monitoring Peer Switch Status

e Monitoring All Access Points

* Monitoring Managed Access Point Status

* Viewing Access Point Authentication Failure Status
* Monitoring Rogue and RF Scan Access Points

» Monitoring Associated Client Information

* Viewing Client Authentication Failure Status

* Monitoring and Managing Ad Hoc Clients

For information about the commands you use to view WLAN status and statistics by using the
CLI, see the D-Link CLI Command Reference.

Monitoring Wireless Global Information

The D-Link Unified Switch periodically collectsinformation from the D-Link Access Pointsit
manages and from peer switches that are associated with it. The information on the Global
page shows status and statistics about the switch and all of the objects associated with it.

You can access the global WLAN statistics by clicking Monitoring > Global.
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For more information about an item on the Wireless Global Status page, click the value
associated with the item to go to its status page.

Figure57. Global WLAN Status

124
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Table 24 describes the fields on the Wireless Global Satus page.
Table 24. Global WL AN Satistics

Field

Description

WLAN Switch
Operation Satus

This status field displays the operational status of the WLAN Switch. The
WLAN Switch may be configured as enabled, but is operationally disabled
due to configuration dependencies. If the operational statusis disabled, the
reason will be displayed in the following status field.

The WLAN Switch is composed of multiple components, and each
component in the system must acknowledge an enable or disable of the
WLAN Switch. During atransition the operational status might temporarily
show a pending status.

IP Address I P address of the switch. For information about the switch |P address, see
“Assigning the P Address to Switches and Managed APS’ on page 64.
Peer Switches Number of peer Unified Switches detected on the network.
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Table 24. Global WLAN Statistics

Field Description

Total Access Total number of Managed APs in the database. Thisvalueis always equal to

Points the sum of “Managed Access Points,” “Connection Failed Access Points,”
and “Discovered Access Points.”

Sandalone Access  Total number of detected D-Link Access Pointsthat are in Standalone Mode.

Points APsin Standalone Mode are not currently managed by a D-Link Unified

Switch.

Managed Access
Paints

Number of APsin the managed AP database that are authenticated,
configured, and have an active connection with the Unified Switch.

Connection Failed
Access Points

Number of APsthat were previously authenticated and managed, but
currently don't have connection with the Unified Switch.

Discovered Access
Points

APs that have a connection with the switch but have not been completely
configured. Thisvalueincludes all managed APswith a*“ Discovered” or
“Authenticated” status.

Rogue Access
Paints

Number of Rogue APs currently detected on the WLAN. When an AP
performs an RF scan, it might detect access points that have not been
validated. It reports these APs as rogues.

Authentication

Number of access points that failed to authenticate with the Unified Switch.

Failed Access

Points

Total Clients Total number of clientsin the database. Thistotal includes clients with an
“Associated”, “ Authenticated”, or “Disassociated” status.

Authenticated Total number of clientsin the client database with an “ Authenticated” status.

Clients

802.11a Clients

Shows the number of clients connected to the 802.11aradio frequency.

802.11b/g Clients

Shows the number of clients connected to the 802.11b/g radio frequency.

Black-listed
Clients

Shows the number of clients that are configured to be disallowed to associate
with any AP that uses the default AP profile.

WLAN Utilization

Total network utilization across all APs managed by this switch. Thisis
based on global statistics.

WLAN Bytes Total bytes transmitted across al APs managed by the switch.
Transmitted

WLAN Bytes Total bytes received across all APs managed by the switch.
Received

WLAN Packets Total packets transmitted across all APs managed by the switch.
Transmitted

WLAN Packets Total packets received across all APs managed by the switch.
Received
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Viewing IP Discovery Status

From the Monitoring > Global > | P Discovery tab, you can view information about

communication with the devicesin the IP discovery list on the Administration > Basic Setup
> Discovery page.

Figure 58. Wireless Discovery Status

| Global | |
\Wireless Discovery Status
IP Address
102542443 Polled
10.254.24 44 Polled
1025424 45 Polled
10.254.24 46 Polled
10.254.24 47 Polled
10254.24.48 Polled

The status isin one of the following states:

* Not Polled—The switch has not attempted to contact the IP addressin the L3/IP
Discovery list.

» Polled—The switch has attempted to contact the |P address.

» Discovered—The switch contacted the peer switch or AP with IP addressin the L3/IP
Discovery list and has authenticated or validated the device.

» Discovered - Failed—The switch contacted the peer switch or AP with IP addressin the
L3/IP Discovery list and was unable to authenticate or validate the device.

If the deviceis an access point, an entry appearsin the AP failure list with afailure reason.

For information about adding IP addresses to the P Discovery list, see “Configuring |P
Addresses of Peersand APsin the Switch” on page 69.

Monitoring Peer Switch Status

The Peer Switch page provides information about other D-Link Unified Switchesin the
network. To access the peer switch information, click Monitoring > Peer Switch.

Peer Unified Switches within the same peer group exchange data about themselves, their
managed APs, and clients. The switch maintains a database with this data so you can view
information about a peer, such asits |P address and software version. If the switch loses
contact with a peer, al of the datafor that peer is deleted.
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Peer switches do not exchange configuration profiles or additional data about their managed
APs. This means that you cannot view any other status or statistics for amanaged AP from a
peer switch. However, switches do use shared information for rogue AP detection.

Figure59. Peer Switch Satus

Peer Switch Status

Vendor Software Protocol Discovery
IP Address 1D Version Version Reason Age
192.168.17 .32 D-Link DE11.1 1 L2 Pall 0d:00:00:20

Table 25 describes the fields available on the Peer Switch Status page.
Table 25. Peer Switch Status

Field Description

IP Address IP address of the peer Unified Switch managed in the peer group.
Vendor ID Vendor of the peer switch software.

Software Version The software version for the given peer switch.

Protocol Version Version of WS software on the peer switch.

Discovery Reason  Thediscovery method of the given peer switch, which can be one of the
following methods:
e« L2Pall
« |IPPdll

Age Time since last communication with the switch in Hours, Minutes, and
Seconds.

Monitoring All Access Points

The Monitoring > Access Points > All Access Points page shows summary information
about managed, failed, and rogue access points the switch has discovered or detected.

Figure 60. All Access Points

All Access Points

Switch Software Authenticated

IMAC Address Location Port P Address Version [ Status Profile Radio Channel Clients

00:11:95:23:7b:30 Lab1 Unknown  192.168.17.168 1.0.1.7 Oh:0m4s  Managed 2-RemoteAccess 1-80211a 44 0
2802119 6 0

00:11:95:a3:7Th:40 Lab2 Unknown 192.1668.17.169 D.05.01.2 Oh:0m:3s  Managed 2-Remotedccess 1802 11a 165 ]
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Thefont color for the AP listing indicates that the AP is one of the following types.

» Green—Managed AP

* Red—Faled AP

* Gray—Rogue AP

*  Amber—Peer Managed AP

You can manually delete status entries. To clear all APsfrom the All Access Points status page
except Managed Access Points, click Delete All.

To configure an Authentication Failed AP to be managed by the switch the next timeit is
discovered, select the check box next to the MAC address of the AP and click M anage. You
will be presented with the Valid Access Point Configuration page. You can then configure the
AP and click Submit to savethe AP in the loca Valid AP database. If you use aRADIUS
server for AP validation, you must add the MAC address of the AP to the AP database on the
RADIUS server. For more information, see Appendix B, “Configuring the External RADIUS
Server” on page 207.

To identify an AP as an Acknowledged Rogue, select the check box next to the MAC address
of the AP and click Acknowledge. The switch adds the AP to the Valid AP database as an
Acknowledged Rogue.

To identify an AP as arogue (again), select the check box next to the MAC address of the
acknowledged AP and click UnAcknowledge. The switch deletes the AP from the Valid AP
database.

To view additional information about the detected AP, click the MAC address of the AP,

Table 26 describes the fields on the All Access Points page.
Table 26. Monitoring All Access Points

Field Description

MAC Address Shows the MAC address of the access point.

Location A location description for the AP. Thisisthe value configured in the valid
AP database (either locally or on the RADIUS server).

Switch Port The physical port (in the slot/port format) on the switch that the AP is

connected to either directly or indirectly in the same L3 domain. If the AP is
beyond the L3 network boundary, then ‘Unknown’ is displayed.

IP Address The network address of the access point.

Software Version Shows the version of D-Link Access Point software that the AP is running.

Age Shows how much time has passed since the AP was last detected and the
information was last updated.
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Table 26. Monitoring All Access Points

Field Description

Satus Shows the access point status:

* Managed—The AP profile configuration has been applied to the AP and
it's operating in managed mode.

¢ No Database Entry—The MAC address of the AP does not appear in the
local or RADIUS Valid AP database.

e Authentication (Failed AP)—The AP failed to be authenticated by the
Unified Switch or RADIUS server.

e Failed—The Unified Switch lost contact with the AP; afailed entry will
remain in the managed AP database unless you remove it. Note that a
managed AP will temporarily show afailed status during areset.

* Rogue—The AP has not attempted to contact the switch, and the MAC
address of the AP is not in the Valid AP database.

*  Acknowledged Rogue—The AP has been acknowledged as aknown
rogue, and its MAC address of the AP isin the Valid AP database.

Profile The AP profile configuration currently applied to the managed AP. The
profile is assigned to the AP in the valid AP database.

NOTE: Once an AP isdiscovered and managed by the Unified Switch, if the
profileis changed in the valid AP database (either locally or on the RADIUS
server) the AP is automatically reset when a new profile is assigned.

Radio Shows the wireless radio mode that each radio on the AP isusing. The
D-Link DWL-3500AP access point has one radio, and the D-Link
DWL-8500AP access point has two radios.

Channd Shows the operating channel for the radio.
Authenticated Shows the number of wireless clients that are associated and authenticated
Clients with the access point per radio.

NOTE: Some status values for some APsin the All Access Points list are not
available. Those arelisted as N/A.

NOTE: You can sort the list of APs by any of the column heading except for Radio,
Channel, and Authenticated Clients. For example, to sort the APs by the
profile they use, click Profile.
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Monitoring Managed Access Point Status

From the M onitoring > Access Points > M anaged Access Points page, you can access a
variety of information about each AP that the switch manages. The pages you access from the
Status tab provide configuration and association information about managed APs and their
neighbors. The pages you access from the Statistics page display information about the
number of packets and bytes transmitted and received on different interfaces.

Figure 61 shows the Managed Access Point Status page with three managed APs.

Figure61. Managed AP Status

Summary | Deril | Radie Summary | Radie Derail | Meighber APs | Meighber Clients | VAP
Managed Access Point Status

Switeh Seltware Cenliguration Rathenticalsd
AC Address Location Poit IP Address Vemsion Stahes  Staius Prefile  Radio Channel Clients

195 a7 A [iTF}] 19296817145 DOSOT1 OdOOO00E Managed Success 1:Defaul 1802 11a B o
24802 11g 1 o
0110543 Th:50 13 1829681772 DOEOT2 DdOOOODE Managed Success I-Defaut 1-80211a ED !
2802115 11 o

The following tabs are available from the M anaged AP Status page:

*  Summary—oLists the APs managed by the switch and provides summary information
about them.

» Detail—Shows detailed status information collected from the AP.

* Radio Summary—Showsthe channel, transmit power, and number of associated wireless
clients for all managed APs.

* Radio Detail—From the Radio Summary page, click the MAC address of the AP to view
detailed statusfor aradio interface. Use the radio button to navigate between the two radio
interfaces.

* Neighbor APs—Shows the neighbor APs that the specified AP has discovered through
periodic RF scans on the selected radio interface.

* Neighbor Clients—Shows information about wireless clients associated with an AP or
detected by the AP radio.

*  VAP—Shows summary information about the virtual access points (VAPS) for the
selected AP and radio interface on the APs that the switch manages.

Table 27 describes the fields you see on the Summary page for the managed access point
status.

Table 27. Managed Access Point Status

Field Description
MAC Address The Ethernet address of the Unified Switch managed AP.
L ocation A location description for the AP. Thisisthe value configured in the valid

AP database (either locally or on the RADIUS server).
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Table 27. Managed Access Point Status

Field Description

Switch Port The physical port (in the slot/port format) on the switch that the AP is
connected to either directly or indirectly in the same L3 domain. If the AP is
beyond the L3 network boundary, then ‘Unknown’ is displayed.

IP Address The network |P address of the managed AP.
Software Version The software version the AP is currently running.
Age Time since last communication between the WDS and the AP.
Satus The current managed state of the AP. The possible values are:
« Discovered - The AP isdiscovered and by the switch, but is not yet
authenticated.

e Authenticated - The AP has been validated and authenticated (if
authentication is enabled), but it is not configured.

* Managed - The AP profile configuration has been applied to the AP and
it's operating in managed mode.

e Failed - The Unified Switch lost contact with the AP, afailed entry will
remain in the managed AP database unless you remove it. Note that a
managed AP will temporarily show afailed status during a reset.

Configuration This statusindicatesif the AP is configured successfully with the assigned
Satus profile. The status is one of the following:

* Not Configured - The profile has not been sent to the AP yet, the AP
may be discovered but not yet authenticated.

* InProgress- The switch is currently sending the AP profile
configuration packet to the AP,

e Success - The entire profile has been sent to the AP and there were no
configuration errors.

e Partial Success - The entire profile has been sent to the AP and there
were configuration errors (for example, some configuration parameters
were not accepted), but the AP is operational.

e Failure - The profile has been sent to the AP and there were
configuration errors, the AP is not operational.

Profile The AP profile configuration currently applied to the managed AP, the
profile is assigned to the AP in the valid AP database.

NOTE: Once an AP isdiscovered and managed by the Unified Switch, if the
profileis changed in the valid AP database (either locally or on the RADIUS
server) the AP must be reset to configure with the new profile.

Radio Shows the wireless radio mode that each radio on the AP isusing. The
D-Link DWL-3500AP access point has one radio, and the D-Link
DWL-8500AP access point has two radios.

Channd Shows the operating channel for the radio.
Authenticated Shows the number of wireless clients associated and associated with the
Clients access point per radio.

NOTE: You can sort the list of APs by any column heading except Radio, Channel,
and Authenticated Clients. For example, to sort the APs by the profile they
use, click Profile.
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Viewing Detailed Managed Access Point Status

To view detailed information about an AP that the switch manages, select the MAC address of

the AP from the drop-down menu above the table that displays the detailed information. Click
the Reset button to reset the managed AP. A pop-up asks you to confirm that you want to reset
the AP. Any wireless clients associated with the access point will be disassociated. To refresh
the status information for the AP, click Refresh

Table 28 describes the fields you see on the Detail page for the managed access point status.
Table 28. Detailed Managed Access Point Status

Field Description

MAC Address- Thelabel at the top of the table shows the MAC address and | ocation of the
L ocation AP. Thelocation is the value configured in the Valid AP database.
Hardware Type Type of the AP hardware. It is either DWL-8500AP or DWL-3500AP.
Switch Port The physical port (in the slot/port format) on the switch that the AP is

connected to either directly or indirectly in the same L3 domain. If the AP is
beyond the L 3 network boundary, then ‘Unknown’ is displayed.

IP Address The network IP address of the managed AP.

Profile The AP profile configuration currently applied to the managed AP, the
profileis assigned to the AP in the valid AP database. Note: Once an AP is
discovered and managed by the Unified Switch, if the profileis changed in
the valid AP database (either locally or on the RADIUS server) the AP must
be reset to configure with the new profile.

Satus The current managed state of the AP. The possible values are:

« Discovered - The AP isdiscovered and by the switch, but is not yet
authenticated.

* Authenticated - The AP has been validated and authenticated (if
authentication is enabled), but it is not configured.

* Managed - The AP profile configuration has been applied to the AP and
it's operating in managed mode.

» Failed - The Unified Switch lost contact with the AP, afailed entry will
remain in the managed AP database unless you remove it. Note that a
managed AP will temporarily show afailed status during areset.

Discovery Reason  Thisstatus valueindicates how the managed AP was discovered, the statusis
one of the following values:

¢ |PPoll Received - The AP was discovered viaan |P poll from the
Unified Switch, its IP address is configured in the IP polling list.

¢ Peer Redirect - The AP was discovered through a peer switch redirect,
the AP tried to associate with another peer switch and learned the
current Unified Switch I P address from the peer (peer learned Unified
Switch IP addressin RADIUS server response when validating the AP).

«  Switch IP Configured - The managed AP is configured with the Unified
Switch |P address.

e Switch IP DHCP - The managed AP learned the current Unified Switch
IP address through DHCP option 43.

¢ L2 Poll Received - The AP was discovered through the D-Link Wireless
Device Discovery protocol.
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Table 28. Detailed Managed Access Point Status

Field Description
Configuration This status indicates if the AP is configured successfully with the assigned
Satus profile. The status is one of the following:

* Not Configured - The profile has not been sent to the AP yet, the AP
may be discovered but not yet authenticated.

* InProgress- The switch is currently sending the AP profile
configuration packet to the AP.

e Complete Success - The entire profile has been sent to the AP and there
were no configuration errors.

e Partial Success - The entire profile has been sent to the AP and there
were configuration errors, but the AP is operational .

e Failure - The profile has been sent to the AP and there were
configuration errors, the AP is not operational.

Protocol Version

Indicates the protocol version supported by the software on the AR, thisis
learned from the AP during discovery.

Software Version Indicates the version of software on the AP, thisislearned from the AP
during discovery.

Last Failing If the configuration status indicates a partial success or completefailure, this

Configuration field indicates the last element that failed during configuration. Thisfield is

Element only visibleif thereisafailed element.

Configuration
FailureError
Message

If the configuration status indicates a partial success or complete failure, this
field contains an ASCII string filled in by the AP containing the error
message for the last failing configuration element.

Code Download
Satus

Thisindicates the current status of a code download request for this AP. The
possible values include the following:

¢ Not Started - A code download has not been requested for the AP,

* Reguested - A code download has been requested for the AP, the switch
has not processed the request.

e InProgress - The switch is processing a code download request for the
AP.

e Success - The AP has successfully downloaded the new software image.

*  Failure- The AP failed to download the new software image.

Associated Clients

Total number of clients currently associated to the AP. Thisis the sum of all
associated clients for al the VAPs enabled on the AP. Association isa
transitiona state.

Authenticated Total number of clients currently authenticated to the AP. This isthe sum of
Clients all authenticated clients for all the VAPs enabled on the AP,

System Uptime Time in seconds since last power-on reset of the managed AP,

Age Time since last communication between the WDS and the AP,

Viewing Managed Access Point Radio Summary Information

You can view general information about each operational radio on all APs managed by the
switch. The Managed Access Point Radio Summary page shows the channel, transmit power,
and number of associated wireless clients for all managed APs. For more information about a
specific radio on an AP, click the radio.
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Table 29 describes the fields you see on the Radio Summary page for the managed access
point status.

Table 29. Managed AP Radio Summary

Field Description

MAC Address The Ethernet address of the Unified Switch managed AP.

L ocation A location description for the AP, thisisthe value configured in the valid AP
database (either locally or on the RADIUS server).

Radio Indicates the radio interface and configured mode of the radio, if the radiois
disabled the radio mode will be displayed as Off instead of showing the
configured mode.

Channe If radio is operational, the current operating channel for the radio.

Transmit Power

If radio is operational, the current transmit power for the radio.

Associated Clients

Total count of clients associated on the physical radio, thisisasum of al the
clients associated to each VAP enabled on the radio.

Authenticated
Clients

Total number of clients currently associated to the AP that have been
authenticated. Thisisthe sum of all authenticated clients for all the VAPs
enabled on the radio.

Viewing Detailed Managed Access Point Radio Information

You can view detailed information about each radio on the APs that the Unified Switch
manages on the Radio Detail page for the managed access point radio status.

Table 30 describes the fields you see on the Radio Detail page for the managed access point

status.

Table 30. Managed AP Radio Detail

Field Description
MAC Address- Shows the MAC address and location of the AP to which the values on the
Location page apply. To view details about a different AP, select its MAC address

(Drop-down Menu)

from the drop-down menu.

Radio

Indicates the radio interface and configured mode of the radio, if the radiois
disabled the radio mode will be displayed as Off instead of showing the
configured mode.

Supported Thelist of eligible channels the AP reported to the switch for channel

Channels assignment. Thelist is based on country code, hardware capabilities, and any
configured channel limitations.

Channd If radio is operational, the current operating channel for the radio.

Associated Clients

Total count of clients associated on the physical radio, thisisasum of al the
clients associated to each VAP enabled on the radio.

Authenticated Total count of clients authenticated on the physical radio, thisisasum of all
Clients the clients authenticated to each VAP enabled on the radio.

Transmit Power If radio is operational, the current transmit power for the radio.
Authenticated Total count of clients authenticated clients on the physical radio, thisisasum
Clients of al the clients authenticated to each VAP enabled on the radio.
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Table 30. Managed AP Radio Detail

Field Description

Fixed Channel Thisflag indicatesif afixed channel is configured and assigned to the radio,

Indicator afixed channel can be configured in the valid AP database (locally or on a
RADIUS server).

Fixed Power Thisflag indicatesif afixed power setting is configured and assigned to the

Indicator radio, afixed transmit power can be configured in the valid AP database
(locally or on aRADIUS server).

Manual Channel Indicates the current state of a manual reguest to change the channel on this

Adjustment Satus  radio. Thevalid values are:

* Not Started - No request has been made to change the channel.
e Reguested - A channel change has been requested by the user but has not

been processed by the switch.
¢ InProgress- The switch is processing a channel change request for this
radio.

e Success - A channel change request is complete.
¢ Failure - A channel change request failed.

Manual Power Indicates the current state of amanual request to change the power setting on
Adjustment Satus thisradio. Thevalid values are:

¢ None- No request has been made to change the power.

¢ Reguested - A power adjustment has been requested by the user but has
not been processed by the switch.

e InProgress- The switch is processing a power adjustment request for
thisradio.

e Success - A power adjustment request is compl ete.

¢ Failure - A power adjustment request failed.

WLAN Utilization  Indicates the total network utilization for the physical radio, thisvalueis
based on radio statistics.

Total Neighbors Total number of neighbors (both APs and clients) that can be seen by this
radioinits RF area.

Viewing Managed Access Point Neighbor APs

During the RF scan, an access point collects and stores beacon information visible from

neighboring access points. Access points can store the neighbor information for up to 64
neighbor APs. If the neighbor scan information exceeds the capacity the oldest datain the
neighbor list is overwritten.

The Delete All Neighbor s button clears the list. The list is repopulated as neighbors are
discovered.
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Table 31 describes the fields you see on the Neighbor APs page for the managed access point
status.

Table 31. Managed AP Neighbor Status

Field Description

MAC Address- Shows the MAC address and location of the AP to which the values on the
L ocation page apply. To view details about a different AP, select its MAC address
(Drop-down Menu)  from the drop-down menu.

Radio Indicates aradio interface and its configured mode. Select one of the radios
(ex. 1-802.11g) to view the neighbor APs detected via an RF scan on that radio.

Neighbor AP MAC  The Ethernet MAC address of the neighbor AP network, this could be a
physical radio interface or VAP MAC address. For D-Link Access Pointsthis
isalways a VAP MAC address. The neighbor AP MAC address may be
cross-referenced in the RF Scan status.

SSID Service Set ID of the neighbor AP network.

RSSI Received signal strength indication, thisisan indicator of the signal strength
relative to the neighbor and may give an idea of the neighbor's distance from
the managed AP.

Satus Indicates the managed status of the AP, whether thisisavalid AP known to

the switch or a Rogue on the network. The valid values are:

WS Managed - The neighbor AP is managed by this switch, the
neighbor AP status can be referenced using its base MAC address.

e Peer WS Managed - The neighbor AP is managed by another switch
within the peer group.

e Acknowledged Rogue - The AP is configured asavalid AP entry (local
or RADIUS), it has been acknowledged and is not reported as Rogue.

e Ad Hoc Rogue - The AP neighbor was detected participating in an ad
hoc network.

Age Indicates the time since this AP was last reported from an RF scan on the
radio.

Viewing Clients Associated with Neighbor Access Points

The Neighbor Clients page shows information about wireless clients that have been
discovered by the selected AP. D-Link Access Points can store information for up to 1024
wireless clients. If the information exceeds the capacity, the oldest datain the neighbor client
list is overwritten. The Delete All Neighbors button clearsthe list. Thelist is repopulated as
neighbors and associated clients are discovered.
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Table 32 describes the fields you see on the Neighbor Clients page for the managed access

point status.

Table 32. Neighbor AP Clients

Field Description

MAC Address- Shows the MAC address and location of the AP to which the values on the

L ocation page apply. To view details about a different AP, select its MAC address

(Drop-down Menu)  from the drop-down menu.

Radio Indicates aradio interface and its configured mode. Select one of the radios

(ex. 1-802.11g) to view the neighbor clients detected on that radio.

Neighbor Client The Ethernet address of client station.

MAC

RSSI Received signal strength indication, thisis an indicator of the signal strength
relative to the neighbor and may give an idea of the neighbor's distance from
the managed AP.

Channd The managed AP channel the client frame was received on, which may be

different than the operating channel for this radio.

Discovery Reason

Indicates one or more discovery methods for the neighbor client. One or
more of the following values may be displayed:

RF Scan - The client was reported from an RF scan on the radio. Note
that client stations are difficult to detect via RF scan, the other methods
are more common for client neighbor detection.

Probe Request - The managed AP received a probe request from the
client.

Associated to Managed AP- Thisneighbor client is associated to another
managed AP.

Associated to This AP - The client is associated to this managed AP on
the displayed radio.

Associated to Peer AP - The client is associated to an AP managed by a
peer switch.

Ad Hoc Rogue - The client was detected as part of an Ad Hoc network.

Age

Indicates the time since this client was | ast reported from an RF scan on the
radio.

Viewing Managed Access Point VAPs

There are eight virtual access points (VAPs) available on each radio of an AP. For each radio

of an access point managed by the switch, you can view a summary of the VAP configuration
and the number of wireless clients associated with a particular VAP,
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Table 33 describes the fields you see on the VAPSs page for the managed access point status.
Table 33. Managed Access Point VAP Satus

Field Description

MAC Address- Shows the MAC address and location of the AP to which the values on the

L ocation page apply. To view details about a different AP, select its MAC address

(Drop-down Menu)  from the drop-down menu.

Radio Indicates aradio interface and its configured mode. Select one of the radios

(ex. 1-802.119) to view VAP status for that radio.

VAP ID Theinteger 1D used to identify the VAP (0-7), thisis used to uniquely
identify the VAP for configuration via CLI/SNMP.

VAP Mode Indicates whether or not the VAP is enabled or disabled. VAPs are always
configured, but are only sending beacons and accepting clientswhen they are
Enabled.

BSSID The Ethernet address of the VAP,

SSID Indicates the network assigned to the VAP. The network for each VAP is

configured within the AP profile and the SSID is based on the network
configuration.

Client Associations  Indicates the total number of clients currently associated to the VAP,

Client Indicates the total number of clients currently authenticated with the VAP,
Authentications

Monitoring Managed AP Statistics

The managed AP statistics show information about traffic on the wired and wireless interface

of the access point. Thisinformation can help diagnose network issues, such as throughput
problems.

Figure 62 shows the Managed Access Point Statistics page with two managed APs.

Figure62. Managed AP Statistics

138

| WLAN Summary | Ethernet summary | Detail | Radio | vaP|

Wanaged Access Point Statistics

MAC Address

D0:01.01:02.01:01 D 0 0 0
D0:01.01.02.02.01 D 0 D 0
D0:01.01:02.0301 D 0 0 0

The following tabs are available from the M anaged AP Statistics page:

*  WLAN Summary—Shows summary information about the wireless interfaces on each
AP the switch manages.

» Ethernet Summary—Shows summary information about the Ethernet (wired) interfaces
on each AP the switch manages.
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» Detail—Shows the number and type of packets transmitted and received on a specific AP.

* Radio—Shows per-radio information about the number and type of packets transmitted
and received for a specific AP.

*  VAP—Shows per-VAP information about the number of packets transmitted and received
and the number of wireless client failures for a specific AP

On the WLAN Summary and Ethernet Summary pages, click the MAC address of the AP to
view detailed statistics about the AP,

Table 34. Managed Access Point WLAN Summary Satistics

Field Description

MAC Address The Ethernet address of the Unified Switch managed AP.
Packets Received Total packets received by the AP on the wireless network.
Bytes Received Total bytes received by the AP on the wirel ess network.
Packets Transmitted Total packets transmitted by the AP on the wireless network.
Bytes Transmitted Total bytes transmitted by the AP on the wirel ess network.

NOTE: You can sort the list of APs by any of the column heading. For example, to
sort the APs by the number of packets transmitted, click Packets
Transmitted.

Viewing Managed Access Point Ethernet Statistics

The Ethernet summary statistics show information about the number of packets and bytes

transmitted and received on the wired interface of each access point managed by the switch.
The wired interface is physically connected to the LAN.

Table 35 describes the fields you see on the Ethernet Summary page for the managed access
point statistics.
Table 35. Managed Access Point Ethernet Summary Satistics

Field Description

MAC Address The Ethernet address of the Unified Switch managed AP.
Packets Received Total packets received by the AP on the wired network.
Bytes Received Total bytesreceived by the AP on the wired network.
Packets Transmitted Total packets transmitted by the AP on the wired network.
Bytes Transmitted Total bytes transmitted by the AP on the wired network.

Viewing Detailed Managed Access Point Statistics

The detailed AP statistics show information about the packets and bytes transmitted and

received on the wired and wireless interface of a particular access point managed by the
switch.
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Table 36 describes the fields you see on the Detail page for the managed access point

statistics.

Table 36. Detailed Managed Access Point Statistics

Field

Description

MAC Address-L ocation
(Drop-down Menu)

Shows the MAC address and location of the AP to which the
values on the page apply. To view details about a different AR,
select its MAC address from the drop-down menu.

WLAN Packets Received

Total packets received by the AP on the wirel ess network.

WLAN Bytes Received

Total bytes received by the AP on the wireless network.

WLAN Packets Transmitted

Total packets transmitted by the AP on the wireless network.

WLAN Bytes Transmitted

Total bytes transmitted by the AP on the wireless network.

Ethernet Packets Received

Total packets received by the AP on the wired network.

Ethernet Bytes Received

Total bytes received by the AP on the wired network.

Ethernet Packets Transmitted

Total packets transmitted by the AP on the wired network.

Ethernet Bytes Transmitted

Total bytes transmitted by the AP on the wired network.

Multicast Packets Received

Total multicast packets received by the AP on the wired
network.

Total ReceiveErrors

Total receive errors detected by the AP on the wired network.

Total Transmit Errors

Total transmit errors detected by the AP on the wired network.

Viewing Managed Access Point Radio Statistics

The radio statistics show detailed information about the packets and bytes transmitted and
received on the radio (wireless) interface of a particular access point managed by the switch.

Table 37 describes the fields you see on the Radio page for the managed access point

statistics.

Table 37. Managed Access Point Radio Statistics

Field

Description

MAC Address-L ocation
(Drop-down Menu)

Shows the MAC address and location of the AP to which the
values on the page apply. To view details about a different
AP, select its MAC address from the drop-down menu.

WLAN Packets Received

Total packets received by the AP on thisradio interface.

WLAN Bytes Received

Total bytes received by the AP on thisradio interface.

WLAN Packets Transmitted

Total packets transmitted by the AP on this radio interface.

WLAN Bytes Transmitted

Total bytes transmitted by the AP on this radio interface.

Fragments Received

Count of successfully received MPDU frames of type data or
management.

Fragments Transmitted

Number of transmitted MPDU with an individual address or
an MPDU with a multicast address of type Data or
Management.

Multicast Frames Received

Count of MSDU frames received with the multicast bit set in
the destination MAC address.
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Table 37. Managed Access Point Radio Statistics

Field

Description

Multicast Frames Transmitted

Count of successfully transmitted MSDU frames where the
multicast bit is set in the destination MAC address.

Duplicate Frame Count

Number of times aframe is received and the Sequence
Control field indicatesis a duplicate.

Failed Transmit Count

Number of timesaMSDU is not transmitted successfully due
to transmit attempts exceeding either the short retry limit or
the long retry limit.

Transmit Retry Count

Number of timesaMSDU is successfully transmitted after
ohe or more retries.

Multiple Retry Count

Number of timesaMSDU is successfully transmitted after
more than one retry.

RTS Success Count

Count of CTS framesreceived in response to an RTS frame.

RTS Failure Count

Count of CTS frames not received in response to an RTS
frame.

ACK Failure Count

Count of ACK frames not received when expected.

FCSError Count

Count of FCS errors detected in areceived MPDU frame.

Frames Transmitted

Count of each successfully transmitted MSDU.

WEP Undecryptable Count

Count of encrypted frames received and the key configuration
of the transmitter indicates that the frame should not have
been encrypted or that frame was discarded due to the
receiving station not implementing the privacy option.

Viewing Managed Access Point VAP Statistics

The VAP statistics show information about the client failures and number of packets and bytes
transmitted and received on each VAP on radio one or two for a particular access point

managed by the switch.

Table 38 describes the fields you see on the VAP page for the managed access point statistics.
Table 38. Managed Access Point VAP Satistics

Field

Description

MAC Address-L ocation
(Drop-down Menu)

Shows the MAC address and location of the AP to which the
values on the page apply. To view information about a different
AP, select its MAC address from the drop-down menu.

Radio Indicates aradio interface and its configured mode. Select one of
(ex. 1-802.11g) the radiosto view its VAP statistics.
VAP ID Select one of the 8 VAPs from the drop-down menu to display its

statistics. All VAPs are available regardless of whether they are
enabled.

WLAN Packets Received

Total packets received by the AP on this VAP,

WLAN Bytes Received

Total bytes received by the AP on this VAP,

WLAN Packets Transmitted

Total packets transmitted by the AP on this VAP,
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Table 38. Managed Access Point VAP Satistics

Field Description

WLAN Bytes Transmitted Total bytes transmitted by the AP on this VAP,

Client Association Failures Number of clients that have been denied association to the VAP.

Client Authentication Number of clients that have failed authentication to the VAP,
Failures

Viewing Access Point Authentication Failure Status

An AP might fail to associate to the switch due to errors such asinvalid packet format or
vendor ID, or because the AP is not configured asavalid AP with the correct local or
RADIUS authentication information.

Status entries for failed access points are collected at a point in time and eventually age out.
The age value for each entry shows how long ago the switch recorded the entry. You can
configure the age out time for status entries on the Administration > Advanced
Configuration > Global page. You can aso manually delete status entries.

To view alist of APsthat failed to associate with the D-Link Unified Switch, click
Monitoring > Access Points > Authentication Failed Access Points.

Figure 63. Authentication Failed AP Satus
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Access Point Failure Status

MAC Address IP Address Last Failure Type Age
O 0003 7feC001c 192.168.17 .33 Mo Database Entry Th:9m:6s
0O 00:11:95e15d10 192.168.17 110 Mo Database Entry Th12mds

[ Delate All ][ Manage ][ Fefresh ]

The AP authentication failure list shows information about APs that failed to establish
communication with the D-Link Unified Switch. The AP can fail due to one of the following
reasons.

* No Database Entry—The MAC address of the AP isnot in the local Valid AP database or
the external RADIUS server database, so the AP has not been validated.

» Authentication—T he authentication password configured in the AP did not match the
password configured in the local database or RADIUS database.

To delete the entries for all APs from the failure list, click Delete All. To configure an
Authentication Failed AP to be managed by the switch the next timeit is discovered, select the
check box next to the MAC address of the AP and click Manage. You will be presented with
the Valid Access Point Configuration page. You can then configure the AP and click Submit
to savethe APinthelocal Valid AP database.

If you use aRADIUS server for AP validation, you must add the MAC address of the AP to
the RADIUS server database. For more information, see Appendix B, “Configuring the
External RADIUS Server” on page 207.
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Click the MAC address of the AP to view more information about the AP. If the AP isnot a
D-Link Access Point, some values are unknown.

To view additional data (beacon information) for an AP in the failurelist, you can search for

the MAC address of the failed AP on the Rogue/RF Scan page. However, some APs that
attempt to contact the switch on the wired network might not be detected during the RF scan.

Table 39. Access Point Authentication Failure Satus

Field Description

MAC Address The Ethernet address of the AP.

IP Address The network |P address of the AP.

Last Failure Type Indicates the last type of failure that occurred.

Vendor ID Vendor of the AP software.

Validation Failures The count of association failures for this AP.

Authentication Failures The count of authentication failures for this AP.

Protocol Version Indicates the protocol version supported by the software on the
AP,

Software Version Indicates the version of software onthe AP,

Hardware Type Hardware platform for the AP.

Age Time in seconds since failure occurred.

Monitoring Rogue and RF Scan Access Points

Theradios on each D-Link Access Point can periodically scan the radio frequency to collect
information about other APs and wireless clients that are within range. In normal operating
mode the AP always scans on the operational channel for the radio. Two other scan modes are
available for each radio on the APs:

e Scan Other Channels—Configuresthe AP to periodically leave its operational channel
and scan other channels within that frequency.

» Scan Sentry—Disables normal operation of the radio and performs a continuous radio
scan. In this mode, no beacons are sent, and no clients are allowed to associate with the
AP,

When Scan Other Channels or Scan Sentry modes are enabled, the AP scans all available
channels on each radio. When the scan is complete, the AP sends information it collected
during the RF scan to the switch that manages it. For information about how to configure the
scan mode, see “ Configuring Wireless Radio Settings’ on page 87.

The D-Link Unified Switch considers an access point to be a Rogue if is detected during the
RF scan process and the MA C address of the detected AP isnot in thelocal or RADIUS Valid
AP database or if the AP is not managed by a peer switch.

From the Monitoring > Access Points > Rogue/RF Scan Access Points page, you can view
information about all APs detected via RF scan, including those reported as Rogues.

You can sort the APs in the list based any of the column headings. For example, to group all
Rogue APs together, click Status.
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Status entries in the RF Scan list are collected at a point in time and eventually age out. The
age value for each entry shows how long ago the switch recorded the entry. You can configure
the age out time for status entries on the Administration > Advanced Configuration >
Global page. You can also manually delete status entries. To clear al APsfrom the RF scan
lit, click Delete All.

To configure a Rogue AP to be managed by the switch the next timeit is discovered, select the
check box next to the MAC address of adetected AP and click Manage. You will be presented
with the Valid Access Point Configuration page. You can then configure the AP and click
Submit to savethe AP in the local Valid AP database. If you use a RADIUS server for AP
validation, you must add the MAC address of the AP to the AP database on the RADIUS
server. For more information, see Appendix B, “ Configuring the External RADIUS Server” on
page 207.

Figure64. RF Scan
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Access Point RF Scan Status

MAC Address SSID Physical Mode Channel Status Age
[100:00:bc:00:12:60 ST-WS-AP5g 802.11a 64 Rogue 0d:01:15:54
[100:02:bc:00:12:00 Broadcom VAP 802.11g 1 Rogue 0d:02:56:14
[100:02:bc:00:12:50 ST-WS-AP3a 802.11a 161 Rogue 0d:00:00:23

00: c: 0 :80 ST-WS-AP4a 802.11a 161 Rogue 0d:00:00:23

2 ST-WS-AP2g 802.11a 64 Rogue 0d:01:31:23

0 ST-WS-AP2a 802.11a 161 Acknowledged Rogue 0d:00:00:23
[100:02:bc:00:13:10 WMetrics-Test 802.11a 56 Rogue 0d:00:58:24
[100:02:bc:00:13:70 Metrics-Test 802.11a 153 Rogue 0d:01:41:31
[100:02:bc:00:13:a0 Metrics-Test 802.11a 153 Rogue 0d:01:12:58
[100:02:bc:00:13:b8 Wetrics-Test 802.11a 56 Rogue 0d:00:21:54
[]00: c:0i 30 WMetrics-Test 802.11a 56 Rogue 0d:00:01:53
[100:02:bc:00:14:60 Wetrics-Test 802.11a 56 Rogue 0d:00:21:54
[100:02:bc:00:14:90 WMetrics-Test 802.11a 56 Rogue 0d:01:26:58
[100:02:bc:00:14:a8 Metrics-Test 802.11a 153 Rogue 0d:00:15:53

A ;i HSHI VAPBRCM 802.11g 1 Rogue 0d:00:00:23
Guest Network 802.11a 44 Rogue 0d:00:34:53

Metrics-Test 802.11a 56 Rogue 0d:00:20:23

[100:02:bc:00:15:90 Metrics-Test 802.11a 56 Rogue 0d:01:18:53
[100:02:bc:00:16:58 WMetrics-Test 802.11g 1 Rogue 0d:02:18:09
[100:02:bc:00:16:60 Metrics-Test 802.11a 1583 Rogue 0d:00:14:23

12345
[ Delete All ][ Manage ][ Acknowledge ][ UnAcknowledge ][ Refresh ]

To identify an AP as an acknowledge rogue, select the check box next to the MAC address of
the AP and click Acknowledge. The switch adds the AP to the Valid AP database as an
Acknowledged Rogue. To identify an AP as arogue (again), select the check box next to the
MAC address of the acknowledged AP and click UnAcknowledge. The switch deletes the AP
from the Valid AP database.

When you manage or acknowledge a rogue AP, the switch adds an entry to the valid AP
database but does not change the entry on the RF Scan Status page. However, the next time the
switch discoversthe AR, its entry in the RF Scan Status list will be handled based on the
change.

To view additional information about the detected AP, click the MAC address of the AP,

The detailed status for access points detected during the RF scan shows the information on the

summary page plus some additional information learned from the beacon frame, such as
transmission rate.

The following table shows the information the Access Point RF Scan Status page shows for an
individual access point.
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Table 40. Access Point RF Scan Status

Field Description

MAC Address The Ethernet MAC address of the detected AP, this could be a physical radio
interface or VAP MAC. For D-Link Access Pointsthisis always a VAP
MAC address.

SSID Service Set ID of the network, thisis broadcast in detected beacon frame.

Physical Mode Indicates the 802.11 mode being used on the AP.

Channe Transmit channel of the AP.

Satus Indicates the managed status of the AP, whether thisisavalid AP known to

the switch or a Rogue on the network. The valid values are:

« WS Managed - The neighbor AP is managed by this switch, the
neighbor AP status can be referenced using its base MAC address.

e Peer WS Managed - The neighbor AP is managed by another switch
within the peer group.

¢ Acknowledged Rogue - The AP is configured asavalid AP entry (local
or RADIUYS), it has been acknowledged and is not reported as Rogue.

¢ AdHoc Rogue - The AP neighbor was detected participating in an ad
hoc network.

Transmit Rate

Indicates the rate at which the AP is currently transmitting data.

Beacon Interval

Beacon interval for the neighbor AP network.

Discovered Age

Time in seconds since this AP was first detected in an RF scan.

Age

Time in seconds since this AP was |ast detected in an RF scan.

Monitoring Associated Client Information

You can view avariety of information about the wireless clients that are associated with the
APs the switch manages. To access the associated client information, click M onitoring >

Client > Associated Clients.

Figure 65. Associated Client Status

I 5510 Status | VAP Status | Statistics

Associated Client Status

MAC AP MAC P Encryption
Address Address 551D Address Location Channel Radio Protocol Status
|:| 00:01:01:10:01:01 00:01:01:02:01:01 [Metwiorks 1921681012 Testlabh B 802118 Open System Azzocisted

|:| 00:01:01:14:01:00 00:01:01:02:01:01 [Metworks 1921681015 Testlabh B 802118 Open System Authenticated

Thefollowing tabs are available:

Monitoring Associated Client Information

145



D-Link Unified Access System User Manual

146

»  Satus—Shows status information about wireless clients that are associated with APs
managed by the switch and contains the following information:

Summary—Shows basic information about associated clients.

Detail—Shows more detailed information about associated clients, such as which
VLAN the client is assigned to and how long the client has been inactive.

Neighbor APs—Shows the managed APs that are within range of the wireless clients,
which can help you determine the managed AP an associated client might use for
roaming.

» SSID Satus—Showsthe SSID and client MAC address of al clients connected to
specific networks.

* VAP Satus—Showsthe clients associated with a specific VAP on aD-Link Access Point

»  Satistics—Shows statistics about wireless clients that are associated with APs managed
by the switch and contains the following information:

Association Summary—Shows the statistics for awireless client whileit is associated
with asingle AP.

Session Summary—If awireless client roams among different managed APs, the
switch can track the statistics for the entire session.

Association Detail—Shows additional information about packets the associated client
transmits and receives during association with a single managed AP.

Session Detail—Shows additional information about packets the associated client
transmits and receives during a session, which can include statistics for one or more
managed AP associations if the client has roamed.

Since the associated client database supports roaming across APs, an entry is not removed
when a client disassociates from a specific AP. After a client has disassociated the entry is
deleted after the client times out. You configure the timeout valuein the Client Roam Timeout
field onthe WLAN > Administration > Advanced Configuration > Global page. The
timeout value corresponds to the time allowed for roaming to another managed AP.

Viewing Associated Client Status

Table 41 describes the information available on the Summary page for the associated client

status.

Table 41. Associated Client Satus Summary

Field

Description

MAC Address The Ethernet address of client station.

AP MAC Address  The Ethernet MAC address of the AP that the client is associated with.

SSID

Indicates the network on which the client is connected.

Tunnel IP Address  If theclientisusing an L3 Tunnel, this field shows the I P address of the

client. Otherwise, thisfield is blank.

L ocation The location of the AP that the client is associated with. The AP locationis
configured in the Valid AP database.

Channd Indicates the operating channel for the client association.

Radio The mode of the radio that the wireless client is using.
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Table 41. Associated Client Satus Summary

Field Description

Encryption The security that the wireless client is using to connect to the WLAN.
Protocol

Satus Indicates whether or not the client has associated and/or authenticated. The

valid values are:

e Associated - Theclient is current associated to the managed AP.

« Authenticated - The client is currently associated and authenticated to
the managed AP.

« Disassociated - The client has disassociated from the managed AP, if the
client does not roam to another managed AP within the client roam
timeout, it will be deleted.

Viewing Detailed Associated Client Status

For each client associated with an AP that the switch manages, you can view detailed status
information about the client and its association with the access point.

Table 42 describes the information available on the Detail page for the associated client status.
Table 42. Detailed Associated Client Satus

Field Description

MAC Address The Ethernet address of client station. To view details about a different
client, select its MAC address from the drop-down menu.

SSID Indicates the network on which the client is connected.

AP MAC Address  MAC address of the AP to which this client is associated.

BSSID Indicates the Ethernet MAC address for the managed AP VAP where this
client is associated.

Location Location of the AP to which this client is associated.

Satus Indicates whether or not the client has associated and/or authenticated. The
valid values are:

e Associated - Theclient is current associated to the managed AP.

« Authenticated - The client is currently associated and authenticated to
the managed AP.

« Disassociated - The client has disassociated from the managed AP, if the
client does not roam to another managed AP within the client roam
timeout, it will be deleted.

Radio Indicates the radio on which the client is associated.

Channe Indicates the operating channel for the client association.

VLAN If clientison a VAP using VLAN data forwarding mode, indicates the
current assigned VLAN.

User Name Indicates the user name of client that have authenticated via 802.1X, clients

on networks with other security modes will not have a user name.

Transmit Data
Rate

Indicates the rate at which the client station is currently transmitting data.
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Table 42. Detailed Associated Client Satus

Field Description

Inactive Period For current association, period of time that the AP has not seen any traffic for
the client.

Age Indicates the time in seconds since the switch has received new association

datafor this client.

Tunné IP Address  Thisfield isblank for al non-tunneled clients. For atunneled client, thisis
the assigned tunnel IP address.

Captive Portal Thisfield appears only if the wireless client has accessed the network
through a captive portal and has been authenticated by the switch.

To view additional information about the client’s captive portal connection,
click “Authenticated,” which linksto the detailed client information
accessible from the Captive Portal > Client Connection Status page.

Viewing Associated Client Neighbor AP Status

The Neighbor AP page for the associated client status shows information about access points

that the client detects. The information on this page can help you determine the managed AP
an associated client might use for roaming.

Table 43 describes the information available on the Neighbor AP page for the associated
client status.

Table 43. Associated Client Neighbor AP Status

Field Description

MAC Address Shows the MAC address of the client to which the values on the page apply.
(Drop-down Menu)  To view details about a different associated client, select its MAC address
from the drop-down menu.

AP MAC Address  The base Ethernet address of the Unified Switch-managed AP.

Location The configured descriptive location for the managed AP
Radio Theradio interface and its configured mode that detected this client asa
neighbor.

Discovery Reason Indicates one or more discovery methods for the neighbor client. One or
more of the following values may be displayed:

* RF Scan - The client was reported from an RF scan on the radio. Note
that client stations are difficult to detect via RF scan, the other methods
are more common for client neighbor detection.

¢ Probe Request - The managed AP received a probe request from the
client.

* Associated to Managed AP- This neighbor client is associated to another
managed AP.

e Associated to thisAP - The client is associated to this managed AP on
the displayed radio.

e Associated to Peer AP - The client is associated to an AP managed by a
peer switch.

« AdHoc Rogue - The client was detected as part of an ad hoc network
with this AP.
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Viewing Associated Client SSID Status

Each managed AP can have up to 16 different networks that each have a unique SSID.
Although severa wireless clients might be connected to the same physical AP, they might not
connect by using the same SSID. The SSID Status page lists the SSIDs of the networks that
each wireless client associated with a managed AP has used for WLAN access.

Table 44. Associated Client SSID Satus

Field Description

SSID Indicates the network on which the client is connected.

MAC Address The Ethernet address of client station.

Channd Indicates the operating channel for the client association.

Satus Indicates whether or not the client has associated and/or authenticated. The

valid values are:

e Associated - Theclient is current associated to the managed AP.

« Authenticated - The client is currently associated and authenticated to
the managed AP.

« Disassociated - The client has disassociated from the managed AP, if the
client does not roam to another managed AP within the client roam
timeout, it will be deleted.

Viewing Associated Client VAP Status

Each AP has 8 Virtual Access Points (VAPs) per radio, and every VAP has a unique MAC
address (BSSID). The VAP Associated Client Status page shows information about the VAPs
on the managed AP that have associated wireless clients.

Table 45. Associated Client VAP Satus

Field Description

BSSID Indicates the Ethernet MAC address for the managed AP VAP where this
client is associated.

SSID The SSID the client is using to connect to the WLAN.

AP MAC Address  Thisfield indicates the base AP Ethernet MAC address for the managed AP.

Location The descriptive location configured for the managed AP.

Radio Displays the managed AP radio interface the client is associated to and its
configured mode.

Client MAC The Ethernet address of client station.

Address

Client IP Address Shows the |P address of the client associated with the VAP,

Viewing Associated Client Statistics

A wireless client can roam among APs without interruption in WLAN service. The D-Link

Unified Switch tracks the traffic the client sends and receives during the entire wirel ess session
while the client roams among APs that the switch manages. The switch stores stati stics about
client traffic while it is associated with asingle AP aswell as throughout the roaming session.
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The statistics on the Association Summary page show information about the traffic awireless
client receives and transmits while it is associated with asingle AP.

Table 46. Associated Client Association Summary Statistics

Field Description

MAC Address The Ethernet address of client station.
Packets Received Packets received from the client station.
Bytes Received Bytesreceived from the client station.
Packets Transmitted Packets transmitted to the client station.
Bytes Transmitted Bytes transmitted to the client station.

The statistics on the Session Summary page show information about the traffic awireless

client receives and transmits while it is connected to the same WLAN network shared by APs
that the switch manages.

If the client roams from one AP to another AP but remains connected to the same network, the
session continues and the session statistics continue to accumulate. If the client closes the
wireless connection or roams out of the range of an AP managed by the switch, the session
ends.

Table 47. Associated Client Summary Statistics

Field Description

MAC Address The Ethernet address of client station.
Packets Received Packets received from the client station.
Bytes Received Total bytes received from the client station.
Packets Transmitted Total packets transmitted to the client station.
Bytes Transmitted Total bytes transmitted to the client station.

The statistics on the Association Detail page show information about the traffic awireless
client receives and transmits while it is associated with asingle AP.

Table 48. Associated Client Association Detail Statistics

Field Description

MAC Address Shows the MAC address of the client to which the values on the

(Drop-down Menu) page apply. To view details about a different associated client,
select its MAC address from the drop-down menu.

Packets Received Total packets received from the client station.

Bytes Received Total bytes received from the client station.

Packets Transmitted Total packets transmitted to the client station.

Bytes Transmitted Total bytes transmitted to the client station.

Fragments Received Total fragmented packets received from the client station.

Fragments Transmitted Total fragmented packets transmitted to the client station.

Transmit Retries Number of times transmits to client station succeeded after one

or moreretries.
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Table 48. Associated Client Association Detail Satistics

Field Description
Transmit Retries Failed

Number of times transmits to client station failed after one or
more retries.

Duplicates Received Total duplicate packets received from the client station.

The statistics on the Session Detail page show information about the traffic a wireless client

receives and transmits while it is connected to the same WLAN network shared by APs that
the switch manages.

Table 49. Associated Client Session Detail Satistics

Field

Description

MAC Address
(Drop-down Menu)

Shows the MAC address of the client to which the values on the
page apply. To view details about a different associated client,
select its MAC address from the drop-down menu.

Packets Received

Total packets received from the client station.

Bytes Received

Total bytes received from the client station.

Packets Transmitted

Total packets transmitted to the client station.

Bytes Transmitted

Total bytes transmitted to the client station.

Fragments Received

Total fragmented packets received from the client station.

Fragments Transmitted

Total fragmented packets transmitted to the client station.

Transmit Retries

Number of times transmits to client station succeeded after one
or moreretries.

Transmit Retries Failed

Number of times transmits to client station failed after one or
more retries.

Duplicates Received

Total duplicate packets received from the client station.

Viewing Client Authentication Failure Status

Wireless clientsthat fail to associate or authenticate with an AP appear in the client failure list
along with the number of failed attempts. The client might have security or authentication
information that does not match the settings on the AP.

Status entries for failed clients are collected at a point in time and eventually age out. The age
value for each entry shows how long ago the switch recorded the entry. You can configure the
age out time for status entries on the Administration > Advanced Configuration > Global
page. You can also manually delete status entries.
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To view alist of clients that fail to associate or authenticate with the a D-Link Access Point,
click the Failed Clients page.

Figure66. Client Authentication Failure Status

Client Failure Status
MAC Address BSSID SSID Last Failure Type Age
O 000121180101 00:01:01:02:02:02 Metwork?2  Authentication 15h44m:57s
O 000132180101 00:01:01:02:01:03 Metwork3  Association 15h44m:57s
L ; [ Denmy MAC ][ Fefresh ]

To delete dl clients from the list, click Delete All.

To block afailed client from WLAN access, select the check box next to the MAC address of
the client and click Deny MAC. The MAC addressis added to the MA C Authentication Deny
MAC List for all AP Profiles where the default action is Deny. To add the client to the MAC
Authentication Allow MAC List for all profiles where the default action is Allow, select the
client and click Allow MAC. You must re-apply the AP profiles in order for the changesto be
applied to the APs.

NOTE: If the Deny MAC button is not available, it means all profiles use Allow as
the default MAC Authentication action. Likewise, if the Allow M AC button
is not available, no profiles have an Allow default action.

NOTE: If you use RADIUS for MAC authentication in one or more AP profiles, you
must add the MAC Addressto the RADIUS database.

Table 50 shows the fields on the summary page for failed client status.
Table 50. Failed Client Satus

Field Description

MAC Address The Ethernet address of the client.

BSSID The managed AP VAP Ethernet MAC address on which the
client attempted to associate and/or authenticate.

SSID The network SSID on which client attempted to associate and/
or authenticate.

Last Failure Type Indicates the last type of failure that occurred, which can be

Authentication or Association.

Age Time since failure occurred.

Click the MAC address of the failed client to view additiona information about a client.

NOTE: If awrong password is entered on a client for WEP, this page may not list that
authentication failed client. This issue actually arises from aknown problem
with the IEEE 802.11 specification. The specification says that if the AP is
unable to decode the third frame (containing the encrypted challenge text), it
should send an unsuccessful result. However, if the AP is unable to decode a
WEP frame, it does not know whether that frame is actually the third frame,
or even a Shared Key frame at all, and does not send a result. Thisissue only
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appliesto WEP (which is not recommended due to security issues) that uses
Shared Key authentication when the key isincorrect.

The client authentication failure status for an individual client shows information about the
client that failed to authenticate or associate with an AP and list the number of authentication
or association failures. A client with a high number of failed authentications might indicate a
possible threat to the WLAN.

Table 51 shows the fields on the detail page for Client Authentication Failure Status.

Table 51. Client Authentication Failure Satus

Field Description

MAC Address The Ethernet address of the client.

BSSID The managed AP VAP Ethernet MAC address on which the
client attempted to associate and/or authenticate.

SSID The network SSID on which client attempted to associate and/

or authenticate.

Last Failure Type Indicates the last type of failure that occurred, which can be
Authentication or Association.

Authentication Failure Count Count of authentication failuresfor this client.

Association Failure Count Count of association failuresfor this client.

Age Time since failure occurred.

Monitoring and Managing Ad Hoc Clients

An ad hoc client isawireless client that gains access to the WLAN through awireless client
that is associated with an access point. The ad hoc client does not communicate directly with
the AP. Ad hoc networks are a particular concern because they consume RF bandwidth and
can present a security risk.

Status entries for ad hoc clients are collected at a point in time and eventually age out. The age
value for each entry shows how long ago the switch recorded the entry. You can configure the
age out time for status entries on the Administration > Advanced Configuration > Global
page. You can also manually delete status entries.

From the Monitoring > Client > Ad Hoc Clients page, you can view and manage wireless
clients that are connected to the WLAN through an ad hoc network.

Figure67. Ad Hoc Clients

Ad Hoc Client Status
MAC Address AP MAC Address Location Radio Detection Mode Age
O 00:01:01:30:01:01  00:01:01:02:01:01 1 EBeacon Frame 15h45m:21s
O 00:01:01:4201:01 00:01:01:.02:03:01 1 EBeacon Frame 15h:45m:21s
0 000101450101 000101020101 1 Eeacon Frame 15h45m:21s
AL [ Deny MAC ][ Fefresh ]
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To delete the ad hoc client entries from the list, click Delete All. The status list is cleared on
the switch.

NOTE: Clearing the list does not disassociate any of the ad hoc clients, and the clients
might still be involved in the ad hoc network.

If you want to block an ad hoc client from WLAN access, select the check box next to the
MAC address of the client and click Deny MAC. The MAC address is added to the MAC
Deny Listin the AP Profile MAC Authentication settings. If you select the check box and
click Allow MAC, the MAC addressis added to the Allow MAC List in the AP Profile MAC
Authentication settings.

NOTE: The MAC addressis added to the local MAC authentication list for al pro-
fileswhere the global default action is set to allow (for Allow MAC), or deny
(for Deny MAC). If you use RADIUS for MAC authentication in one or more
AP profiles, you must add the MAC to the RADIUS database.

Each AP profile has one global MAC authentication list which is either alist to deny accessto
all MAC addresses on the list or to alow accessto all MAC addresses on the list. To sethe
mode for the default AP Profile, click the Administration > Basic Setup > AAA/RADIUS
tab. Set the MAC Authentication Default Action field to Allow or Deny all MAC Addressesin
thelist. To set the mode for adifferent AP profile go to the Global tab on the AP Profile to
configure.

The switch does not remove MAC entries from this list even when a client successfully
authenticates with an AP. The historical ad hoc data gives you more time to take action against
clients that establish ad hoc networks on the WLAN.

Table 52. Ad Hoc Client Satus

Field Description

MAC Address The Ethernet address of the client. If the Detection Mode is Beacon then the
client is represented as an AP in the RF Scan database and the Neighbor AP
List. If the Detection Modeis Data Frame then the client information isin the
Neighbor Client List.

AP MAC Address  The base Ethernet MAC Address of the managed AP which detected the

client.
Location The configured descriptive location for the managed AP.
Radio The radio interface and its configured mode that detected the ad hoc device.

Detection M ode The mechanism of detecting this Ad Hoc device. The possible values are
Beacon Frame or Data Frame.

Age Time in seconds since last detection of the ad hoc network.
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Configuring Advanced Settings

This chapter contains the following sectionsto help you configure your D-Link Unified
Access System network:

» Creating, Configuring, and Managing AP Profiles
» Configuring Global Settings

» Enabling SNMP Traps

» Configuring QoS

Creating, Configuring, and Managing AP Profiles

Access point configuration profiles are a useful feature for large wireless networks with APs
that serve avariety of different users. You can create multiple AP profiles on the D-Link
Unified Switch to customize APs based on location, function, or other criteria. Profilesarelike

templates., and once you create an AP profile, you can apply that profile to any AP that the
Unified Switch manages.

For each AP profile, you can configure the following features:

* Global RADIUS settings
*  MAC authentication list
» Radio settings

* Network settings

* QoS configuration

Figure 68 shows ten APs that are managed by a D-Link Unified Switch in a campus network.
Each building has multiple APs, and the usersin one building have different network
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requirements than the usersin other buildings. The administrator of this WLAN has created
two AP profiles on the switch in addition to the default profile.

Figure68. Multiple AP Profiles

Buildng 1 Thes Y hont

AP Profile: Default &=

Building 2
AP Profile: Engineering

Building 3
AP Profile: Marketing i,

Building 1 contains the main lobby and several conference rooms. The WLAN usersin this
location are primarily non-employees and guests. The APs in Building 1 uses the default AP
profile with no additional networks and no security.

Building 2 isthe engineering building. The Building 2 APs use a profile called “ Engineering.”
The Engineering profile has three different VAPs that each have a unique SSID: Hardware,
Software and Test.

Building 3 isthe Sales and Marketing building. The Building 3 AP uses a profile called
“Marketing.” The Marketing AP Profile has three VAPs. The SSIDs for the VAPs are: Sales,
Marketing, and Program Management.

If the network administrator adds another AP to Building 2, she assigns the Engineering
profile to the AP during the AP validation process.
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8 Configuring Advanced Settings

Creating, Copying, and Deleting AP Profiles

From the Access Point Profile Summary page, you can create, copy, or delete AP profiles.
You can create up to 16 AP Profiles on the D-Link Unified Switch. To create anew profile,
enter the name of the profile in the Profile Name field, and then click Add.

Figure 69. Adding a Profile

I Default|
Access Point Profile Summary

Profile Profile Status
[1-Default Associated

Building B | A

After you add the profile, the Global Configuration page for the profile appears, and a new
tab with the name of the profile appears athe top of the page. Click the Radio, VAP, or QoS
tabsto configure additional features for the profile.

Figure 70 shows the layout for AP Profile configuration.

Figure 70. Configuring an AP Profile

Profiles

/\ Profile Configuration Pages
Summaryl D@( |

U clobal | Radic | sSID| QosP

Access Point Profile Global Configuration

AP Profile 2-Building B

RADIUS MAC Authentication
IP Address | Default Action & Allow O Deny
Secret | [l Edit Deny MAC List <empty list=

Accounting [

Profile Name |Building B

MAC Address | |

Delete ][ Fefresh ][ Submit ]

To copy an existing profile and all of its configurationsto a new profile, select the profile with
the configuration to copy, enter aname for the new profile, and click Copy.
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To delete aprofile, select the profile and click Delete.

NOTE: You cannot delete aprofile if the switch is managing an access point that is
currently using that profile.

To access an existing profile, click the tab with the name of the profile. When you add a new
profile, it has the default AP settings, which are listed in Appendix A. When you copy a
profile, it has the AP settings configured in the original profile.

To modify any settings within a profile, click the Global, Radio, Network or QoS settings for
the profile you select and update the appropriate fields.

For more information about the fields on the Global page, see “Configuring AAA and
RADIUS Settings’ on page 85.

For more information about the fields on the Radio page, see “ Configuring Wireless Radio
Settings” on page 87.

For more information about the fields on the Network page, see “Configuring SSID Settings’
on page 93.

For more information about the fields on the QoS page, see “Configuring QoS” on page 163.

Applying an AP Profile

After you update an AP Profile on the Unified Switch, the changes are not applied to the
access points that use that profile until you explicitly apply the profile on the Access Point
Profile Summary page or reset the APs that use the profile.

NOTE: When you change the VLAN ID for awireless network, the AP might
temporary lose its DHCP-assigned | P address when you apply the updated
profile. If this occurs, the AP goes into Standalone mode. As soon asthe AP
regainsits | P address from the DHCP server on your network, it resumes
normal operation as amanaged AP. You might also see this behavior when
you enable or disable a VAP (SSID) and re-apply the AP profile.

To apply the profile changes to all access points that use a profile, select the profile and click
Apply, as Figure 71 shows.

Figure71. Applyingthe AP Profile

158

I Defaultl Marketing I Engineering
Access Point Profile Summary
Frofiie Profile Status
[11-Defaul Associated
[¥]2-Marketing Configured
[3-Epginesring Configured
Delete quly Fefresh

Selected Profile to Apply
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NOTE: When you apply new AP Profile settings to an AP, the access point stops and
restarts system processes. If this happens, wireless clients will temporarily
lose connectivity. We recommend that you change access point settings when

WLAN trafficislow.

The Profile Status field can have one of the following values:

8 Configuring Advanced Settings

» Associated—The profileis configured, and one or more APs managed by the switch are

associated with this profile.

» Associated-M odified—The profile has been modified since it was applied to one or more
associated APs; the profile must be re-applied for the changes to take effect.
* Apply Requested—After you select a profile and click Apply, the screen refreshes and

shows that an apply has been requested.

* Apply In Progress—The profileisbeing applied to all APsthat use this profile. During
this process the APs reset, and all wireless clients are disassociated from the AP,
» Configured—The profile is configured, but no APs managed by the switch currently use

this profile.

NOTE: You associate a profile with an AP in the Valid AP database.

Configuring Global Settings

Thefields on the Administration > Advanced Configuration > Global > General tab are

settings that apply to the D-Link Unified Switch.

Figure72. Global Configuration
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Table 53 describes the fields on the Wireless Global Configuration page.
Table 53. General Global Configurations

Field Description

Peer Group ID In order to support larger networks, you can configure Unified Switches as
peers, with up to 4 switchesin a peer group. Peer Unified Switches share
some information about APs and allow L3 roaming among them.
Peer Unified Switches are grouped according to the Group ID.

Client Roam This value determines how long to keep an entry in the Associated Client

Timeout Status list after a client has disassociated. Each entry in the status list shows
an age, and when the age reaches the value you configure in the timeout field,
the entry is deleted.

Ad Hoc Client This value determines how long to keep an entry in the Ad Hoc Client Status

Satus list. Each entry in the status list shows an age, and when the age reaches the

value you configure in the timeout field, the entry is deleted.

AP Failure Satus

This value determines how long to keep an entry in the AP Authentication
Failure Status list. Each entry in the status list shows an age, and when the
age reaches the value you configure in the timeout field, the entry is del eted.

Client Failure

This value determines how long to keep an entry in the Client Authentication

Satus Failure Status list. Each entry in the status list shows an age, and when the
age reaches the value you configure in the timeout field, the entry is deleted.

RF Scan Satus This value determines how long to keep an entry in the RF Scan Status list.
Each entry in the status list shows an age, and when the age reaches the value
you configure in the timeout field, the entry is deleted.

Tunnd IPMTU Sets the maximum size of the | P packet handled by the network. The MTU is

Size enforced only on tunneled VAPs. Select one of the following values:

e 1500: Mapsthe tunneled IP frame size to 1518 bytes (untagged) and
1522 bytes (tagged). Use this setting if your network does not support
jumbo frames. Using 1500 asthe Tunnel IP MTU size forces the D-Link
Unified Access System to limit its maximum message size to 1518/1522
bytes. This setting directs the wireless system to mitigate the problem of
oversized frames by enabling the MTU discovery protocol and limiting
the maximum segment size in TCP connection setup messages.

e 1520: Mapsthe tunneled IP frame size to 1538 bytes (untagged) and
1542 bytes (tagged). Use this setting if your network supports jumbo
frames and you have configured the physical ports between the switch
and the APs to support 1538/1542 byte packets.

I P Packets that use the L3 tunnel have an extra 20 bytesin the header for
encapsulation. This means that wireless clients configured with a 1500 byte
IPMTU size may exceed the maximum MTU size of the existing network
infrastructure if it is set up to switch and route 1518 (1522-tagged) byte
frames.

Setting the Network MTU Size to 1500 or 1520 does not affect physical port
MTU size. The physical ports on the switch and the rest of the network
devices must be configured with the appropriate MTU size.

NOTE: If the AP is not connected directly to the wireless switch and the
Tunnel IPMTU Sizeis set to 1520, any Ethernet segmentsin the path
between the AP and the wireless switch must support jumbo frames and be
configured for jumbo frames.
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Enabling SNMP Traps

If you use Simple Network Management Protocol (SNMP) to manage the D-Link Unified
Switch, you can configure the SNMP agent on the switch to send traps to the SNM P manager
on your network from the Administration > Advanced Configuration > Global > SNMP
Trapstab.

Figure 73. SNMP Trap Configuration

| General |
AP Failure Traps Enable «
AP State Change Traps Enable ~
Client Failure Traps Enable
Client State Change Traps Disable ~
Peer Switch Traps Enable «
RF Scan Traps Disable «
Rogue AP Traps Disable |
Wireless Status Traps Disable ~

The AP does not send out any traps. The switch generates all SNMP traps based on its own
events and events it learns about through updates from the APs it manages.

Table 54 describes the events that generate SNMP traps. All traps are disabled by default.
Table 54. SNMP Traps

Field Description

AP Failure Traps If you enable thisfield, the SNMP agent sends atrap if an AP failsto
associate or authenticate with the switch.

AP Sate Change If you enable thisfield, the SNMP agent sends atrap for one of the following
Traps reasons.

*  Managed AP Discovered

e Managed AP Failed

e Managed AP Unknown Protocol Discovered

* Managed AP Load Balancing Utilization Exceeded

Client Failure If you enablethisfield, the SNMP agent sends atrap if awirelessclient fails
Traps to associate or authenticate with an AP that is managed by the switch.
Client Sate If you enable thisfield, the SNMP agent sends atrap for one of the following
Change Traps reasons associated with the wireless client:

¢ Client Association Detected
¢ Client Disassociation Detected
¢ Client Roam Detected

Enabling SNMP Traps 161



D-Link Unified Access System User Manual

162

Table 54. SNMP Traps

Field

Description

Peer Switch Traps

If you enablethisfield, the SNMP agent sends atrap for one of the following
reasons associated with a peer switch:

¢ Peer Unified Switch Discovered

e Peer Unified Switch Failed
¢ Peer Unified Switch Unknown Protocol Discovered

RF Scan Traps

If you enable thisfield, the SNMP agent sends a trap when the RF scan
detects anew AP, wireless client, or ad-hoc client.

Rogue AP Traps

If you enable thisfield, the SNMP agent sends a trap when the switch
discoversarogue AP,

Wireless Satus
Traps

If you enable this field, the SNMP agent sends atrap if the operational status
of the D-Link Unified Switch changes or of any of the following databases or
lists has reached the maximum number of entries:

¢ Managed AP database

AP Neighbor List

¢ Client Neighbor List

¢ AP Authentication Failure List

* RFScan APList

¢ Client Association Database

¢ Client Authentication Failure List

Client
Authentication
Trap

If you enable thisfield, the SNMP agent sends a trap when awireless client
authenticates successfully to the network through a captive portal.
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8 Configuring Advanced Settings

Configuring QoS

Quality of Service (QoS) provides you with the ability to specify parameters on multiple
gueues for increased throughput and better performance of differentiated wireless traffic like
Voice-over-1P (Vol P), other types of audio, video, and streaming media as well as traditional
IP data over the D-Link Unified Access System.

For detailed information about QoS and how it is used in the D-Link Unified Access System,
see Appendix D, “Understanding Quality of Service” on page 229.

Figure 74. QoS Configuration
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AP EDCA Parameters
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Station EDCA Parameters
Queue AIFS cwMin cwlMax TXOP Limit

Data 0 (Voice) 12 | 3 msecs b 7 msecs G ffi?
Data 1 (Video) 2 1 7 msecs b 15 msecs e 34
Data 2 (Best Effort) I3 | 15 msecs b B3 msecs v :D
Data 3 (Background) ?' 15 msecs b 1023 msecs v ID

Configuring QoS on the D-Link Unified Access System consists of setting parameters on
existing queues for different types of wireless traffic, and effectively specifying minimum and
maximum wait times (through Contention Windows) for transmission. The settings described
here apply to data transmission behavior on the access point only, not to that of the client
stations.

AP Enhanced Distributed Channel Access (EDCA) Parameters affect traffic flowing from the
access point to the client station. Station Enhanced Distributed Channel Access (EDCA)
Parameters affect traffic flowing from the client station to the access point.

NOTE: QoSis configured per radio interface.
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Table 55 describes the QoS settings you can configure.
Table 55. QoS Settings

Field Description

Queue Queues are defined for different types of data transmitted from AP-to-
station:
Data 0 (Voice)

High priority queue, minimum delay. Time-sensitive data such as Vol P
and streaming media are automatically sent to this queue.

Data 1(Video)

High priority queue, minimum delay. Time-sensitive video datais
automatically sent to this queue.

Data 2 (best effort)

Medium priority queue, medium throughput and delay. Most traditional
IP datais sent to this queue.

Data 3 (Background)

Lowest priority queue, high throughput. Bulk datathat requires
maximum throughput and is not time-sensitive is sent to this queue
(FTP data, for example).

AIFS The Arbitration I nter-Frame Spacing (Al FS) specifiesawait time (in
(Inter-Frame Space) milliseconds) for data frames.

Valid values for AIFS are 1 through 255.

cwMin This parameter isinput to the agorithm that determines the initial
(Minimum Contention  random backoff wait time ("window") for retry of atransmission.

Window) The value specified here in the Minimum Contention Window is the

upper limit (in milliseconds) of arange from which theinitial random
backoff wait time is determined.

The first random number generated will be a number between 0 and the
number specified here.

If the first random backoff wait time expires before the dataframeis
sent, aretry counter isincremented and the random backoff value
(window) is doubled. Doubling will continue until the size of the
random backoff value reaches the number defined in the Maximum
Contention Window.

Valid valuesfor the“cwm n” arel, 3, 7, 15, 31, 63, 127, 255, 511, or
1023. The value for “cwmi n” must be lower than the value for “cwrax”.

cwM ax The value specified here in the Maximum Contention Window isthe

(Maximum Contention  upper limit (in milliseconds) for the doubling of the random backoff

Window) value. This doubling continues until either the data frameis sent or the
Maximum Contention Window size is reached.

Once the Maximum Contention Window size is reached, retries will
continue until a maximum number of retries allowed is reached.

Valid valuesfor the“cwmax” are 1, 3, 7, 15, 31, 63, 127, 255, 511, or
1023. The value for “cwmax” must be higher than the value for
“cwmin”.
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8 Configuring Advanced Settings

Field

Description

Max. Burst Length

AP EDCA Parameter Only (The Max. Burst Length applies only to
traffic flowing from the access point to the client station.)

This value specifies (in milliseconds) the Maximum Burst Length
allowed for packet bursts on the wireless network. A packet burstisa
collection of multiple frames transmitted without header information.
The decreased overhead results in higher throughput and better
performance.

Valid values for maximum burst length are 0 through 999.

WMM Mode

Wi-Fi MultiM edia (WMM) is enabled by default. With WMM
enabled, QoS prioritization and coordination of wireless medium access
ison. With WMM enabled, QoS settings on the D-Link Unified Access
System control downstream traffic flowing from the access point to
client station (AP EDCA parameters) and the upstream traffic flowing
from the station to the access point (station EDCA parameters).

Disabling WMM deactivates QoS control of station EDCA parameters
on upstream traffic flowing from the station to the access point

With WMM disabled, you can still set some parameters on the
downstream traffic flowing from the access point to the client station
(AP EDCA parameters).

To disable WMM extensions, click Disabled.
To enable WMM extensions, click Enabled.

Queue

Queues are defined for different types of data transmitted from station-
to-AP:

Data 0 (Voice)

Highest priority queue, minimum delay. Time-sensitive data such as
Vol P and streaming media are automatically sent to this queue.

Data 1(Video)

Highest priority queue, minimum delay. Time-sensitive video dataiis
automatically sent to this queue.
Data 2 (best effort)

Medium priority queue, medium throughput and delay. Most traditional
IP datais sent to this queue.

Data 3 (Background)

Lowest priority queue, high throughput. Bulk data that requires
maximum throughput and is not time-sensitive is sent to this queue
(FTP data, for example).

AIFS
(Inter-Frame Space)

The Arbitration Inter-Frame Spacing (AIFS) specifiesawait time (in
milliseconds) for data frames.

Valid values for AIFS are 1 through 255.
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Table 55. QoS Settings

Field Description

cwMin This parameter is input to the algorithm that determines theinitial
(Minimum Contention  random backoff wait time ("window") for retry of atransmission.
Window)

The value specified in the Minimum Contention Window is the upper
limit (in milliseconds) of arange from which theinitial random backoff
wait time is determined.

The first random number generated will be a number between 0 and the
number specified here.

If the first random backoff wait time expires before the data frameis
sent, aretry counter isincremented and the random backoff value
(window) is doubled. Doubling will continue until the size of the
random backoff value reaches the number defined in the Maximum
Contention Window.

Valid valuesfor cwMin are 1, 3, 7, 15, 31, 63, 127, 255, 511, or 1023.
Thevalue for cwMin can be equal to or lower than the value for cwMax.

cwM ax The vaue specified in the Maximum Contention Window isthe upper
(Maximum Contention  limit (in milliseconds) for the doubling of the random backoff value.
Window) This doubling continues until either the data frameis sent or the

Maximum Contention Window size is reached.

Once the Maximum Contention Window size is reached, retries will
continue until a maximum number of retries allowed is reached.

Valid valuesfor cwMax are 1, 3, 7, 15, 31, 63, 127, 255, 511, or 1023.
The value for cwMax can be equal to or higher than the value for
cwMin.

TXOP Limit Station EDCA Parameter Only (The TXOP Limit applies only to
traffic flowing from the client station to the access point.)

The Transmission Opportunity (TXOP) isan interva of timewhen a
WME client station has the right to initiate transmissions onto the
wireless medium (WM).

This value specifies (in milliseconds) the Transmission Opportunity
(TXOP) for client stations; that is, the interval of time when aWMM
client station has the right to initiate transmissions on the wireless
network.

The TXOP Limit rangeis 0 to 65535. The valueisin units of 32-
microsecond periods.

166 © 2001- 2008 D-Link Corporation. All Rights Reserved.



Configuring the Captive Portal

The Captive Portal (CP) feature allows you to block wired and wireless clients from accessing
the network until user verification has been established.

This chapter contains the following sections to help you configure and monitor the CP feature
on the Unified Switch.

» Configuring Global Captive Portal Settings

»  Configuring the Captive Portal

* Monitoring and Configuring Captive Portal Users
» Associating Interfaces with the Captive Portal

» Viewing the Captive Portal Globa Status

* Viewing the Client Summary

*  SNMP Trap Configuration

For information about the commands you use to manage and maintain the APs by using the
CLI, seethe D-Link CLI Command Reference.

NOTE: The captive portal configuration pages are available from the Security folder
under both the LAN and WLAN tabs.

Figure 75. Navigating to the Captive Portal Feature
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Configuring Global Captive Portal Settings

Use the CP Global Configuration pageto control the administrative state of the CP feature
and configure global settings that affect all captive portals configured on the switch.

To configure the global CP settings, click Security > Captive Portal > Global

Configuration.

Figure 76. Global Captive Portal Configuration
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Global Configuration
Enable Captive Portal O
CP Global Operational Status Disabled
CP Global Disable Reason Administrator Disabled
Additional HTTP Port 0 (0 to 65535)
Authentication Timeout (secs) 1300 (60 to 600)

Table 56 describes the global CP fields you can view or configure.

Table 56. Global Captive Portal Configuration

Field Description

Enable Captive Select the check box to enable the CP feature on the switch. Clear the check
Portal box to disable the captive portal feature.

CP Global Shows whether the CP feature is enabled.

Operational Status

CP Global Disable
Reason

If CPisdisabled, thisfield displays the reason, which can be one of the
following:

* None

e Administratively Disabled

e NolPv4 Address

¢ Routing Enabled, But no IPv4 routing interface

Additional HTTP

HTTP traffic uses port 80, but you can configure an additional port for HTTP

Port traffic. Enter a port number between 0-65535 (excluding port 80).
Authentication To access the network through a portal, the client must first enter
Timeout authentication information on an authentication Web page. Enter the number

of seconds to keep the authentication session open with the client. When the
timeout expires, the switch disconnects any active TCP or SSL connection
with the client.
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Configuring the Captive Portal

Usethe CP Summary page to create or delete captive portal configurations. The switch
supports 10 CP configurations. CP configuration 1 is created by default and can not be deleted.
Each captive portal configuration can have unique guest or group access modes and a
customized acceptance use policy that displays when the client connects.

To view summary information about existing captive portas, or to add or delete a captive
portal, click Security > Captive Portal > CP Configuration.

Figure 77. Captive Portal Summary
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To create a CP configuration, enter the configuration name in the text box and click Add.
After you add the configuration, the CP Configuration page for that configuration displays,
and a new tab with the name of that configuration appears.

To delete an existing CP, select the check box for the CP to remove, and then click Delete.

To configure the settings for an existing CP, click the name in the Configuration column or
click the appropriate tab.

Table 57 describes the fields on the CP Summary page.

Table 57. Captive Portal Summary

Field Description

Configuration Shows the captive portal 1D and name. To access the configuration page for
an exiting CP, click the configuration name.

Mode Shows whether the CP is enabled.
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Table 57. Captive Portal Summary

Field Description
Protocol Indicates whether the portal usesHTTP or HTTPS.
Verification Specifies which type of user verification to perform:

¢ Guest: The user does not need to be authenticated by a database.

e Local: Theswitch uses aloca database to authenticate users.

* RADIUS: The switch uses a database on aremote RADIUS server to
authenticate users.

To configure authorized users on the local or remote RADIUS database, see

“Monitoring and Configuring Captive Portal Users’ on page 174.

Changing the Captive Portal Settings

By default, the D-Link Unified Switch has one captive portal. You can change the settings for

that captive portal, and you can also create and configure up to nine additional portals. After
you create a captive portal from the CP Summary page, you can change its settings.

Figure 78. Captive Portal Configuration
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| CP Summary test }

CP Configuration | (English) | Espafiol (Spanish) I E #3E (Japanese) | £ 2 (Simplified Chinese) | Zp2 1t 3¥ (Traditional Chinese) |

URL Redirect Mode ¥

CP Configuration

Enable Captive Portal Code Language

Configuration Name Default en (English) E]
Protocol Mode @HTTP OHTTPS es Espafiol (Spanish) ()l clear ]
Verification Mode O Guest ® Local O RADIUS ja H #EE (Japanese) C]

CP Configuration 1-Default

zh & 32 (Simplified Chinese) [ ][ Clear ]

Redirect URL I

Session Timeout (secs) |0 (0 to 86400)

Idle Timeout (secs) 0 (0 to 900)

User Group 1-Default v (210 32)

zh-tw RSy (Traditional Chinese) E]

[ Clear ][ Submit ][ Refresh ]

Table 58 describes the fields on the CP Configuration page.

Table 58. CP Configuration

Field Description

Enable Captive Select the check box to enable the CP. Clear the check box to disableit.
Portal

Configuration Thisfield allows you to change the name of the portal added from the CP
Name Summary page.
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Table 58. CP Configuration

Field Description

Protocol Mode Choose whether to use HTTP or HTTPs as the protocol for the portal to use
during the verification process.

e HTTP: Does not use encryption during verification

e HTTPS: Usesthe Secure Sockets Layer (SSL), which requires a
certificate to provide encryption. The certificate is presented to the user
at connection time.

Verification Mode  Select the mode for the CP to use to verify clients:

e Guest: The user does not need to be authenticated by a database.

e Local: The switch uses alocal database to authenticate users.

* RADIUS: The switch uses a database on aremote RADIUS server to
authenticate users.

URL Redirect Select the check box to specify that the CP should redirect the newly

Mode authenticated client to the configured URL. If the check box is clear, the user
sees the local e-specific wel come page after a successful verification.

Redirect URL Specify the URL to which the newly authenticated client is redirected if the
URL Redirect Mode is enabled.

Session Timeout Enter the number of secondsto wait before terminating a session. A user is

logged out once the session timeout isreached. If the valueis set to O then the
timeout is not enforced. The default value is 0.

Idle Timeout Enter the number of seconds a user can remain idle before automatically
being logged out. If the valueis set to 0 then the timeout is not enforced.The
default valueis 0.

Note: Idletimeout is not supported for wired clients.

User Group If the Verification ModeisLoca or RADIUS, assign an existing User Group
to the captive portal or create anew group. All users who belong to the group
are permitted to access the network through this portal. The User Group list
isthe same for all CP configurations on the switch.

The User Group field also allows you to add, delete, or rename user groups
for al captive portals.

¢ Toassign an existing user group to the CP, select it from the drop-down
menu.

«  To create anew user group, enter the group name in the blank field and
click Add.

«  To change the name of an existing user group, select the name to change
from the drop-down menu, enter the new name in the blank field, and
click Modify.

¢ Todelete auser group, select it from the drop-down menu and click
Delete.

Note: The User Group fields are unavailableif the Verification Mode is

Guest.
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Table 58. CP Configuration

Field Description

Code Enter the IANA Language Subtag code for the language. All codes are listed
in the IANA Language Subtag Registry. If the language is currently
supported by the switch, the code isfilled in automatically when you select

the language.

Language To add a captive portal configuration in alanguage that is supported by the
switch, click the ... button to display and select the language to use for the
captive portal.

To remove a captive portal configuration in alanguage, click Clear.

Customizing the Captive Portal Web Page

When a client connects to the switch, either through a wired connection or through an access

point, the user is presented with the captive portal Web page. The CP Web Page
Customization page allows you to customize the appearance of that page with specific text
and images.

You can create up to five local e-specific web pages for each captive portal aslong as the pages
al use the same verification type; either guest or authorized user web pages. This alows you
to create pages in avariety of languages to accommodate a diverse group of users.

To customize the page that wired and wireless clients see when they access the captive portal,
click the tab that corresponds to the language of the page to customize.

Figure 79. CP Web Page Customization
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CP Summary test

CP Configuration | (English) I Espaiiol (Spanish) | H % (Japanese) | i) f& B 3% (Simplified Chinese) | 282 1 X (Traditional Chinese) |

CP WEB Page Customization

Available Images: | D-Link_logo.gif .V]
Branding Image: D-Link_logo.gif [+] Fonts:  arial, sans-serif

Browser Title: Captive Portal

Page Title: Welcome!

Colors: Separator: #326BA0 [:] Foreground-#E3EFFF D Background: #FFFFFF D

Accountimage: | login_keyjpg  [¥]
Account Title: EnterYour Usemame &
User Label: Username

Password Label: Password

Button Label: Eonnech Check here to indicate that you have read and accepted the Ac

|
Instructional Text: To startusing this service. enter your credentials and click the Connect button
Denied Message: Error: Invalid Credentials. please try again!
Resource Message:  Error: Limited Resources, please reconnect and try again later!
Timeout Message: Error: Timed Out, please reconnect and iry again!
Busy Message: Connecling, please be patient
No Accept Message: Error You must acknowledge the Acceptance Use Policy befare connecting!
Welcome Title: Congratulations!

Welcome Text: You are now authorized and connected to the netwark

[ Clear ][ Preview ][ Submlt]
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The following table describes the fields on the CP Web Page Customization page.

Table 59. CP Web Page Customization

Field

Description

Available Images

The menu shows the images that are available to use for the page branding
and the account image. To add images, click Browse and select an image on
your local system (or accessible from your local system). Click Download to
download the image to the switch.

Theimage should be 5 KB max, 200 x 200 pixels, GIF or JPG format.

To delete animage from the list, select the file name from the menu and click
Delete. You can only delete images that you download.

Branding Image

Select the name of theimage file to display on the top left corner of the page.
Thisimage is used for branding purposes, such as the company logo.

Fonts

Enter the name of the font to use for all text on the CP page.

Browser Title

Enter the text to display on the client’s Web browser title bar or tab.

Page Title

Enter the text to use as the page title. Thisis the text that identifies the page.

Colors

Select the colorsto use for the CP page. Click the ... button, and then select
the color to use. The sample account information is updated with the colors
you choose.

Account Image

Select the image that will display on the Captive Portal page above the login
field. To download a new image to the switch, use the Available Image field.

Account Title

Enter the summary text to display that instructs users to authenticate.

User Label Enter the text to display next to the field where the user enters the username.

Password L abel Enter the text to display next to the field where the user enters the password.

Button Label Enter the text to display on the button the user clicks to connect to the
network.

Acceptance Use Enter the text to display in the Acceptance Use Policy field. The acceptance

Palicy Text Box

use policy instructs users about the conditions under which they are allowed
to access the network. The policy can contain up to 8192 text characters.

Acceptance Check
Box Prompt

Enter the text to display next to the box that the user must select to indicate
that he or she accepts the terms of use.

Instructional Text

Enter the detailed text to display that instructs users to authenticate. Thistext
appears under the button.

Denied M essage

Enter the text to display when the user does not provide valid authentication
information. This message al so appears when the user is not amember of the
user group assigned through the CP Configuration page. This message
displays after the user clicks the button to connect to the network.

Resour ce M essage

Enter the text to display when the system has rejected authentication due to
system resource limitations. This message displays after the user clicks the
button to connect to the network.

Timeout M essage

Enter the text to display when the system has rejected authentication because
the authentication transaction took too long. This could be due to user input
time, or atimeout due to the overall transaction.
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Table 59. CP Web Page Customization

Field Description

Busy Message Enter the text to display when the Captive Porta is processing the
authentication request. This message displays after the user clicks the button
to connect to the network.

No Accept Enter the text to display when the user did not accept the acceptance use

M essage policy. This message displays after the user clicksthe button to connect to the
network.

WelcomeTTitle Enter thetitle to display to greet the user after he or she successfully connects
to the network.

Welcome Text Enter the optional text to display to further identify the network to be

accessed by the CP user. This message displays under the Welcome Title.

Use the buttons at the bottom of the page to perform the following tasks:

» To reset the page to the default values, click Clear.
» To preview the customized page, click Preview.
» To apply the changes to the switch, click Submit.

Monitoring and Configuring Captive Portal Users

You can configure a portal to accommodate guest users and authorized users. Guest users do
not have assigned user names and passwords. Authorized users provide avalid user name and
password that must first be validated against alocal database or RADIUS server. Authorized
users can gain network access once the D-Link Unified Switch confirms the user’s credentials.

The Local User Summary page alows you to add authorized users to the local database,
which can contain up to 1024 user entries. You can also delete users from the local database
from the Local User Summary page.

To view and configure CP usersin the local database, click Security > Captive Portal >
Local User.

Any usersthat are already configured are listed on the L ocal User Summary page.

Figure 80. Captive Portal Local User Summary

| Local User Configuration :

Local User Summary

User Session Timeout Idle Timeout
[ut 0 0
[Jamy 0 0

[ Add | [ Delete |[ Delete All || Refresh |

Table 60 describes the fields on the L ocal User Summary page.
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Table 60. L ocal User Summary

Field Description
User | dentifies the name of the user.
Session Timeout Shows the number of seconds auser is permitted to remain connected to the

network. Once the Session Timeout value is reached, the user is logged out
automatically. A value of 0 means that the user does not have a Session
Timeout limit.

Idle Timeout Shows the number of seconds the user can remain idle before the switch
automatically logs the user out. A value of 0 means that the user will not be
logged out automatically.

Note: Idletimeout is not supported for wired clients.

Use the buttons at the bottom of the page to perform the following tasks:

» To accessthe configuration page for a specific user listed on the page, click the user name.

» Toadd anew user and configure the Local User settings, click Add.

 Todeete auser from the local database, select the check box next to the user to remove
and click Delete. Select multiple check boxes to delete more than one user at atime.

» Click Delete All to remove al configured users from the local database.

Configuring Users in the Local Database

From the L ocal User Configuration page, you can configure additional settingsfor an
existing CP user in the local database.

Figure81. Local User Configuration

Local User Summary I

Local User Configuration

User Name amy

Password == (8 to 64)

User Group |[EEEER Session Timeout (secs) |0 {0 to 86400)

Idle Timeout (secs) 0 (0 to 900)

Delete ][ Submit ][ Refresh

Table 61 describes the fields you use to configure CP usersin the local database.

Table 61. L ocal User Configuration

Field Description

User Name Enter the name of the user.

Password Enter a password for the user. The password length can be from 8 to 64
characters.
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Table 61. L ocal User Configuration

Field Description

User Group Assign the user to at least one User Group. To assign a user to more than one
group, press the Ctrl key and click each group.

New users are assigned to the 1-Default user group by default.

Session Timeout Enter the number of seconds a user is permitted to remain connected to the
network. Once the Session Timeout value is reached, the user islogged out
automatically. A value of 0 means that the user does not have a Session
Timeout limit.

Idle Timeout Enter the number of seconds the user can remain idle before the switch
automatically logs the user out. A value of 0 means that the user does not
have an idle timeout limit.

Note: Idletimeout is not supported for wired clients.

Configuring Users in a Remote RADIUS Server

You can use aremote RADIUS server client authorization. You must add all usersto the
RADIUS server. Thelocal database in the D-Link Unified Switch does not share any
information with the remote RADIUS database.

Table 62 indicates the RADIUS attributes you use to configure authorized captive portal
clients. The table indicates both RADIUS attributes and vendor-specific attributes (VSA).
V SAs are denoted in the Attribute column and are comma delimited (vendor id, attribute id).

Table 62. Captive Portal User RADIUS Attributes

Attribute Number Description Range Usage Default

User-Name 1 User name to be 1-32 Required None
authorized characters

User-Password 2 User password 8-64 Required None

characters

DLink-Captive- 6132,127 A comma-delimited list String Optional None. The

Portal-Groups of group names that default
correspond to the group is
configured CP instance used if not
configurations. defined

here.
Session- 27 L ogout once session Integer Optional 0
Timeout timeout is reached (seconds)

(seconds). If the attribute
is 0 or not present then
use the value configured
for the captive portal.

Idle-Timeout 28 Logout onceidletimeout  Integer Optional 0
is reached (seconds). If (seconds)
the attribute is O or not
present then use the
value configured for the
captive portal.
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Associating Interfaces with the Captive Portal

From the I nterface Association page, you can associate a configured captive portal with a
specific physical interface or wireless network (SSID). The CP feature only runs on the wired
or wireless interfaces that you specify. A CP can have multiple interfaces associated with it,
but an interface can be associated to only one CP at atime.

NOTE: When associating a physical interface with a captive portal configuration,
note the following restrictions:

Captive portal and STP should not be enabled on the same physical interface.
Captive portal and 802.1X cannot be enabled on the same physical interface.
Port security and captive portal cannot be enabled on the same physical interface.
If aphysical interface is made a LAG member, the captive portal becomes
disabled on the interface.

To associate interfaces with CPs, click Security > Captive Portal > I nterface Association.

Figure 82. Global Captive Portal Configuration

Interface Association
CP Configuration 1 - Default |»
Associated Interfaces  Slot: 0 Port: 1 Gigabit - Level Interface List  Slot: 0 Port: 2 Gigabit - Level ~
Wireless Network 3 - Managed SSID 3 Slat 0 Port- 3 Gigabit - Level |
Wireless Metwork 5 - Managed SSID & Slot: 0 Port: 4 Gigabit - Level
Slot: 0 Port: & Gigabit - Level
Slot: 0 Port: 6 Gigabit - Level
Slot: 0 Port: 7 Gigabit - Level
Slot: 0 Port: 8 Gigabit - Level
Slot: 0 Port: 9 Gigabit - Level ~
Add

Table 63 describes the fields on the I nter face Association page.

Table 63. Global Captive Portal Configuration

Field

Description

CP Configuration Lists the captive portals configured on the switch by number and name.

Associated Lists the interfaces that are currently associated with the selected captive

Interfaces portal. Wirelessinterfaces are identified by the wireless network number and
SSID. Physical (wired) interfaces are identified by the Port Description that
includes slot number, port number, and interface type.

InterfaceList Lists the interfaces available on the switch that are not currently associated

with aCP. Wireless interfaces are identified by the wireless network number
and SSID. Physical (wired) interfaces are identified by the Port Description
that includes slot number, port number, and interface type.

Use the following steps to associate one or more interfaces with a captive portal.

1. Select the desired captive portal from the CP Configuration list.
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2. Sedlect theinterface or interfaces from the Interface List. To select more than one interface,
hold the Ctrl key and click multiple interfaces.

3. Click Add.

NOTE: When you associate an interface with a captive portal, theinterfaceis
removed from the Interface List. Each interface can be associated with only
one CP at atime.

Usethefollowing steps to remove an interface from the Associated Interfaceslist for acaptive
portal.

1. Select the desired captive portal from the CP Configuration list.

2. Inthe Associated Interfacesfield, select the interface or interfaces to remove. To select
more than one interface, hold the Ctrl key and click multiple interfaces.

3. Click Delete.

Theinterface is removed from the Associated Interface list and appearsin the Interface
List.

Viewing the Captive Portal Global Status

The CP Global Status page contains a variety of information about the CP feature. From the
CP Global Satus page, you can access information about the CP activity and interfaces.

To view captive portal status information, click Security > Captive Portal > Global Status.

Figure 83. Global Captive Portal Satus
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| CP Activation and Activity Status]

Global Status
CP Global Operational Status Enabled Configured Captive Portals 2
CP IP Address 10.27.64.255 Supported Captive Portals 10
Authenticated Users 0 Active Captive Portals 1
System Supported Users 128

Table 64 describes the fields displayed on the CP Global Status page.
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ve Portal Satus

Field

Description

CP Global
Operational Status

Shows whether the CP feature is enabled.

CP Global Disable

If CPisdisabled, thisfield indicates the reason for the CP to be disabled,

Reason which can be one of the following:

* None

e Administratively Disabled

* NolPv4 Address

¢ Routing Enabled, But no IPv4 routing interface

Thisfield does not appear if the CP operational statusis Enabled.
CPIP Address Shows the captive portal 1P address
Authenticated Shows the number of users currently authenticated to all captive portal
Users instances on this switch.
System Supported  Shows the number of authenticated users that the system can support.
Users
Configured Shows the number of captive portals configured on the switch.

Captive Portals

Supported Captive  Shows the number of supported captive portalsin the system.

Portals

Active Captive Shows the number of captive portal instances that are operationally enabled.
Portals

Viewing CP Activation and Activity Status

The CP Activation and Activity Status page provides information about each CP configured

on the switch.

Figure 84. CP Activation and Activity Satus

Global Status |

|

Operational Status
Blocked Status

Authenticated Users

CP Activation and Activity Status

1 - guest network ||

Enabled
Mot Blocked
0

The CP Activation and Activity Status page has a drop-down menu that contains all captive
portals configured on the switch. When you select a captive portal, the activation and activity

status for that portal di

splays.

Viewing the Captive Portal Global Status 179



D-Link Unified Access System User Manual

180

Table 65 describes the information that displays for each portal.

Table 65. CP Activation and Activity Satus

Field Description

Operational Satus Indicates whether the captive portal is enabled or disabled.

Disable Reason If the captive portal is disabled, then this field indicates the reason. The
portal instance may be disabled for the following reasons:

* None- CPisenabled.

e Administratively Disabled

¢ RADIUS Authentication mode enabled, but RADIUS server is not
defined.

¢ Not associated with any interfaces.

e Theassociated interfaces do not exist or do not support the CP
capability.

Blocked Satus Indicates whether authentication attempts to the captive portal are currently
blocked.

Usethe Block and Unblock buttonsto control the blocked status. If the CPis
blocked, users cannot gain access to the network through the CP. Use this
function to temporarily protect the network during unexpected events, such
as denia of service attacks.

Note: The Blocked Status is the operational status and not the configured
status. It does not persist over areboot. By default, the status is unblocked.

Block and Unblock are only available when the CP operational statusis

Enabled.
Authenticated Shows the number of usersthat successfully authenticated to this captive
Users portal and are currently using the portal.

The following buttons are available on the CP Activation and Activity page:

» Block—Click Block to prevent users from gaining access to the network through the
selected captive portal.

» Unblock—If the Blocked Status of the selected captive portal is Blocked, click Unblock
to alow access to the network through the captive portal.

» Refresh—Click Refresh to update the screen with the most current information.
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Viewing Interface Activation Status

The Interface Activation Satus page shows information for every interface assigned to a
captive portal instance. Use the drop-down menus to select the porta or interface with the
information you want to view.

Figure 85. Interface Activation Satus

| Interface Capability Status ‘

Interface Activation Status

1 - Default |w|
Wireless Metwork 9 - Another Captive Portal |+ |

Operational Status Enabled
Blocked Status Mot Blocked
Authenticated Users 1

Table 66 describes the fields on the I nterface Activation Status page.

Table 66. | nterface Activation Satus

Field Description

Operational Status  Shows whether the portal is active on the specified interface.

Disable Reason If the selected CP is disabled on thisinterface, thisfield indicates the reason,
which can be one of the following:

* Interface Not Attached
» Disabled by Administrator

Blocked Satus Indicates whether the captive portal istemporarily blocked for
authentications.

Authenticated Displays the number of authenticated users using the captive portal instance
Users on thisinterface.

Viewing Interface Capability Status

The Interface Capability Status page contains information about interfaces that can have
CPs associated with them. The page also contains status information for various capabilities.
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Specifically, this page indicates what services are provided through the CP to clients
connected on thisinterface. The list of servicesis determined by the interface capabilities.

Figure 86. Interface Capability Status

1 |
Interface Activation Status I [

Interface Capability Status

Wireless Metwork 1 - darsenSSID 1 (i3]
Session Timeout Enable Idle Timeout Enable
Bytes Received Counter Enable Packets Received Counter Enable

Bytes Transmitted Counter Enable Packets Transmitted Counter Enable

Roaming Support Enable

The drop-down menu contains all the physical interfaces and wireless interfaces available on
the switch. Physical (wired) interfaces are identified by the Port Description that includes slot
number, port number, and interface type. Wireless interfaces are identified by the wireless
network number and SSID. Use the drop-down menu to select the interface with the
information to display.

Table 67 describes the fields on the Interface Capability Status page.

Table 67. Interface and Capability Status

182

Parameter

Description

Session Timeout

Shows whether the interface supports client session timeout. This attributeis
supported on all interfaces.

Bytes Received
Counter

Shows whether the interface supports displaying the number of bytes
received from each client.

Bytes Transmitted
Counter

Shows whether the interface supports displaying the number of bytes
transmitted to each client.

Roaming Support

Shows whether the interface supports client roaming. Only wireless
interfaces support client roaming.

Idle Timeout Shows whether the interface supports atimeout when the user doesn't send or
receive any traffic.
Packets Received Shows whether the interface supports displaying the number of packets
Counter received from each client.
Packets Shows whether the interface supports displaying the number of packets
Transmitted transmitted to each client.
Counter
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Viewing the Client Summary

Use the Client Summary page to view summary information about all authenticated clients
that are connected to the network through the captive portal. From this page, you can manually
force the captive portal to disconnect one or more authenticated clients. Thelist of clientsis
sorted by client MAC address.

To view information about the clients connected to the D-Link Unified Access System through
the captive portal, click Security > Captive Portal > Client Connection Status.

Figure 87. Client Summary

1
Client Detail | Client Statistics I Interface - Client Status | CP - Client Status |

H Logout ' Help

lient MAC Address Client IP Address User Protocol Verification
[]00:04:23:7c:dc.c4 10.27.65.51 Todd HTTP Local

Delete |[ Delete All | [ Refresh

Table 69 describes the fields on the Client Summary page.

Table 68. Client Summary

Field Description

Client MAC Identifies the MAC address of the client that has connected to the network
Address through a captive portal .

Client IP Address  Identifiesthe |P address of the client.

User Displays the user name (or Guest I1D) of the connected client.

Protocol Shows the current connection protocol, which is either HTTP or HTTPS.
Verification Shows the current account type, which is Guest, Local, or RADIUS.

To force the captive porta to disconnect an authenticated client, select the check box next to
the client MAC address and click Delete. To disconnect all clients from all captive portas,
click Delete All.

Click the MAC address of aclient to view additional status information.
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Viewing Client Detail

The Client Status page shows detailed information about each client connected to the network
through a captive portal.

Figure 88. Client Detail

Client Summary | I Client Statistics | Interface - Client Status | CP - Client Status |

Client Detail

00:04:23:Tcdccd [v)

User Name Todd Session Time 4d:01:49:14
CP Configuration 1-Default Verification Local
Protocol HTTP Interface Wireless Network 9 - Another Captive Portal

Client IP Address 10.27 6551

The drop-down menu lists each associated client by MAC address. To view status information
for aclient, select it from the list.

Table 69 describes the fields on the Client Detail page.

Table 69. Client Detail

Field Description

User Name Displays the user name (or Guest D) of the connected client.

CP Configuration  Identifiesthe name of the CP the client is using. The switch supportsup to 10
CPs.

Protocol Shows the current connection protocol, which is either HTTP or HTTPS.

Client IP Address  Identifiesthe |P address of the client.

Session Time Shows the amount of time that has passed since the client was authorized.

Verification Shows the current account type, which is Guest, Local, or RADIUS.

Interface Identifies the interface the client isusing.
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Viewing the Client Statistics

Use the Client Satistics page to view information about the traffic a client has sent or
received.

Figure 89. Client Satistics

Client Summary | Client Detail ‘ Interface - Client Status | CP - Client Status ‘

n‘ Logovt e Help

Client Statistics

tes Received Packets Received
By
Bytes Transmitted Packets Transmitted

Clear Statistics ][ Refresh

The drop-down menu lists each associated client by MAC address. To view statistical
information for aclient, select it from the list.

Table 70 describes the fields on the Client Statistics page.

Table 70. Client Interface Association Connection Statistics

Field Description
Bytes Transmitted Total bytes the client has transmitted
Bytes Received Total bytes the client has received
Packets Transmitted Total packets the client has transmitted
Packets Received Total packets the client has received

Viewing the Client Interface Association Status

Usethe Interface - Client Satus page to view clients that are authenticated to a specific
interface.

Figure 90. Interface- Client Satus

Client Summary | Client Detail | Client Statistics ‘ CP - Client Status ‘
p Logout e Help

Interface - Client Status

Wireless Network 9 - Anather Captive Portal ||

Client IP Address CP Configuration Protocol Verification
00:04:23:Tc:4c:cd 10.27.65.51 1-Default HTTP Local
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The drop-down menu lists each interface on the switch. To view information about the clients
connected to a CP on thisinterface, select it from the list.

Table 71 describes the fields on the Interface - Client Status page.

Table 71. Interface - Client Satus

Field Description

Client MAC Address Identifies the MAC address of the client

Client IP Address Identifies the IP address of the client

CP Configuration Identifies the captive portal the client used to access the network

Protocol Shows the current connection protocol, which is either HTTP or
HTTPS

Verification Shows the current account type, which is Guest, Local, or RADIUS.

Viewing the Client CP Association Status

Usethe CP - Client Status page to view clients that are authenticated to a specific CP
configuration.

Figure9l. CP - Client Satus

Client Summary | Client Detail | Client Statistics | Interface - Client Status |

E Logout c Help

CP - Client Status
1-Default [v]
lient MAC Address  Client IP Address  Interface Protocol Verification
00:04:23:7c:4c:cd 10.27.65.51 Wireless Network 9 - Another Captive Portal HITE Local

The drop-down menu lists each CP configured on the switch. To view information about the
clients connected to the CP, select it from thelist.

Table 72 describes the fields on the Client CP Association Status page.

Table 72. CP - Client Satus

Field Description

Client MAC Address Identifies the MAC address of the client

Client IP Address Identifies the IP address of the client

Interface I dentifies the interface the client used to access the network

Protocol Shows the current connection protocol, which iseither HTTP or HTTPS
Verification Shows the current account type, which is Guest, Local, or RADIUS.
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SNMP Trap Configuration

Usethe SNM P Trap Configuration page to configure whether or not SNMP traps are sent
from the Captive Portal and to specify captive portal events that will generate atrap.

All CP SNMP traps are disabled by default.

To configure SNM P trap settings for various captive portal features, click Security > Captive
Portal > SNMP Trap Configuration.

Figure92. SNMP Trap Configuration

SNMP Trap Configuration
Captive Portal Trap Mode Disable ||
Client Authentication Failure Traps Disable ||
Client Connection Traps Disable iv_"
Client Database Full Traps Disable |v|
Client Disconnection Traps Disable |w|

Table 73 describes the events that generate SNMP traps when the status is Enabled.

Table 73. SNMP Trap Configuration

Field Description

Captive Portal Trap Choose one of the following captive portal trap modes:

Mode «  Select Enableto allow the SNMP agent on the switch to generate
captive portal SNMP traps that are enabled.
»  Select Disableto prevent the SNMP agent on the switch from
generating any captive portal SNMP traps, even if they are
individually enabled.

Client Authentication If you enable thisfield, the SNMP agent sends atrap when a client

Failure Traps attempts to authenticate with a captive portal but is unsuccessful.

Client Connection If you enable thisfield, the SNMP agent sends atrap when a client
Traps authenticates with and connects to a captive portal.

Client Database Full If you enable thisfield, the SNMP agent sends atrap each time an entry
Traps cannot be added to the client database because it isfull.

Client Disconnection If you enable thisfield, the SNMP agent sends atrap when a client
Traps disconnects from a captive portal.
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Visualizing the Wireless Network

The WLAN Visuaization component is an optional feature that graphically showsinformation
about the wireless network. WLAN Visualization uses a Java applet to display D-Link Unified
Switches, D-Link Access Points, other access points, and associated wireless clients. The
WLAN Visualization tool can help you visualize where the APs are in relationship to the
building.

You can upload one or more custom images to create a background for the graph. Then, you
place the WLAN components discovered by the switch on the graph to help provide arealistic
representation of your wireless network. From each object on the WLAN Visualization graph,
you can access information about the object and links to configuration pages on the Web
interface.

This chapter contains the following sections to help you manage the WLAN Visualization
component of the D-Link Unified Access System:

» Importing and Configuring a Background Image
e Setting Up the Graph Components

» Understanding the Menu Bar Options

* Managing the Graph
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Figure 93 shows an example of afloor plan with a D-Link Unified Switch that manages two
APs. Thefigure also shows two switches and arogue AP.

Figure93. Sample WLAN Visualization
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Importing and Configuring a Background Image

By default, the WLAN Visualization graph does not have a background image. You can
upload one or more images, such as your office floor plan, to provide a site context and site
related information.

Images that you upload should be in one of the following two file formats:

*  GIF (Graphics Interchange Format)
* JPG (Joint Photographic Experts Group)

Additionally, we recommend that you do not use color images since the WLAN components
might not show up aswell.

To load an image onto the switch to use as a background for the WLAN Visualization graph,
use the following procedures:

1. Click WLAN Visualization > Download I mage.
2. Click Browseto navigate to the file location.
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10 Visualizing the Wireless Network

3. Select thefileto upload and click Sart File Transfer.

Download File

Image File Selection: Citftpifloorplan.jpg [ Browse..

Start Fe Transfer

Mote: Supported image file types are GIF and JPG. You are encouraged to limit the use of colors as this
willl improve WLAN compaonent wisibility.

Once you upload an image file and save the running configuration, the image remains on the
switch and you can assign it to an existing graph using the WLAN Visualization application.

Setting Up the Graph Components

To start the WLAN Visualization tool, click WL AN Visualization > Launch... Thisopens a
new browser window and starts the Java applet.

Thefirst time you launch the WLAN Visualization tool, there is no background image, and all
discovered WLAN components are ungraphed. The screen is split into two panes. The left
pane has 3 container views that are used to hold un-graphed components. The right paneis an

areawhere graph definitions are shown. This graph paneisinitialy blank and must be defined
before WLAN components can be placed.

Creating a New Graph

To create a new graph and load the background image, launch the WLAN Visualization tool
and use the following steps.

1. Fromthe WLAN Visualization menu bar, click Edit > New Graph.
The New Graph Definition dialogue box opens.
2. Enter aname to identify the graph and select the image to use as the background.

For information about how to upload an image to use as a graph background, see
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“Importing and Configuring a Background Image”’ on page 190.
File Edit VWiew Options Legend Help
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3. Enter the represented length for one of the graph dimensions (height or width).

Use the Selection and M easurement drop-down menus to specify whether the length isthe
height or width, and whether it isin meters or feet.

The length you enter determines the scale of the background image in relation to the
network components. The scale of the background image affects the way the WLAN
Visualization tool presents the radio frequency (RF) coverage of the access points, so it is
important to be as accurate as possible when you specify the length.

For example, in the following graphs, the background image is the same, and the APs are
in the same location in both images. The only difference between the images is that one
image was set up with agraph definition length of 200 feet, and the other image was set up
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10 Visualizing the Wireless Network

with a graph definition length of 800 feet.

l{ Building 100 |

Graph Definition

Graph Mame: Euilding 100 Length = 200’
mage Selection:/floorplan.jpg =
Scale Factor
Selection:|Height -

Measurement:|Feet 57

Length: 200

Java Applet Window L}

il

I’ Building 100

Graph Definition
Length = 800’

Graph Name: Building 100

Image Selection:floorplan.jpg ﬂ

Scale Factor

Selection: Height -
Measurement: Feet -
Length: 200
| Save || Cancel |

Java Applet Window

4. Click Save to complete the graph setup.
The background you uploaded to the switch appearsin the background of the graph.
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You can create multiple graphs. For example, if your network spans multiple floors or
buildings, you might have a graph for each area. Additional graphs that you create appear as
tabs at the top of the graph panel, as Figure 94 shows.

Figure94. Multiple Graphs

File Edit View Options Legend Help

I Switches |( Building 100 |  Building 200 | Building 300 J)}

192.168.17.66

. :

To create additional graphs, repeat the stepsin this section.

Graphing the WLAN Components

The WLAN Visualization tool automatically shows the WLAN components that the switch
has discovered.

The panel lists the following component types:

»  Switches (Unified Switch and peer Unified Switches)
* Managed Access Paints
* RF Scan Access Points

These components appear in the panel on the left until you drag them onto the graph. From the
View menu, you can choose to view the componentsin alist view, which shows all three types
of componentsin the left panel or in atabbed view, which shows one type of component at a
time, organized by tabs. Figure 95 shows an example of alist view and a tabbed view of the
same components. Access points are listed by location or MAC address, and switches are
listed by IP address.

Figure95. List View and Tabbed View

List View Tab View
T
Switches TGwitches
10.254.24.214 Managed APs
.................................................................. A RF Scan APs
Managed APs 00:11:05:A3:7B:00
10.254.24.217 00:11:95:A3:7B:50
10.254.24.220
RF Scan APs
00:0m:84:20:50:10
00:02:BC:00:12:90
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10 Visualizing the Wireless Network

Wireless clients do not appear in the panedl. Instead, they are automatically graphed based on
their association with (or disassociation from) a D-Link Access Point that is graphed.

If you mouse-over an ungraphed component, atool tip appears to provide additional
information about the ungraphed component, as shown in Figure 96l

Figure 96. Component Tool Tip

Managed AP
IP address: 192 168.17.66

MAC address: 00:11:95:A3:32:20
Configuration: Success
Status: anaged

Radio 1

Protocol: [EEE 2802114
Power Range: High

RF Channel: 40

Radio 2

Protocol: |IEEE 802.11g
Power Range: High

RF Channel: 11

To graph acomponent that islisted in the panel, click the component and drag it to the location
in the graph that represents the physical location of the component in the building. Once you
move a switch or access point to the graph areg, it is removed from the panel.
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Hold the SHIFT or CTRL key to select multiple components, then right-click a selected
component to drag the components onto the graph at the same time.

Figure97. Graphed Components
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To remove a component from the graph, right-click the component, the select Edit >
Un-Graph.

Understanding the Menu Bar Options

The following table provides an overview of the menu items available in the WLAN
Visualization tool.

Table 74. WL AN Visualization Menu Bar Options

Menu Item Description

File

Force Refresh Resynchronizes the Java client application. If you edit the graph,
you can force arefresh to manually update the view.

Reconnect and Refresh Disconnects the client application from the switch and re-connects

it.
Exit Exitsthe WLAN Visualization application.
Edit
New Graph Opens awindow that allows you to create and configure a new
graph, including the name, background image, and scale factor for
the graph.
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10 Visualizing the Wireless Network

Table 74. WLAN Visualization Menu Bar Options

Menu Item Description
Edit Graph Opens the window for an existing graph. You can change the back-
ground image or graph scale. To change the name of the graph, you
must create a new graph.
Delete Graph Deletes the active graph. When you select this item, a dialogue box
appears to confirm that you want to del ete the graph.
Image Management Lists the available background images and allows you to delete any
available image.
View
Ungraphed Components  Allows you to change the view of the ungraphed componentsin the

panel on the left:

e Tab View—Shows one type of component at atime, organized
by tabs.

e List View—Shows all three types of componentsin the left
panel.

Figure 95 on page 194 shows the difference between the tab view

and list view.

AP Power Display

Sel ect the power range image to display for amanaged AP:

»  Disable Power Display—The power range image is not
displayed

e Show 802.11 a—Shows the transmit power for all managed
APsthat have aradio operating in 802.11a mode.

e Show 802.11 b/g—Shows the transmit power for al managed
APsthat have aradio operating in 802.11 b/g mode.

The size of the power range image is based on the transmit power

for the radio, which can be low, medium, or high. The size of the

power range image also depends on the actual scale factor of the

current background image.

If the AP has two radios that are configured in the same mode, two
power range images are displayed.

NOTE: The color of the power range image is based on the assigned
channel of the associated radio.

If two APs use the same channel (or channelsthat are close together)
and are within each other’s transmission range, the APs will
interfere with each other and wireless clients will experience poor
WLAN performance. To reduce interference, you can take one of
the following steps:

¢ Reduce the transmit power on the APs.

e Physicaly place the APs further apart.

¢ Usethe automatic channel adjustment algorithm on the APs or
statically set the channels so they are non-interfering channels.

CAUTION: Power ranges are for illustrative purposes only. The
actual power distribution varies based on factors such as office wall
propagation and background RF noise.
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Table 74. WL AN Visualization Menu Bar Options

Menu Item Description
Options
Show Managed APs Controls whether to display D-Link Access Point on the graph.
Clearing the check box hides but does not un-graph the objects.
Show RF Scan APs Controls whether to display the APs detected through the RF scan.
Clearing the check box hides but does not un-graph the objects.
Show Managed AP Controls whether to display wireless clients associated with man-
Clients aged APs. Clearing the check box hides but does not un-graph the
objects.
L egend
Images Shows the icons associated with each WLAN component on the
graph.
Channel Color Maps the color of the power transmission image to the channel that
theradio isusing for transmission.
Help
Table of Contents Opensanew HTML window to display the table of contents for the

WLAN online Help.

Legend Menu

Theitemsin the L egend menu contain information about the icons and colors that appear on
the graph.

The I mages menu item shows the icons that represent the WLAN components on the graph.

Figure 98. Legend

Switches:
Local Switch

—
s Peer Switch

Managed APs:
¥ Managed (w/2 radios)
S5S Managed (w2 sentry)
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-

Peer Managed
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-

Acknowledged Rogue

P

Rogue or Ad-Hoc Rogue

Miscellaneous:
Client Stations

- AP Power Display
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10 Visualizing the Wireless Network

Asthe legend shows, the Managed AP icon can be blue, green, or red, depending on the status
of the AP:

» Blue—The AP has been discovered and by the switch, but it isin atransitional state. The
AP could be waiting to be authenticated, or it has been validated and authenticated but not
configured.

» Green—The AP profile configuration has been applied to the AP, and it is operating in
managed mode.

* Red—The switch haslost contact with the AP, the AP is being reset, or the AP has
experienced an authentication failure.

When aradio is operating in Sentry Mode, the antenna on the AP icon is replaced by the letter
“S’ as Figure 99 shows.

Figure99. Sentry Mode - Detailed View

For radios in sentry mode, the AP power display image around the AP is gray.

The Channel Color legend maps the color of the power display image to the channel that the
image color represents. The color corresponds to the channel that the radio is using for
transmission. The available channels depend on the mode and country of operation.

Figure 100. Channel Colors
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To view the channel that aradio is using, you can mouse-over the managed AP to activate the

tool tip. Thetool tip displays general information about the AP, including the channel that each
radio uses.

Figure101. Tool Tip for Radio Managed AP Infor mation

| - 1 | \.l| 1
14 R B 111 | 110 | 108 108

AC address: 00:11:95A3:32:80
ocation: lah —
onfiguration: Success
atus: Managed

rotocol: [EEE 802.11a
ower Range: High
Channel: 153

dio 2
rotocol: IEEE B02.110
ower Range: High
Channel: 1

You can also right-click the object to access a variety of information, which the next section
describes.
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10 Visualizing the Wireless Network

After you place a component on the graph, you can right-click the component to learn more
information about it, un-graph it, or link to a page on the Web Ul to manage or monitor the

component.

Figure 102. Wireless Component Attributes
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MAC Address: 00:11:95:A3:32:80
Location: lak

Configuration: Success

Status: Managed

Radio 1

Protocol: IEEE 802.11a
Power Range: High

RF Channel: 153

Radio 2

Protocol: IEEE 802.11g
Power Range: High

RF Channel: 1

Table 75 lists the attribute and link information available from each component.
Table 75. Component Information

Component Attributes Links/Commands
Switch IP Address Basic Setup
RF Management
Global Status/Statistics
Peer Switch IP Address Peer Switch Status
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Table 75. Component Information

Component Attributes Links/Commands
Managed AP MAC Address Configuration

Location « AP Profile Configuration

Configuration e Valid AP Configuration

Management
Status—Managed i
i e Radio

Radio—1 or 2 «  Software Download

Protocol—802.11hb/g or 802.11a * Debug

Power Range—L ow, Medium, or High Status and Statistics

RF Channel—Depends on channel plan * IE)/I:tnalged AP Status

al
Sentry Mode (if enabled) «  Radio Status and
Statistics
Command: AP Reset

Other AP MAC Address Status

Status—Rogue, Standalone, Peer Managed, Commands:

or Acknowledged AP «  Manage

RF Channel * Acknowledge
Wireless Client MAC Address Associated Client Status

Radio—1 or 2 Detail

RF Channel—Depends on channel plan

Command: Disassociate
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Settings

This chapter identifies the default values for the D-Link Unified Switch, the default D-Link
Access Point settings, and the default AP Profile setting that the switch assigns to the AP after
it is discovered and authenticated (when the AP uses the default profile).

Default D-Link Unified Switch Settings

Table 76 shows the default settings for the D-Link Unified Switch.

Table 76. Switch Defaults

Feature

Default

System Information

User Name admin
Password None
Network I nformation
DHCP Client Disabled
Network Configuration Protocol ~ None
IP Address 10.90.90.90
Subnet Mask 255.0.0.0
802.1Q Enabled
Management VLAN ID 1
Untagged VLAN ID 1
Spanning Tree Protocol Enabled

Default D-Link Unified Switch Settings
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Table 76. Switch Defaults

Feature

Default

WLAN Information

Unified Switch Mode Enabled
AP Authentication Disabled
AP Vadidation Local
Country Code us
Default Profile Name Default
Peer Switch Group ID 1

L2 (VLAN) /L3 (IP) Discovery  Enabled
SNMP Traps Disabled
Client Roam Timeout 30 seconds
Ad Hoc Client Status 24 hours
AP Failure Status 24 hours
Client Failure Status 24 hours
RF Scan Status 24 hours

Default D-Link Access Point Settings

Table 77 shows the default D-Link Access Point settings.
Table 77. Default AP Settings

Feature

Default

System Information

User Name admin
Password admin
Network I nformation
DHCP Client Enabled
Management | P Address 10.90.90.91 (If not assigned by DHCP)
Subnet Mask 255.0.0.0 (If not assigned by DHCP)
Management VLAN 1
Untagged VLAN 1
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Default D-Link Access Point Profile Settings

Table 78 showsthe AP settings for the default profile. By default, when a D-Link Access Point
associates with the switch, the settingsin thistable are assigned to the AP upon successful AP
validation.

Table 78. AP Profile Default Settings

Feature Default
Radio Settings
Radio (1 and 2) On
Radio 1 IEEE 802.11 Mode 802.11a

NOTE: If the AP operatesin aregulatory domain
where 802.11ais not supported, the radio is disabled
and no mode is configured.

Radio 2 |EEE 802.11 Mode 802.11b/g

RF Scan Other Channels Disabled

RF Scan Interval 60 seconds

RF Scan Duration 10 milliseconds

Super A/G Disabled

Extended Range Disabled

Automatic Channel Enabled

Automatic Power Enabled

Initial Power 100

Load Balancing Disabled

Load Utilization 60%

Maximum Clients 256

RTS Threshold 2347 bytes

DTIM Period 10 beacons

Fragmentation Threshold 2346 bytes

Beacon Period 100 milliseconds

Rate Sets |EEE 802.1a: 54, 48, 36, 24, 18, 12, 9, 6

Supported (Mbps) |EEE 802.1g: 54, 48, 36, 24, 18, 12, 11, 9,6,5.5,2,1
IEEE 802.1b: 11,55, 2, 1
Atheros Dynamic Turbo 5 GHz: 108, 96, 72, 48, 36, 24,
18, 12

Rate Sets (Mbps) |IEEE 802.1a: 24, 12, 6

(Basic/Advertised) |EEE 802.1g: 11, 5.5, 2, 1

IEEE 802.1b: 2, 1
Atheros Dynamic Turbo 5 GHz: 48, 24, 12
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Table 78. AP Profile Default Settings

Feature

Default

Virtual Access Point and Network Settings

Status VAPO is enabled on both radios, all other VAPs
disabled

Network Name (SSID) Guest Network (VAPO)

VLAN 1

Hide SSID Disabled

L3 Tunnel Disabled

Security Mode Open System

MAC Authentication Disabled

RADIUSIP Address

Use Profile (Global)

RADIUS Accounting Disabled
Other Settings

QoS Enabled

WMM Enabled

Default Captive Portal Settings

Table 79 shows the default captive portal settings.

Table 79. Default Captive Portal Settings

Feature

Default

Global Configuration

Operationa Status Enabled

Additional HTTP Port None

Peer Switch Statistics Reporting 120 seconds

Interval

Authentication Session Timeout 600 seconds
CP Configuration

Status Enabled

Configuration Name None

Protocol Mode HTTP

Verification Mode Guest

User Group None

URL Redirect Mode Disabled

Session Timeout 0 (unlimited)

Idle Timeout 0 (unlimited)

Languages English
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Configuring the External RADIUS
Server

You can store the Valid AP configuration on alocal database on the D-Link Unified Switch or
on an external RADIUS server. This appendix describes the attributes you must define for
each feature to setup their configuration on the RADIUS server.

One important reason why you might define the AP information on the RADIUS server rather
than on the switch isto allow peer switches to obtain the data from a single source rather than
having to define it on each switch.

Configuring RADIUS Settings for Access Points

Sincethe AP isidentified by its physical MAC address, you must add a RADIUS entry for
each AP with the User-Name attribute set to the MAC address. Table 80 indicates the
attributes to configure in the RADIUS server entry for each AP. Add the vendor-specific
attributes by using the D-Link vendor ID (6132) and the identifier D-Link-Wireless-AP-*
(where “*” represents the attribute name).

NOTE: This appendix does not describe RADIUS configuration for AP network
authentication using 802.1X. Thisfeature is separate from avalid AP
configuration entry. The edge device that connects to the AP performs the
network authentication. The edge device might not be the D-Link Unified
Switch.

Table 80. RADIUS Attributes for the Access Point

RADIUS Server

Attribute Description Range Usage
User-Name (1) Ethernet Address of the AP. Valid Ethernet MAC Required
Address
User-Password (2) A fixed password used to 8-63 characters, default  Required
lookup an AP entry. NOPASSWORD
Vendor-Specific (26) A description for the AR, 1-32 characters Optional
Location often based on its location.

Configuring RADIUS Settings for Access Points 207



D-Link Unified Access System User Manual

208

Table 80. RADIUS Attributes for the Access Point

RADIUS Server

Attribute Description Range Usage
Vendor-Specific (26)  Indicates whether thisAPis WS Managed (1) Required
Mode mangged by the S_Ni tch,byan  gandalone )

administrator, or isarogue
AP Acknowledged Rogue
©)
Vendor-Specific (26)  If APismanaged by aswitch, 1-16 Required if
Profile-ID the ID of the configuration modeis WS
profile for thisAP. managed.
Vendor-Specific (26)  If thereismorethan oneWS  Valid IP Address Optional
Switch-1P using this RADIUS server,
indicatesthe IP address of the
WS to managed this AP,
Vendor-Specific (26)  Indicates afixed channel for  Valid channels depend Optional, if
Radio-1-Chan theradio. on the regulatory defined and
Vendor-Speific (26) domain (country-code)  valid will
Radio-2-Chan and the configured override auto
mode for that radio in channel

the assigned AP profile.

If the channel is not
valid, itsignored.

0 indicates automatic
channel assignment.

configuration

Vendor-Specific (26)  Indicates afixed power 0, 1-100 percent Optional, if
Radio-1-Power setting for the radio. 0 indicates automatic defined and
power assignment. valid will
override auto
power
configuration
Vendor-Specific (26)  Indicates afixed power 0, 1-100 percent Optional, if
Radio-2-Power setting for the radio. 0 indicates automatic defined and
power assignment. valid will
override auto
power

configuration

When you do not require authentication between the APs and the RADIUS server, the switch
uses the password “NOPASSWORD” in communications between the RADIUS client on the
switch and the RADIUS server. The RADIUS client on the switch uses this password when it
retrieves entries from the server. When you do require AP authentication, the password for AP
authentication to the Unified Switch (separate from and in addition to AP authentication to the

network) will be in thisfield.
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FreeRADIUS Server Configuration Example

FreeRADIUS is an open source RADIUS server that you can download free from
http://www.freeradius.org. The examplein this section describes the files you need to
configure in order to authenticate the D-Link Unified Switch and the D-Link Access Point
with the RADIUS server and to configure the Valid AP settings in the RADIUS database.

Configuring RADIUS Clients

If you require the D-Link Unified Switch or D-Link Access Points to authenticate themselves
with the RADIUS server, you must configure client entries for the devicesin the RADIUS
server'set ¢/ raddb/ cl i ents. conf file

The entry contains the IP address of the client, the shared secret, and anickname (or DNS
name) for the device.

Thefollowing entry inthecl i ents. conf fileisfor aswitch with the following information:

e |Paddress: 192.168.30.249
e Subnet mask: 255.255.255.0
e Shared secret: wireless

e DNSname: wireless-swl

The following code shows the format of the client entry inthecl i ents. conf file:

client 192.168.30.249/24 {
secret = wirel ess
shor t nane = wirel ess-swl

}

Creating and Including an Attribute Dictionary

You configure attributes in an attribute dictionary so that you can assign the attributes and
values to an access point when you configure it in the Valid AP database on the RADIUS
server. For example, to assign alocation to an access point, the attribute you define has the
following format:

ATTRI BUTE D-Li nk- Wr el ess- AP-Locati on 101 string D-Link
Thefieldsin the attribute are as follows:

» Attribute—type of entry

» D-Link-Wireless-AP-Location—name of the attribute

* 101—ID number assigned to the attribute; you must use this number when you configure
the location attribute

» string—type of datafor the attribute

»  D-Link—uvendor-specific name for the attribute

Thefollowing VALUE field defines one of the values you can assign to an AP for the AP
Mode.

VALUE D- Li nk- Wr el ess- AP- Mode W5- Managed 1
The VALUE fields are asfollows:

*  VALUE—type of entry
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* D-Link-Wireless-AP-Mode—name of the attribute
*  WS-Managed—value for the attribute
» 1—name-to-number mapping for the attribute

Thefollowing code is an example of the D-Link attribute dictionary. The code shows the
completefile. You can create your own dictionary and configure the attributes and values that
your WLAN requires. The VENDOR field has the vendor-specific attribute name-to-number

mapping.

After you create the file, save the dictionary in the et ¢/ r addb directory with afile name
di cti onary. <conpany>, for example, di cti onary. D-Li nk.

ATTRI BUTE D- Li nk- Wr el ess- AP- Radi o- 1- Power 107
ATTRI BUTE D- Li nk- Wr el ess- AP- Radi o- 2- Power 108

nteger D Link
nteger D Link

VENDOR D- Li nk 6132
#
# D- Li nk Vendor Specific Extensions
#
#
ATTRI BUTE D- Li nk- Wr el ess- AP- Locat i on 101 string D- Li nk
ATTRI BUTE D- Li nk- Wr el ess- AP- Mode 102 integer D-Link
ATTRI BUTE D-Li nk-Wrel ess-AP-Profile-1D 103 integer D-Link
ATTRI BUTE D- Li nk-Wrel ess-AP-Swi tch-1P 104 i paddr D- Li nk
ATTRI BUTE D- Li nk- Wr el ess- AP- Radi o- 1- Chan 105 integer D-Link
ATTRI BUTE D- Li nk- W r el ess- AP- Radi o- 2- Chan 106 integer D-Link
i
i

VALUE D-Li nk-Wr el ess- AP- Mbde W5- Managed 1
VALUE D- Li nk-Wr el ess- AP- Mode St andal one 2
VALUE D-Link-Wrel ess- AP- Mode Rogue 3
VALUE D- Link-Wr el ess- AP- Radi o- 1- Chan Aut o 0
VALUE D- Li nk-Wr el ess- AP- Radi o- 2- Chan Aut o 0
VALUE D- Link-Wrel ess- AP- Radi o- 1- Power Auto 0
VALUE D-Link-Wrel ess- AP-Radi o- 1- Power M ni mum 1
VALUE D Link-Wrel ess- AP-Radi o-1- Power Maxi num 100
VALUE D- Link-Wr el ess- AP- Radi 0o- 2- Power Auto 0
VALUE D Link-Wrel ess-AP-Radi o-2-Power M ni num 1
VALUE D-Li nk-W rel ess- AP- Radi 0- 2- Power  Maxi mum 100

After you create an attribute dictionary file, you must insert an INCLUDE statement into the
the main file dictionary for the FreeRADIUS server.

The main dictionary iset ¢/ r addb/ di cti onary. The following example shows an INCLUDE
statement for the D-Link attribute dictionary called di cti onary. D- Li nk.

$I NCLUDE di ctionary. D-Li nk

Adding Access Points to the Valid AP Database

You use the attributes you define in the dictionary file to configure the settings for an access
point in the Valid AP database on the RADIUS server. The file you configure isthe

et ¢/ raddb/ user s file. The following code is an example of a database entry for an AP with
the MAC address 00:11:95:a3:32:80.
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NOTE: Inthe FreeRADIUS database, the MAC address is case sensitive, and the
octets must be separated by hyphens.

00-11-95-a3-32-80 Aut h- Type : = Local, User-Password=="NOPASSWORD"
D Li nk- Wr el ess- AP- Mbde = W5- Managed,
D- Li nk- Wrel ess-AP-Location = "Lobby AP",
D-Li nk-Wrel ess-AP-Profile-1D = 1,
D-Li nk-Wrel ess-AP-Switch-1P = 192. 168. 30. 4,
D- Li nk- Wr el ess- AP- Radi o- 1- Chan = Auto,
D- Li nk- Wr el ess- AP- Radi o- 2- Chan = Auto,
D- Li nk- Wr el ess- AP- Radi o- 1- Power Aut o,
D- Li nk- Wr el ess- AP- Radi o- 2- Power Aut o

Configuring RADIUS Settings for Wireless Clients

You can configure D-Link Access Points to use 802.1X authentication on the RADIUS server
to alow or deny specific users on client stations access to the wireless network. If you enable
802.1X authentication, the client entry on aRADIUS server can support user-based VLANS
and subnet assignments for 1P tunneling. Table 81 shows the attributes to set for wireless
clientswithin the RADIUS server.

Table 81. RADIUS Attributes for Wireless Clients

RADIUS Server

Attribute Description Range Usage
User-Name (1) 1-32 characters Required
User-Password (2) 1-128 characters Required
Tunnel-Medium-Type 802 Optional

(65)

Configuring RADIUS for Client MAC Authentication

You can configure the AP to use RADIUS-based MAC authentication to allow or deny
specific client stations access to the wirel ess network. Although this method isless secure than
802.1X, you can use it for client stations that do not support 802.1X.

The addresses you enter are either allowed or denied based on the global default action within
the AP profile.

Table 82 indicates the attributes that you configure in the RADIUS server entry.
Table 82. RADIUS Attributesfor Wireless Client MAC Authentication

RADIUS Server

Attribute Description Range Usage
User-Name (1) Ethernet Address of theclient  Valid Ethernet Required
station. MAC Address.
User-Password (2) A fixed password used to NOPASSWORD Required

lookup aclient MAC entry.
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FreeRADIUS Example for Wireless Client

Configuration

You can use an external RADIUS server, such as a server running FreeRADIUS, to
authenticate users who attempt to connect to an access point. The authentication is based on
the username and password, and not the wireless client used for access. The RADIUS server
can also assign the user to aVLAN after he or she is authenticated by the server.

In addition to user-based authentication, you can configure MA C-based authentication to
alow or deny wireless clients access to the AP based on the MAC address of the client.

Configuring User-Based Authentication and Dynamic VLANs

You can configure an entry in the external RADIUS server to pass a users credentials to the
access point and to dynamically assign the user to aVLAN.

Dynamic VLANs alow you to assign auser to a VLAN, and switches dynamically use this
information to configure the port on the switch automatically. Selection of the VLAN is
usually based on the identity of the user. The RADIUS server informs the access point of the
selected VLAN as part of the authentication. This setup enables users of Dynamic VLANSsto
move from one location to another without intervention and without having to make any
changes to the switches.

If you use an external RADIUS server to manage VLANS, you configure the server to use
Tunnel attributes in Access-Accept messages in order to inform the access point about the
selected VLAN. These attributes are defined in RFC 2868 and their use for dynamic VLAN is
specified in RFC 3580.

The VLAN attributes defined in RFC3580 are as follows:

*  Tunnel-Type=VLAN (13)
*  Tunnel-Medium-Type = 802
*  Tunnel-Private-Group-ID = VLANID

To create a user and assign the user to aparticular VLAN by using FreeRADIUS, open the
et ¢/ raddb/ user s file, which contains the user account information, and add for the new user.

The following example shows the entry for auser inthe user s file. The usernameis
“johndoe,” the password is “test1234.” The user isassigned to VLAN 77.

j ohndoe Aut h- Type: = EAP, User-Password == “test1234"
Tunnel - Type = “VLAN',
Tunnel - Medi um Type = “I| EEE- 802",

Tunnel -Private-Goup-1D = “77",

Tunnel-Type and Tunnel-Medium-Type use the same va ues for all stations. Tunnel-Private-
Group-1D isthe selected VLAN ID and can be different for each user.

NOTE: Do not use the management VLAN ID of the AP for the value of the Tunnel-
Private-Group-1D.

The dynamically-assigned RADIUS VLAN cannot be the same as the AP’s management
VLAN. If the RADIUS server attempts to assign adynamic VLAN to aclient that associates
with an AP with that VLAN as the management VLAN, the AP ignores the dynamic VLAN
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assignment and a newly associated client is assigned to the default VLAN for that VAP, A re-
authenticating client retains its previous VLAN ID.

The default management VLAN ID for all APsis 1. The only way to changean AP's
management VLAN ID isby using theset managenent vl an-i d command from the CLI.

After you change theet ¢/ r addb/ user s file, you must restart the RADIUS server daemon to
apply the changes.

Configuring MAC Authentication

For each network, you can configure whether to use alocal or RADIUS database for client
MAC authentication. To use RADIUS-based MAC authentication for wireless clients, you add
an entry for each client in the et ¢/ r addb/ user s file. If the default action for MAC
Authentication on the switch is set to “Allow,” only clients that have an entry intheuser s file
are allowed access to the network through the AP, If the default action is set to “deny” the
clientswithaMAC addressin the users file cannot authenticate with the AP,

Thefollowing lineisan example of an entry for aclient inthe et ¢/ r addb/ users file.
00- OF- FE- 1C- F2- 67 Aut h- Type: = Local, User-Password == “NOPASSWORD'

NOTE: The password is aways NOPASSWORD, and the MAC address of the client
uses hyphens, not colons.
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L 3 Roaming can be achieved by using VLAN trunking (associate the SSID with a VLAN) or
by using an L3 Tunnel (associate the SSID with atunnel subnet). The examplein this
appendix describes how to configure a D-Link Unified Switch by using an L3 Tunnel for a
network that needs L 3 roaming capabilities.

This example contains information about the following features, which might be required to
use L3 tunneling on your WLAN:

e Configuring the WLAN and Tunnel Interfaces
» Configuring the L3 Tunnel Network
» Configuring DHCP Relay and the DHCP Server
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Configuring the WLAN and Tunnel Interfaces

The following figure shows an example of a network that uses L 3 tunnels to support wireless
roaming. The subnet that all clients will use for L3 roaming is 192.168.60.0/24. The
configuration examples in the rest of this appendix use the network information in this figure.

Figure 103. Example of a Network with L3 Tunnel Subnet

WS1 VLAN Routing Interface
192.168.60.15

WS1 WLAN (Loopback) Interface
192.168.100.15

WS2 Network WS2 VLAN Routing Interface
Interface @ 192.168.60.25
M WS2 WLAN (Loopback)

Interface
192.168.200.15

5

i WS1 Network

% Interface
Call Server 192.168.2.20

192.168.60.35

AP1
192.168.18.10

= 192.168.28.10
Wireless Client @ Wireless Client
192.168.60.55 o 192.168.60.55
e )
2 f = -

The network in the example has the following characteristics:

» TheVLAN Routing interface on each switch, call server, and roaming wireless client are
all on the L3 tunnel subnet.

»  Peer Unified Switches have logical interfaces on the same L3 tunnel subnet in order for
clients to roam among APs managed by all peer Unified Switches on the network.

*  Peer Unified Switches are not on the same physical subnet.

* TheAPsare not in the same subnet as the switches or asthe L3 tunnel subnet.

» Thecall server is physically connected to a Unified Switch, and the port the call server
usesisassigned to the VLAN ID of the VLAN Routing interface of the tunneled subnet.

» Each switch uses aloopback interface for the WLAN functions, and the loopback
interface is on a different network than the L3 tunnel subnet.

* Routing is enabled on each switch.

» Network devices have routes to the loopback and L3 tunnel subnets, and a host can ping
the loopback interface and L3 tunnel interface on each switch.

» DHCPréeay isenabled on each switch so that a DHCP server on the network can assign IP
addresses to the wireless clients.

» Thewireless client receives an |P address in the L 3 tunnel subnet and keeps that |P
address throughout the roaming session.

CAUTION: APs, peer Unified Switches, and other routers must not be connected to
the tunneled routing interface.
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Some phone system require placement of acall server on the same subnet as the phones. The
D-Link tunneling feature supports this configuration.

There are afew things to consider when planning a network with L3 roaming capabilities:

» Packetsthat use the L3 tunnel have an extra 20 bytes in the header for encapsulation.

» To support these larger frames, you can increase the MTU size on all intermediate ports
and Unified Switch ports.

* If you use tunneling only for IP telephony, or if you set the MTU size on all wireless
clientsthat use tunneling to 1480, you do not need to increase the MTU sizein the
network.

e For traffic in the L3 tunnel, the switch forwards |Pv4 unicast frames in hardware; other
types of traffic, such as multicast and non-1P traffic, are forwarded in software.

- Multicast and non-1P traffic on the L3 tunneling network could cause network
congestion.

- Wirdess tunneling does not work if IPv6 or multicast traffic is enabled onthe L3
tunnel interface.

* All devicesthat use the L3 tunnel network are stored in the ARP cache because the
wireless subnet islocal to the switch, which means the ARP cache can fill up faster than
expected.

*  Whentunneled clients are used in conjunction with peer switches, one of the peer switches
must be configured as a default gateway for the tunneled clients. Normally the default
gateway routes al traffic from the client’s subnet to other subnets, however in a peer
switch network the Unified Switch that manages the AP to which the client is associated
routes the frames into the remote subnets. This means that each peer switch must have
routing table entries that enable it to route frames to every subnet in the network.

Using a Loopback Interface for the Wireless Functions

By creating aloopback interface, you can control which routing interface the wireless function
uses for its | P address when multiple routing interfaces exist. With the loopback interface, the
I P address of the wireless function is always the same.

NOTE: Inthiscontext, the loopback interface does not refer to the loopback interface
with the 127.0.0.1 P address. When you configure aloopback interface for
the wireless interface on the switch, it is essentially a permanent logical inter-
face and cannot have an | P address of 127.0.0.1. You must create a dedicated
subnet for the loopback interface, and other devices on the network must be
able to contact the IP address of the loopback interface.

You must create static routes so other devices can find the loopback interface.

The advantage of defining aloopback interface is that the interface never goes down. The
disadvantage is that network configuration is more complex because the loopback interface is
located on its own subnet and the rest of the network must know how to get to the subnet.

The network must have routes between the Unified Switch and the APs to manage. The APs
must be able to ping the IP address of the loopback interface used asthe WLAN interface on
the Unified Switch.

The following procedures show an example of how to enable routing and configure an |P
address on aloopback or routing interface.
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1. Logontothe CLI and switch to Global Config mode:

(System Pronpt)
User: admn

Passwor d:

(System Pronpt) >enable
Passwor d:

(System Pronpt) #config
(System Pronpt) (Config)#

2. Enable routing.
(System Pronpt) (Config)#i p routing

3. Change to Interface Config mode for loopback interface O, and assign an | P address and
subnet mask.

(System Pronpt) (Config)#i nterface | oopback 0O
(System Pronmpt) (Interface |oopback 0)#ip address 192. 168. 100. 15 255. 255. 255. 255

You can also use the Web interface or SNMP to enable routing and configure an |P address.
Thefollowing example shows the procedures to enabl e routing and configure an | P address on
the switch by using the Web interface.

1. Logon tothe Web interface and click Routing > | P > Configuration to accessthe | P
Configuration page.

From the Routing M ode drop-down menu, choose Enable, and then click Submit.

To create aloopback interface, click Routing > L oopback > Configuration.

From the Loopback drop-down menu, choose Create, and then click Submit

Enter an IPv4 address and subnet mask in the appropriate fields, and then click Submit.

SAE N S AN

Creating the VLAN Routing Interface

The D-Link Unified Switch and the D-Link Access Point support Virtual LANs (VLANS) to
provide the logical separation of a physical network. You can use VLANSs to segment the
wireless network on a per-VAP basis. VLAN routing interfaces alow VLANS to span across
different subnets, which is useful for L3 Tunneling.

In Figure 103, WS1 and WS2 have a VLAN routing interface on the L3 Tunnel subnet. The
following commands show how to configure the interface for WS1, which hasaVLAN
Routing interface with VLAN ID 200 and an I P address of 192.168.60.15.

1. Enter VLAN config mode, create aVLAN, and give it aname.

(swi tch-pronpt) #vlan database
(switch-prompt) (M an)#vlan 200
(switch-pronmpt) (M an)#vlan name 200 "L3 Tunnel "

2. Create aVLAN routing interface on VLAN 200.
(swi tch-pronmpt) (M an)#vlan routing 200
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3. Exit to Privileged EXEC mode and view the VLAN routing interface configuration.

(switch-pronmpt) (W an)#exit
(swi tch-pronpt) #show ip vlan

MAC Address used by Routing VLANs: 00: 00: 00: 01: 00: 02

Logi cal
VLAN | D Interface | P Addr ess Subnet Mask
200 0/4/1 0.0.0.0 0.0.0.0

The new VLAN routing interface is 0/4/1 in unit/slot/port format. For non-stacking
platforms, the interface would be 4/1.

4. Enter the interface configuration mode for the new VLAN routing interface.
(swi tch-pronpt) #configure
(switch-prompt) (Config)#interface 0/4/1

5. Assign an IP address to the interface and enable routing.

(switch-pronpt) (Interface 0/4/1)#ip address 192.168. 60. 15 255. 255. 255.0
(switch-prompt) (Interface 0/4/1)#routing

6. Add the port to which the call server is attached to VLAN 200 (in this example, the call
server is attached to port 3).

(switch-prompt) (Config)#interface 1/0/3
(switch-pronpt) (Interface 1/0/3)#vlan participation include 200

To perform the same steps by using the Web interface, use the following procedures:
1. FromthelL 2 Features>VLAN > Configuration page, create aVLAN, giveit aname,

and add the port to which the call server is attached to VLAN 200 (in this example, the call
server is attached to port 3).

VLAN Configuration

VLAN ID and Name Create v

VLAN ID 200 | {1to 3965)

VLAN Name !'['éu'l_'ﬂnnel

VLAN Type Static
Status ~~ |Participation Tagging

All v v
0/ Autodetect « Untagged «
052 Autodetect » Untagged «
073 Include v Untagged
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2. Fromthe L3 Features> VLAN Routing Configuration page, createaVLAN routing
interface on VLAN 200.

AN QR
l=2 ws-s026 VLAN Routing Configuration
HEF administration r
BMHE# L2 Features VEanin |L {1 to 3965)
EHER L3 Features Slot/Port A1
'% ARE MAC Address 00:50:ba:22:22:
IP Address 0000
Subnet Mask 0.00.0
% Loopbacks
'% BOOTR/DHCE Relay Ager

3. Fromthe L3 Features> IP > Interface Configuration page, assign an IP address and
subnet mask to the interface, and make sure routing is enabled.

o ooe —— -]

55555 IP Interface Configuration

F{EE  administration

Slot/Port

H{#8 Lz Features il -

EIE L3 Features IP Address 192.168.60.15 \
FHEE aRP Subnet Mask |2§§'2_5_5_§'5§_§ \
EHEg 1P Routing Mod R

suliguaien outing Mode Enable «
B Wi te = o= Configuratio Administrative Mode Enabled
EHEE Loapbacks Forward Net Directed Broadcasts Disable «
EE@ BOOTP/DHCP Relay Ager -
B router Active State Inactive
WLAMN Routing Configurati MAC Address 00:50:BA:22:22:24
EE vRRP Encapsulation Type Ethermnet «

E{EE QoS

HE acL Proxy Arp Enable ~

B{f Security Local Proxy Arp Disable

"

B Monitaring IP MTU 1500 (68 to 1500)

4. FromtheMonitoring > L3 Status > VL AN Routing Summary page, view the summary
information for the VLAN routing interface.

VLAN Routing Summary

LAN ID m MAC Address IP Address Subnet Mask
41 00:50:B4:22:22:24 192.168.60.15 255.255.255.0

Configuring the L3 Tunnel Network

Configure L3 tunneling by modifying or adding a Network. Then, make sure the network is
associated with aVVAP on the AP Profile assigned to the APs that wireless clients might use for
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roaming. Once you change the AP Profile, re-apply the profile to the APsto reset the APs that
use the profile.

NOTE: When L3 tunneling is enabled, the VLAN ID for the network is not used. In

fact, the switch puts the management VLAN ID, if any, on the tunneled pack-
ets.

In this example, the L3 Tunnel network is on Network 3 on the Default AP Profile. The SSID
of the network is“L3 Tunnel,” and the security mechanism is WPA Enterprise.

Example of Configuring L3 Roaming by Using the CLI

Thefollowing procedures show how to configure the D-Link Unified Switch by using the CLI.
The Web interface configuration procedures follow this example.

1.

Enter the network configuration mode for network 3.

(swi tch-pronpt) #configure
(switch-pronpt) (Config)#wreless
(switch-prompt) (Config-wirel ess)#network 3

Create the network name (SSID).
(switch-pronpt) (Config-network)#ssid “L3 Tunnel”

Configure security on the network to control wireless client access.

For this network, the administrator uses WPA Enterprise for the security mode. The
administrator must also configure the security on each client that is allowed to access the
L3 Tunnel network.

(switch-pronpt) (Config-network)#security node wpa-enterprise

Enable L3 roaming.
(swi tch-pronpt) (Config-network)#tunnel

Configure the L3 network | P address and subnet mask for the tunnel.

NOTE: The network address you enter must be the same subnet used by the VLAN
routing interface created in “Creating the VLAN Routing Interface” on
page 218.

(sw tch-pr 0rrpt5)

(Confi g- net wor k) #t unnel subnet 192.168.60. 0 nask
255.255.255.0

Exit out of Network mode and Enter AP profile configuration mode for the default profile
(Profile 1).

(swi tch-pronpt) (Config-network)#exit
(switch-prompt) (Config-wireless)#ap profile 1

Enter the AP Profile Radio Config mode for the radio you want to use.

In this example, the L3 Tunnel network uses Radio 1, which is the 802.11g radio by
default.

(switch-pronpt) (Config-ap-profile)#radio 1

Enter the AP Profile VAP Config mode for VAP 2 and enable the VAP.
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10.

VAP 0 is the default network and is the only network enabled by default. In this example,
the Guest networksis on VAP 0, the Corporate Network ison VAP 1, and the L3 Tunnel
Network ison VAP 2.

(swi tch-pronpt) (Config-ap-radio)#vap 2

(swi tch-pronpt) (Config-ap-profile-vap)#enable

Associate the L3 Tunnel Network (network 3) with VAP 2.

(swi tch-pronpt) (Config-ap-profile-vap)#network 3

Enter CTRL + Z to exit to Privileged EXEC mode and view the network configuration to

make surethe L3 Tunnel Statusiis listed as “ Configured” and to confirm that other
network settings are correct.

(swi tch-pronpt) #show wirel ess network 3

Network 1D ... 3

SOl D L3 Tunnel
Default VLAN. ... ... .. . e 1

Hide SSID. ... Di sabl e
Deny Broadcast..........c.ouuiiiinuniinnnennn. Di sabl e

L3 Tunnel Mode. ... ... ... .. Enabl e

L3 Tunnel Status............ ... ... Confi gured
L3 Tunnel Subnet IP........ ... ... ... ... .. ... 192.168. 60. 0
L3 Tunnel Subnet Mask.......................... 255.255.255. 0
Security Mude. . ... .. ... WPA Enterprise
MAC Authentication............... ... ... ..... Di sabl e
RADIUS Use AP Profile....... ... ... ... ... ... ... Enabl e

RADI US Server IP.... ... ... . . .. 0.0.0.0

RADI US Secret Configured....................... No

RADI US Accounting. ....... ..., Di sabl e

WPA VerSiONS. . ..ot WPA/ WPA2
WPA Giphers. . ... TKI P

WPA Key Type. .. ASCl |

WPA KeY. .o

WPA2 Pre-Authentication........................ Enabl e

WPA2 Pre-Authentication Limt (minutes)........ 0

WPA2 Pre- Aut hentication Tineout (mnutes)...... 0

--Mre-- or (q)uit

WPA2 Key Forwarding............ ..., Enabl e

WPA2 Key Caching Holdtime (mnutes)............ 10

VEP Aut hentication Type.......... ... ... ... Open System
VIEP Key TYPe. .. e HEX

VEP Key Length (bits).......... ... ... ........ 128

VEP Transfer Key Index............ ... ... ....... 1

VEP KEY L.ttt ettt e e e e

VEP Key 2. . . .

VEP Key 3. ..

VEEP Key 4. ..

An important value to note isthe L3 Tunnel Status value. The following table lists the
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possible values and explains what they mean.
Table 83. L3 Tunnel Satus Values

L3 Tunnel Status Description

None The status might be None for one of the following reasons:

e« TheWLAN Operational Statusis disabled

e L3 Tunnel is Disabled

¢ Thenetwork isnot associated with any AP profiles. If you create
or edit a network and configure L3 Tunneling, but there are no
VAPs on any AP Profilesthat use the network, the statusis None.

Configured The L3 Tunnel is configured and ready to be applied to the APs that
use this profile.
Not Configured - Routing is disabled on the routing interface.

Routing Disabled

Not Configured - No  The status might show this value for one of the following reasons:
Routing Interface

The routing interface for the L3 Tunnel network does not exist.
IPv6 is enabled on the routing interface.

IP Multicast is enabled on the routing interface.

The Tunnel subnet address does not match a routing interface.

Inthe examplein thisappendix, the VLAN routing interface hasan IP
address of 192.168.60.15/24, and the L3 Tunnel Subnet is
192.168.60.0/24, so the tunnel subnet matches a routing interface.

11. From Privileged EXEC mode, apply the modified default profile to the APs that use the
default profile (Profile 1).

(switch-pronpt)#wireless ap profile apply 1

After the managed AP updates complete, the L3 Tunnel network is available on all APsthat
use the default profile. Users who connect to an AP by using the L3 Tunnel SSID can roam
among all APswithout traffic interruption.

To test connectivity, make sure you can ping from each AP to the switch loopback 1P address
and the IP address used by the routing interface for L3 tunnels. From Privileged EXEC mode,
you can enable debugging on the AP with thewi rel ess ap debug <macaddr > command,
which allows you to Telnet to the AP.

Once awireless client associates with the tunneled subnet, use the ping command and set a
large packet size to make sure you can send the desired MTU size through the tunnel.

From aWindows client, use -1 <si ze> to set the packet size and - f to prohibit packet
fragmentation, for example:

ping -1 1542 -f 192.168. 60. 15

From a Unix system, use - s <si ze> to set the packet size and - M do to prohibit packet
fragmentation, for example:

ping -s 1542 -M do 192. 168. 60. 15
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Example of Configuring L3 Roaming by Using the Web Interface

The following steps shows the procedures to configure the L3 Tunnel Network by using the
Web interface on the switch.

1. Fromthe Administration > Basic Setup > SSID tab, select the check box next to the
SSID to configure and click Edit.

WAR Configuration

AP Profile 1-Default
®1-802.11a O2-802.11g

SSID VLAN L3 Tunnel Hide SSID Securi

Guest Netwark % 1-Default Disabled Disabled Mane

Company WLAN % 1-Default Digabled Digahled WPA Enterprise
¥ Managed 35ID3 » 1-Default Disabled Disabled Mone

Managed S5ID 4 £k 1-Default Disabled Digabled Mane

Managed S5ID 5 Ed 1-Default Disabled Disabled Maone

Managed SSID 6 E 4 1-Default Disabled Disabled Maone

Managed S5ID 7 I 1-Default Disabled Digabled MNane

Managed S5ID & I 1-Default Disabled Disabled Maone

[ Refresh | [ Submit | [ Mest |

2. From Wireless Network Configuration page, configure the following settings:

- SSID—L3 Tunnd

- L3 Tunnel check box—Sel ected

- L3 Tunnel Subnet—192.168.60.0
- L3 Tunnel Mask—255.255.255.0.
- Security—WPA/PSK.

The L3 Tunnel Subnet isthe network 1P address of the VLAN routing interface configured
in the procedures for Creating the VLAN Routing Interface.

Global | Discovery | AAA/RADIUS | Radio

| Valid AP |

ork Configuration
SSID [valP Netwark ] Security OnNane OWEP ©WPAMWPA2
Hide SSID | @wWPA Personal O YWPA Enterprise
lgnore Broadcast ]
VLAN o WPA Versions  [V]ywpa [Vlwpaz
| (1 to 4094
L[t ) WPA Ciphers  [“|TkIP []CCMPAES)
L3 Tunnel

WPA Key Type ASCI

L3 Tunnel Status Mot Configured - Routing Disabled T
Passphrase ImArYHAdaliTTIeLamE] |

L3 Tunnel Subnet i192_158_1DD_D ]

L3 Tunnel Mask 2552552550 |
MAC Authentication O | gcal O Radius @ Disable

RADIUS IP Address 'i.D.D.D Lise Profile
RADIUS Secret I Edit

RADIUS Accounting

Clear Refresh S%Smit

3. Click Submit to save the changesto the L3 Tunnel network configuration.
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4, Check the L3 Tunnel Status to make sure the L3 Tunnel Statusis Configured.

5. To apply the profile changes to the APs, click Administration > Advanced
Configuration > AP Profiles.

6. Select the Default profile check box and click Apply.

I Default|
Profile Profile Status
ivi1-Default Associated
|
&)

When you update the profile, the Unified Switch adds the L3 Tunnel network to the Managed
APsthat use the default profile.

Configuring DHCP Relay and the DHCP Server

Unless you use the Unified Switch as a DHCP server or use static | P addresses for all devices,
you must enable DHCP relay on the switch so that the switch can forward DHCP requests
from the roaming wireless clients to the DHCP server on your network.

If you choose to use the Unified Switch as a DHCP server for wireless clients, you must
configure the DHCP server and the address pool for wireless clients.

Configuring the Relay Agent
Use the following command in Global Config mode to enable BootP and DHCP relay on the
switch:

boot pdhcprel ay enabl e

Use the following command in Global Config mode to specify the IP address of the BootP or
DHCP server that will assign |P addresses to wireless clients:

boot pdhcprel ay serverip 192.168. 30. 2

Configuring DHCP Relay and the DHCP Server 225



D-Link Unified Access System User Manual

226

To configure BootP and DHCP relay from the Web interface on the switch, go to the
L 3 Features > BootP/DHCP Relay Agent > Configuration page. Configure the server |P
address and enable the Admin Mode, then click Submit.

e —
P — BOOTPIDHCP Relay Agent Configuration
= i )
E-{E@ administration Maximum Hop Count il |(1 to 16)
E{## L2 Features T —
EMBE L3 Featurss Server IP Address 1192.168.55.12 |
B arp Admin Mode Enable: @
i 1 Minimom Wait Ti
_% foghass inimum Wait Time (secs) 0 l(O to 100)
E@ BOOTP/DHCP Relay Ager Circuit ID Option Mode Disable
Configuration
Status :
E Submit
'% Router

Configuring the DHCP Server

To configure DHCP on the D-Link Unified Switch, you configure the global DHCP settings
and the address pool for the clients. The following example shows how to create an address
pool for thewireless clients on the L3 Tunnel network. You can create additional address pools
so that the DHCP server on the Unified Switch can serve | P addresses to wireless clients that
use other networks (such as the Guest Network or Corporate LAN).

The following commands show how to configure a DHCP server to use for the wireless clients
that connect to the L3 Tunnel wireless network.

1.

From Global Config mode, enable DHCP.
(swi tch-pronpt) (Config)#service dhcp

Exclude the | P addresses in the range of 192.168.60.1 through 192.168.60.50, which
includes the | P addresses of WS1, WS2, and the Call Server.

sw t ch- pr onpt Config)#i p dhcp excl uded-address 192. 168. 2. 201
( 192. 1%8.?255( 9)# P P

Create an address pool.

(switch-pronmpt) (Config)#i p dhcp pool vlan200

Configure the L3 Tunnel subnet and netmask as the network address for the clients on
VLAN 200.

(swi tch-pronmpt) (Config)network 192.168.60.0 255.255.255.0

Configure the default router for the address pool.
(switch-prompt) (Config)default-router 192.168.60.1
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Use the following procedures to perform the same configuration by using the Web interface.

1. Fromthe Administration > DHCP Server > Global Configuration page, enable the

Admin Mode and enter the range of |P addresses that you do not want to assign to wireless

clients, then click Submit.

| DHCP Server Global Configuration

Admin Mode

Ping Packet Count
Conflict Logging Mode
Bootp Automatic Mode

Add Excluded Addresses *
From

To
Delete Excluded Addresses

Enable ~

2 {0, 210 10)

Enable =~

Disable «

192.168.60.1

1192.168.60.50

*mddress in To text bax iz specified to Exclude a range of addresses and left blank in order to Exclude & single address.

2. Navigate tothe Administration > DHCP Server > Pool Configuration page and select
Create from the Pool Name drop-down menu.

3. Enter aname for the address pool in the Pool Name field and select Dynamic from the

Type of Binding drop-down menu.
Enter a network number, network mask, and default router address in the appropriate

fields and click Submit.

DHCP Server Pool Configuration

Pool Name

Type of Binding
Network Number
Network Mask
Prefix Length
Lease Time
Days

Hours

Minutes

Default Router Addresses

L3 Clients »
Dynamic v
(192168 60.0
255.255.255.0 |
o3y
Specified Duration  +
1 |(0t059)
0 |{0to1439)

0 |(0to 86399)

(192168 .60.1
| |

Configuring DHCP Relay and the DHCP Server
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Understanding Quality of Service

Quality of Service (QoS) provides you with the ability to specify parameters on multiple
gueues for increased throughput and better performance of differentiated wireless traffic like
Voice-over-IP (VoI P), other types of audio, video, and streaming media as well as traditional
IP data over the D-Link Unified Access System.

A primary factor that affects QoS is network congestion due to an increased number of clients
attempting to accessthe air waves and higher traffic volume competing for bandwidth during a
busy time of day. The most noticeable degradation in service on a busy, overloaded network
will be evident in time-sensitive applications like Video, Voice-over-IP (Vol P), and streaming
media.

Unlike typical datafiles which are less affected by variability in QoS, Video, Vol P and
streaming media must be sent in a specific order at a consistent rate and with minimum delay
between Packet transmission. If the quality of service is compromised, the audio or video will
be distorted.

QoS and Load Balancing

By using a combination of load balancing and QoS techniques, you can provide a high quality
of service for time-sensitive applications even on a busy network. Load balancing sets
thresholds for client associations and AP utilization. QoS is a means of allocating bandwidth
and network access based on transmission priorities for different types of wireless traffic
within a single access point.

802.11e and WMM Standards Support

QoS describes a range of technologies for controlling data streams on shared network
connections. The |EEE 802.11e task group isin the process of defining a QoS standard for
transmission quality and availability of service on wireless networks. QoS is designed to
provide better network service by minimizing network congestion; limiting jitter, latency, and
packet |oss; supporting dedicated bandwidth for time-sensitive or mission critical applications,
and prioritizing wireless traffic for channel access.

Aswith all IEEE 802.11 working group standards, the goal isto provide a standard way of
implementing QoS features so that components from different companies are interoperable.
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The D-Link Access Points provide QoS based on the Wireless Multimedia (WMM)
specification, which implements a subset of 802.11e features.

Both access points and wireless clients (laptops, consumer electronics products) can be
WM M -enabled by the Wi-Fi Alliance.

Coordinating Traffic Flow

Configuring QoS options on the D-Link Unified Access System consists of setting parameters
on existing queues for different types of wirelesstraffic. You can configure different minimum
and maximum wait times for the transmission of packets in each queue based on the
requirements of the media being sent. Queues automatically provide minimum transmission
delay for Voice, Video, multimedia, and mission critical applications, and rely on best-effort
parameters for traditional 1P data.

For example, time-sensitive Voice, Video, and multimediaare given effectively higher priority
for transmission (lower wait timesfor channel access), while other applications and traditional
IP data which are less time-sensitive but often more data-intensive are expected to tolerate
longer wait times.

The D-Link Unified Access System implements QoS based on the IEEE Wireless Multimedia
(WMM) standard. A Linux-based queuing classis used to tag packets and establish multiple
gueues. The queues provided offer built-in prioritization and routing based on the type of data
being transmitted.

The Administration Ul provides away for you to configure parameters on the queues.

QoS Queues and DSCP on Packets

QoS on the D-Link Unified Access System leverages WMM information in the | P packet
header related to Diff-Serv Code Point (DSCP). Every IP packet sent over the network
includes a DSCP field in the header that indicates how the data should be prioritized and
transmitted over the network. The DSCP field consists of a6 bit value defined by the local
administration. For WMM, Wi-Fi Alliance suggests a particular mapping for DSCP values

The access point examines the DSCP field in the headers of al packets that pass through the
AP. Based on thevaluein apacket’s DSCP field, the AP prioriti zes the packet for transmission
by assigning it to one of the queues. This process occurs automatically, regardless of whether
you deliberately configure QoS or not.

A different type of datais associated with each queue. The gueue and associated priorities and
parameters for transmission are as follows:

» DataO (Voice). Highest priority queue, minimum delay. Time-sensitive data such as Voice
over IP (VolP) is automatically sent to this queue.

» Datal (Video). High priority queue, minimum delay. Time-sensitive data such as Video
and other streaming media are automatically sent to this queue.

» Data?2 (Best Effort). Medium priority queue, medium throughput and delay. Most
traditional |P datais sent to this queue.
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» Data 3 (Background). Lowest priority queue, high throughput. Bulk data that requires
maximum throughput and is not time-sensitive is sent to this queue (FTP data, for
example).

Using the QoS settings in the AP profile, you can configure Enhanced Distributed Channel
Access (EDCA) parameters that determine how each queueis treated when it is sent by the
access point to the client or by the client to the access point.

Wireless traffic travels:

»  Downstream from the access point to the client station
» Upstream from client station to access point

» Upstream from access point to network

» Downstream from network to access point

With WMM enabled, QoS settings on the D-Link Unified Access System affect thefirst two of
these; downstream traffic flowing from the access point to client station (AP EDCA
parameters) and the upstream traffic flowing from the station to the access point (station
EDCA parameters).

With WMM disabled, you can still set some parameters on the downstream traffic flowing
from the access point to the client station (AP EDCA parameters).

The other phases of the traffic flow (to and from the network) are not under control of the QoS
settings on the AP,

EDCF Control of Data Frames and AIFS

Datais transmitted over 802.11 wireless networksin frames. A frame consists of a discrete
portion of data along with some descriptive meta-information packaged for transmission on a
wireless network.

Each frame includes a source and destination MAC address, a control field with protocol
version, frame type, frame sequence number, frame body (with the actual information to be
transmitted) and frame check sequence for error detection.

The 802.11 standard defines various frame types for management and control of the wireless
infrastructure, and for data transmission. 802.11 frame types are (1) management frames, (2)
control frames, and (3) data frames. Management and control frames (which manage and
control the availability of the wireless infrastructure) automatically have higher priority for
transmission.

802.11e uses interframe spaces to regulate which frames get access to avail able channels and
to coordinate wait times for transmission of different types of data.

Management and control frames wait a minimum amount of time for transmission; they wait a
short interframe space (SIF). These wait times are built-in to 802.11 as infrastructure support
and are not configurable.

The D-Link Unified Access System supports the Enhanced Distribution Coordination
Function (EDCF) as defined by the 802.11e standard. EDCF, which is an enhancement to the
DCEF standard and is based on CSMA/CA protocol, defines the interframe space (1FS) between

EDCF Control of Data Frames and AIFS 231



D-Link Unified Access System User Manual

Backoff time
in milliseconds

232

data frames. Data frames wait for an amount of time defined as the arbitration interframe
space (AIFS) before transmitting.

This parameter is configurable.

Random Backoff and Contention Windows

If an access point detects that the medium isin use (busy), it uses the DCF random backoff
timer to determine the amount of time to wait before attempting to access a given channel
again. Each access point waits some random period of time between retries. The wait time
(initially a random value within arange specified as the Minimum Contention Window)
increases exponentially up to a specified limit (Maximum Contention Window). The random
delay avoids most of the collisions that would occur if multiple APs got access to the medium
at the same time and tried to transmit data simultaneously. The more active users you have on
anetwork, the more significant the performance gains of the backoff timer will bein reducing
the number of collisions and retransmissions.

— Doubling continues on each try until MaxCW is reached
at which point this wait time is used on retries
Backoff 4 = re-doubled until data is sent or until retries limit is reached

Backoff2 = MinCW doubled

Initial Backoff = random number in
range of MinCW

III|IIII_|IIII|IIIIV|||||

1 5 10 15 20 25

The random backoff used by the access point is a configurable parameter. To describe the
random delay, a*“Minimum Contention Window” (MinCW) and a “Maximum Contention
Window” (MaxCW) is defined.

» Thevalue specified for the Minimum Contention Window is the upper limit of arange for
theinitial random backoff wait time. The number used in the random backoff isinitially a
random number between 0 and the number defined for the Minimum Contention Window.

» If thefirst random backoff time ends before successful transmission of the data frame, the
access point increments a retry counter, and doubles the value of the random backoff
window. The value specified in the Maximum Contention Window is the upper limit for
this doubling of the random backoff. This doubling continues until either the dataframeis
sent or the Maximum Contention Window size is reached.

Packet Bursting for Better Performance

The D-Link Unified Access System includes 802.11e based packet bursting technology that
increases data throughput and speed of transmission over the wireless network. Packet
bursting enables the transmission of multiple packets without the extra overhead of header
information. The effect of thisisto increase network speed and data throughput. The size of
packet bursts allowed (maximum burst length) is a configurable parameter.
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TXOP Interval for Client Stations

The Transmission Opportunity (TXOP) is an interva of time when aWi-Fi Multimedia
(WMM) client station has the right to initiate transmissions onto the wireless medium (WM).

802.1p and DSCP tags

IEEE 802.1p is an extension of the |IEEE 802 standard and is responsible for QoS provision.
One purpose of 802.1p isto prioritize network traffic at the datalink/ MAC layer.

The 802.1q tag includes athree-bit field for prioritization, which alows packets to be grouped
into various traffic classes. Eight priority levels are defined. The highest priority is seven,
which might go to network critical traffic (voice). The lowest priority level is zero, thisisused
as abest-effort default, it isinvoked automatically when no other value has been set.

NOTE: IEEE 802.1p prioritization will not work unless QoS and WMM are enabled.
WMM must be enabled on both the AP and on the client connecting to the AP.
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Figure 104 outlines the way in which tags are retrieved and traffic prioritized on a network.

Figure 104. Traffic Prioritization

START

v

Is VLAN tag?

A YES

Take Priority from Is VLAN priority tag
Dscp (VLAN id = 0)

YES
NO

Is priority tag = 0

Take priority from tag Bask(e::riority from

Take priority from tag

Table 84 outlinesthe VLAN priority and DSCP values.
Table 84. VLAN Priority Tags

VLAN Priority Priority DSCP Value
0 Best Effort 0
1 Background 16
2 Background 8
3 Best Effort 24
4 Video 32
5 Video 40
6 Voice 48
7 Voice 56
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Limited Warranty (USA Only)

Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (* D-Link”) provides
this Limited Warranty:

» Only to the person or entity that originally purchased the product from D-Link or its
authorized reseller or distributor, and

e Only for products purchased and delivered within the fifty states of the United States, the
District of Columbia, U.S. Possessions or Protectorates, U.S. Military Installations, or
addresses with an APO or FPO.

Limited Warranty: D-Link warrants that the hardware portion of the D-Link product
described below (“Hardware”) will be free from material defects in workmanship and
materials under normal use from the date of original retail purchase of the product, for the
period set forth below (“Warranty Period”), except as otherwise stated herein.

Limited Lifetime Warranty for the product is defined as follows:

» Hardware: For aslong asthe original customer/end user owns the product, or five (5)
years after product discontinuance, whichever occurs first (excluding power supplies and
fans)

» Power suppliesand fans: Three (3) Year

» Spare parts and spare kits: Ninety (90) days

The customer's sole and exclusive remedy and the entire liability of D-Link and its suppliers
under this Limited Warranty will be, at D-Link’s option, to repair or replace the defective
Hardware during the Warranty Period at no charge to the original owner or to refund the actual
purchase price paid. Any repair or replacement will be rendered by D-Link at an Authorized
D-Link Service Office. The replacement hardware need not be new or have an identical make,
model or part. D-Link may, at its option, replace the defective Hardware or any part thereof
with any reconditioned product that D-Link reasonably determinesis substantially equivaent
(or superior) in al material respects to the defective Hardware. Repaired or replacement
hardware will be warranted for the remainder of the original Warranty Period or ninety (90)
days, whichever islonger, and is subject to the same limitations and exclusions. If a material
defect isincapable of correction, or if D-Link determinesthat it is not practical to repair or
replace the defective Hardware, the actual price paid by the original purchaser for the
defective Hardware will be refunded by D-Link upon return to D-Link of the defective
Hardware. All Hardware or part thereof that is replaced by D-Link, or for which the purchase
price isrefunded, shall become the property of D-Link upon replacement or refund.
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Limited Software Warranty: D-Link warrants that the software portion of the product

(“ Software”) will substantially conform to D-Link’s then current functional specifications for
the Software, as set forth in the applicable documentation, from the date of origina retail
purchase of the Software for a period of ninety (90) days (“ Software Warranty Period”),
provided that the Software is properly installed on approved hardware and operated as
contemplated in its documentation. D-Link further warrants that, during the Software
Warranty Period, the magnetic media on which D-Link delivers the Software will be free of
physical defects. The customer's sole and exclusive remedy and the entire liability of D-Link
and its suppliers under this Limited Warranty will be, at D-Link’s option, to replace the non-
conforming Software (or defective media) with software that substantially conforms to D-
Link’sfunctional specificationsfor the Software or to refund the portion of the actual purchase
price paid that is attributable to the Software. Except as otherwise agreed by D-Link in
writing, the replacement Software is provided only to the original licensee, and is subject to
the terms and conditions of the license granted by D-Link for the Software. Replacement
Software will be warranted for the remainder of the original Warranty Period and is subject to
the same limitations and exclusions. If amaterial non-conformance isincapable of correction,
or if D-Link determinesin its sole discretion that it is not practical to replace the non-
conforming Software, the price paid by the original licensee for the non-conforming Software
will be refunded by D-Link; provided that the non-conforming Software (and all copies
thereof) isfirst returned to D-Link. The license granted respecting any Software for which a
refund is given automatically terminates.

Non-Applicability of Warranty: The Limited Warranty provided hereunder for Hardware
and Software portions of D-Link's products will not be applied to and does not cover any
refurbished product and any product purchased through the inventory clearance or liquidation
sale or other salesin which D-Link, the sellers, or the liquidators expressly disclaim their
warranty obligation pertaining to the product and in that case, the product isbeing sold “ As-Is’
without any warranty whatsoever including, without limitation, the Limited Warranty as
described herein, notwithstanding anything stated herein to the contrary.

Submitting A Claim: The customer shall return the product to the origina purchase point
based on its return policy. In case the return policy period has expired and the product iswithin
warranty, the customer shall submit a claim to D-Link as outlined below:

»  The customer must submit with the product as part of the claim awritten description of the
Hardware defect or Software nonconformance in sufficient detail to allow D-Link to
confirm the same, along with proof of purchase of the product (such as acopy of the dated
purchase invoice for the product) if the product is not registered.

* The customer must obtain a Case ID Number from D-Link Technical Support at 1-877-
453-5465, who will attempt to assist the customer in resolving any suspected defects with
the product. If the product is considered defective, the customer must obtain a Return
Material Authorization (“RMA”) number by completing the RMA form and entering the
assigned Case ID Number at https://rma.dlink.com/.

o After an RMA number isissued, the defective product must be packaged securely in the
original or other suitable shipping package to ensure that it will not be damaged in transit,
and the RMA number must be prominently marked on the outside of the package. Do not
include any manuals or accessories in the shipping package. D-Link will only replace the
defective portion of the product and will not ship back any accessories.

» Thecustomer isresponsible for all in-bound shipping chargesto D-Link. No Cash on
Delivery (“*COD”) is allowed. Products sent COD will either be rejected by D-Link or
become the property of D-Link. Products shall be fully insured by the customer and
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shipped to D-Link Systems, Inc., 17595 Mt. Herrmann, Fountain Valley, CA 92708.
D-Link will not be held responsible for any packagesthat arelost in transit to D-Link. The
repaired or replaced packages will be shipped to the customer via UPS Ground or any
common carrier selected by D-Link. Return shipping charges shall be prepaid by D-Link if
you use an address in the United States, otherwise we will ship the product to you freight
collect. Expedited shipping is available upon request and provided shipping charges are
prepaid by the customer.

D-Link may reject or return any product that is not packaged and shipped in strict compliance
with the foregoing requirements, or for which an RMA number is not visible from the outside
of the package. The product owner agrees to pay D-Link’s reasonable handling and return
shipping charges for any product that is not packaged and shipped in accordance with the
foregoing requirements, or that is determined by D-Link not to be defective or non-
conforming.

What IsNot Covered: The Limited Warranty provided herein by D-Link does not cover:
Productsthat, in D-Link’s judgment, have been subjected to abuse, accident, alteration,
modification, tampering, negligence, misuse, faulty installation, lack of reasonable care, repair
or service in any way that is not contemplated in the documentation for the product, or if the
model or serial number has been atered, tampered with, defaced or removed; Initial
installation, installation and removal of the product for repair, and shipping costs, Operational
adjustments covered in the operating manual for the product, and normal maintenance;
Damage that occursin shipment, due to act of God, failures due to power surge, and cosmetic
damage; Any hardware, software, firmware or other products or services provided by anyone
other than D-Link; and Products that have been purchased from inventory clearance or
liquidation sales or other salesin which D-Link, the sellers, or the liquidators expressly
disclaim their warranty obligation pertaining to the product. While necessary maintenance or
repairs on your Product can be performed by any company, we recommend that you use only
an Authorized D-Link Service Office. Improper or incorrectly performed maintenance or
repair voids this Limited Warranty.

Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED
HEREIN, THE PRODUCT ISPROVIDED “ASIS” WITHOUT ANY WARRANTY OF
ANY KIND WHATSOEVER INCLUDING, WITHOUT LIMITATION, ANY WARRANTY
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-
INFRINGEMENT. IF ANY IMPLIED WARRANTY CANNOT BE DISCLAIMED IN ANY
TERRITORY WHERE A PRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED
WARRANTY SHALL BELIMITED TO NINETY (90) DAY S. EXCEPT AS EXPRESSLY
COVERED UNDER THE LIMITED WARRANTY PROVIDED HEREIN, THE ENTIRE
RISK ASTO THE QUALITY, SELECTION AND PERFORMANCE OF THE PRODUCT IS
WITH THE PURCHASER OF THE PRODUCT.

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK
ISNOT LIABLE UNDER ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR
OTHER LEGAL OR EQUITABLE THEORY FOR ANY LOSS OF USE OF THE
PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER, WHETHER
DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING BUT NOT
LIMITED TO, DAMAGES FOR LOSS OF GOODWILL, LOSS OF REVENUE OR
PROFIT, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, FAILURE OF
OTHER EQUIPMENT OR COMPUTER PROGRAMS TO WHICH D-LINK’S PRODUCT
ISCONNECTED WITH, LOSS OF INFORMATION OR DATA CONTAINED IN, STORED
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ON, OR INTEGRATED WITH ANY PRODUCT RETURNED TO D-LINK FOR
WARRANTY SERVICE) RESULTING FROM THE USE OF THE PRODUCT, RELATING
TOWARRANTY SERVICE, OR ARISING OUT OF ANY BREACH OF THISLIMITED
WARRANTY, EVEN IF D-LINK HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. THE SOLE REMEDY FOR A BREACH OF THE FOREGOING LIMITED
WARRANTY ISREPAIR, REPLACEMENT OR REFUND OF THE DEFECTIVE OR
NON-CONFORMING PRODUCT. THE MAXIMUM LIABILITY OF D-LINK UNDER
THISWARRANTY ISLIMITED TO THE PURCHASE PRICE OF THE PRODUCT
COVERED BY THE WARRANTY. THE FOREGOING EXPRESS WRITTEN
WARRANTIES AND REMEDIES ARE EXCLUSIVE AND ARE IN LIEU OF ANY
OTHER WARRANTIES OR REMEDIES, EXPRESS, IMPLIED OR STATUTORY.

Governing Law: This Limited Warranty shall be governed by the laws of the State of
Cdlifornia. Some states do not allow exclusion or limitation of incidental or consequential
damages, or limitations on how long an implied warranty lasts, so the foregoing limitations
and exclusions may not apply. This Limited Warranty provides specific legal rights and you
may also have other rights which vary from state to state.

Trademarks: D-Link is aregistered trademark of D-Link Systems, Inc. Other trademarks or
registered trademarks are the property of their respective owners.

Copyright Satement: No part of this publication or documentation accompanying this
product may be reproduced in any form or by any means or used to make any derivative such
as trandation, transformation, or adaptation without permission from D-Link Corporation/D-
Link Systems, Inc., as stipulated by the United States Copyright Act of 1976 and any
amendments thereto. Contents are subject to change without prior notice. Copyright 2007 by
D-Link Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning: ThisisaClass A product. In aresidential environment, this product may
cause radio interference, in which case the user may be required to take adegquate measures.

FCC Satement: This equipment has been tested and found to comply with the limits for a
Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in acommercid installation. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful interference to radio
communication. However, there is no guarantee that interference will not occur in a particul ar
installation. Operation of this equipment in aresidential environment islikely to cause harmful
interferenceto radio or television reception. If this equipment does cause harmful interference
to radio or television reception, which can be determined by turning the equipment off and on,
the user is encouraged to try to correct the interference by one or more of the following
measures:

* Reorient or relocate the receiving antenna.

» Increase the separation between the equipment and receiver.

»  Connect the equipment into an outlet on a circuit different from that to which the receiver
is connected.

» Consult the dealer or an experienced radio/TV technician for help.

For detailed warranty information applicable to products purchased outside the United
Sates, please contact the corresponding local D-Link office.
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Product Registration

Register your D-Link product online at http://support.dlink.com/register.

Product registration is entirely voluntary and failure to complete or return this formwill not

diminish your warranty rights.
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Limited Warranty

D-Link provides this limited warranty for its product only to the person or entity who originally
purchased the product from D-Link or its authorized reseller or distributor. D-Link would fulfill the
warranty obligation according to the local warranty policy in which you purchased our products.

Limited Hardware Warranty: D-Link warrants that the hardware portion of the D-Link products
described below (“Hardware”) will be free from material defects in workmanship and materials from
the date of original retail purchase of the Hardware, for the period set forth below applicable to the
product type (“Warranty Period”) if the Hardware is used and serviced in accordance with applicable
documentation; provided that a completed Registration Card is returned to an Authorized D-Link
Service Office within ninety (90) days after the date of original retail purchase of the Hardware. If a
completed Registration Card is not received by an authorized D-Link Service Office within such ninety
(90) period, then the Warranty Period shall be ninety (90) days from the date of purchase.

Product Type Warranty Period
Product (including Power Supplies and Fans) One (1) Year
Spare parts and pare kits Ninety (90) days

D-Link’s sole obligation shall be to repair or replace the defective Hardware at no charge to
the original owner. Such repair or replacement will be rendered by D-Link at an Authorized D-
Link Service Office. The replacement Hardware need not be new or of an identical make,
model or part; D-Link may in its discretion may replace the defective Hardware (or any part
thereof) with any reconditioned product that D-Link reasonably determinesis substantially
equivalent (or superior) in all material respects to the defective Hardware. The Warranty
Period shall extend for an additional ninety (90) days after any repaired or replaced Hardware
isdelivered. If amaterial defect isincapable of correction, or if D-Link determinesin its sole
discretion that it is not practical to repair or replace the defective Hardware, the price paid by
the original purchaser for the defective Hardware will be refunded by D-Link upon return to
D-Link of the defective Hardware. All Hardware (or part thereof) that is replaced by D-Link,
or for which the purchase price is refunded, shall become the property of D-Link upon
replacement or refund.

Limited Software Warranty: D-Link warrants that the software portion of the product

(“ Software™) will substantially conform to D-Link’s then current functional specifications for
the Software, as set forth in the applicable documentation, from the date of original delivery of
the Software for a period of ninety (90) days (“Warranty Period”), if the Software is properly
installed on approved hardware and operated as contemplated in its documentation. D-Link
further warrants that, during the Warranty Period, the magnetic media on which D-Link
delivers the Software will be free of physical defects. D-Link’s sole obligation shall be to
replace the non-conforming Software (or defective media) with software that substantially
conformsto D-Link’s functional specifications for the Software. Except as otherwise agreed
by D-Link in writing, the replacement Softwareis provided only to the original licensee, and is
subject to the terms and conditions of the license granted by D-Link for the Software. The
Warranty Period shall extend for an additional ninety (90) days after any replacement Software
isdelivered. If amaterial non-conformance isincapable of correction, or if D-Link determines
in its sole discretion that it is not practical to replace the non-conforming Software, the price
paid by the original licensee for the non-conforming Software will be refunded by D-Link;
provided that the non-conforming Software (and all copies thereof) isfirst returned to D-Link.
The license granted respecting any Software for which arefund is given automatically
terminates.
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What You Must Do For Warranty Service:

Reqistration Card. The Registration Card provided at the back of this manual must be
completed and returned to an Authorized D-Link Service Office for each D-Link product
within ninety (90) days after the product is purchased and/or licensed. The addresses/
telephone/fax list of the nearest Authorized D-Link Service Office is provided in the back of
this manual. FAILURE TO PROPERLY COMPLETE AND TIMELY RETURN THE
REGISTRATION CARD MAY AFFECT THE WARRANTY FOR THIS PRODUCT.

Submitting A Claim. Any claim under this limited warranty must be submitted in writing
before the end of the Warranty Period to an Authorized D-Link Service Office. The claim must
include awritten description of the Hardware defect or Software nonconformance in sufficient
detail to allow D-Link to confirm the same. The original product owner must obtain a Return
Material Authorization (RMA) number from the Authorized D-Link Service Office and, if
reguested, provide written proof of purchase of the product (such as a copy of the dated
purchase invoice for the product) before the warranty serviceis provided. After an RMA
number isissued, the defective product must be packaged securely in the original or other
suitable shipping package to ensure that it will not be damaged in transit, and the RMA
number must be prominently marked on the outside of the package. The packaged product
shall be insured and shipped to Authorized D-Link Service Office with al shipping costs
prepaid. D-Link may reject or return any product that is not packaged and shipped in strict
compliance with the foregoing requirements, or for which an RMA number is not visible from
the outside of the package. The product owner agreesto pay D-Link’s reasonabl e handling and
return shipping charges for any product that is not packaged and shipped in accordance with
the foregoing requirements, or that is determined by D-Link not to be defective or non-
conforming.

What Is Not Covered

Thislimited warranty provided by D-Link does not cover:

» Products that have been subjected to abuse, accident, alteration, modification, tampering,
negligence, misuse, faulty installation, lack of reasonable care, repair or servicein any
way that is not contemplated in the documentation for the product, or if the model or serial
number has been altered, tampered with, defaced or removed;

« Initial installation, installation and removal of the product for repair, and shipping costs;

»  Operational adjustments covered in the operating manual for the product, and normal
maintenance;

» Damage that occurs in shipment, due to act of God, failures due to power surge, and
cosmetic damage;

* Any hardware, software, firmware or other products or services provided by anyone other
than D-Link.

Disclaimer of Other Warranties;: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED
HEREIN, THE PRODUCT ISPROVIDED “AS-1S’ WITHOUT ANY WARRANTY OF
ANY KIND INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-
INFRINGEMENT. IF ANY IMPLIED WARRANTY CANNOT BE DISCLAIMED IN ANY
TERRITORY WHERE A PRODUCT ISSOLD, THE DURATION OF SUCH IMPLIED
WARRANTY SHALL BE LIMITED TO NINETY (90) DAY S. EXCEPT AS EXPRESSLY
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COVERED UNDER THE LIMITED WARRANTY PROVIDED HEREIN, THE ENTIRE
RISK ASTO THE QUALITY, SELECTION AND PERFORMANCE OF THE PRODUCT IS
WITH THE PURCHASER OF THE PRODUCT.

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK
ISNOT LIABLE UNDER ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY OR
OTHER LEGAL OR EQUITABLE THEORY FOR ANY LOSS OF USE OF THE
PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER, WHETHER
DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL (INCLUDING, BUT NOT
LIMITED TO, DAMAGESFOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER
FAILURE OR MALFUNCTION, LOSS OF INFORMATION OR DATA CONTAINED IN,
STORED ON, OR INTEGRATED WITH ANY PRODUCT RETURNED TO D-LINK FOR
WARRANTY SERVICE) RESULTING FROM THE USE OF THE PRODUCT, RELATING
TOWARRANTY SERVICE, OR ARISING OUT OF ANY BREACH OF THISLIMITED
WARRANTY, EVEN IF D-LINK HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. THE SOLE REMEDY FOR A BREACH OF THE FOREGOING LIMITED
WARRANTY ISREPAIR, REPLACEMENT OR REFUND OF THE DEFECTIVE OR
NON-CONFORMING PRODUCT.

GOVERNING LAW: This Limited Warranty shall be governed by the laws of the state of
Cdifornia.

Some states do not allow exclusion or limitation of incidental or consequential damages, or
limitations on how long an implied warranty lasts, so the foregoing limitations and exclusions
may not apply. Thislimited warranty provides specific legal rights and the product owner may
also have other rights which vary from state to state.

Trademarks

Copyright 2007 D-Link Corporation. Contents subject to change without prior notice. D-Link
isaregistered trademark of D-Link Corporation/D-Link Systems, Inc. All other trademarks
belong to their respective proprietors.

Copyright Statement

No part of this publication may be reproduced in any form or by any means or used to make
any derivative such as trandlation, transformation, or adaptation without permission from D-
Link Corporation/D-Link SystemsInc., as stipulated by the United States Copyright Act of
1976.

FCC Warning

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio frequency energy and, if
not installed and used in accordance with this manual, may cause harmful interferenceto radio
communications. Operation of this equipment in aresidential areais likely to cause harmful
interference in which case the user will be required to correct the interference at his own
expense.

© 2001- 2008 D-Link Corporation. All Rights Reserved.



Technical Support

(

Technical Support

You can find software updates and user documentation on the D-Link
website.

D-Link provides free technical support for customers within the United
States and within Canada for the duration of the service period, and
warranty confirmation service, during the warranty period on this product.
U.S. and Canadian customers can contact D-Link technical support through
our website, or by phone.

Tech Support for customers within the United States:
D-Link Technical Support over the Telephone:
(877) 354-6555
Monday to Friday 8:00am to 5:00pm PST

D-Link Technical Support over the Internet:
http://support.dlink.com
email:support@dlink.com

Tech Support for customers within Canada:

D-Link Technical Support over the Telephone:
(877) 354-6560
Monday to Friday 7:30am to 9:00pm EST

D-Link Technical Support over the Internet:
http://support.dlink.com
email: support@dlink.ca

D-Link
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Technical Support

hope will provide you a speedy resolution for your problem.

For Customers within
the United Kingdom & Ireland:
D-Link UK & Ireland Technical Support over the Internet:

http://www.dlink.co.uk
ftp:/ftp.dlink.co.uk

D-Link UK & Ireland Technical Support over the Telephone:

08456 12 0003 (United Kingdom)
+1890 886 899 (Ireland)
Lines Open
8.00am-10.00pm Mon-Fri
10.00am-7.00pm Sat & Sun

For Customers within Canada:

D-Link Canada Technical Support over the Telephone:
1-800-361-5265 (Canada)
Mon. to Fri. 7:30AM to 9:00PM EST

D-Link Canada Technical Support over the Internet:
http://support.dlink.ca
email: support@dlink.ca

~N

You can find software updates and user documentation on the D-Link websites.

If you require product support, we encourage you to browse our FAQ section on
the website before contacting the support line. We have many FAQ’s that we

D-Link
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Technische Unterstutzung

Aktualisierte Versionen von Software und Benutzerhandbuch finden
Sie auf der Website von D-Link.

D-Link bietet kostenfreie technische Unterstitzung fur Kunden
innerhalb Deutschlands, Osterreichs, der Schweiz und Osteuropas.

Unsere Kunden kénnen technische Unterstitzung tber unsere
Website, per E-Mail oder telefonisch anfordern.

Web: http://www.dlink.de
E-Mail: support@dlink.de
Telefon: +49 (1805)2787

0,12€/Min aus dem Festnetz der Deutschen Telekom.

Telefonische technische Unterstltzung erhalten Sie Montags bis Freitags
von 09.00 bis 17.30 Uhr.

Unterstltzung erhalten Sie auch bei der Premiumhotline fiir D-Link
Produkte unter der Rufnummer 09001-475767
Montag bis Freitag von 6-22 Uhr und am Wochenende von 11-18 Uhr.
1,75€/Min aus dem Festnetz der Deutschen Telekom.

Wenn Sie Kunde von D-Link auBerhalb Deutschlands, Osterreichs, der
Schweiz und Osteuropas sind, wenden Sie sich bitte an die zustandige
Niederlassung aus der Liste im Benutzerhandbuch.

\\ S
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Assistance technique

Vous trouverez la documentation et les logiciels les plus récents sur
le site web D-Link.

Vous pouvez contacter le service technique de
D-Link par notre site internet ou par téléphone.

Support technique destiné aux clients établis en France:
Assistance technique D-Link par téléphone :
0820 0803 03

N° INDIGO - 0,12€ TTC/min*
*Prix en France Métropolitaine au 3 mars 2005

Du lundi au samedi — de 9h00 a 19h00
Assistance technique D-Link sur internet :
http://www.dlink.fr
e-mail : support@dlink.fr

Support technique destiné aux clients établis au Canada :
Assistance technique D-Link par téléphone :
(800) 361-5265
Lun.-Ven. 7h30 a 21h00 HNE.
Assistance technique D-Link sur internet :
http ://support.dlink.ca
e-mail : support@dlink.ca

D-Link
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Asistencia Técnica

Puede encontrar las ultimas versiones de software asi
como documentacion técnica en el sitio web de D-Link.

D-Link ofrece asistencia técnica gratuita para clientes
residentes en Espafia durante el periodo de garantia del
producto.

Asistencia Técnica de D-Link por teléfono:
+34 902 30 45 45
Lunes a Viernes de 9:00 a 14:00 y de 15:00 a 18:00

Asistencia Técnica de D-Link a través de Internet:
http://www.dlink.es/support/
e-mail: soporte@dlink.es

D-Link
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Supporto tecnico

Gli ultimi aggiornamenti e la documentazione sono
disponibili sul sito D-Link.

Supporto tecnico per i clienti residenti in Italia

D-Link Mediterraneo S.r.L.
Via N. Bonnet 6/B 20154 Milano

Supporto Tecnico dal lunedi al venerdi dalle ore
9.00 alle ore 19.00 con orario continuato
Telefono: 02-39607160

URL : http://www.dlink.it/supporto.html
Email: tech@dlink.it

D-Link
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Technical Support

You can find software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within Benelux for the
duration of the warranty period on this product.

Benelux customers can contact D-Link technical support through our website, or
by phone.

Tech Support for customers within the Netherlands:
D-Link Technical Support over the Telephone:
0900 501 2007
Monday to Friday 9:00 am to 10:00 pm

D-Link Technical Support over the Internet:
www.dlink.nl

Tech Support for customers within Belgium:
D-Link Technical Support over the Telephone:
070 66 06 40
Monday to Friday 9:00 am to 10:00 pm

D-Link Technical Support over the Internet:
www.dlink.be

Tech Support for customers within

Luxemburg:
D-Link Technical Support over the Telephone:
+32 70 66 06 40
Monday to Friday 9:00 am to 10:00 pm

D-Link Technical Support over the Internet:
www.dlink.be

D-Link
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Pomoc techniczna

Najnowsze wersje oprogramowania i dokumentacji uzytkownika
mozna znalez¢ w serwisie internetowym firmy D-Link.

D-Link zapewnia bezptatng pomoc techniczng klientom w Polsce
w okresie gwarancyjnym produktu.

Klienci z Polski moga sie kontaktowaé z dziatem pomocy
technicznej firmy D-Link za posrednictwem Internetu lub
telefonicznie.

Telefoniczna pomoc techniczna firmy D-Link:
(+48 12) 25-44-000

Pomoc techniczna firmy D-Link Swiadczona przez
Internet:
URL: http://www.dlink.pl
e-mail: dlink@fixit.pl

D-Link
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Technicka podpora

Aktualizované verze software a uzivatelskych pfiru¢ek najdete na
webové strance firmy D-Link.

D-Link poskytuje svym zakaznikim bezplatnou technickou
podporu

Zakaznici mohou kontaktovat oddéleni technické podpory pfes
weboveé stranky, mailem nebo telefonicky

Web: http://www.dlink.cz/suppport/
E-mail: support@dlink.cz
Telefon: 224 247 503

Telefonicka podpora je v provozu:
PO- PA od 09.00 do 17.00

D-Link
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Technikai Tamogatas

Meghaijté programokat és frissitéseket a D-Link Magyarorszag
weblapjardl tolthet le.
Telefonon technikai segitséget munkanapokon hétfétél-csitortdkig
9.00 — 16.00 6raig és penteken 9.00 — 14.00 oraig kérhet
a (1) 461-3001 telefonszamon vagy a support@dlink.hu
emailcimen.

Magyarorszagi technikai tamogatas :

D-Link Magyarorszag
1074 Budapest, Alséerdésor u. 6. — R70 Irodahaz 1 em.

Tel. : 06 1 461-3001
Fax : 06 1 461-3004

email : support@dlink.hu
URL : http://www.dlink.hu

D-Link
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Teknisk Support

Du kan finne programvare oppdateringer og bruker
dokumentasjon pa D-Links web sider.

D-Link tilbyr sine kunder gratis teknisk support under
produktets garantitid.

Kunder kan kontakte D-Links teknisk support via vare
hjemmesider, eller pa tif.

Teknisk Support:

D-Link Teknisk telefon Support:
800 10 610
(Hverdager 08:00-20:00)

D-Link Teknisk Support over Internett:
http://www.dlink.no

D-Link
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Teknisk Support

Du finder software opdateringer og bruger-
dokumentation pa D-Link’s hiemmeside.

D-Link tilbyder gratis teknisk support til kunder
i Danmark i hele produktets garantiperiode.

Danske kunder kan kontakte D-Link’s tekniske
support via vores hjemmeside eller telefonisk.

D-Link teknisk support over telefonen:

TIf. 7026 9040
Hverdager: kl. 08:00 — 20:00

D-Link teknisk support pa Internettet:
http://www.dlink.dk

D-Link
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Teknista tukea asiakkaille
Suomessa:

D-Link tarjoaa teknista tukea asiakkailleen.
Tuotteen takuun voimassaoloajan.
Tekninen tuki palvelee seuraavasti:

Arkisin klo. 9 - 21
numerosta
0800-114 677

Internetin kautta
Ajurit ja lisatietoja tuotteista.
http://www.dlink_fi

Sahkopostin kautta
voit myos tehda kyselyita.

D-Link
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Teknisk Support

Pa var hemsida kan du hitta mer information om mjukvaru
uppdateringar och annan anvandarinformation.

D-Link tillhandahaller teknisk support till kunder i Sverige
under hela garantitiden fér denna produkt.

Teknisk Support for kunder i Sverige:
D-Link Teknisk Support via telefon:
0770-33 00 35
Vardagar 08.00-20.00

D-Link Teknisk Support via Internet:
http://www.dlink.se

D-Link
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Suporte Técnico

Vocé pode encontrar atualizagdes de software e documentagéo de
utilizador no site de D-Link Portugal http://www.dlink.pt.

A D-Link fornece suporte técnico gratuito para clientes no Portugal
durante o periodo de vigéncia de garantia deste produto.

Suporte Técnico para clientes no Portugal:

Assisténcia Técnica:

Email: soporte@dlink.es
http://www.dlink.pt/support/
ftp://ftp.dlink.es

Technical Support
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Texvikn Y1rooTnpign

MnopeiTte va Bpeite software updates kal NANPOPOPIES Yia Tn Xpron TWV NPoiovTwv
OTIG 10T00€AIBEG TNG D-Link

H D-Link npoo@épel oToug NEAATEG TNG dwPEAV UMNOGTHPIEN
oTov EAAadIKO Xwpo

MMopPEiTE va ENIKOIVWVEITE E TO THAMA TEXVIKNG UNOOTAPIENG HEOW TNG I0TOOEAIDAG
N HEOCW TNAEPWVOU

MNa neAareg evrog Tou EAAadIKoU X®mpPou:
TnAepwvikn unootnpi&n D-Link :

TnA: 210 86 11 114
®ag: 210 86 53 172
(Agutépa-Napaokeun 09:00-17:00)

e-mail: support@dlink.gr
Texvikn unootnpi&n D-Link péow Internet:

http://www.dlink.gr
ftp:/ /ftp.dlink.it

D-Link
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Technical Support

Tech Support for customers in

Australia:
Tel: 1300-766-868
Monday to Friday 8:00am to 8:00pm EST
Saturday 9:00am to 1:00pm EST
http://www.dlink.com.au
e-mail: support@dlink.com.au

India:
Tel: 1800-222-002
Monday to Friday 9:30AM to 7:00PM
http://www.dlink.co.in/support/productsupport.aspx

Indonesia, Malaysia, Singapore and Thailand:

Tel: +62-21-3851275 (Indonesia)
Tel: 1800-882-880 (Malaysia)
Tel: +65 66229355 (Singapore)
Tel: +66-2-719-8978/9 (Thailand)

Monday to Friday 9:00am to 6:00pm
http://www.dlink.com.sg/support/
e-mail: support@dlink.com.sg

Korea:

Tel: +82-2-890-5496
Monday to Friday 9:00am to 6:00pm
http://www.d-link.co.kr
e-mail: lee@d-link.co.kr

New Zealand:
Tel: 0800-900-900
Monday to Friday 8:30am to 8:30pm
Saturday 9:00am to 5:00pm
http://www.dlink.co.nz
e-mail: support@dlink.co.nz

N

You can find software updates and user documentation on the D-Link website.
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You can find software updates and user documentation on the D-Link website.
Tech Support for customers in

Egypt:

Tel: +202-2919035 or +202-2919047
Sunday to Thursday 9:00am to 5:00pm
http://support.dlink-me.com
e-mail: amostafa@dlink-me.com

Iran:

Tel: +98-21-88822613
Sunday to Thursday 9:00am to 6:00pm
http://support.dlink-me.com
e-mail: support.ir@dlink-me.com

Israel:
Tel: +972-9-9715701
Sunday to Thursday 9:00am to 5:00pm
http://www.dlink.co.il/support/
e-mail: support@dlink.co.il

Pakistan:

Tel: +92-21-4548158 or +92-21-4548310
Sunday to Thursday 9:00am to 6:00pm
http://support.dlink-me.com
e-mail: support.pk@dlink-me.com

South Africa and Sub Sahara Region:
Tel: +27-12-665-2165
08600 DLINK (for South Africa only)
Monday to Friday 8:30am to 9:00pm South Africa Time
http://www.d-link.co.za

Turkey:

Tel: +90-212-2895659
Monday to Friday 9:00am to 6:00pm
http://www.dlink.com.tr
e-mail: turkiye@dlink-me.com
e-mail: support@d-link.co.za

U.A.E and North Africa:
Tel: +971-4-391-6480 (U.A.E)
Sunday to Wednesday 9:00am to 6:00pm GMT+4
Thursday 9:00am to 1:00pm GMT+4
http://support.dlink-me.com
k e-mail: support@dlink-me.com

D-Link
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TexHnyeckasa nogaepxKka

O6HoBNEHMA NporpaMMHOro obecneyeHns n JOKyMeHTaums
[OCTYMHbl HAa VIHTepHeT-canTe D-Link.

D-Link npepoctaBnseT 6ecnnatHyo noaaepXkKy Ansa KIMeHToB
B TE€YEeHMe rapaHTUMHOroO CpokKa.

KnueHTbl MoryT o6patuTbCs B rpynny TEXHUYECKON Noaaep KK/
D-Link no TenedoHy unu yepes IHTepHeT.

TexHnyeckas noanepxka D-Link:
+495-744-00-99

TexHu4yeckasa nogaepkka yepes UHTepHeT
http://www.dlink.ru
e-mail: support@dlink.ru

D-Link

Building Networks for People

261



D-Link Unified Access System User Manual

r

Asistencia Técnica

D-Link Latin América pone a disposicién de sus clientes, especificaciones,
documentacion y software mas reciente a través de nuestro Sitio Web
www.dlinkla.com

El servicio de soporte técnico tiene presencia en numerosos paises de la
Regién Latino América, y presta asistencia gratuita a todos los clientes de
D-Link, en forma telefonica e internet, a través de la casilla
soporte@dlinkla.com

Soporte Técnico Help Desk Argentina:
TTeléfono: 0800-12235465 Lunes a Viernes 09:00 am a 22:00 pm
Soporte Técnico Help Desk Chile:

Teléfono: 800 8 35465 Lunes a Viernes 08:00 am a 21:00 pm
Soporte Técnico Help Desk Colombia:

Teléfono: 01800-9525465 Lunes a Viernes 07:00 am a 20:00 pm
Soporte Técnico Help Desk Ecuador:

Teléfono: 1800-035465 Lunes a Viernes 07:00 am a 20:00 pm
Soporte Técnico Help Desk El Salvador:
Teléfono: 800-6335 Lunes a Viernes 06:00 am a 19:00 pm
Soporte Técnico Help Desk Guatemala:
Teléfono: 1800-8350255 Lunes a Viernes 06:00 am a 19:00 pm
Soporte Técnico Help Desk Panama:

Teléfono: 00800 0525465 Lunes a Viernes 07:00 am a 20:00 pm
Soporte Técnico Help Desk Costa Rica:
Teléfono: 0800 0521478 Lunes a Viernes 06:00 am a 19:00 pm
Soporte Técnico Help Desk Peru:

Teléfono: 0800-00968 Lunes a Viernes 07:00 am a 20:00 pm
Soporte Técnico Help Desk Republica Dominicana:
Teléfono: 1888 7515478 Lunes a Viernes 06:00 am a 19:00 pm
Soporte Técnico Help Desk Venezuela:
Teléfono: 0800-1005767 Lunes a Viernes 08:00 am a 21:00 pm

~
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Technical Support

Suporte Técnico

Vocé pode encontrar atualizactes de software e documentacéo
de usuério no site da D-Link Brasil www.dlinkbrasil.com.br.

A D-Link fornece suporte técnico gratuito para clientes no Brasil
durante o periodo de vigéncia da garantia deste produto.

Suporte Técnico para clientes no Brasil:

Telefone
Sao Paulo +11-2185-9301

Segunda a sexta
Das 8h30 as 18h30
Demais Regides do Brasil 0800 70 24 104

E-mail:
e-mail: suporte@dlinkbrasil.com.br
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Dukungan Teknis

Update perangkat lunak dan dokumentasi pengguna dapat
diperoleh pada situs web D-Link.

Dukungan Teknis untuk pelanggan:

Dukungan Teknis D-Link melalui telepon:
Tel: +62-21-3851275
Senin sampai Jumat 9:00 - 12:30, 14:00 - 18:00
Waktu Singapura

Dukungan Teknis D-Link melalui Internet:
e-mail: support@dlink.com.sg
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International Offices

USA

17595 Mt. Herrmann Street
Fountain Valley, CA 92708
TEL: 1-800-326-1688
URL: www.dlink.com

Canada

2180 Winston Park Drive
Oakville, Ontario, L6H 5W1
Canada

TEL: 1-905-8295033

FAX: 1-905-8295223

URL: www.dlink.ca

Europe (U.K.)
D-Link (Europe) Ltd
D-Link House, Abbey Road

Park Royal, London NW10 7BX

United Kingdom

TEL: +44 (0)20 8955 9000
FAX: +44 (0)20 8955 9001
URL: www.dlink.co.uk

Austria

Millennium Tower
Handelskai 94-96

A-1200 WIEN,

Austria

TEL: +43 (0)1 240 27 270
FAX: +43 (0)1 240 27 271
URL: www.dlink.at

Belgium

Rue des Colonies 11
B-1000 Brussels,
Belgium

TEL: +32 (0)2 517 7111
FAX: +32 (0)2 517 6500
URL: www.dlink.be

Bulgaria

60A BulgariaBlvd., Office 1,

Sofia 1680,

Bulgaria

TEL: +359 2 958 22 42
FAX: +359 2 958 65 57
URL: www.dlink.eu

Czech Republic
Vaclavske namesti 36
110 00 Praha 1

Czech Republic

TEL: +420 224 247 500
FAX: +420 224 234 967

Hot line CZ: +420 225 281 553
Hot line SK: +421 263 813 628

URL: www.dlink.cz
URL: www.dlink.sk

Denmark
Naverland 2,

DK-2600 Glostrup, Copenhagen,

Denmark

TEL: +45 43 96 9 040
FAX: +4543 42 43 47
URL: www.dlink.dk

Finland

Latokartanontie 7A
FIN-00700 Helsinki,
Finland

TEL : +358 10 309 8840
FAX: + 358 10 309 8841
URL: www.dlink.fi

France

41 boulevard Vauban
78280 Guyancourt

France

TEL: +33(0)1 3023 86 88
FAX: +33(0)1 30 23 86 89
URL: www.dlink.fr

Germany

Schwalbacher Strasse 74
D-65760 Eschborn,
Germany

TEL: +49 (0)6196 77 99 0
FAX: +49 (0)6196 77 99 300
URL: www.dlink.de

Greece

101, Panagoulis Str. 163-43
Heliopolis, Athens,

Greece

TEL: +30 210 9914512
FAX:+30 210 9916902
URL: www.dlink.gr

Hungary

Rékoczi Gt 70-72
HU-1074 Budapest,
Hungary

TEL: +36 (0) 1461 30 00
FAX: +36 (0) 1 461 30 04
URL: www.dlink.hu

Italy

ViaNino Bonnet n. 6/b
20154 — Milano,

Italy

TEL: +39 02 2900 0676
FAX: +39 02 2900 1723
URL: www.dlink.it

L uxembourg

Rue des Colonies 11
B-1000 Brussels,
Belgium

TEL: +32 (0)2 517 7111
FAX: +32 (0)2 517 6500
URL: www.dlink.be

Netherlands

Weena 290

3012NJ Rotterdam,
Netherlands

TEL: +31 (0)10 282 1445
FAX: +31 (0)10 282 1331
URL: www.dlink.nl

Norway
Karihaugveien 89
N-1086 Oslo,

Norway

TEL: +47 99 300 100
FAX: +47 223090 85
URL: www.dlink.no

Poland

Budynek Aurum

ul. Walicow 11

00-851 Warszawa,

Poland

TEL: +48 (0) 2258392 75
FAX: +48 (0) 22 583 92 76
URL: www.dlink.pl

Portugal

RuaFernando Palha, 50 Edificio Simol
1900 Lisbon,

Portugal

TEL: +351 21 8688493

FAX: +351 21 8622492

URL: www.dlink.es

Romania
B-dul Unirii nr. 55, bl. E4A, sc.2, et. 4,

ap. 39,

sector 3, Bucuresti,
Romania

TEL: +40(0)21 320 23 05
FAX: +40(0)21 320 23 07
URL: www.dlink.eu

Spain

Avenida Diagonal, 593-95, 9th floor
08014 Barcelona,

Spain

TEL: +34 93 409 07 70

FAX: +34 93 491 07 95

URL: www.dlink.es

Sweden
Gustavslundsvéagen 151B
S-167 51 Bromma
Sweden

TEL: +46 (0)8 564 619 00
FAX: +46 (0)8 564 619 01
URL: www.dlink.se

Switzerland

Glatt Tower, 2.0G
Postfach

CH-8301 Glattzentrum
Switzerland

TEL: +41 (0)1 832 11 00
FAX: +41 (0)1 832 11 01
URL: www.dlink.ch

Singapore

1 International Business Park
#03-12 The Synergy
Singapore 609917

TEL: 65-6774-6233

FAX: 65-6774-6322

URL: www.dlink-intl.com

Australia

1 Giffnock Avenue
North Ryde, NSW 2113
Australia

TEL: 61-2-8899-1800
FAX: 61-2-8899-1868
URL: www.dlink.com.au

India

D-Link House, Plot No.5,
Kurla-Bandra Complex Road, Off.
CST Road,

Santacruz (E), Mumbai - 400 098 India
TEL: 91-22-26526696/ 30616666
FAX: 91-22-26528914/ 8476

URL: www.dlink.co.in

Middle East (Dubai)
P.O.Box: 500376

Office: 103, Building:3
Dubai Internet City

Dubai, United Arab Emirates
TEL: +971-4-3916480

FAX: +971-4-3908881

URL: www.dlink-me.com

Turkey
CayazayaMaslak Yolu
S/A Kat: 5,

Istanbul, Turkey

TEL: 0212-289-5659
FAX:0212-289-7606
URL: www.dlink.com.tr

Iran

Unit 6, No. 39, 6th Alley,
Sanaei St, Karimkhan Ave
Tehran-IRAN

TEL: 9821 8882 2613
FAX: 9821 8883 5492

Pakistan

Office#311, Business Avenue
Main Shahrah-e-Faisa

K arachi-Pakistan

TEL: 92-21-4548158, 4548310
FAX: 92-21-4535103

Egypt ) )
47,El Merghany street, Heliopolis
Cairo-Egypt

TEL: +202-2919035, +202-2919047
FAX: +202-2919051

URL: www.dlink-me.com

lsrael

11 Hamanofim Street

Ackerstein Towers, Regus Business
Center

PO.B 2148, Hertzelia-Pituach
46120

Israel

TEL: +972-9-9715700

FAX: +972-9-9715601

URL: www.dlink.co.il

Latin America

Auv. Vitacura # 2939, floor 6th
Las Condes, Santiago

RM Chile

TEL: 56-2-5838-950

FAX: 56-2-5838-952

URL: www.dlinkla.com

Brazil

Av das Nacoes Unidas

11857 — 14- andar - ¢j 141/142
Brooklin Novo

Sao Paulo - SP - Brazil

CEP 04578-000 (Zip Code)
TEL: (55 11) 21859300

FAX: (55 11) 21859322

URL: www.dlinkbrasil.com.br

South Africa

Einstein Park 11

Block B

102-106 Witch-Hazel Avenue
First Floor Block B
Einstein Park 11

Highveld Techno Park
Centurion

Gauteng

Republic of South Africa
TEL: 27-12-665-2165
FAX: 27-12-665-2186
URL: www.d-link.co.za

Russia

Grafsky per., 14, floor 6

M oscow

129626 Russia

TEL: 7-495-744-0099
FAX: 7-495-744-0099 #350
URL: www.dlink.ru

Japan K .K.

Level 6 Konan YK Building, Konan
2-4-12

Minato-Ku Tokyo 108-0075, Japan
URL: www.dlink-jp.com

China

No0.202, C1 Building, Huitong Of-
fice Park, No. 71, Jianguo Road,
Chaoyang District, Beijing
100025, China

TEL +86-10-58635800

FAX: +86-10-58635799

URL: www.dlink.com.cn

Taiwan

No. 289, Sinhu 3rd Rd.,
Neihu District,

Taipei City 114, Taiwan
TEL: 886-2-6600-0123
FAX: 886-2-6600-1188

URL: www.dlink.com.tw
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Registration Card
All Countries and Regions Excluding USA

Print, type or use block letters.

Your name: Mr./Ms

Organization: Dept.
Your title at organization:
Telephone: Fax:
Organization's full address:

Country:
Date of purchase (Month/Day/Year):

Product Model Product Serial No.

Product was purchased from:
Reseller's name:
Telephone: Fax:

Answers to the following questions help us to support your product:
1. Where and how will the product primarily be used?
(1 Home 1 Office dTravel dCompany Business dHome Business 1 Personal Use
2. How many employees work at installation site?
(11 employee 12-9 [110-49 (150-99 [1100-499 1 500-999 11000 or more
3. What network protocol(s) does your organization use?
1 XNS/IPX dTCP/IP 1 DECnet Others
. What network operating system(s) does your organization use?
(1 D-Link LANsmart 1 Novell NetWare 1 NetWare Lite ASCO Unix/Xenix APC NFS 13Com 3+Open
1 Cisco Network  OBanyan Vines  DECnet Pathwork & Windows NT dWindows 2000 dWindows XP
Others
5. What network management program does your organization use?
1 D-View 4 HP OpenView/Windows 1 HP OpenView/Unix [d SunNet Manager 1 Novell NMS
1 NetView 6000 Others
6. What network medium/media does your organization use?
1 Fiber-optics QThick coax Ethernet  OThin coax Ethernet Q10BASE-T UTP/STP
1 100BASE-TX 1 100BASE-T4 QOWireless 802.11b and 802.11g 1 Wireless 802.11a Others
. What applications are used on your network?
(J Desktop publishing Spreadsheet 1 Word processing [ CAD/CAM
(1 Database management [JAccounting Others
. What category best describes your company?
(1 Aerospace 1 Engineering Education OFinance OHospital dLegal Qinsurance/Real Estate
1 Manufacturing  Retail/Chainstore/Wholesale 1 Government 1 Transportation/Utilities/Communication
VAR @ System house/company Other
9. Would you recommend your D-Link product to a friend?
dYes ONo ODon't know yet
10. Your comments on this product?

SN

~
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